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Centreon is open source software which enables you to supervise all the elements comprising your information system.

How to reduce your time to monitoring with Centreon IMP ?

Contents:
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CENTREON 46-52 RUE ALBERT FR75014 PARIS

1



2
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Contents



CHAPTER 1

About

Centreon is an open source IT monitoring solution by Centreon, a leading Paris-based software company.

Centreon is a fully packaged, easy to install and ready to use solution that includes all required components for the
real-time monitoring of any Information System:

• A generic data collection engine

• A complete Plugin library to monitor the complete IT infrastructure, from business applications down to network
elements

• A multi-user, ergonomic user interface

• Advanced user rights management through Access Control Lists (ACL)

• Comprehensive Alarms and Notifications management

• Real-time, customized dashboards

• Availability reports

The Centreon open source solution is the foundation of the Centreon EMS software suite, which adds the following
licensed modules:

• Centreon EPP, for instant monitoring configuration

• Centreon MAP, to create graphical real-time views

• Centreon BAM, to correlate key business processes to critical IT components

• Centreon MBI, to automatically create ITIL-compliant infrastructure management and capacity planning reports

Other modules are developed by the open source community and extend Centreon capabilities.

Centreon is a mature and robust solution that supports a variety of architecture to address scalability, high-availability,
resiliency and distributed networks monitoring.

Finally, the Centreon solution includes many tools to integrate into your IT Operations Management production envi-
ronment:

• A complete set of APIs to automate monitoring configuration from tools such as Salt, Ansible, Puppet, Chef. . .

• Integration with all popular ITSM solution such as ServiceNow, GLPI, Easyvista, iTop, OTRS. . .

• Stream connectors to Time-Series DataBase, Big Data or Manager of Managers solutions: Graphite, InfluxDB,
Elasticsearch, Splunk, BMC Truesight, ServiceNow Event Management, ...

3
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CHAPTER 2

Release notes

You can find in this chapter all changelogs that give you knowledges about the changes integrated into each releases
of Centreon Web.

Please find here the releases notes of the last major versions :

2.1 Centreon 18.10

Please find here the release notes dedicated to the last 18.10.x version of Centreon.

2.1.1 Centreon Web 18.10.3

Enhancements

Bug Fixes

2.1.2 Centreon Web 18.10.2

Enhancements

• [Configuration] Prevent time period to call itself via templates - PR #7024

• [Configuration] Re-add the PID column in the poller list page - PR #6993

• [Documentation] Add clean yum cache command for 18.10 upgrade - PR #7030

• [Documentation] Correct typo in RS architecture FR chapter - PR #6965

• [Downtimes] Apply ACL on resources to configure recurring downtimes - PR #6962

• [Translate] Add all date picker libraries for new translation - PR #7040

• [UX] Improve full screen mode - PR #6976

Bug fixes

• [Chart] Fix graph export when a curve is only displayed in legend - PR #7009

• [Documentation] Describe DBMS minimal version to prevent partitioning tables issue - PR #6974

• [Monitoring] Use all selected filter on refresh with “play” button - PR #6984
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• [Extensions] Fix module upgrades using php scripts - PR #7073

• [Remote Server] Update default path of broker watchdog logs

Technical

• Update select2 component - PR #7034

2.1.3 Centreon Web 18.10.1

Enhancements

• [Install] Optimize db partitioning during fresh install - PR #6937

• [Documentation] Improve FAQ chapter - PR #6900

• [Documentation] Improve prerequisites chapter - PR #6922

• [Documentation] Improve installation chapter - PR #6942 #6973

• [Documentation] Improve architecture chapter - PR #6966

• [Documentation] Add chapter to manage custom centreon uri - PR #6903

• [Documentation] Improve upgrade chapter - PR #6905 #6907 #6908

• [Documentation] Global documentation improvement - PR #6896 #6906 #6931 #6933

Bug fixes

• [API] Fix PHP warning - PR #6917

• [API] Fix export of hostgroup services - PR #6948

• [Configuration] Fix host categories creation and update form - PR #6901

• [Configuration] Remove old wizard button - PR #6902

• [Configuration] Fix export of cbd watchdog logs path - PR #6919

• [Configuration/Widget] Fix widget upgrade if directory has changed - PR #6975

• [Remote Server] Fix incorrect variable name - PR #6915]

• [Translation] Update strings - PR #6899

• [Global] Remove duplicate() method in children classes - PR #6918

• [Global] Update topology extract where clause from db - PR #6898

Security fixes

2.1.4 Centreon Web 18.10.0

New features

Centreon Remote Server is a new building-block in the Centreon distributed monitoring architecture. It comes in
addition to the existing Centreon Central Server and Centreon Pollers.

6
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Centreon Remote Server allows remote IT operations team to benefit from the full Centreon user experience, albeit
on a subset of Centreon Pollers. Monitoring configuration takes place on the Central Server and is automatically
synchronized with all Remote Servers. Monitoring Operations (Acknowledge, Downtime...) may take place both on a
Remote Server or the Central Server.

In case of network link failure between a Remote Server and the Central Server, data retention takes place and the two
Servers are synchronized as soon as the connection is up again.

Centreon Remote Server is integrated in Centreon Core. It fully replaces the Poller Display module.

UI & UX Design

• Add new banner system and UX

• Add new menus system and UX

• Unique format of dates displayed according to user language settings

• Thanks to the community, Centreon is now available in Spanish and Portuguese (Portugal & Brazil)

Notice: The “Home > Poller Statistics” menu moved to “Administration > Server Status”. Moreover, this one is now
named “Platform Status”.

Enhancements

• [Stats] Add a Centreon Experience Improvement Program

• [API] Possibility to cancel flexible RTDOWNTIME - #6062

• [Install] Add possibility to install/update all modules in one time

• [Configuration] Add a new wizard to configure in one time a complete poller or Remote Server

• [Configuration] Add possibility to install/update all modules in one time

• [Configuration] Add possibility to install/update all widgets in one time

• [LDAP] Manage multiple LDAP group with same dn - PR #6714

• [LDAP] If user account is disabled in AD, user will be still able to connect in Centreon - #6240

• [LDAP] Update LDAP Attributes on authentication - #3402

• [LDAP] Problem with LDAP contact groups with name members with accent - #5368

• [LDAP] Improve group synchronization - #6203 #6239 #6241

• [Packages] New centreon-database package, helpful for standalone Centreon databases;

Bug fixes

• [Install] Fix several PHP notices

• [Backup] Fix PHP paths in backup script - PR #6787

• [Chart] Fix graph search with ACL in performances page - PR #6798

• [Configuration] Meta Service using quotes in output format string - PR #6216

• [Configuration] Fix duplicate advanced matching SNMP traps rules - PR #6738

• [Configuration] Avoid duplicate entry in ACL table after host creation - PR #6810

2.1. Centreon 18.10
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• [Configuration] Fix host categories form - PR #6785

• [Configuration] fix regexp for trap argument ending by backslash - PR #6699

• [Downtime] Add a downtime for user linked to ACL - PR #5988

• [Downtime] Fix recurrent downtime form (period loading) - PR #6645

• [Monitoring] Display cancel button in comments page using ACL rights - PR #6857

• [Monitoring] Display cancel button in downtimes page using ACL rights - PR #6856

• [Monitoring] Persist search filters - #5109 #6161

• [Monitoring] Persist selected results limit & pagination - #6325 #6161 #6367

• [Monitoring] Invalid accentuated chars transcription in timeperiod exception models - #6359

• [Monitoring] Add missing style for button in service acknowledge form - PR #6805

• [Monitoring] Host number calculation with ACL is not correct in HG summary - PR #6855

• [Monitoring] Fix service by servicegroup page when using ACL #6863

• [Notification] Exclude services started by BA from BAM UI notification style - PR #6782

Security fixes

• [ACL] Fix XSS issue on the ACL list page - PR #6634

• [Administration] Fix XSS issue - PR #6635

• [Administration] Fix XSS security - PR #6633

• [Configuration: Adding security filters on the host list page - PR #6625

• [Configuration] Fix XSS security issue on adding poller macros - PR #6626

• [Downtime/comments] Fix XSS issue for host, service & downtime comments - PR #6637

• [General] Create new escape method to fix XSS issue (commit 5820a04)

• [General] Fix XSS issue - PR #6636

• [Monitoring] Fix XSS security issue - PR #6632

• [SNNP trap] Fix SQL injection on editing trap SNMP - PR #6627

• [Virtual metric] Fix SQL injection - PR #6628

• [ACL access groups] Fix XSS vulnerability - PR #6710

Technical architecture changes

• Upgrade from PHP 5.x to PHP 7.x compatibility (7.1/7.2)

• Upgrade jQuery libraries

• Add ReactJS technology for new interfaces

• Prevent memory leaks - #4764

• Upgrade from DB.php connector to PDO

8
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Known bugs or issues

• Meta-services management with ACL (add/duplicate)

• Centreon AWIE issues when trying to export large configuration

• Got bogus version XX in httpd error logs #6851

2.2 Centreon 2.8

Please find here the release notes dedicated to the last 2.8.x version of Centreon.

2.2.1 Centreon Web 2.8.1

Released November 14th, 2016

The 2.8.1 release for Centreon Web is now available for download. Here are its release notes.

Changes

• New theme for Centreon web installation and update;

• Add REST exposure for Centreon API, Centreon CLAPI still available;

• Integration of Centreon Backup module in Centreon;

• Integration of Centreon Knowledge Base module in Centreon;

• Integration of Centreon Partitioning module in Centreon;

• New design to display charts using C3JS.

• New filters available to select display charts

• Possibility to display charts on 1, 2 or 3 columns;

• Apply zoom on one chart apply zoom for all displayed charts;

• Merge of meta-services and services real-time monitoring display;

• Strict inheritance of contacts and contacts groups from hosts on services notification parameters. Contacts and
groups of contacts from services definition will be erased during generation of configuration by settings from
host;

Features

• New servicegroups filters in real-time monitoring;

• New display of chart in pop-up of services in real-time monitoring and status details

• Add poller name in pop-up of hosts in real-time monitoring;

• Add monitoring command line with macros type password hidden (via ACL) in service status details;

• Integration of poller’s name in “Monitoring > System Logs” page;

• Integration of ACL action on poller for generation and export of configuration;

2.2. Centreon 2.8
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• Add new notification settings to not send recovery notification if status of host or service came back quickly to
non-ok (issue for SNMP traps for example);

• Add geo-coordinates settings on hosts, services and groups. Used by Centreon Map product;

• Possibility to define a command on multi-lines;

• Add Centreon Broker graphite and InfluxDB export;

• Add possibility for all Centreon web users to select their home page after connection;

• Add possibility to define downtimes on hostgroups, servicegroups and multi-hosts;

• Add an acknowledge expiration time on host and service;

• Better ergonomics on selectbox for Mac OS and MS Windows users;

• Add possibility to set downtimes on Centreon Poller display module;

• Add possibility to reduce Centreon Broker input/output configuration;

• Optimization of SQL table for logs access;

• Add timezone on host’s template definition;

Security Fixes

• #4668: Autologin with invalid token for imported users with null password ;

• #4458: User can create admin account

Bug Fixes

• #4703: Macros are always listed on command line descriptions;

• #4694: Don’t display notification in pop-up for acknowledged or downtimes objects;

• #4585, #4584, #4590: Correction of CSV export in “Monitoring > Event Logs”, “Dashboard > Hostgroups” and
“Dashboard > Servicegroups” pages. Correction of XML error in “Dashboard > Hostgroups” and “Dashboard
> Servicegroups” pages;

• #4617, #4609: Complete contextual help in hosts and services forms;

• #4147: Fix ACL to add widget

Removed Features

• No possibility to split charts;

• No possibility to display multi-period on one chart (Day, Week, Month, Year);

Known bugs or issues

• This release is not yet compatible with other commercial products from Centreon, like Centreon MBI, Centreon
BAM or Centreon Map. If your are using any of these products, you are strongly advised NOT to update
Centreon Web until new releases of the fore mentioned products are available and specifically mention Centreon
Web 2.8 compatibility ;

• Centreon Engine performance chart still in RRDTools PNG format ;

• Zoom out on chart change period on filters ;

10
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• User with ACL can’t see it own previously created meta service ;

• Problem with recurrent downtimes and DST ;

• Issues on SSO Authentication

2.2.2 Centreon Web 2.8.2

Released December 8th, 2016.

The 2.8.2 release for Centreon Web is now available for download. Here are its release notes.

Features

• #4779 : Centreon Web supports proxy configuration for use with its modules requiring external web access.
This notably concerns Centreon Plugin Pack Manager (component of the Centreon IMP offer).

Bug Fixes

• #4791: Can’t delete host command on host/host template form ;

• #4773: Centreon Clapi call and empty line at beginning ;

• #4752: Options missing in notification tab ;

• #4728: Avoid http warnings on first connection with ldap auto import ;

Known bugs or issues

• Centreon Engine performance chart still in RRDTools PNG format ;

• Zoom out on chart change period on filters ;

• User with ACL can’t see it own previously created meta service ;

• Problem with recurrent downtimes and DST ;

2.2.3 Centreon Web 2.8.3

Released January 11th, 2017.

The 2.8.3 release for Centreon Web is now available for download. Here are its release notes.

Features

• #4807: clean generation page ;

Bug Fixes

• #4843: SQL error in meta-service output ;

• #4775: disabled service are displayed in graph page ;

• #4729: command arguments are not displayed ;
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• #4690: make timeperiod exceptions work ;

• #4572: poller duplication does not duplicate all fields ;

• #4838: geo coord help menu not working on hostgroup page ;

• #4827: remove old centreon-partitioning script ;

• #4826: use correct configuration file when reloading centreontrapd ;

• #4809: error during link between contact and LDAP contact group ;

• #4746: fix login when SSO header is empty ;

Known bugs or issues

• Centreon Engine performance chart still in RRDTools PNG format ;

• Zoom out on chart change period on filters ;

• User with ACL can’t see it own previously created meta service ;

• Problem with recurrent downtimes and DST ;

2.2.4 Centreon Web 2.8.4

Released February 8th, 2017.

The 2.8.4 release for Centreon Web is now available for download. Here are its release notes.

Features

No feature.

Bug Fixes

• Fix problem with the upgrade process - all Centreon systems coming from 2.7.x have a database problem -
column timezone was missing in the table $STORAGE$.hosts ; –> this problem prevents centreon-broker from
starting

Known bugs or issues

• Centreon Engine performance chart still in RRDTools PNG format ;

• Zoom out on chart change period on filters ;

• User with ACL can’t see it own previously created meta service ;

• Problem with recurrent downtimes and DST ;

2.2.5 Centreon Web 2.8.5

Released March 29th, 2017.

The 2.8.5 release for Centreon Web is now available for download. Here are its release notes.
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Features

API

• Possibility to create an account to reach API without web access - #4980, PR #4992

Monitoring

• Better display in service detail with long output or long command - #4974, #4975, PR #5002

• Recurrent downtimes, extend specific period settings to select 2nd, 2td or 5th o month - #4207, #4908

Charts

• Add split function in chart - #4803, #4990

• Add button to display curve legend (min/max/average) - #4595

• Add button to display multiple periods view - #4884

• Extend chart legend and add more information on helps - PR #5006

• Extend help for stacking and transparency - #4884

Ergonomics

• Add new Centreon style for some buttons - PR #5060, PR #5061, PR #5062, PR #5067, PR #5068

• Add possibility to copy-paste executed command ligne from service details page - PR #5065

Bug Fixes

ACL

• Incorrect redirection to error page with ACL - #4932

• Dashboard not works when using filter #4886, PR #5023

• Blank page on “Monitoring > Status Details > Hosts” with acl - #4960

Authentication

• Only logout are logged - #4924, PR #5004

• Autologin with any token - #4668

• generateImage.php problem with akey (auto-login) - ##4920, PR #4865
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Monitoring

• “Executed Check Command Line” is wrong for services associated to hostgroups - #4955, PR #5037

• Poller delete stay on Poller list in Monitoring Tab - #5026, PR #5027

• Acknowledge - duplicate comments with external command on host monitoring page - #4862, PR #5015

• Do not display services downtimes (remove filter “h”) - #4918, #4947, #5000, PR #5001

• Column ‘sg_id’ in field list is ambiguous - #4938

• Remove ‘s’ in service popin for duration - PR 5051

• Select servicegroup does not work - #4907, #4885

• Escaping problem in executed command - #4976, PR #4985, PR #4999

• Fix problem on graph when user ask to display graphs of a hosts - PR #4991

• Cannot Export Event Log to CSV - #4943

• View logs for service does not work - #4958

• Centreontrapd and exec code - PR #5054

Graphs

• Curves color on New graph is not equal to old graph - #5033

• Wrong host title in Graph - #4964 #4984

Dashboard

• Incorrect CSS for reporting of a service - #4934, PR #5009

Configuration

• Exploit correlation with Centreon BAM - PR #5049

• Disable notification sounds not working - #4988, PR #4973

• Add user name in the generated configuration files - #4822

• Duplicate Poller and illegal characters - #4931, PR #4986, #4987

• Can view first help icon in Centreon Broker configuration - #4944, PR #5003

• Describe arguments does not work with % character in command line - #4930

• Generate and export SNMP traps - #4972, #4978

• Host macro did not save on host edit - #4951

• Do not check modification on disabled pollers - #4945
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Custom view

• Rewrite system to share public views - PR #4823

• Rewrite system to share locked views to contacts or contactgroups

• Rewrite system to share non-locked views to contacts or contactgroups

• When user access to custom views menu, edition mode is disabled - #5008, PR #4811

• Listing of widget with infinite scroll displays at least 3 times each widget - #4892

• “Set Default” button not working - #5079

Documentation

• Improve installation chapters - #4970, PR #4967

• open_files_limit error during installation - #5017, #5038

• Menu “Legend” doesn’t exist in Centreon 2.8.x - PR #4968, PR #4969

• Update product lifecycle - PR 5044

• Correct contact creation example - PR #5035, - PR #5036

API

• Rename TIMEPERIOD object to TP - PR #4913, PR #4914

• CLAPI doesn’t work when Centreon BAM is installed - #4921, PR #5049, PR 5005

• DowntimeManager - do not remove downtimes not linked to objects to allows configuration with API - #5057

Backup

• Backup export does not work - #4726, PR #5019

• Backup won’t work without old deprecated variables - #4965, #PR #5007

Installation

• SQL script error for upgrade from 2.6.6 to 2.7.0RC1 - #5064, PR #5066

• Using sources, error with CentPlugins Trap on install - PR #4963

Known bugs or issues

• Centreon Engine performance chart still in RRDTools PNG format;

• Zoom out on chart change period on filters;

• User with ACL can’t see it own previously created meta service;

• Problem with recurrent downtimes and DST;

• Issue with international keyboard and chrome when use accented characters;
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2.2.6 Centreon Web 2.8.6

Bug Fixes

KB

• Downtimes - Display real BA name instead of _Module_ - #5014, PR #5094

• InfluxDB broker output config: metric columns not stored properly - #5058, PR #5089

• Poller status still working when the poller is disabled - #5126

• Filter on the status host/service on the motiroring isn’t working #5131, #5140

• Fix acl on host categories for inheritance

• Avoid infinite loop in acl category

• Fix error message in install process

• Fix path to centengine and cbd init scripts

• Fix topcounter must count all meta services - #5071, PR #5100

• Fix access downtime page for users with ACL - #4952, #5025, PR #5093

• Centreon > Services - Services listed twice - #5158, PR #5010

• Custom views - problem with multiselect users when sharing View - #5029, PR #5074

• Massive change - impossible to add service group - #5132

• Fix URL decode problem with character ‘+’ in object’s name - #5128, PR #4883

• Fix CLAPI import

• Poller status still working when the poller is disabled - #5126, PR #5133

Enhancements

• Display inherited categories in host details page

• Do not check modification of configuration on disabled poller for better performance - PR #4928

• Improve access to services configuration page - PR #5077, PR #5076

• Improve global performance - PR #4900

• Improve Knowledge Base configuration

• Fix wiki links of objects with spaces in their name - #4306

• Improve documentation

• Set geo_coords parameter with clapi

If you already used a knowledge base, please execute following script :

php /usr/share/centreon/bin/migrateWikiPages.php

16
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapter 2. Release notes



Known bugs or issues

• There’s an issue in the ldap configuration form. A fix is available and will be package with the next bugfix
version. Until then you can apply the patch available here

• There’s an issue on all listing pages. A fix is available and will be package with the next bugfix version. Until
then you can apply the available patch

2.2.7 Centreon Web 2.8.7

Bug Fixes

• Fix various security issues

• Fix ldap configuration form

• Fix downtime popup in listing pages

• Fix object listing pages which are empty after some actions

2.2.8 Centreon Web 2.8.8

Bug Fixes

• Fix Centreon Engine configuration form

• Fix custom view sharing

• Fix Knowledge Base script compatibility with PHP < 5.4

2.2.9 Centreon Web 2.8.9

Bug Fixes

• Fix Incorrect style for “Scheduled downtime” in dashboard - #5240

• Apply new Centreon graphical charter to add and modify pages for metaservice indicator - #5255

• [2.8.6] : Double quote are converted in html entities in fields Args - #5205

• Duplicate host template doesn’t work - #5252

• [BUG] “Home > Poller Statistics > Graphs” only works for Central - #4954

• “Recovery notification delay” is not written to centreon-engine’s configuration - #5249 - PR #5268

• Severity of ‘host category’ - #5245

• [2.8.8] Deploy Service action won’t work - #5215

• [2.8.8] Issue when adding new connector - #5233

• [2.8.8] Data pagination - #5259

• Cannot modify metaservice indicator - #5254 - PR #5267

• [2.7.11] Migration 2.7.11 to 2.8.x does not work #5265

• 2.7 to 2.8 upgrade error - #5220
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• Cannot insert numbers in service description field - #5275

• [2.8.7] - Timezone / Location BUG !! - #5218

• 2.8.8 Service Trap Relation empty - #5223

• [2.7.x/2.8.X] Old school style in popup - #5232

• [BUG] ACL - Servicegroup - #5101 - PR #5222

• [2.8.7] Missing argument 1 for PEAR::isError() - #5214 - PR #5225

• [Reporting > Dashboard > Services] Unable to export CSV - #5170 - PR #5172

Graphs

• Graph are not correctly scaled - #5248

• [Chart] scale in charts using CPU template is wrong Kind/Bug Status/Implemented - #5130

• Graph scale values not working - #4815

• [2.8.5] Charts upper limit different from template - #5123

• Remove chart padding - #5288

• Base Graph 1000/1024 Kind/Bug Status/Implemented - #5069

• [2.8.6] non-admin user split chart permission - #5177

• After using split chart, curves are not displayed anymore (period filter not applied) - #5198 - PR #5171

• [GRAPH] Problem with external graph usage (Widgets, Centreon BAM) - #5270

• Incorrect scale and position for rta curve (performance ping graph) - #5202

• Wrong tool tip display on chart with two units when one of the curves is disabled - #5203

• Splited chart png export misnamed doesn’t work with HTTPS - #5121 - PR #5171

• [2.8.5] Splited chart png export misnamed - #5120

• [Chart] curves units are displayed on incorrect side - #5113

• Assign good unit and curves to y axis when 2 axis - #5150

• remove curves artifacts - #5153

• Beta 2.8 Curve with an weird shape. - #4644

• The round of the curves - #5143

• The extra legend is option in chart. - #5156

• Add option for display or not the toggle all curves in views charts - #5159

• Use the base from graph template for humanreable ticks - #5149

2.2.10 Centreon Web 2.8.10

Enhancements

• Proposal break Ajax #5256

• Do not export empty Centreon Broker parameters with API #5284
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• Remove duplicate $_GET[”autologin”] in test #5344

• Documentation improvement #5063

• Update engine reserved macros ($HOSTID$, $SERVICEID$, $HOSTTIMEZONE$) #5246

• Config generation is too long #5388

• Rename Centreon Broker Daemon option #5276

Bugfix

• Failure with special character in password for mysqldump #5173

• Unable to select all services in escalation form #5326 #PR5325

• Contacts/contactgroups inheritance #5396 PR #5400

• Check if wiki is configured and extend error message #5278 PR #5269

• Select All don’t work on service categories PR #5389

• Autologin + fullscreen options #5338 PR #5338

• Directory “/var/spool/centreon” not created by Centreon-common.rpm #5405

• “Fill in” option in graph doesn’t work with “VDEF” DEF type #5354

• Delete SNMP Traps #5282

• Can’t duplicate trap definition #5272 PR #5280

• Virtual Metric problems with French language package #5355

• Impossible to set manually a service to a meta service for non admin users #5358 PR #5391

• Graph period displayed does not match selected zoom period #5334

• Host configuration can not be saved or modified #5348

2.2.11 Centreon Web 2.8.11

Enhancements

• Fix typos in Enabled/Disabled filters PR #5251

• Do not list meta services in list of service to add to a SNMP trap #5418 PR #5419

Bugfix

• Knowledgebase - Delete wiki page not functional #5059

• Massive Change don’t modify the Recovery notification delay of a host #5451

• Impossible to acknowledge several object from custom views #5420

• Load custom views - fixed database entry duplication PR #5260

• Adding SNMP traps definition : values set to fields in Relations tab are not saved #5406 PR #5415 PR #5417

• SNMP Trap, not all parameters are saved on creation #5361 PR #5415 PR #5417

• Page “Services by Servicegroup > Display > Summary” not working #5399 PR #5416
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• [CLAPI] Duplicate CMD in export #5455

• [CLAPI] Fatal error with PDOException #5453 PR #5462

2.2.12 Centreon Web 2.8.12

Enhancements

• [API] Update documentation to remove non available functions

• [API] Export/Import LDAP configuration

• [API] Export/Import ACL Groups

• [API] Export/Import ACL Menus

• [API] Export/Import ACL Actions

• [API] Export/Import ACL Resources

• [API] Replacing contact_name by contact_alias PR #5546

• [Configuration] Input text not aligned in Curves page #5534 PR #5553

• [Monitoring] Monitoring Services by Hostgroup : improvement order suggestion #5402 PR #5552

• [Monitoring] Increase perfs on EventLogs for non admin user PR #5480

• [Knowledge Base] Display API errors #5502

• [Knowledge Base] Refresh page after deletion #5503

• [Backup] Get correct datadir with CentOS7/MariaDB PR #5484

Bugfix

• [ACL] Bug on Access Groups #5189

• [ACL] The ACL of a contact and of a contact group is deleted during duplication #5497

• [API] CLAPI Import not working #5541

• [API] CLAPI export with select filter give PHP Warning and non result #5548

• [API] Missing functions setseverity and unsetseverity for services by hostgroup #5262

• [API] Problem with icon_image and map_icon_image of Hostgroup #5292

• [API] Missing function setservice for Service categories #5304

• [API] Problem with setting gmt in API #5291

• [API] Contact group additive inheritance isn’t implemented #5311

• [API] Contact additive inheritance isn’t implemented #5310

• [API] Problem with delmacro for services by hostgroup #5309

• [API] Several bugs on HG / CG when export is filtered #5297 PR #5297

• [Monitoring] Sorting by duration and Maximum page size change #5287 #5410 PR #5517

• [Configuration] Dependent host deleted during a service dependency duplication #5531

• [Configuration] All pollers had “config changed” #5549
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• [Configuration] Unable to change the severity of an host template #5472

• [Configuration] Unable to change the severity of a service template #5559

• [Configuration] Meta service - unable to change the geo_coordinates #5493 PR #5505

• [Configuration] Meta service - unable to add more than one contact #5506 PR #5507

• [Configuration] Meta service - Implied contact is deleted during duplication #5495 PR #5508

• [Configuration] Problem with escalation’s name during a duplication #5512 PR #5513

• [Configuration] Duplicate severity should remove link to objects #5478 PR #5509

• [Configuration] Fix search in trap select2

• [Configuration] Fix search in service template select2

2.2.13 Centreon Web 2.8.13

Enhancements

• [Doc] Improve centreon documentation #5611 PR #5612

• [Doc] clarify documentation of centreon clapi authentication #5625 PR #5628

• [Performance] Correct svc top counter with meta and merge SQL requests PR #5616

Bugfix

• [Top Counter] Metaservices not counted properly in statuses filter #5458 PR #5616

• [Configuration] Properly export interval length in storage endpoints #5461

• [Documentation] Time Range exceptions invalid format #5578

• [Chart] No graphics with backslash #5554 #5342 PR #5565

• [LDAP] Problem with LDAP autoimport and groupmapping with comma in CN #4867

• [Monitoring] No inheritance in query of notified contacts (Monitoring view) #4981

2.2.14 Centreon Web 2.8.14

Enhancements

• [API] Update CLAPI commands to show resources of a downtime PR #5705

• [API] Add possibility to grant access to children menu (or not) PR #5694

• [API] Add possibility to add and get list of on-demand downtime #5192 #5682 PR #5623 - beta

• [API] Add possibility to get realtime hosts status #5682 - beta

• [API] Add possibility to get realtime services status #5682 - beta

• [Documentation] Activate services at system startup PR #5698

• [Administration] Add possibility to test proxy configuration #5561 PR #5722
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Bugfix

• [API] Fix list of hosts with gethosts method of Instance object #5300 PR #5603

• [Install] Add unique key on comments table PR #5665

• [Custom Views] Sharing View problem to select multiple users #5029

• [Configuration] Multiple ‘update mode’ fields in massive changes #5266 PR #5636

• [configuration] Massive Change on Hosts activate Stalking Option Up #4946

• [Reporting] Reporting Dashboard messed up #5491 #5520

• [Monitoring] No inheritance in query of notified contacts #4981

• [Monitoring] Top counter display too much resources with ACL #5713 PR #5703

2.2.15 Centreon Web 2.8.15

Important notice

This version include a fix for the calculation of downtimes with daylight saving time (DST). The downtime end will
be calculate with the new hour.

For example, if you put a downtime from 1 AM to 5 AM, the duration of the downtime will be 5 hours if during the
DST you get 1 hour more (3 AM come back to 2 AM).

Enhancements

• [Documentation] Improve api documentation (url) #5792

• [Downtimes] Manage downtimes with dst (recurrent and realtime) #5780

Bugfix

• [Install] Fix foreign key upgrade of traps_group table PR #5752

• [CLAPI] Fix duplicate ldap serverPR #5769

• [CLAPI] Fix duplicate htpl in stpl #5774

• [CLAPI] Fix duplicate on stpl #5775

• [Chart] Add unit on y axis

• [Chart] Fix extra legend on period change

• [Chart] Fix export with empty metric

• [Configuration] Add obsess_over_hosts parameter in main centengine configuration PR #5746

• [Monitoring] Ranking of ascending / descending guests NOK #5695 PR #5744

• [Monitoring] fix variable name in centreontrapd.pm
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2.2.16 Centreon Web 2.8.16

Enhancements

• [Administration] Improve ‘Server Status’ page PR #5820

• [API] Add exceptions for realtime PR #5735 #5795

• [Configuration] Broker remove non existing protocol #5830 PR #5832

• [Configuration] Check illegal characters one time only PR #5831

• [Documentation] Wrong translation in documentation #5858 PR #5862

• [Documentation] Improve installation documentation #5825 PR #5844

• [Documentation] Improve Time Period documentation #5828 #5637 PR #5845 #5843

• [Documentation] Improve API realtime downtimes examples

Bugfix

• [Install] Properly place update to 2.8 from 2.7. #5809

• [ACL] centAcl cron LDAP sync removes all ContactGroups on unexpected error #5547

• [API] Parent/Child relation are not exported with CLAPI #5605 PR #5857

• [API] Authorize id 0 for object PR #5812

• [Chart] Add legend name when defined PR #5817

• [Configuration] Improve host/service macro visibility

• [Configuration] add massive change contact/cg update mode for host form #5878

• [Knowledge Base] Search function non functional for templates of services #5762 PR #5829

• [Knowledge Base] Increase page limit for mediawiki migration PR #5798

• [Monitoring] Custom MACRO not interpreted in URL #5846 PR #5850

• [Monitoring] Display 0 in top counter if SQL result is empty #5758 PR #5826

• [Security] Some field was not encoded PR #5847

2.2.17 Centreon Web 2.8.17

Enhancements

• [API] Add Host getparam PR #5783

• [API] Delete/Cancel Real Time Downtime #5879 PR #5894

• [API] Display future downtime PR #5903

• [Documentation] Update lifecycle in documentation PR #5901

• [Documentation] Remove obsolete paragraph PR #5898
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Bug Fixes

• [ACL] Undefined variable host id PR #5891

• [ACL] Use correct id for acl host relation PR #5896

• [Chart] Graphs in IE stretched #5081

• [Configuration] Fix macro password visibility PR #5873

• [Configuration] Host search not saved when activate/deactivate a host #5711 PR #5827

• [Documentation] Correct API documentation for host/service relation #5854

• [Documentation] Improve documentation install using ISO #5772 PR #5851

• [Install] Script install.sh - Could not create user #5785 PR #5890

• [Knowledge Base] Correct typo of error message PR #5917

• [Monitoring] fix macro password with arguments in object details page PR #5928 #5881

Security

• Prepare query and execute it #5904

• Improve list of objects for Select2 #5918

• Update SQL query to prevent SQL injection in setRotate form #5915

2.2.18 Centreon Web 2.8.18

Enhancements

• [Administration] Add more actions and logging for ACL management - PR #5841

• [API] Validate input parameters - PR #5958

• [API] Check illegal char in add function for CLAPI - PR #5948

• [API] Improve error message - PR #5972

• [API] Get multiple parameters for host - PR #5946

• [Configuration] Add form to configure Centreon Broker generic stream connectors - PR #6024 #6053 #6052
#6042 (beta)

• [Documentation] Add new chapter for Centreon ISO el7 installation - PR #6019

• [Documentation] Describe get parameters for hosts #5783 - PR #5924

• [Knowledge-Base] Add option to disable SSL certificate - PR #6027

Bug Fixes

• [Administration] Define default value for Broker - #6029 PR #6033

• [Configuration] Change low limit of EventMaxQueueSize for Centreon Broker configuration - PR #6013

• [Configuration] Avoid php notice when poller has no timezone - PR #6031

• [Install] Compatibility with PHP version 5.3 - PR #5976
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• [Meta-service] Do not duplicate them on update - PR #5982

• [Meta-service] Possibility for user with ACL to display chart - PR #5952

• [Monitoring] Top Counter with ACL really slow - #5974 PR #5992

• [Monitoring] Centreon UI freezes when access to “View contact Notification” - #5760 PR #5954

• [Monitoring] Replace dot character in command line for better display - PR #5945

• [Monitoring] Fix add downtime on hostgroup or poller with ACL - PR #6023

2.2.19 Centreon Web 2.8.19

Enhancements

• [API] Return error when filtered object does not exist - PR #6074

• [API] Add clapi set option - PR #6065

• [UX] Add new loading css - PR #6066 #6072

Bug Fixes

• [API] Fix clapi export with hosts parent relations - #6061

• [API] Uninitialized array causing php warning - PR #6046 #6097

• [Monitoring] Top counter very slow since upgrade from 2.8.17 to 2.8.18 - #6085 PR #6093

2.2.20 Centreon Web 2.8.20

Enhancements

• [API] Add default poller - PR #6098

• [API] Link host with default poller if unknown poller - PR #6099

• [ACL] Improve performance - #6056 PR #6107

• [Documentation] Improve Centreon CLAPI usage - PR #6090 #6091

• [Documentation] Improve documentation to add a new poller - #6075 PR #6086

• [Documentation] Add notice for 64 bits support only - PR #6101

• [Monitoring] Display links in output and comments - #5943 PR #6113

Bug Fixes

• [ACL] Allow nested groups filter in ldap configuration - #6127 PR #6128

• [API] Export specific service, add host before service in CLAPI - PR #6100

• [API] CLAPI add resource export filter - PR #6125

• [API] CLAPI Export contact with contact group - PR #6131

• [API] CLAPI Export service categories - PR #6134
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• [Configuration] SNMP trap poller generation uses ACL - #6043 PR #6069

• [Custom Views] Fix share custom view - PR #6109

• [Poller Stats] Poller Statistics Graphs are displayed in first column only - #6003 PR #6122

Others

• Update copyright date on the login page - PR #6076

• Remove multiple debug in Centreon - PR #6138

2.2.21 Centreon Web 2.8.21

Enhancements

• [Documentation] Add chapter about how to write a stream connector - PR #6189

• [API] Separate REST API configuration and REST API realtime access - PR #6188

Bug Fixes

• [ACL] Manage filters (poller, host, service) on servicegroup - PR #6163

• [Configuration] Fix output stream connector name for fresh install - PR #6159 #6182

• [Configuration] No “Conf changed” flag set to “yes” when deploying services to selected hosts - #6160 PR
#6191

Other

• Fix php warning in realtime host API - PR #6174

2.2.22 Centreon Web 2.8.22

Enhancements

Bug Fixes

• [CLAPI] Fix host services deployment - PR #6212

Other

2.2.23 Centreon Web 2.8.23

Enhancements

• [Documentation] Correct typo - PR #6202

• [Documentation] Update icon to add metrics to a meta service - PR #6167

• [Documentation] Correct typo in documentation about stream connector howto #6261
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Bug Fixes

• [ACL] fix select all checkbox in acl actions form - PR #6193

• [Administration] fix purge on pmax partition - PR #6232

• [Downtimes] fix recurrent downtimes on HG when no SG exist - PR #6201

Security

• Update jquery ui libs +fix compat - PR #6181

Others

• fix(centAcl.php): Dead code removed - PR #6262

• fix(lib): allow chaining on jquery pagination plugin - PR #6219

• fix(jQuery): fix broken input in reporting_dashboard - PR #6254

• fix(style): fix style in widget preferences popin - PR #6197

• fix(style): fix padding of buttons in custom views page - PR #6198

• fix(front): retrieve jquery toggle function (renamed to toggleClick) - PR #6217

• fix(front): fix acl actions checkboxes (check all / uncheck all) - PR #6309

2.2.24 Centreon Web 2.8.24

Bug Fixes

• Remove duplicate entries in centreon_acl table - PR #6366

Security

• Fix execution command by rrdtool command line - PR #6263

• Fix XSS on command form - PR #6260

• Fix XSS security on menu username - PR #6259

• Fix SQL injection on graphs - PR #6251

• Fix SQL Injection in administration logs - PR #6255

• Fix SQL injection in dashboard - PR #6250

• Fix SQL injection in Curve template - PR #6256

• Fix SQL Injection in Virtual Metrics - PR #6257

2.2.25 Centreon Web 2.8.25

Introduction to a new banner to prepare the next releases. This feature must be enabled for each user. After the update,
users will be asked to activate or not this feature. New banner will appear after refresh of the page. A rollback is still
possible through the “My account” menu.

2.2. Centreon 2.8
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Enhancements

• [UX] New banner in feature flipping mode - PR #6294

• [API] Submit result for passif resources - PR #6209

• [API] Export is too long when lot of parentship - PR #6372

Bug Fixes

• [API] Correct real time service filters - #6080 PR #6363

• [API] Restore broker configuration with clapi generate too much output and input - #5011 PR #6220

• [API] Partial / Filtered export does not work as expected for HC, SC, CG - #5294 PR #6355

• [API] Export uses resource macro name instead of id for setparam - #6221 PR #6222

• [API] HTML Entities cause REST API Serialization Errors - #6110 PR #6234

• [API] Fix acl group setcontact export - PR #6224

• [API] Avoid to order parentship several times - PR #6373

• [Configuration] View contact notification service missing - #6073 PR #6340

• [Downtimes] Prevent permission denied centcore cmd for downtimemanager - PR #6289

• [LDAP] Remove contact password if ldap password storage is disabled - #5627 PR #6347

• [Monitoring] Sort by service name after status in service grid - PR #6290

• [Reporting] Avoid bug on partitioned tables - PR #6382

Security

• Fix SQL injection from metrics RPN’s field - PR #6356

Others

• Avoid PHP notice Undefined index: centreon in notifications.php - PR #6266

• Delete “Ping” and “Tracert” entries (no more used) - PR #6277

• Fix typo in FR documentation - PR #6375

• Fix “how to write a stream connector” chapter - PR #6296 #6295

• Add some missing developers in Centreon About - PR #6410 #6253

• Several fixes and improvements in documentation

2.3 Centreon 2.7

Please find here the release notes dedicated to the last 2.7.x version of Centreon.
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2.3.1 Centreon 2.7.0

Released December 17, 2015

The 2.7.0 release for Centreon Web is now available for download. The full release notes for 2.7.0 follow:

Features and Bug Fixes

• Changing the graphic charter to be consistent with the new logo Centreon

• Flat design (CSS and icons)

• Custom view improvement

• Adding an editing or visualization mode

• Graphic widgets relief to be able to put more on a page

• Adding a fullscreen mode

• Menu Review for improved navigation and simplified user actions

• Review og pages dedicated hosts and services pages in monitoring to include more informations.

• Redesign of the reporting page

• Recasting bar searches and filters in each page of Centreon

• Redesign Event Logs page (removing treeview + Added search system + Improved performances)

• Redesign view page (removing treeview + Added search system + Improved performances)

• Merging downtimes pages for hosts and services

• Merging comments pages for hosts and services

• Integration of a graphics module to replace a non-performing component QuickForm (Improved forms on multi
element selection)

• Simplifying the configuration of Centreon Broker (Temporary and Failover are automatically configured + en-
hanced best practices)

• Ergonomic improvement of the configurations objects:

• Improved hosts form

• Improved services form

• Improved management macros: dynamic form system that provides the necessary inherited macros templates
for proper operation of the configuration

• Added ability to set a description of each macro used in commands

• Review of the pathway for the generation of the configuration

• Automatic creation of a configuration file for the poller when it is created

• Deleting configuration options in the Administration section, now automatically configured. This simplifies the
handling of Centreon

• Improved ACL system (Improved performances)

• Native integration of Centreon CLAPI

• Improved documentation

• Redesign Configuration part

2.3. Centreon 2.7
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• Redesign Exploitation part

• Integration of the API part

Changes

• Important web design changes can make interface not compatible with older modules. A re-factoring work will
be needed to ensure optimal operation.

• Changing the timezone system : DST management (may need to check the timezones of each host and contact
after the update)

• Changing databases schemes for hostgroups and servicegroups in the real state database (centreon_storage) :
added id and deletion of alias, url, url note, icon.

• Changing the path for generating the configuration of Centreon Engine instances : no more specific page to
generate the configuration. The action is now available from the pollers list.

• Switching to InnoDB all Centreon tables (except logs and data_bin too big for an automatic update).

• PHP 5.1 no longer supported

• Browser compatibility : IE 11, FF 5 et Chrome 39 at least

• Shared views in custom views are not automatically loaded in views of others users. Now views are able to be
public and user can load them during the creation step.

Security fixes

• Removing PHP session ID in the URL of the Ajax flow of certain pages.

• Integration of a CSRF token in all forms to prevent “Man in the middle” effect.

Removed Features

• Nagios and NDOutils are no longer compatible with Centreon web. Only Centreon Engine and Centreon Broker
are compatible from version 2.7.0

• Removing centstorage and logAnalyser executables.

• Removing the Nagios configurations load module.

• Removing the ability to configure the colors of graphics templates

• Removing color choices for menus

• Removing choosing colors for monitoring status

• Removing the ability to configure Nagios CGI

• Transformation of the tactical overview in widget

• Transformation of the Monitoring Engine statistics Page in widget

• Deleting the Server Status page (phpsysinfo) become incompatible with the PHP version recommended for
Centreon

• Remove timeperiod exclusions in the UI. This function don’t work very fine whether with Centreon Engine 1.x
or Nagios. We prefer removing the function in order to avoid problems.
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Known Bugs

• ACL of pages is not fully updated during the upgrade process. So please check all your ACL pages after the
migration. You may have problems with the followings pages:

• Monitoring > Hosts

• Monitoring > Services

• Monitoring > Performances (new page)

• Monitoring > Downtimes

• Monitoring > Comments

• Monitoring > Eventlogs > System logs

• Graph slip not working

• Pagination is broker when you go on the last page, change the number of line to the Max. Page become empty.

• If you have timeperiods used in exception or inclusion of timeperiod and now deleted, their ids stays in the
database in relation table. During the sql update process, this blocks an addition of constraint on this relation
table. To fix it, you have to remove old timeperiod id.:

mysql> DELETE FROM timeperiod_exclude_relations WHERE timeperiod_id NOT IN (SELECT tp_id FROM timeperiod) OR timeperiod_exclude_id NOT IN (SELECT tp_id FROM timeperiod);
mysql> DELETE FROM timeperiod_include_relations WHERE timeperiod_id NOT IN (SELECT tp_id FROM timeperiod) OR timeperiod_exclude_id NOT IN (SELECT tp_id FROM timeperiod);

How to Install ?

Now that you are aware about all specificities of this version, you can install it. If you install from zero your system,
please follow the installation guide. Else you can refer to the upgrade guide. Take care about prerequisites and all
upgrade steps in order to avoid data loss.

2.3.2 Centreon 2.7.1

Released January 07, 2016

The 2.7.1 release for Centreon Web is now available for download. The full release notes for 2.7.1 follow:

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

• Improved ergonomics of the select2 component

• Improved performances of monitoring pages

• Improved performances of the event logs page

• Improved performances of downtimes configuration on host page

• Improved documentation

2.3. Centreon 2.7
CENTREON 46-52 RUE ALBERT FR75014 PARIS

31

https://download.centreon.com
http://documentation.centreon.com/docs/centreon/en/latest/release_notes/index.html


• Fixed problem when sharing views in Custom views page

• Fixed a right problem in CLAPI generation of the configuration

• Fixed problem in services per hostgroups pages

• Fixed problems in configuration generation when mysql is not using 3306 port

2.3.3 Centreon 2.7.2

Released February 24, 2016

The 2.7.2 release for Centreon Web is now available for download. The full release notes for 2.7.2 follow:

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

• Fix eventlogs pages for performances and right for non admin users

• Fix Recurent Downtimes behavior with timezones

• Fix some broken relations in web interface

• Fix Reporting pages for non admin users

• Fix some elements with the generation of the configuration

• Fix encoding problems

• Fix filters in configuration pages

• Fix Poller duplication

• Fix various ACL problems

• Fix some SQL queries

• Fix export of Meta Services

• Improve ACL on Custom Views

Known Bugs

• Recurrent downtimes during for more than a day are not working

• It’s impossible to remove relations between usergroup and custom views

• With the update some widgets have to be deleted and recreated

2.3.4 Centreon 2.7.3

Released March 15,2016

The 2.7.3 release for Centreon Web is now available for download. The full release notes for 2.7.3 follow.
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Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

• Fix Recurrent downtimes starting at 00:00

• Fix search in Poller configuration page

• Fix problems when sharing custom views

• Fix description problem with custom macros containing dash

• Fix time Interval change isn’t being reflected in the polling Engine config

• Fix Missing GMT and UTC timezone

• Fix No performance graph for host group service

• Fix ACL were showing too much objects

• Fix Impossibility to delete custom macros on service

• Fix Split on multi graph

• Fix Design on Monitoring Performances page

• Fix CLAPI handled all broker parameters

• Fix Custom macros can contain dash

• Fix Time Interval change isn’t being reflected in the polling Engine config

• Fix UI doesn’t display the good limit of pagination

• Fix Some French translations were missing

• Enh Improve listing possibilities in Widget configuration (Pollers and categories)

• Enh Usability of select2

• Enh Possibility to reload several pollers in one time

• Enh Add an API to send External Commands

2.3.5 Centreon 2.7.4

Released April 14,2016

The 2.7.4 release for Centreon Web is now available for download. The full release notes for 2.7.4 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

2.3. Centreon 2.7
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Fix of an encoding problem

Following a change of encoding tables in centreon database which occurred in the 2.7.0 version, bad encoded charac-
ters appear in the Centreon web interface. Indeed, the change charset “latin1” to “utf8” was not followed by an update
of the content of tables in the database.

To restore a valid encoding of special and accented characters, it is necessary to manually run the script provided by
Centreon.

Warning

This script should be run once and only once.

If an operator has modified/corrected special characters or accented since the 2.7.0 update, processing performed by
the script will truncate the string to turn on the first special or accented character. It will then be necessary to change
the impacted objects to manually update them. (The script can unfortunately provide the list of impacted objects.

All contents of table type “varchar”, “char” or “text” will be updated

Prerequisites

Don’t forget to backup your database before doing any operations.

Installation

Download and install the script in “/usr/share/centreon/bin/” with the command:

wget http://resources.centreon.com/upgrade-2.6-to-2.7/migrate_utf8.php -O /usr/share/centreon/bin/migrate_utf8.php

Execution

From a shell terminal, perform the script:

php /usr/share/centreon/bin/migrate_utf8.php

Validation

Connect to your web interface and check that there are no more bad encoded characters on it.

CHANGELOG

Features and Bug Fixes

• Fix: Contacts in contactgroups were exported with a wrong ID

• Fix: Error when saving “Administration > Parameters > Monitoring” page

• Fix: Zoom in Performance graph

• Fix: Select contactgroups / contacts in services & hosts configuration was not working

• Fix: Display only categories and not severities on form
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• Fix: Scroll bar in “Configuration - Hosts - Host Groups”

• Fix: Category Relation on host and host template form

• Fix: Order in More Actions Menu

• Fix: generateSqlLite not install with source

• Fix: SSO connection with LDAP user

• Enh: Add possibility to set local to “browser” when adding a contact by CLAPI

2.3.6 Centreon 2.7.5

Released July 06,2016

The 2.7.5 release for Centreon Web is now available for download. The full release notes for 2.7.5 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

• Fix: Flapping configuration was not exported to Centreon Engine configuration files

• Fix: Option “test the plugin” didn’t working with special characters

• Fix: It was possible to select Meta Service or BA in performance page filters

• Fix: With non admin users, it was impossible to select services in Performances page

• Fix: Non admin users could not seen services in Reporting page

• Fix: Number of hosts in Hostgroups was not good for non admin users

• Fix: Max and Min was not correct for inverted curves

• Fix: It was impossible to create Virtual metrics with web UI in french language

• Fix: Exclude Deactivate poller in configuration generation page filter

• Enh: Add an error message when no pollers are selected in configuration generation page

2.3.7 Centreon 2.7.6

Released July 21,2016

The 2.7.6 release for Centreon Web is now available for download. The full release notes for 2.7.6 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.
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CHANGELOG

Features and Bug Fixes

• Fix: Hard PATHs in some folders

• Fix: Correction of some typos

• Fix: contact_location default value incorrect

• Fix: Security fix linked to the configuration export

• Fix: Problem with custom view style when user was not able to edit the view then old style was used

• Fix: Centreontrapd issue if number of downtimes is greater than 1

• Fix: Service comments wrong request

• Enh: SQL Optimisation in handling service templates

2.3.8 Centreon 2.7.7

Released September 13,2016

The 2.7.7 release for Centreon Web is now available for download. The full release notes for 2.7.7 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

• Fix: Non initialized value in Centreon ACL page

• Fix : Security issue with autologin when user has no password

• Enh: [Centreon Clapi] Add export filters

2.3.9 Centreon 2.7.8

Released November 09,2016

The 2.7.8 release for Centreon Web is now available for download. The full release notes for 2.7.8 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.
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CHANGELOG

Features and Bug Fixes

• Fix: Improve graph rest API

• Fix: Two “update mode” lines for service groups in Massive change causing annoying behavior

2.3.10 Centreon 2.7.9

Released March, 21th 2017.

The 2.7.9 release for Centreon Web is now available for download. The full release notes for 2.7.9 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Features and Bug Fixes

• Fix: allow full configuration export for Centreon Poller Display

• All graphs linked to a host aren’t displayed in performance page - #4731

• Documentation - correct example to use TP instead of TIMEPERIOD - PR #4915, Pr #4916

• Force CENGINE key in centreon database options to use Centreon Engine - #4922

2.3.11 Centreon 2.7.10

The 2.7.10 release for Centreon Web is now available for download. The full release notes for 2.7.10 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Bug Fixes

• Fix various security issues

• Fix ldap configuration form

• Fix downtime popup in listing pages

• Fix object listing pages which are empty after some actions

2.3.12 Centreon 2.7.11

The 2.7.11 release for Centreon Web is now available for download. The full release notes for 2.7.11 follow.
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Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Bug Fixes

• Fix ldap authentication #5216

• Fix CLAPI export using filters #5084

• Fix CLAPI poller generate (generate, test, move, restart/reload/ applycfg) #5224 #5221

• Fix Incorrect style for “Scheduled downtime” in dashboard #5240

• Fix Contact - import LDAP apply new CSS style #5235

• Fix HTML export with filters #4868

• Fix brokercfg export with filter

• Fix get command list query #5229

• Apply sso fixes from 2.8.x

• Improve performances #5157

• Convert string in UTF-8 #5118 #5244

2.3.13 Centreon 2.7.12

The 2.7.12 release for Centreon Web is now available for download. The full release notes for 2.7.12 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Bug Fixes

• [CLAPI] Several bugs on HG / CG when export is filtered #5297 PR #5320

• [CLAPI] fix clapi ldap contact import

• Unable to load public custom view - No Layout... #5449

• Impossible to acknowledge several object from custom views #5420

• Security: avoid external command shell injection in comment

2.4 Centreon 2.6

Please find here the release notes dedicated to the last 2.6.x version of Centreon.

2.4.1 Centreon 2.6.6

Released October 29, 2015
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Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

• #3812: [2.6.3] Strange display of service group details page

• #3824: PHP Warning: array_map(): Argument #2 should be an array

• #3840: [2.6.4] Wrong reporting graph data with default user language fr_FR.UTF-8

• #3846: [2.6.5] CRSF Token critical: Impossible to upgrade a plugin

• #3847: [2.6.5] split component switch

• #3852: [2.6.5] CSRF error appears in user massive change form

• #3854: Cannot add new macro after deleting all macros already created

• #3855: Cannot add new host template to host after deleting all templates

• #3861: Comments shows only “A”

• #3864: [2.6.5] CSRF when trying to upload a SNMP MiB

2.4.2 Centreon 2.6.5

Released October 21, 2015

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Security fixes

• #3831: XSS injection in object lists (ZSL-2015-5266)

• #3835: CSRF Issues on Centreon (ZSL-2015-5263)

Bug fixes

• #3821: Upgrade from 2.6.1 to 2.6.3 kill Centreon Frontend

• #3826: Split Component and zoom doesn’t work

• #3827: Service Group Details page isn’t displayed for non admin in Centreon 2.6.3

• #3837: Relation of passive service with SNMP traps problem with multihost link

• #3842: Full logs display on event logs page for a non admin user

2.4. Centreon 2.6
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2.4.3 Centreon 2.6.4

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

• #3793: Problem when creating an empty hostgroup with non admin user

• #3795: Update Centreon Administration About page (forge -> GitHub)

• #3796: Problem when connect two time with same user in API

• #3797: Password in macro

• #3800: Current State Duration isn’t displayed

• #3803: ACL : Manage multiple Resources group on the same ACL user group

• #3807: Unable to enable status option on main.cfg

2.4.4 Centreon 2.6.3

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

• #564: Filter field does not work in service groups monitoring screen

• #1000: Services of service groups are dispatched on many pages

• #3782: SQL Keyswords

• #3783: index_data switch in option form

• #3788: Problem with static keywords

2.4.5 Centreon 2.6.2

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.
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CHANGELOG

Features

• Modules can extend actions after restart/reload pollers

Security fixes

• #2979 : Secure the type of media which file can be uploaded (ZSL-2015-5264)

• Fix some SQL injections (ZSL-2015-5265)

Bug fixes

• #3559 : Fix query with MariaDB / MySQL configure in STRICT_TRANS_TABLES

• #3554 : Can send acknowledgment with multiline from monitoring page

• #3397 : Fix display graph with unicode characters in metric name

• #2362 : Correct value when use index_data inserted by Centreon Broker in configuration

• #1195 : Display correct number of pollers in status bar

• #196 : Display all columns when filter is applied on Monitoring services unhandled view

2.4.6 Centreon 2.6.1

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

• #5655: Changing Host Templates doesn’t delete services

• #5925: Popup Dialogs (Acknowledge, Downtimes etc.) not working with Internet Explorer

• #6224: Special characters in LDAP are replaced by underscore

• #6358: It’s possible to bypass ACLs on Event Logs page

• #6375: servicegroups empty into servicegroups.cfg but ok in DB

• #6377: PHP logs are too much verbose with PHP 5.4

• #6378: PHP logs are too much verbose with PHP 5.3

• #6383: Random severity on services

• #6390: Escalations with contact groups containing space

• #6391: Some traps are skipped

• #6396: Warning and critical threshold display in centreon graph
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• #6399: Wrong condition in centreonLDAP.class.php

• #6410: Do not limit to 20 the number of trap rules or macro in host and services config pages

Features

• #6035: Removing Centreon Broker local module

• #6366: New option for Centreon Engine log

• #6392: Block choice of Nagios and NDO in installation process

2.4.7 Centreon 2.6.0

Notice

If you are upgrading from a version prior to 2.5.4, make sure to go through all the release notes available here.

What’s new?

Compatibility with PHP 5.4.x

Centreon is now compatible with PHP in version 5.4.x. So, you do not need to downgrade to PHP 5.3.x version when
you install it on Debian 6, Ubuntu 13.04, RedHat 7 and CentOS 7.

Centreon proprietary module (Centreon BAM, Centreon BI, Centreon MAP, Centreon KB) is not compatible as yet
with this PHP version.

New options for Centreontrapd

It’s now possible with Centreontrapd to :

• Filter services on same host ;

• Transform output (to remove pipe for example) ;

• Skip trap for hosts in downtime ;

• Add custom code execution ;

• Put unknown trap in another file.

ACL and configuration modification with admin users

ACL management has been improved to allow for a greater number of simultaneous sysadmin users to work on the
same monitoring platform.

The synchronization is more efficient in configuration page between admin and normal users.
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Partial rebuild of events information

It’s now possible to partially rebuild events information with eventsRebuild script. You can now use option ‘-s’ when
rebuilding and the rebuild will start from this date.

Before, you had to rebuild from the beginning of the related data.

Criticality inheritance

Centreon 2.6 introduces a capability for the dependent services of a host to automatically inherit its configured critical-
ity. It’s also possible to define the levels of global critically of a particular host and dependent services cluster thanks
to the use of templates.

Integration of Centreon new logo

The new Centreon logo has been integrated into this new version.

CHANGELOG

Bug fixes

• #5655: Changing Host Templates doesn’t delete services

• #5782: Warning daemon_dumps_core variable ignored

• #5795: ACL and configuration modification with admin users

• #5868: Generation of services groups isn’t correct for poller

• #6052: Month_cycle option in recurring downtime is not properly set

• #6119: Filter doesn’t work on many pages in Administration -> Log

• #6163: A template should not be able to inherit from itself

• #6336: Problem with schedule downtime when using different timezones

Features

• #3239: PHP-5.4 Compatibility

• #5238: Criticality inheritance

• #5334, #6114, #6120 : Optimization and customization on Centreontrapd

• #5952: Add possibility to rebuild partially Events information

• #6160: New Centreon logo

Note: higher versions are now available in download on our download portal. It’s high recommended to update your
platform in order to avoid bugs or security problems.

2.5 Centreon 2.5

Please find here the release notes dedicated to the last 2.5.x version of Centreon.

2.5. Centreon 2.5
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2.5.1 Centreon 2.5.4

Notice

If you are upgrading from a version prior to 2.5.3, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

• #5458: Display problem with host groups

• #5924: Generation of service configuration files does not work when “service_inherit_contacts_from_host” is
not enabled

• #5926: Centreon-Broker-2.7.x compatibility

• #5929: Fix problem in import service groups by cfg file

• #5942: Fix compatibility with IE

• #5946: Problem in reporting due to acknowledgment

• #5986: Session’s Id does not change after logout

Features

• #5433: Argument column larger in service configuration

• #5944: Services inherit criticality from hosts

2.5.2 Centreon 2.5.3

Warning

This version include a couple of security fixes. Please proceed to the update of your platform if your centreon is not in
version 2.5.3 at least. If you’re using Debian or Suse before doing the update, you need to install php5-sqlite package.

The update can take some times due to the update to UTF-8 format (#5609)

Notice

If you are upgrading from a version prior to 2.5.2, make sure to go through all the release notes available here.

CHANGELOG

• #5895: Security Issues : CVE-2014-3828 & CVE-2014-3829

• #5888: Differences between update and fresh install for “Insert in index data” field

• #5829: Add config file in parameters for all crons of Centreon in order to install centreon on different directories

• #5852: Fix problem with massive change for “Inherit contacts from host” in service form

• #5841: Empty dependencies are now remove automatically
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• #5840: Fix problem with host duplication when this host has a “”’ in the alias

• #5790 & #5813 & #5750: Fix problems on Tactical Overview

• #5786: Fix problem when generating correlation config file.

• #5756: Fix problem with centstorage => Table log is growing to much

• #5609: Push Centreon Broker table to UTF-8

• #5589: Fix problem with Contact inheritance between service and its template who doesn’t work

• #4865: Fix problem with search in Eventlog

2.5.3 Centreon 2.5.2

Notice

If you are upgrading from a version prior to 2.5.1, make sure to go through all the release notes available here.

CHANGELOG

• #5593: Fixes a bug where trap advanced matching rules were not working

• #5600: Fixes a bug where it was impossible to add or modify a poller

• #5533: Fixes a bug where it was impossible to update the severity level of a service

• #5307: Tooltips messages were not translated in the Broker configuration form

• #5664: Enhances loading time of the service detail page

• #5439: Enhances loading time of the meta service page

2.5.4 Centreon 2.5.2

Notice

If you are upgrading from a version prior to 2.5.1, make sure to go through all the release notes available here.

CHANGELOG

• #5593: Fixes a bug where trap advanced matching rules were not working

• #5600: Fixes a bug where it was impossible to add or modify a poller

• #5533: Fixes a bug where it was impossible to update the severity level of a service

• #5307: Tooltips messages were not translated in the Broker configuration form

• #5664: Enhances loading time of the service detail page

• #5439: Enhances loading time of the meta service page

2.5. Centreon 2.5
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2.5.5 Centreon 2.5.1

WARNING

If you are upgrading from Centreon 2.5.0 make sure to read the following.

Warning: If you are upgrading from a version prior to 2.5.0, just skip this notice and follow this procedure
instead: https://blog.centreon.com/centreon-2-5-0-release/.

As usual, database backups are to be made before going any further.

It does not matter whether you run the commands below before or after the web upgrade; do note that those scripts
may take some execution time depending on the size of your log tables.

You are using NDOUtils

If you are using NDOUtils, chances are that you have plenty of duplicate entries in your log table. Follow the procedure
in order to re insert the logs:

Copy all the log files from the remote pollers to the local poller in /var/lib/centreon/log/POLLERID/. To know the
POLLERID of each of your pollers, execute the following request against the MySQL server (centreon database):

mysql> SELECT id, name FROM nagios_server;

Then, execute the following script:

/path/to/centreon/cron/logAnalyser -a

You are upgrading from Centreon 2.5.0

There was a bug in Centreon 2.5.0 that probably messed up your reporting data, you will have to recover by running
these commands:

/path/to/centreon/cron/eventReportBuilder -r

/path/to/centreon/cron/dashboardBuilder -r -s <start_date> -e <end_date>

start_date and end_date must be formatted like this yyyy-mm-dd; they refer to the time period you wish to
rebuild your dashboard on.

2.5.6 Centreon 2.5

WARNING

If you are upgrading from Centreon 2.4.x make sure to read the following. As usual, database backups are to be
made before going any further. Then, follow these procedures in order to ensure the integrity of the RRD graphs. Not
following this may cause your graphs to malfunction!

If you are using Centreon Broker

• Check right of conf.pm file. Apache must have the right to modify conf.pm file

• Stop all the centreon-engine services
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• Stop the centreon-broker daemon

• Upgrade Centreon-Broker on all the pollers

• Restart all the engines

• Upgrade Centreon (web install)

• Execute /path/to/centreon/bin/changeRrdDsName.pl

• Check that your graphs are showing properly on the web interface

• Start the centreon-broker daemon

If you are using NDO

• Stop centstorage

• Upgrade Centreon (web install)

• Execute /path/to/centreon/bin/changeRrdDsName.pl

• Start centstorage

What’s new?

ACL on configuration objects

ACL rules are now applied to configuration objects. For more information regarding this feature, be sure to checkout
our blog post: http://blog.centreon.com/configuration-acl-with-centreon-2-5-2/

UI and sound notifications

It is now possible to get UI and sound notifications on Centreon, you can set your preferences in your profile page. A
quick overview there: http://blog.centreon.com/centreon-ui-notification-system/

Only available if you use Centreon Broker.

New system with SNMP traps

Centreon has evolved with an easiest way to handle SNMP traps. Some advantages of the new system:

• No more ‘snmptt’

• More advanced configuration in SQL Database

• Local database (SQLite) on Pollers

You have to look on the centreon documentation in order to configure Centreon using this new system. Go in section:
User guide > Advanced > SNMP TRAPS

2.5. Centreon 2.5
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Important notes

Centcore is now mandatory

External commands are now sent to centcore regardless of whether the poller is local or not. So be sure to have it
running all the time from now on.

Note: higher versions are now available in download on our download portal. It’s high recommended to update your
platform in order to avoid bugs or security problems.

2.6 Centreon 2.4

Please find here the release notes dedicated to the last 2.4.x version of Centreon.

2.6.1 Centreon 2.4.5

Important notes

Connector

You can now linked a command to a connector from the connector form in Configuration > Commands > Connectors.

Centreon Broker

Centreon 2.4.x branch is now compatible with Centreon Broker 2.5.x branch. Also several options have been added in
Centreon Broker configuration form accessible in Configuration > Centreon > Configuration (Below Centreon-Broker
label in the left panel). Here the new options:

• “Write timestamp” in General tab: To enable or disable timestamp logging in each log line (disable this option
is useful with when Centreon-Broker is used with Nagios)

• “Write thread id” in General tab: To enable or disable thread id logging in each log line

• “Write metrics” in Output tab with RRD - RRD file generator: To enable or disable the update of the performance
graph

• “Write status” in Output tab with RRD - RRD file generator: To enable or disable the update of the status graph

• “Store performance data in data_bin” in Output tab with Storage - Perfdata Generator (Centreon Storage): To
enable or disable insertion of performance data in data_bin table

• “Insert in index data” in Output tab with Storage - Perfdata Generator (Centreon Storage): Allow Centreon-
Broker to create entries in index_data table (use with caution)

2.6.2 Centreon 2.4.4

Important notes

Graphs

It is now possible to set RRD graphs’ to “DERIVE” and “ABSOLUTE” type. In order to do so go to Administration
> Options > CentStorage > Manage, then click on the metric you would like to update. In the “More actions” toolbar,
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you will now see the new data source types.

Monitoring consoles

A new option is available, allowing you to choose the display order of the monitored resources. The new option is
available in Administration > Options, in the Problem display properties section.

2.6.3 Centreon 2.4.1

Important notes

Connectors

If you are already using the Centreon Connectors, please note that the connector path is no longer called with user
variable $USER3$. It is instead in the Configuration > Centreon > Pollers > Centreon Connector
path. In that regard, be sure to fill this field and update the connector command line in Configuration >
Commands > Connectors by removing the $USER3$ prefix.

i.e:

$USER3$/centreon_connector_perl

should become:

centreon_connector_perl

Once you’re done with updating those configurations, you may delete the former $USER3$ as it will be no longer
used.

2.6.4 Centreon 2.4

What’s new?

Better integration with Centreon Engine and Centreon Broker

The installation process has been reviewed: it is now possible to specify the monitoring engine (Centreon Engine
or Nagios) and the event broker module (Centreon Broker or NDOUtils). All you need to do right after a fresh
installation is export your configuration files, then reload your monitoring engine and the monitoring system should
be up and running!

This version offers the possibility to define the connectors for Centreon Engine. Obviously, you do not need to
configure these connectors if you are still using Nagios.

It’s been said that Centreon Broker can be cumbersome to configure, especially if you are not familiar with its func-
tioning. Centreon 2.4 offers a configuration wizard now!

Custom views

This new page enables users to make their own views with various widgets and they are able to share their custom
views with their colleagues!

See the user guide to learn more about this feature.

2.6. Centreon 2.4
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Support for multiple LDAP servers

The LDAP authentication system is much more robust than before. Indeed, it is now possible to have multiple LDAP
configurations on top of the failover system. The LDAP import form will let you choose the LDAP server to import
from.

Make sure that all your LDAP parameters are correctly imported after an upgrade.

New autologin mechanism

A better autologin mechanism has been introduced in this version. Now using randomly generated keys, it allows you
to access specific pages without being prompted for a username and a password.

Database indexes verification tool

If you upgrade from an old version of Centreon, now you can check the existence of all database indexes to ensure
maximum performance

Important notes

Administration

Communication with pollers The default system user used by Centcore to communicate with pollers has changed
from nagios to centreon.

Plugins For better performances, we advise you to use check_icmp instead of check_ping if you are in an
IPv4 network, that is (check_icmp is not yet compatible with IPv6). Switching from check_ping to check_icmp
should be quite simple as the plugins take the same parameters. All you have to do is change the check commands:
check_centreon_ping, check_host_alive and all the commands that call check_ping.

Web interface

Autologin A new autologin mechanism has been added in Centreon 2.4. More secured than the previous one, it will
soon replace it. If you currently use this feature, we recommend upgrading to the new one as soon as you can.

Centreon Broker init script If you are using Centreon Broker, make sure to fill the Start script for broker daemon
parameter in Administration > Options > Monitoring. RRD graphs cannot be rebuilt if this parameter is
omitted!

Centcore options Two parameters have been added into the Administration > Options > Monitoring
page:

• Enable Perfdata Synchronization (Centcore)

• Enable Logs Synchronization (Centcore)

For performance issues, these options must be disabled if your monitoring system is running with Centreon Broker.
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Resource.cfg and CGI.cfg The resource and CGI configuration objects are now specific to each monitoring poller.
The values of $USERx$ macros can be different from one poller to another.

Interval length The interval_length is now a global parameter that you have to set in Administration >
Options > Monitoring, although it should be left at 60 seconds in most cases.

Centstorage

Supported data source types Centreon Broker now supports all of the RRDtool data source types (COUNTER,
GAUGE, DERIVE and ABSOLUTE). This support will not be added to Centstorage as it will soon be replaced by
Centreon Broker.

See the Centreon Broker documentation to learn how you can convert your existing plugins.

Note: higher versions are now available in download on our download portal. It’s high recommended to update your
platform in order to avoid bugs or security problems.

It is very important when you update your system to refer to this section in order to learn about behavior changes or
major changes that have been made on this version. This will let you know the impact of the installation of these
versions on the features you use or the specific developments that you have built on your platform (modules, widgets,
plugins).

If you have any questions relating to the content of the notes, you can ask your questions on our github.

To resolve viewing issues for all widgets, you must clear your cache.

2.6. Centreon 2.4
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CHAPTER 3

Lifecycle Products Policy

Starting with Centreon 18.10, Centreon will publish new releases of the Centreon solution at a regular cadence, en-
abling the community, businesses and developers to plan their roadmaps with the guarantee of upstream access to the
latest open source capabilities.

3.1 Version numbers are YY.MM

Releases of Centreon are named according to the year and the month of delivery. For example, Centreon 18.10 was
released in October 2018. All modules and components of the Centreon software suite use the same versioning.

3.2 Release cadence

The Centreon company plans to deliver two releases by year, the first in April and the second in October. Between
these two major releases, Centreon will continuously deliver minor updates including security fixes, bug fixes and
enhancements.

3.3 Maintenance and security updates

The lifecycle of a version is divided into three phases:

1. First phase: Bugs of all severity levels (minor, major, critical, blocker) and security issues are fixed by priority.

2. Second phases: Major, critical bugs and blockers, or security issues are fixed by priority.

3. Third phase: Blockers or security issues are fixed by priority.

Note: The severity and prioritization of bugs are the Centreon team’s responsibility.

The second phase of a version begins when the next major version is available. For example, the release of Centreon
19.04 starts the second phase of Centreon 18.10.

The third phase of a version begins when the second next major version is available. For example, the release of
Centreon 19.10 starts the third phase of Centreon 18.10 and the second phase of Centreon 19.04.

This schema shows the Centreon lifecycle:
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3.4 Maintenance table for earlier products

Note: Any other products not described in the following tables are no longer supported by Centreon.

3.4.1 Centreon OSS 3.4

Product Version Release date End of life State
Centreon Web 2.8.x 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon Engine 1.8.x 2017/09/19 Centreon 20.04 Blocking & security issues
Centreon Broker 3.0.x 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon DSM 2.x 2014/09/01 Centreon 20.04 Blocking & security issues
Centreon Open Tickets 1.2.x 2016/06/20 Centreon 20.04 Blocking & security issues
Centreon AWIE 1.x 2018/04/11 Centreon 20.04 Blocking & security issues
Centreon Poller Display 1.5.x 2018/04/11 Centreon 20.04 Blocking & security issues
Centreon Widgets 1.x N/A Centreon 20.04 Blocking & security issues
Centreon Plugins YYYYMMDD N/A Centreon 20.04 Blocking & security issues

3.4.2 Centreon IMP 3.4

Product Version Release date End of life State
Centreon OSS 3.4 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon License Manager 1.1.x 2018/02/23 Centreon 20.04 Blocking & security issues
Centreon Plugin Packs Manager 2.4.x 2018/05/30 Centreon 20.04 Blocking & security issues
Plugin Packs 3.x N/A N/A All issues

3.4.3 Centreon EMS 3.4

Product Version Release date End of life State
Centreon IMP 3.4 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon BAM 3.6.x 2018/02/22 Centreon 20.04 Blocking & security issues
Centreon MAP 4.4.x 2017/01/02 Centreon 20.04 Blocking & security issues
Centreon MBI 3.2.x 2018/07/09 Centreon 20.04 Blocking & security issues
Centreon Auto Discovery 2.3.x 2017/08/24 Centreon 20.04 Blocking & security issues
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CHAPTER 4

Installation

This chapter describes how to install your Centreon monitoring platform.

The monitoring platform may be installed in several ways. However, we strongly recommend using Centreon ISO to
install your platform. Enjoy of our work of industrialization during install and update steps of your the environment.
Also enjoy optimizations installed by default on the system.

Centreon Installation can be performed from source (tar.gz) but the work is more complex. In addition the installer
shall be supported by the community.

Before installation, be sure to follow the prerequisites installation and sizing (resources CPU, memory, disks, parti-
tioning, etc ...). Also take care to choose the type of architecture that should be set up for your needs.

Finally, you can install the platform.

4.1 Prerequisites

The Centreon web interface is compatible with the following list of web browser:

• Chrome (latest version)

• Firefox (latest version)

• Internet Explorer IE 11 (latest version)

• Safari (latest version)

Your screen resolution must be at least 1280 x 768.

4.1.1 Softwares

Operating System

Centreon offers an ISO including CentOS v7 and all packages.

If you prefer to use Red Hat OS you must install a v7 version and use rpms from repository.

Else you can use another GNU/Linux operating system but installation will be more complex and realized using
software sources.

Note: Only 64-bit operating systems (x86_64) are supported.
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DBMS

Centreon advises you to use MariaDB instead of MySQL.

Software Version
MariaDB >= 10.1.29
MySQL >= 5.6.16

Dependent software

The following table describes the dependent software:

Software Version
Apache 2.4
GnuTLS >= 2.0
Net-SNMP 5.7
openssl >= 1.0.1k
PHP 7.1 & 7.2
Qt >= 4.7.4
RRDtools 1.4.7
zlib 1.2.3

4.1.2 Select type of architecture

The table below gives the prerequisites for the installation of Centreon:

Number of Services Estimated number of hosts Number of pollers Central Poller
< 500 50 1 central 1 vCPU / 1 GB
500 - 2000 50 - 200 1 central 2 vCPU / 2 GB
2000 - 7000 200 - 700 1 central + 1 poller 4 vCPU / 4 GB 1 vCPU / 4 GB
7000 - 14000 700 - 1400 1 central + 1 poller 4 vCPU / 8 GB 2 vCPU / 4 GB
14000 - 21000 1400 - 2100 1 central + 2 pollers 4 vCPU / 8 GB 2 vCPU / 4 GB
21000 - 28000 2100 - 2800 1 central + 3 pollers 4 vCPU / 8 GB 2 vCPU / 4 GB
... ... ... ... ...

Note: A poller can monitor around 7000 active services. vCPU must have a frequency around 3 GHz. The number of
vCPU depends of the complexity of checks. If you use connectors or perform a lot of system/third-party binary calls,
please add more vCPU.

4.1.3 Define space disk

The space used for store collected and performance data depends on several criteria:

• Frequency of controls

• Number of controls

• Retention time

The following table provides an idea of the disk space needed for your platform with:

• Data are collected every 5 minutes

• The retention period is 6 month

• Each performance graph have 2 curves
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Number of Services /var/lib/mysql /var/lib/centreon
< 500 10 GB 2.5 GB
500 - 2000 42 GB 10 GB
2000 - 10000 126 GB 30 GB
10000 - 20000 252 GB 60 GB
20000 - 50000 660 GB 150 GB
50000 - 100000 1.4 TB 600 GB

4.1.4 Define files system

Note: Your system must use LVM to manage files system.

Centreon server

Files system description:

File system Size
swap 1 to 1.5 total size of RAM space
/ at least 20 GB
/var/log at least 10 GB
/var/lib/centreon define in previous chapter
/var/lib/centreon-broker at least 5 GB
/var/cache/centreon/backup at least 10 GB (please daily export the backups and delete the exported data)

MariaDB DBMS

Note: Al least 1GB of non allocated free space must be available on the volume group where /var/lib/mysql is
located when you want to use snapshot LVM as backup method.

Files system description:

File system Size
swap 1 to 1.5 total size of RAM space
/ at least 20 GB
/var/log at least 10 GB
/var/lib/mysql define in previous chapter
/var/cache/centreon/backup at least 10 Go (please daily export the backups and delete the exported data)

Monitoring poller

Files system description:

File system Size
swap 1 to 1.5 total size of RAM space
/ at least 20 GB
/var/log at least 10 GB
/var/lib/centreon-broker at least 5 GB
/var/cache/centreon/backup at least 5 Go (please daily export the backups and delete the exported data)

4.1. Prerequisites
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4.1.5 Users and groups

Note: This information are available for Red Hat / CentOS system. Name of users, groups and services can change
regarding GNU/Linux distribution.

Description of software and linked users:

Software Service User Comment
Apache httpd apache automatic start
MySQL (MariaDB) mysqld (mysql) mysql automatic start
Centreon centcore centreon automatic start
Centreon centreontrapd centreon automatic start
Centreon Broker cbwd centreon-broker automatic start
Centreon Broker cbd centreon-broker automatic start
Centreon Engine centengine centreon-engine automatic start

Description of optional software and linked users:

Software Service User Comment
Centreon VMware centreon_vmware centreon not installed by default
RRDtool rrdcached rrdcached not enabled and not defined in Centreon by default

Description of groups and linked users:

Group Users
apache nagios,centreon
centreon centreon-engine,centreon-broker,apache
centreon-broker centreon,nagios,centreon-engine,apache
centreon-engine centreon-broker,apache,nagios,centreon

Description of users, umask and home directory:

User umask home
root 0022 /root
apache 0022 /var/www
centreon 0002 /var/spool/centreon
centreon-broker 0002 /var/lib/centreon-broker
centreon-engine 0002 /var/lib/centreon-engine
mysql 0002 /var/lib/mysql

4.2 Examples of architectures

Centreon allows several choices in the composition of the architecture of your monitoring tool. In a relatively sim-
ple architecture with a server hosting all services, the architecture can also be organized around a strategic division
that distributes the load over multiple collection servers with the establishment of collection points across multiple
continents.

You will find here all architectures supported.

4.2.1 Simple architecture

Description

The simple architecture is to have all oversight entities within the same server, ie:
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• Centreon web interface

• Databases (MySQL + RRD)

• Monitoring Engine

• Broker

This architecture is the simplest a user may encounter.

Components

Many components are used to build this architecture:

• Apache web server for Centreon web interface

• MariaDB databases to store Centreon configuration parameters as well as monitoring and performance data

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

• Centreon Broker SQL allows to store information into MariaDB databases and forward them to Centreon Broker
RRD

• Centreon Broker RRD generates and updates RRD files with data in order to display performance graphs

Architecture

The diagram below summarizes the architecture:

4.2. Examples of architectures
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4.2.2 Distributed architecture

Description

The distributed architecture is to have two types of entities:

• A central Centreon server to display information

• One or more remote servers to collect data

The central Centreon server includes the following items:

• Centreon web interface

• Databases (MySQL + RRD)

• Monitoring Engine

• Broker

The Poller includes the following items:

• Monitoring Engine

• Broker module to forward collected data to a central broker

This architecture is used for:

• Enable load balancing across multiple remote monitoring servers
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• Network streams isolation: if your monitoring architecture have to monitor a DMZ area, it is easier (and safe)
to place a remote server in the DMZ network

Components

Central Centreon server

Many components are used to build a central Centreon server:

• Apache web server for Centreon web interface

• MariaDB databases to store Centreon configuration parameters as well as monitoring and performance data

• The Centcore process is used to send monitoring configuration to the remote server and to manage it

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

• Centreon Broker SQL allows to store information into MariaDB databases and forward them to Centreon Broker
RRD

• Centreon Broker RRD generates and updates RRD files with data in order to display performance graphs

Poller

Many components are used to build a poller:

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

Architecture

The diagram below summarizes the architecture:
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4.2.3 Distributed architecture with remote DBMS

Description

The distributed architecture with remote DBMS is to have three types of entities:

• A central Centreon server to display information

• A DBMS server to store collected data

• One or more remote servers to collect data

The central Centreon server includes the following items:

• Centreon web interface

• Monitoring Engine

• Broker

• RRD files

The DBMS server store information into MySQL databases.

The poller includes the following items:

• Monitoring Engine

• Broker module to forward collected data to a central broker

This architecture is used for:

• Enable load balancing across multiple remote monitoring servers

• Network streams isolation: if your monitoring architecture have to monitor a DMZ area, it is easier (and safe)
to place a remote server in the DMZ network

• Have a remote DBMS

Components

DBMS server

The DBMS server is used only to store Centreon configuration parameters as well as monitoring and performance data
into MariaDB databases

Central Centreon server

Many components are used to build a central Centreon server:

• Apache web server for Centreon web interface

• The central Centreon server get configuration and collected data from DBMS server

• The Centcore process is used to send monitoring configuration to the remote server and to manage it

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

• Centreon Broker SQL allows to store information into MariaDB databases and forward them to Centreon Broker
RRD
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• Centreon Broker RRD generates and updates RRD files with data in order to display performance graphs

Poller

Many components are used to build a poller:

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

Architecture

The diagram below summarizes the architecture:

4.2.4 Distributed architecture with failover

Description

The distributed architecture with remote DBMS is to have three types of entities:

• A central Centreon server to display information

• One or more remote servers to collect data

In order to have a failover the centreon central server is duplicated.

The central Centreon server includes the following items:

• Centreon web interface

• Monitoring Engine

• Broker

• Databases (MySQL + RRD)

The pollers include the following items:

• Monitoring Engine

4.2. Examples of architectures
CENTREON 46-52 RUE ALBERT FR75014 PARIS

63



• Broker module to forward collected data to a central broker

This architecture is used for:

• Enable load balancing across multiple remote monitoring servers

• Network streams isolation: if your monitoring architecture has to monitor a DMZ area, it is easier (and safe) to
place a remote server in the DMZ network

• Have a failover system: if the master centreon server is DOWN the other one allows to continue to display data.

Components

Central Centreon server

There is two types of Centreon central server:

• A master server

• A slave server which is configured as the master one but with only MySQL and Centreon Broker RRD monitor-
ing processes started.

Many components are used to build a master Centreon server:

• Apache web server for Centreon web interface

• The central Centreon server get configuration and collected data from DBMS server

• The Centcore process is used to send monitoring configuration to the remote server and to manage it

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

• Centreon Broker SQL allows to store information into MariaDB databases and forward them to the two Centreon
Broker RRD (master and slave)

• Centreon Broker RRD generates and updates RRD files with data in order to display performance graphs

A MySQL replication allows to store in both databases Centreon configuration and collected data.

The slave server is used in regular mode to generate and to update RRD files with data in order to display performance
graphs.

In case of failure, the operator has to start the following process on slave server: Apache, CentCore, Centreon Engine
and Centreon Broker SQL. The slave server becomes master.

The failover and the management of components are made by Corosync / Pacemaker system.

Architecture

The diagram below summarizes the architecture:
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4.2.5 Distributed architecture with Remote server

Centreon Remote Server is a new building-block in the Centreon distributed monitoring architecture. It comes in
addition to the existing Centreon Central Server and Centreon Pollers.

Centreon Remote Server allows remote IT operations team to benefit from the full Centreon user experience, albeit
on a subset of Centreon Pollers. Monitoring configuration takes place on the Central Server and is automatically
synchronized with all Remote Servers. Monitoring Operations (Acknowledge, Downtime...) may take place both on a
Remote Server or the Central Server.

In case of network link failure between a Remote Server and the Central Server, data retention takes place and the two
Servers are synchronized as soon as the connection is up again.

Centreon Remote Server is integrated in Centreon Core. It fully replaces the Poller Display module.

Description

The distributed architecture with Remote sever is to have three types of entities:

• A Centreon Central server to configure monitoring and to display & operate on collected data

• One or more Centreon Remote server to display & operate on a subset of collected data

• One or more pollers to collect data

The central Centreon server includes the following items:

• Centreon web interface(configure, display & operate)

• Monitoring Engine

• Broker

• Databases (MySQL + RRD)

The Remote servers include the following items:

• Centreon web interface (display & operate a subset of data)

• Monitoring Engine

• Databases (MySQL + RRD)
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• Broker module to forward collected data to a central broker

This architecture is used for:

• Enable load balancing across multiple remote monitoring servers

• Network streams isolation: if your monitoring architecture has to monitor a DMZ area, it is easier (and safe) to
place a remote server in the DMZ network

• Have dedicated webinterface to display & operate on a subset of data.

Components

Central Centreon server

Many components are used to build a Centreon server:

• Apache web server for Centreon web interface

• MariaDB databases to store Centreon configuration parameters as well as monitoring and performance data

• The Centcore process is used to send monitoring configuration to the remote server and to manage it

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

• Centreon Broker SQL allows to store information into MariaDB databases and forward them to Centreon Broker
RRD

• Centreon Broker RRD generates and updates RRD files with data in order to display performance graphs

Remote monitoring server

Many components are used to build a remote server:

• Apache web server for Centreon web interface

• MariaDB databases to store monitoring and performance data

• The Centcore process is used to operate on collected data

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine

• Centreon Broker SQL allows to store information into MariaDB databases and forward them to Centreon Broker
RRD locally as well as the Centreon Central server

• Centreon Broker RRD generates and updates RRD files with data in order to display performance graphs

Poller

Many components are used to build a poller:

• A monitoring engine to collect data

• Collected data are sent to Centreon Broker SQL using cbmod by monitoring engine
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Architecture

The diagram below summarizes the architecture:

4.2.6 Table of network flows

Tables of network flows to integrate monitoring platform to IT

From To Proto-
col

Port Application

Central
server

NTP
server

NTP UDP 123 Synchronization of the system clock

Central
server

DNS
server

DNS UDP 53 Domain name resolution

Central
server

SMTP
server

SMTP TCP 25 Notification via email

Central
server

LDAP(s)
server

LDAP(s) TCP 389
(636)

Authentication to access the Centreon web interface

Central
server

DBMS
server

MySQL TCP 3306 Access to Centreon databases

Central
server

HTTP
Proxy

HTTP(s) TCP 80,
8080 (443)

If your platform needs to connect to a web proxy to access
the Centreon IMP solution

Central
server

Reposi-
tory

HTTP
(FTP)

TCP 80 (FTP
20)

Repository for system and application packages

From To Protocol Port Application
Poller NTP server NTP UDP 123 Synchronization of the system clock
Poller DNS server DNS UDP 53 Domain name resolution
Poller SMTP server SMTP TCP 25 Notification via email
Poller Repository HTTP (FTP) TCP 80 (FTP 20,21) Repository for system and application packages

Note: Other flows can be necessary for Centreon web authentication (RADIUS, etc.) or notification system defined.
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Tables of monitoring flows

From To Protocol Port Application
Central server Poller SSH TCP 22 Export of Centreon configuration
Poller Central server BBDO TCP 5669 Transfer of collected data
Poller Network equipment, servers, etc. SNMP UDP 161 Monitoring
Network equipment Poller Trap SNMP UDP 162 Monitoring
Poller Servers NRPE TCP 5666 Monitoring
Poller Servers NSClient++ TCP 12489 Monitoring

Note: If the Centreon server is a poller too, do not forget to open monitoring flows.

Note: Other flows can be necessary to monitor databases, access to API, or application ports.

If you have feedbacks regarding our architecture, please inform us on GitHub.

4.3 Downloads

Open Source software supplied by Centreon is generally available in 4 formats:

• ISO Linux based on CentOS v7 distribution (recommended)

• RPM packages available for CentOS v7 distribution (recommended)

• virtual machines, based on CentOS v7 distribution, with OVA (VMware) and OVF (VirtualBox and others)
formats

• Archives containing the sources

RPM packages and ISO linux are the best format to obtain our software. They are packaged by Centreon experts and
relieve you of any concern over the installation process.

Note: Centreon recommends using the Centreon packaged version. Installation is detailed in the chapter entitled:
Using Centreon

If your platform does not support RPM packages, you should use archives containing the sources of stable versions of
our software and install them manually. Manual compilation of some packages can be complex.

For downloading Centreon sources, please refer to our website.

4.4 Using Centreon el7 ISO

4.4.1 Installation

Step 1: Starting up the server

To install Centreon, start up your server from the Centreon ISO image in version el7. Start up with Install CentOS 7:
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Step 2: Choosing a language

Choose the language for the installation process then click on Done:

Step 3: Selecting components

Click on the Installation Type menu:
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You can choose different options:

• Central with database: Install Centreon (web interface and database), monitoring engine and broker.

• Central without database: Install Centreon (web interface only), monitoring engine and broker.

• Poller: Install poller (monitoring engine and broker only).

• Database: Install database server (use with Central server without database option).
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Step 4: System configuration

Partitioning the disk

Click on the Installation Destination menu:

Select the hard disk drive and the I will configure partitioning option, then click on Done:

Using the + button create, your own partitioning file system following the instructions in documentation prerequisites,
then click on Done:
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A confirmation window appears. Click on Accept Changes to validate the partitioning:

Configuring the network

Click on the Network & Hostname menu:
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Enable all network interfaces and define hostname, then click on Done:

Configuring the timezone

Click on the Date & Time menu:
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Select timezone, then click on the configuration button:

To enable or add a NTP server, click on OK, then on Done:
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Beginning the installation

Once configuration is complete, click on Begin Installation:

Click on Root Password:
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Define and confirm root user password. Click on Done:

Wait for installation process to finish:
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When the installation is complete, click on Reboot:

Updating the system packages

Connect to your server using a terminal and execute the command:

# yum update
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Accept all GPG keys:

Then restart your server with the following command:

# reboot

4.4.2 Configuration

Log in to Centreon web interface via the URL: http://[SERVER_IP]/centreon. The Centreon setup wizard is displayed.
Click on Next.
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The Centreon setup wizard checks the availability of the modules. Click on Next.

Click on Next.
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Click on Next.

Provide the information on the admin user, then click on Next.

By default, the ‘localhost’ server is defined and the root password is empty. If you use a remote database server,
change these entries. In this case, you only need to define a password for the user accessing the Centreon databases,
i.e., ‘Centreon’. Click on Next.
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Note: If the Add innodb_file_per_table=1 in my.cnf file under the [mysqld] section and restart MySQL Server.
error message appears, perform the following operations:

1. Log in to the ‘root’ user on your server.

2. Modify this file:

/etc/my.cnf

3. Add these lines to the file:

[mysqld]
innodb_file_per_table=1

4. Restart mysql service:

# systemctl restart mysql

5. Click on Refresh.

The Centreon setup wizard configures the databases. Click on Next.
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At this point, you will be able to install the Centreon server modules.

Click on Install.

Once installation is complete, click on Next.

At this point, an advertisement informs you of the latest Centreon news and products. If your platform is connected to
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the internet, you will receive the up-to-date information. If you are not online, only information on the current version
will be displayed.

The installation is complete. Click on Finish.

You can now log in.

You can change the default language of the web interface:

1. Click on your profile on the top right of the banner

2. Click on Edit profile

3. Select your language in the **Language* field
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4. Click on Save

To start the monitoring engine :

1. On your web interface, go to Configuration ==> Pollers.

2. Keep the default options and click on Export configuration.

3. Select Central poller from the box input Pollers.

4. Uncheck Generate Configuration Files and Run monitoring engine debug (-v).

5. Check Move Export Files and Restart Monitoring Engine with option Restart selected.

6. Click on Export again.

7. Log in to the ‘root’ user on your server.

8. Start Centreon Broker

# systemctl start cbd

9. Start Centreon Engine

# systemctl start centengine

10. Start centcore

# systemctl start centcore

11. Start centreontrapd

# systemctl start centreontrapd

Monitoring is now working. You can begin monitoring your IT system!

To make services automatically start during system bootup run these commands on the central server:

# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

The Centreon web interface contains several menus, each with a specific function:
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• Home lets you access the first home screen after logging in. It provides a summary of overall monitoring status.

• Monitoring provides a combined view of the status of all monitored items in real and delayed time using logs
and performance graphics.

• Reporting provides an intuitive view (using diagrams) of the evolution of monitoring over a given period.

• Configuration allows you to configure all monitored items and the monitoring infrastructure.

• Administration allows you to configure the Centreon web interface and view the overall status of the servers.

4.4.3 Quick and easy monitoring configuration

Centreon is a highly versatile monitoring solution that can be configured to meet the specific needs of your IT in-
frastructure. To quickly configure Centreon and help you get started, you may want to use Centreon IMP. This tool
provides you with Plugin Packs, which are bundled configuration templates that will dramatically reduce the time
needed to implement the Centreon platform for monitoring the services in your network.

Centreon IMP requires the Centreon License Manager and Centreon Plugin Pack Manager in order to function.

If you haven’t installed any modules during the installation process, go to the Administration > Extensions > Mod-
ules menu.

Click on Install/Upgrade all and validate.

Once the installation is complete, click on Back. The modules are now installed.
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Now proceed to Configuration -> Plugin packs -> Manager. 10 free Plugin Packs are provided to get you started.
Five additional Packs are available once you register and over 150 more if you subscribe to the IMP offer (for more
information: our website).

You can continue to configure your monitoring system with Centreon IMP by following the instructions in this guide.

4.5 Using packages

Centreon provides RPM packages for its products through the Centreon open source version available free of charge
in our repository.

These packages have been successfully tested in version 7.x CentOS and Red Hat environments.

4.5.1 Pre-installation steps

SELinux should be disabled. To do this, you first have to edit the file /etc/selinux/config and replace “enforcing” by
“disabled”:

SELINUX=disabled

Note: After saving the file, please reboot your operating system to apply the changes.

A quick check of SELinux status:

$ getenforce
Disabled
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4.5.2 Installing the repository

Redhat Software collections repository

To install Centreon you will need to set up the official software collections repository supported by Redhat.

Note: Software collections are required in order to install PHP 7 and associated libs (Centreon requirement).

Software collections repository installation:

# yum install centos-release-scl

The repository is now installed.

Centreon repository

To install Centreon software from the repository, you should first install the centreon-release package which will
provide the repository file.

Centreon repository installation:

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

The repository is now installed.

4.5.3 Installing a Centreon central server

This chapter describes the installation of a Centreon central server.

Installing Centreon central server with database

Run the command:

# yum install centreon
# systemctl restart mysql

Installing Centreon central server without database

Run the command:

# yum install centreon-base-config-centreon-engine

Installing MySQL on the dedicated server

Run the commands:

# yum install centreon-database
# systemctl restart mysql

Note: centreon-database package installs a database server optimized for use with Centreon.
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Database management system

The MySQL database server should be available to complete installation (locally or not). MariaDB is recommended.

It is necessary to modify LimitNOFILE limitation. Setting this option into /etc/my.cnf will NOT work.

Run the commands:

# mkdir -p /etc/systemd/system/mariadb.service.d/
# echo -ne "[Service]\nLimitNOFILE=32000\n" | tee /etc/systemd/system/mariadb.service.d/limits.conf
# systemctl daemon-reload
# systemctl restart mysql

Setting the PHP timezone

You must set the PHP timezone. Perform the command:

# echo "date.timezone = Europe/Paris" > /etc/opt/rh/rh-php71/php.d/php-timezone.ini

Note: Change Europe/Paris to your timezone.

After saving the file, please do not forget to restart the apache server:

# systemctl restart httpd

Configuring/disabling the firewall

Add firewall rules or disable the firewall by running following commands:

# systemctl stop firewalld
# systemctl disable firewalld
# systemctl status firewalld

Launching services during system bootup

To make services automatically start during system bootup run these commands on the central server:

# systemctl enable httpd
# systemctl enable snmpd
# systemctl enable snmptrapd
# systemctl enable rh-php71-php-fpm
# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

Note: If MySQL database is on a dedicated server, execute the enable command of mysql on the database server.

Concluding the installation

Before starting the web installation process, you will need to execute:
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# systemctl start rh-php71-php-fpm
# systemctl start httpd
# systemctl start mysqld
# systemctl start cbd
# systemctl start snmpd
# systemctl start snmptrapd

4.5.4 Configuration

Log in to Centreon web interface via the URL: http://[SERVER_IP]/centreon. The Centreon setup wizard is displayed.
Click on Next.

The Centreon setup wizard checks the availability of the modules. Click on Next.

Click on Next.

4.5. Using packages
CENTREON 46-52 RUE ALBERT FR75014 PARIS

89

http://{[}SERVER_IP{]}/centreon


Click on Next.

Provide the information on the admin user, then click on Next.
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By default, the ‘localhost’ server is defined and the root password is empty. If you use a remote database server,
change these entries. In this case, you only need to define a password for the user accessing the Centreon databases,
i.e., ‘Centreon’. Click on Next.

Note: If the Add innodb_file_per_table=1 in my.cnf file under the [mysqld] section and restart MySQL Server.
error message appears, perform the following operations:

1. Log in to the ‘root’ user on your server.

2. Modify this file:

/etc/my.cnf

3. Add these lines to the file:
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[mysqld]
innodb_file_per_table=1

4. Restart mysql service:

# systemctl restart mysql

5. Click on Refresh.

The Centreon setup wizard configures the databases. Click on Next.

At this point, you will be able to install the Centreon server modules.

Click on Install.

Once installation is complete, click on Next.
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At this point, an advertisement informs you of the latest Centreon news and products. If your platform is connected to
the internet, you will receive the up-to-date information. If you are not online, only information on the current version
will be displayed.

The installation is complete. Click on Finish.

You can now log in.
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You can change the default language of the web interface:

1. Click on your profile on the top right of the banner

2. Click on Edit profile

3. Select your language in the **Language* field

4. Click on Save

To start the monitoring engine :

1. On your web interface, go to Configuration ==> Pollers.

2. Keep the default options and click on Export configuration.

3. Select Central poller from the box input Pollers.

4. Uncheck Generate Configuration Files and Run monitoring engine debug (-v).

5. Check Move Export Files and Restart Monitoring Engine with option Restart selected.

6. Click on Export again.

7. Log in to the ‘root’ user on your server.

8. Start Centreon Broker

# systemctl start cbd

9. Start Centreon Engine

# systemctl start centengine
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10. Start centcore

# systemctl start centcore

11. Start centreontrapd

# systemctl start centreontrapd

Monitoring is now working. You can begin monitoring your IT system!

To make services automatically start during system bootup run these commands on the central server:

# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

The Centreon web interface contains several menus, each with a specific function:

• Home lets you access the first home screen after logging in. It provides a summary of overall monitoring status.

• Monitoring provides a combined view of the status of all monitored items in real and delayed time using logs
and performance graphics.

• Reporting provides an intuitive view (using diagrams) of the evolution of monitoring over a given period.

• Configuration allows you to configure all monitored items and the monitoring infrastructure.

• Administration allows you to configure the Centreon web interface and view the overall status of the servers.

4.5.5 Quick and easy monitoring configuration

Centreon is a highly versatile monitoring solution that can be configured to meet the specific needs of your IT in-
frastructure. To quickly configure Centreon and help you get started, you may want to use Centreon IMP. This tool
provides you with Plugin Packs, which are bundled configuration templates that will dramatically reduce the time
needed to implement the Centreon platform for monitoring the services in your network.

Centreon IMP requires the Centreon License Manager and Centreon Plugin Pack Manager in order to function.

If you haven’t installed any modules during the installation process, go to the Administration > Extensions > Mod-
ules menu.

Click on Install/Upgrade all and validate.
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Once the installation is complete, click on Back. The modules are now installed.

Now proceed to Configuration -> Plugin packs -> Manager. 10 free Plugin Packs are provided to get you started.
Five additional Packs are available once you register and over 150 more if you subscribe to the IMP offer (for more
information: our website).

You can continue to configure your monitoring system with Centreon IMP by following the instructions in this guide.

4.6 Using VM

Two pre-configured virtual machines are available on Centreon download web site.

These virtual machines are available in OVA (VMware) and OVF (VirtualBox) format.
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4.6.1 Centreon Central server

Import

The first step is to import the OVF File. To do that go in File > Deploy OVF Template and choose your file. You can
then follow different menus. Choices you made are linked to your VMWare configuration so it’s difficult to be more
specific. Just be noticed that best practice are to used Thin Provision to keep some spaces in disk.

Connection

The server has default password.

To connect to the web UI use : admin/centreon.

You can also connect to the server using SSH with the account : root/centreon The root password of the DBMS is
not initialized.

Note: For security reasons, we highly recommend you to change those passwords after installation.

On the first connection, a message describes the operations to be performed. Run these, especially operations 4 and
5.

Note: To remove this message, remove the /etc/profile.d/centreon.sh file.

4.6.2 Poller

Using Poller VM is nearly the same as central. You just have to exchange SSH keys and configure it on web interface.

Exchange SSH keys

The communication between a central server and a poller server is done by SSH.

You should exchange the SSH keys between the servers.

If you don’t have any private SSH keys on the central server for the centreon user:

# su - centreon
$ ssh-keygen -t rsa

Copy this key on the new server:

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

The password of the centreon user is centreon. It can be easily changed using passwd command.

On Web interface

4.6.3 Configure new poller in Centreon

Since Centreon 18.10, a new wizard is available to define a new poller to a Centreon platform.

Note: It is possible to configure a new Poller manually, however Centreon recommends using the following procedure.
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Go to the Configuration > Pollers menu and click Add server with wizard to configure a new poller.

Select Add a Centreon Poller and click Next:

Set the name, the IP address of the poller and the IP address of the Centreon Central server and click Next:

Note: The IP address of the poller is the IP address or the FQDN to access to this poller since Centreon Central
server.

The IP address of the Centreon Central server is the IP address or the FQDN to access to the Centreon Central server
since the poller.

If you want to link this poller to the Centreon Server, click Apply:
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Else, if you want to link this poller to an existing Remote Server, select the Remote Server in the list. Then click
Apply:

Note: If you want to change the sense of the flow between the Centreon Server (or the Remote Server and the Poller,
check the Advanced: reverse Centreon Broker communication flow checkbox.

Wait a few seconds, the wizard will configure your new server.

The Poller is now configured:

Go to the Simplified configuration of Centreon with IMP chapter to configure your first monitoring.

4.7 Using sources

4.7.1 Prerequisites

CentOS

Most CentOS users will find easier to install Centreon Web by using packages provided by Centreon.

CentOS and RHEL environments do not possess as standard on archives all the dependencies necessary for the instal-
lation of Centreon. You should add the RPM Forge repository.

el7 system:

$ wget http://repository.it4i.cz/mirrors/repoforge/redhat/el7/en/x86_64/rpmforge/RPMS/rpmforge-release-0.5.3-1.el7.rf.x86_64.rpm
$ wget https://repository.it4i.cz/mirrors/repoforge/RPM-GPG-KEY.dag.txt

Use your favorite text editor and delete the first line of the RPM-GPG-KEY.dag.txt file. The first line should contain:

"-----BEGIN PGP PUBLIC KEY BLOCK-----"
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Then perform the following commands:

$ rpm --import RPM-GPG-KEY.dag.txt
$ rpm -Uvh rpmforge-release-0.5.3-1.el7.rf.x86_64.rpm

You can now install the necessary prerequisites:

$ yum update
$ yum upgrade
$ yum install httpd gd fontconfig-devel libjpeg-devel libpng-devel gd-devel perl-GD perl-DateTime \

openssl-devel perl-DBD-MySQL mysql-server mysql-devel php php-mysql php-gd php-ldap php-xml php-mbstring \
perl-Config-IniFiles perl-DBI perl-DBD-MySQL rrdtool perl-rrdtool perl-Crypt-DES perl-Digest-SHA1 \
perl-Digest-HMAC net-snmp-utils perl-Socket6 perl-IO-Socket-INET6 net-snmp net-snmp-libs php-snmp \
dmidecode lm_sensors perl-Net-SNMP net-snmp-perl fping cpp gcc gcc-c++ libstdc++ glib2-devel \
php-pear nagios-plugins

Additional commands are necessary to configure the environment correctly:

$ usermod -U apache
$ pear channel-update pear.php.net

If you can’t access the Internet directly but have to pass via a proxy, perform the following command:

$ pear config-set http_proxy http://my_proxy.com:port

Then execute:

$ pear upgrade-all

Debian jessie / Ubuntu 14.04

Note: Debian and Ubuntu latest version not yet supported.

Install the following prerequisites:

$ apt-get install sudo tofrodos bsd-mailx lsb-release mysql-server libmysqlclient18 libdatetime-perl \
apache2 apache2-mpm-prefork php5 php5-mysql php-pear php5-intl php5-ldap php5-snmp php5-gd php5-sqlite \
rrdtool librrds-perl libconfig-inifiles-perl libcrypt-des-perl libdigest-hmac-perl \
libdigest-sha-perl libgd-perl snmp snmpd libnet-snmp-perl libsnmp-perl nagios-plugins

To finish, you should install SNMP MIBs. Because of a license problem the MIB files are not available by default in
Debian. To add them, change the /etc/apt/sources.list file and add the non-free category.

To Debian, then execute the following commands:

$ apt-get update
$ apt-get install snmp-mibs-downloader

Suse

Packages

Install the following prerequisites:
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$ yast -i gcc gcc-c++ make automake apache2 php5 php5-mysql apache2-mod_php5 php5-pear \
php5-ldap php5-snmp php5-gd php5-soap php5-intl php5-posix php5-gettext php5-mbstring mysql \
libmysqlclient-devel perl-DBD-mysql mysql-community-server rrdtool perl-Config-IniFiles \
net-snmp perl-Net-SNMP perl-SNMP gd libjpeg-devel libpng-devel fontconfig-devel \
freetype2-devel sudo mailx fping iputils dos2unix cron dejavu nagios-plugins

On some OpenSuse distributions, the default settings of the mine type are not valid to function with the Centreon web
interface. Edit the /etc/mime.types file and find the lines:

text/x-xsl xsl
text/x-xslt xslt xsl

Replace them by:

text/xml xsl
text/xml xslt xsl

Save the file and restart Apache:

/etc/init.d/apache2 restart

4.7.2 Monitoring engine

Centreon is tested and approved only for the monitoring engine Centreon Engine.

You can install it following the procedure in documentation. Don’t forget to install the Nagios plugins if you have not
already done so.

4.7.3 Stream Multiplexer

Centreon is tested and approved only for the stream multiplexer Centreon Broker.

Install this Stream Multiplexers before continuing with the installation.

Warning: Centreon Web is not compatible with Nagios monitoring engine.

4.7.4 Centreon

Download the latest version of Centreon-web here.

Shell Installation

Extract the Centreon archive:

tar zxf centreon-web-2.8.x.tar.gz

Change directory:

cd centreon-web-2.8.x

Run the installation script:

./install.sh -i
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Note: The installation script allows customised configuration; this process will show you the best paths to use.
Furthermore quick yes/no questions can be replied to by [y] most of the time.

Prerequisites check

If the Prerequisites installation step has been run successfully you should have no problem during this stage. Otherwise
repeat the Prerequisites installation process:

###############################################################################
# #
# Centreon (www.centreon.com) #
# Thanks for using Centreon #
# #
# v2.8.0 #
# #
# infos@centreon.com #
# #
# Make sure you have installed and configured #
# sudo - sed - php - apache - rrdtool - mysql #
# #
###############################################################################
------------------------------------------------------------------------

Checking all needed binaries
------------------------------------------------------------------------
rm OK
cp OK
mv OK
/bin/chmod OK
/bin/chown OK
echo OK
more OK
mkdir OK
find OK
/bin/grep OK
/bin/cat OK
/bin/sed OK

License agreement

This General Public License does not permit incorporating your program into
proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Library General
Public License instead of this License.

Do you accept GPLv2 license ?
[y/n], default to [n]:
> y

Main components

Answer [y] to all the questions.
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------------------------------------------------------------------------
Please choose what you want to install

------------------------------------------------------------------------

Do you want to install Centreon Nagios Plugins ?
[y/n], default to [n]:
> y

Definition of installation paths
--------------------------------

------------------------------------------------------------------------
Starting Centreon Web Installation

------------------------------------------------------------------------

Where is your Centreon directory ?
default to [/usr/local/share/centreon]
>

Do you want me to create this directory ? [/usr/local/share/centreon]
[y/n], default to [n]:
> y
Path /usr/local/share/centreon OK

Where is your Centreon log directory ?
default to [/var/log/centreon]
>

Do you want me to create this directory ? [/var/log/centreon]
[y/n], default to [n]:
> y
Path /var/log/centreon OK

Where is your Centreon configuration directory ?
default to [/usr/local/etc/centreon]
>

Do you want me to create this directory ? [/usr/local/etc/centreon]
[y/n], default to [n]:
> y
Path /usr/local/etc/centreon OK

Where is your Centreon binaries directory ?
default to [/usr/local/bin]
>

Where is your Centreon variable state information directory ?
default to [/var/lib/centreon]
>
Path /var/lib/centreon/ OK

Do you want me to create this directory ? [/var/lib/centreon]
[y/n], default to [n]:
> y
Path /var/lib/centreon OK

/usr/bin/rrdtool OK
/usr/bin/mail OK
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/usr/bin/php OK
/usr/share/php OK
/usr/bin/perl OK
Finding Apache user : apache
Finding Apache group : apache

Centreon user and group

The Centreon applications group: this group is used for the access rights between the various Centreon components.

What is the Centreon group ? [centreon]
default to [centreon]
>

What is the Centreon user ? [centreon]
default to [centreon]
>

Monitoring user

This is the user used to run the monitoring engine (Centreon Engine). If you followed the Centreon Engine official
installation procedure the user will likely be centreon-engine.

What is your Centreon Engine user ?
default to [centreon-engine]
>

This is the user used to run the stream broker (Centreon Broker). If you followed the Centreon Broker official instal-
lation procedure the user will likely be centreon-broker.

What is your Centreon Broker user ?
default to [centreon-broker]
>

Monitoring logs directory

What is your Centreon Engine log directory ?
default to [/var/log/centreon-engine]
>

Plugin path

Where is your monitoring plugins (libexec) directory ?
default to [/usr/lib/nagios/plugins]
>
Path /usr/lib/nagios/plugins OK
Add group centreon to user apache OK
Add group centreon to user centreon-engine OK
Add group centreon-engine to user apache OK
Add group centreon-engine to user centreon OK
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Sudo configuration

------------------------------------------------------------------------
Configure Sudo

------------------------------------------------------------------------

Where is sudo configuration file ?
default to [/etc/sudoers]
>
/etc/sudoers OK

What is your Centreon Engine startup command (init.d, service, ...) ?
default to [service centengine]
>

Are you sure ? [service centengine]
[y/n], default to [n]:
> y

Where is your Centreon Engine binary ?
default to [/usr/sbin/centengine]
>

Where is your Centreon Engine configuration directory ?
default to [/etc/centreon-engine]
>

Where is your Centreon Broker configuration directory ?
default to [/etc/centreon-broker]
>

What is your Centreon Broker startup command (init.d, service, ...) ?
default to [service cbd]
>

Are you sure ? [service cbd]
[y/n], default to [n]:
> y

Do you want me to reconfigure your sudo ? (WARNING)
[y/n], default to [n]:
> y
Configuring Sudo OK

Apache configuration

------------------------------------------------------------------------
Configure Apache server

------------------------------------------------------------------------

Do you want to add Centreon Apache sub configuration file ?
[y/n], default to [n]:
> y
Create ’/etc/httpd/conf.d/centreon.conf’ OK
Configuring Apache OK

Do you want to reload your Apache ?
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[y/n], default to [n]:
> y
Reloading Apache service OK
Preparing Centreon temporary files
Change right on /var/log/centreon OK
Change right on /usr/local/etc/centreon OK
Change macros for insertBaseConf.sql OK
Change macros for sql update files OK
Change macros for php files OK
Change macros for php config file OK
Change macros for perl binary OK
Change right on /etc/centreon-engine OK
Change right on /etc/centreon-broker OK
Add group centreon to user apache OK
Add group centreon to user centreon-engine OK
Add group centreon to user centreon OK
Copy CentWeb in system directory OK
Install CentWeb (web front of centreon) OK
Change right for install directory
Change right for install directory OK
Install libraries OK
Write right to Smarty Cache OK
Copying libinstall OK
Change macros for centreon.cron OK
Install Centreon cron.d file OK
Change macros for centAcl.php OK
Change macros for downtimeManager.php OK
Install cron directory OK
Change right for eventReportBuilder OK
Change right for dashboardBuilder OK
Change macros for centreon.logrotate OK
Install Centreon logrotate.d file OK
Prepare centFillTrapDB OK
Install centFillTrapDB OK
Prepare centreon_trap_send OK
Install centreon_trap_send OK
Prepare centreon_check_perfdata OK
Install centreon_check_perfdata OK
Prepare centreonSyncPlugins OK
Install centreonSyncPlugins OK
Prepare centreonSyncArchives OK
Install centreonSyncArchives OK
Prepare generateSqlLite OK
Install generateSqlLite OK
Install changeRrdDsName.pl OK
Prepare export-mysql-indexes OK
Install export-mysql-indexes OK
Prepare import-mysql-indexes OK
Install import-mysql-indexes OK
Prepare clapi binary OK
Install clapi binary OK
Centreon Web Perl lib installed OK
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Pear module installation

------------------------------------------------------------------------
Pear Modules
------------------------------------------------------------------------
Check PEAR modules
PEAR 1.4.9 1.10.1 OK
DB 1.7.6 1.9.2 OK
DB_DataObject 1.8.4 1.11.5 OK
DB_DataObject_FormBuilder 1.0.0RC4 1.0.2 OK
MDB2 2.0.0 2.4.1 OK
Date 1.4.6 1.4.7 OK
Archive_Tar 1.1 1.3.11 OK
Auth_SASL 1.0.1 1.0.6 OK
Console_Getopt 1.2 1.3.1 OK
Validate 0.6.2 0.8.5 OK
Log 1.9.11 1.12.9 OK
Archive_Zip 0.1.2 0.1.2 OK
All PEAR modules OK

Configuration file installation

------------------------------------------------------------------------
Centreon Post Install

------------------------------------------------------------------------
Create /usr/share/centreon/www/install/install.conf.php OK
Create /etc/centreon/instCentWeb.conf OK

Performance data component (Centstorage) installation

------------------------------------------------------------------------
Starting CentStorage Installation

------------------------------------------------------------------------

Where is your Centreon Run Dir directory ?
default to [/var/run/centreon]
>

Do you want me to create this directory ? [/var/run/centreon]
[y/n], default to [n]:
> y
Path /var/run/centreon OK

Where is your CentStorage RRD directory ?
default to [/var/lib/centreon]
>
Path /var/lib/centreon OK
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
install www/install/createTablesCentstorage.sql OK
Creating Centreon Directory ’/var/lib/centreon/status’ OK
Creating Centreon Directory ’/var/lib/centreon/metrics’ OK
Change right : /var/run/centreon OK
Install logAnalyserBroker OK
Install nagiosPerfTrace OK
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Change macros for centstorage.cron OK
Install CentStorage cron OK
Change macros for centstorage.logrotate OK
Install Centreon Storage logrotate.d file OK
Create /usr/local/etc/centreon/instCentStorage.conf OK

Poller communication subsystem (Centcore) installation

------------------------------------------------------------------------
Starting CentCore Installation

------------------------------------------------------------------------
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Copy CentCore in binary directory OK
Change right : /var/run/centreon OK
Change right : /var/lib/centreon OK
Change macros for centcore.logrotate OK
Install Centreon Core logrotate.d file OK
Replace CentCore init script Macro OK
Replace CentCore sysconfig script Macro OK

Do you want me to install CentCore init script ?
[y/n], default to [n]:
> y
CentCore init script installed OK
CentCore sysconfig script installed OK

Do you want me to install CentCore run level ?
[y/n], default to [n]:
> y
CentCore Perl lib installed OK
Create /usr/local/etc/centreon/instCentCore.conf OK

Centreon SNMP trap management installation

------------------------------------------------------------------------
Starting CentreonTrapD Installation

------------------------------------------------------------------------

Where is your SNMP configuration directory ?
default to [/etc/snmp]
>
/etc/snmp OK
Finding Apache user : apache
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change macros for snmptrapd.conf OK
Replace CentreonTrapd init script Macro OK
Replace CentreonTrapd sysconfig script Macro OK

Do you want me to install CentreonTrapd init script ?
[y/n], default to [n]:
> y
CentreonTrapd init script installed OK
CentreonTrapd sysconfig script installed OK
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Do you want me to install CentreonTrapd run level ?
[y/n], default to [n]:
> y
trapd Perl lib installed OK
Install : snmptrapd.conf OK
Install : centreontrapdforward OK
Install : centreontrapd OK
Change macros for centreontrapd.logrotate OK
Install Centreon Trapd logrotate.d file OK
Create /usr/local/etc/centreon/instCentPlugins.conf OK

Plugin installation

------------------------------------------------------------------------
Starting Centreon Plugins Installation

------------------------------------------------------------------------

Where is your CentPlugins lib directory
default to [/var/lib/centreon/centplugins]
>

Do you want me to create this directory ? [/var/lib/centreon/centplugins]
[y/n], default to [n]:
> y
Path /var/lib/centreon/centplugins OK
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change macros for CentPlugins OK
Installing the plugins OK
Change right on centreon.conf OK
CentPlugins is installed
Create /usr/local/etc/centreon/instCentPlugins.conf OK

End

###############################################################################
# #
# Go to the URL : http://localhost.localdomain/centreon/ #
# to finish the setup #
# #
# Report bugs at https://github.com/centreon/centreon/issues #
# Read documentation at https://documentation.centreon.com #
# #
# Thanks for using Centreon. #
# ----------------------- #
# Contact : infos@centreon.com #
# http://www.centreon.com #
# #
###############################################################################
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PHP dependencies installation

First, you need to install PHP dependency installer composer. Composer can be downloaded here
<https://getcomposer.org/download/> (it is also available in EPEL repository).

Once composer is installed, go to the centreon directory (usually /usr/share/centreon/) and run the following command
:

composer install --no-dev --optimize-autoloader

Javascript dependencies installation

First, you need to install javascript runtime nodejs. Installation instructions are available here
<https://nodejs.org/en/download/package-manager/>.

Once nodejs is installed, go to the centreon directory (usually /usr/share/centreon/) and run the following commands :

npm install
npm run build
npm prune --production

Any operating system

SELinux should be disabled; for this, you have to modify the file “/etc/sysconfig/selinux” and replace “enforcing” by
“disabled”:

SELINUX=disabled

After saving the file, please reboot your operating system to apply the changes.

PHP timezone should be set: go to /etc/php.d directory and create a file named php-timezone.ini which contains the
following line:

date.timezone = Europe/Paris

After saving the file, please don’t forget to restart apache server.

The Mysql database server should be available to complete installation (locally or not). MariaDB is recommended.

After this step you should connect to Centreon to finalize the installation process.

4.7.5 Configuration

Log in to Centreon web interface via the URL: http://[SERVER_IP]/centreon. The Centreon setup wizard is displayed.
Click on Next.
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The Centreon setup wizard checks the availability of the modules. Click on Next.

Click on Next.
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Click on Next.

Provide the information on the admin user, then click on Next.

By default, the ‘localhost’ server is defined and the root password is empty. If you use a remote database server,
change these entries. In this case, you only need to define a password for the user accessing the Centreon databases,
i.e., ‘Centreon’. Click on Next.
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Note: If the Add innodb_file_per_table=1 in my.cnf file under the [mysqld] section and restart MySQL Server.
error message appears, perform the following operations:

1. Log in to the ‘root’ user on your server.

2. Modify this file:

/etc/my.cnf

3. Add these lines to the file:

[mysqld]
innodb_file_per_table=1

4. Restart mysql service:

# systemctl restart mysql

5. Click on Refresh.

The Centreon setup wizard configures the databases. Click on Next.
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At this point, you will be able to install the Centreon server modules.

Click on Install.

Once installation is complete, click on Next.

At this point, an advertisement informs you of the latest Centreon news and products. If your platform is connected to
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the internet, you will receive the up-to-date information. If you are not online, only information on the current version
will be displayed.

The installation is complete. Click on Finish.

You can now log in.

You can change the default language of the web interface:

1. Click on your profile on the top right of the banner

2. Click on Edit profile

3. Select your language in the **Language* field
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4. Click on Save
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CHAPTER 5

Quick Start

This chapter describes you how to quickly start to configure your Centreon monitoring interface by using configuration
objects.

5.1 Login

To connect to your Centreon web interface access to URL: http://IP_ADDRESS/centreon

Note: Replace IP_ADDRESS by the IP address or FQDN of your Centreon web server.

Inform your user name and associated password and click on Connect button:

You are now connected to Centreon web interface.
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5.2 Basic Plugins

For the initial use of our monitoring environment with Centreon, we need some basic plugins available for free in our
plugin package, for this, with the plugins pack installed. access the menu Configuration -> Plugin Packs

Select the plugin base-generic as shown below

Now you have the basic templates and plugins to initial monitoring!

Install other plugins you probably need for your environment, for Linux and Windows available for free:

5.3 Add a host

Your platform is now ready to monitor your first servers or network equipment but you don’t know how to. Don’t
worry! It is simple to start monitoring.

First connect to your Centreon web interface with an administrator account or an account which allow to manage
monitored object.

Go to the Configuration > Hosts > Hosts menu and click on Add button:
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You access to a form to define your equipment to monitor but don’t worry all fields are not necessary!

To start to monitor your equipment set:

• The name of object in Host Name entry field

• Describe your object in Alias entry field

• Set the IP address of DNS in IP Address / DNS entry field

• Click on + Add a new entry button and select generic-active-host

• Click on Yes button for Create Services linked to the Template too field

Save the modification by clicking on Save button.
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The host is now defined in Centreon web interface but the monitoring engine doesn’t monitor it!

You have now to generate the configuration, export it and send it to the monitoring engine.

You can see result in Monitoring > Status Details > Hosts menu:

5.4 Add a service

You already added a host and you want to monitor some indicators.

Note: An indicator is named service in Centreon.

Go to the Configuration > Services > Services by host menu and click on Add button:

120
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapter 5. Quick Start



To add a service to a host you have to define only three fields:

• Select the host in Linked with Hosts field

• Define the name of the service in Description entry field

• Select a predefined template of service, for example Base-Ping-LAN, in Service Template field

Note: After selecting a template of service new field appear. This values describe arguments use to monitor your
service. Most often it is the alert thresholds. You can use the default values or overwrite those.

Save the modification by clicking on Save button.
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The service is now defined in Centreon web interface but the monitoring engine doesn’t monitor it!

You have now to generate the configuration, export it and send it to the monitoring engine.

You can see result in Monitoring > Status Details > Services menu:

5.5 Deploy a host from a template

In a previous quick start you added a new host using the generic-host template. This template provides a predefined
minimum configuration to define a host.

But the templates of host in Centreon web offer more than just a pre definition of values. In Centreon web you can
link templates of service to template of host. With this process you can deploy easily a new host and their service in
one time.

In this example we will use a template of host provided by Centreon plugin packs to monitor a Linux server. This
template of host allows to deploy the following services:

• CPU

• Load

• Memory

• Swap

You need to install these plugins, using the **Centreon plugin packs**.

First connect to your Centreon web interface with an administrator account or an account which allow to manage
monitored object.

Go to the Configuration > Hosts > Hosts menu and click on Add button:
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You access to a form to define your equipment to monitor. To start to monitor your equipment set:

• The name of object in Host Name entry field

• Describe your object in Alias entry field

• Set the IP address of DNS in IP Address / DNS entry field

• Click on + Add a new entry button and select OS-Linux-SNMP

• Click on Yes button for Create Services linked to the Template too field

5.5. Deploy a host from a template
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Save the modification by clicking on Save button.

The host is now defined in Centreon web interface but the monitoring engine doesn’t monitor it!

You have now to generate the configuration, export it and send it to the monitoring engine.

You can see result in Monitoring > Status Details > Services menu:
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5.6 Deploy services from a template

In a previous quick start you added a new host from template using the OS-Linux-SNMP template. This template of
host deployed the following services:

• CPU

• Load

• Memory

• Swap

But some indicators aren’t yet monitored because they depend of the server itself, for example name of files system,
name of network interfaces, etc.

First connect to your Centreon web interface with an administrator account or an account which allow to manage
monitored object.

Go to the Configuration > Services > Services by host menu and click on Add button:

5.6. Deploy services from a template
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To add a service to a host you have to define only three fields:

• Select the host in Linked with Hosts field

• Define the name of the service in Description entry field, for example Traffic-eth0 to monitor the traffic band-
width usage of interface eth0

• Select a predefined template of service, for example OS-Linux-Traffic-Generic-Name-SNMP, in Service
Template field

Note: After selecting a template of service new field appear. This values describe arguments use to monitor your
service. Most often it is the alert thresholds. You can use the default values or overwrite those.

Modify the value of macro INTERFACENAME to enter the name of network interface to monitor, for example eth0
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Save the modification by clicking on Save button.

The service is now defined in Centreon web interface but the monitoring engine doesn’t monitor it!

You have now to generate the configuration, export it and send it to the monitoring engine.

You can see result in Monitoring > Status Details > Services menu:

5.6. Deploy services from a template
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5.7 Add a user

A Centreon user is both a contact who can be notified of an alert of a host or service and someone who can connect to
the Centreon web interface.

First connect to your Centreon web interface with an administrator account or an account which allow to manage
monitored object.

Go to the Configuration > Users > Contacts / Users menu and click on Add button:

You access to a form to define your information but don’t worry all fields are not necessary!

The form is divided into several sections:

• The first part to set notifications options for events of hosts and services

• A second part to define the credentials to access to the Centreon web interface

• A final section to set additional options

5.7.1 Mandatory options

On the first tab General Information define:

• your Alias, use as a login to connect to Centreon web interface
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• your Full Name

• your Email address

5.7.2 Notifications options

To receive notifications you have to fill some parameters:

• Enable Notifications allows to receive notification

• for Host Notification Options field select the status that you want to receive, for example: Down, Recovery,
Flapping, Downtime Scheduled

• for Host Notification Period select the time slot during which you’ll receive notifications, for example: 24x7

• for Host Notification Commands select how you will be notified, for example: host-notify-by-email

• for Service Notification Options field select the status that you want to receive, for example: Warning, Un-
known, Critical, Recovery, Flapping, Downtime Scheduled

• for Service Notification Period select the time slot during which you’ll receive notifications, for example: 24x7

• for Service Notification Commands select how you will be notified, for example: service-notify-by-email

5.7. Add a user
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5.7.3 Access to Centreon web interface

To connect to Centreon web interface you have to fill information:

• Reach Centreon Front-end allows to connect to web interface

• define your Password and Confirm Password

• define your Timezone / Location

• define if you are Admin (full access to all menus and options in Centreon web interface) or not
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Save the modification by clicking on Save button.

Depending on the configuration you made your account is ready to receive notification and/or connect to the Centreon
web interface.

If you have ideas of “quick start” and want to participate in creating some of tutorials to help users of the community,
please make your “pull-requests” for us to easily integrate them from GitHub.

5.7. Add a user
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CHAPTER 6

Configuration

This chapter will allow you to know all the configuration mechanisms of your supervision system. This stage of
implementation of the supervision must be reflected to set up a supervision deployment strategy. Remember, the goal
is to have a scalable and maintainable system.

Do forget to think about setting up a global strategy of the configuration in order to make able to have global actions
configurations. For that, mechanisms are in place in Centreon to simplify your life such as guest models and services.

6.1 Generic actions

In the Configuration menu it is possible to perform certain “generic” actions on the various objects.

6.1.1 Add / Delete

The addition of a new object is done via the Add instruction next to the More actions menu....

To delete an object :

1. Select the object(s) that you want to delete by checking the box(s) next to its name.

2. In the More actions... menu click on Delete.

Warning: Deletion of an object is final. If you delete an object by accident, you will need to re-create it. In the
same way, deletion of an object automatically deletes all the objects linked to it and which cannot live without it.
E.g.: Deletion of a host results in the deletion of all the services associated with this host.

To modify an object, click on its name.

6.1.2 Duplication

Principle

Duplication of an object enables it to be copied / cloned to be able to re-use its Attributes for the creation of a new
object. E.g.: I have 10 identical web servers to supervise:

• I add the first web server with all the necessary Attributes

• I duplicate this host 9 times
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• It only remains for me to change the host names and the IP addresses of each duplication to adapt it to the 9
other web servers to be monitored

Thanks to this method, it is no longer necessary to create each host individually.

Practice

To duplicate a host:

1. Select the host that you want to duplicate

2. In the Options column, enter the number of duplications that you want to obtain

3. In the More actions... menu click on Duplicate

6.1.3 Massive Change

Principle

Massive change enable us to apply a change to multiple objects.

E.g.: All the web servers previously created change SNMP communities. A massive change enables us to change this
community without it being necessary to change each sheet of each host individually.

Practice

To perform a massive change:

1. Select the objects you want change

2. In the More Actions... menu click on Massive Change

The change menu opens, there are 2 types to change :

• Incremental: signifies that the change will be added to the existing options

• Replacement: signifies that the change will overwrite the existing options

6.1.4 Enable / disable

Principle

The enabling and disenabling of objects enables us to take the object into account or not during configuration genera-
tion. The main advantage is to be able to keep the configuration of an object without applying it.
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Practice

To enable / disable an object:

1. Select the objects you want change

2. In the more actions... menu click on Enable / disable

It is also possible to enable or disable an object via the “Status” field of the object detail sheet or by using the following
icons:

• to enable

• to disable

6.2 Hosts

A host is any entity having an IP address corresponding to a resource of the information system. E.g.: A server,
network printer, a NAS server, a temperature sensor, an IP camera, etc.

All these host additions take place in the menu: Configuration ==> Hosts ==> Add.

6.2. Hosts
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6.2.1 Configuration of the host

General information

• The Host Name field defines the host name that will be used by the Monitoring Engine.

• The Alias field shows the alias of the host.

• The IP address / DNS field defines IP address or DNS name of the host. The Resolve button enables us to
resolve the domain name by questioning the DNS server configured on the central server.

• The SNMP Community & Version fields contain the name of the community and the SNMP version.

• The Monitored from field indicates which poller server is charged with monitoring this host.

• The Timezone / Location field indicates the timezone location of the monitored hosts.

• The Host Templates field enables us to associated one or more models of hosts with this object.

In case of conflicts of settings present on multiple models, the host model above overwrites the identical properties

defined in host models below. The button enables us to change the order of host models. The button
serves to delete the host model.

• If the Create Services linked to the Template too field is defined as Yes, Centreon automatically generates
the services based their self on the service templates linked to the host templates defined above (see the chapter
Templates).

Monitoring properties of the host

• The Check Command field indicates the command use to check the availability of the host.

• The Args field defines the arguments given to the check command (each argument starts with a ”!”).

The Macros part serves to add custom macros.

• The Macro name and Macro value field enable us to define the name and value of the macro.

• The Password box enables the value of the macro to be hidden.

To reinitialize to the default value (defined in template) click on .

To view the description of the macro, click on .

To delete the macro, click on .

To change the order of the macros, click on .

Scheduling options of the host

• The Check Period field defines the time period during which the scheduler checks the status of the object.

• The Max Check Attempts field defines the number of checks to be performed before confirming the status of
the host: when the status is confirmed the notification process is triggered.
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• The Normal Check Interval is expressed in minutes. It defined the interval between checks when the host
status is OK.

• The Retry Check Interval is expressed in minutes. It defined the check interval of the Not-OK status of the
host.

• The Active Checks Enabled and Passive Checks Enabled fields enable / disable the active and passive checks.

6.2.2 Notification tab

• The Notification Enabled field enables us to enable or disable the notifications concerning the object.

• The Notification Options define the statuses for which a notification will be sent.

• The Notification Interval is expressed in minutes. It indicates the time between sending each notifications when
the status is Not-OK. If the value is defined as 0 the scheduler sends a single notification per status change.

• The Notification Period field indicates the time period during which the notifications will be enabled.

• The First notification delay is expressed in minutes. It refers to the time delay to be respected before sending
the first notification when a Not-OK status is validated.

• If the Contact additive inheritance box is checked, Centreon does not overwrite the configuration of the parent
host model but adds the contacts in addition to the contacts defined in the parent model.

• The list of Linked contacts indicates the contacts which will receive the notifications.

• If the Contact group additive inheritance box is checked, Centreon does not overwrite the configuration of the
parent host template but adds the contact groups in addition to the contact groups defined in the parent template.

• The list of Linked contacts Groups indicates the groups of contacts which will receive the notifications.

6.2.3 Relations tab

• The Parent Host Groups list defined the host groups to which the host belongs.

• The Parent Host Categories list defined the categories to which the host belongs.

• The Parent Hosts list enables us to define the physical family relationships between objects.

• The Child Hosts list enables us to define the physical family relationships between objects.

6.2.4 Data processing tab

• If Obsess Over Host is enabled, the host check feedback command will be enabled.

• The Check Freshness field allows us to enable or disable the result freshness check.

• The Freshness Threshold is expressed in seconds. if during this period no host status change request (passive
command) is received the active check command is executed.

• The Flap Detection Enabled field allows us to enable or disable the detection flapping in the statuses (status
value changing too often on a given period).

• The Low Flap Threshold and High Flap Threshold fields define the high and low thresholds for the detection
of flapping in percentage of status change.

• The Process Perf Data field allows us to enable or disable performance data processing (and so the generation
of performance graphics). This option is not necessary when Centreon Broker is use.

6.2. Hosts
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• The Retain Status Information and Retain Non Status Information fields indicate if the information con-
cerning the status is saved after every time the check command is repeated.

• The Stalking Options field defined the options to be recorded if retention is enabled.

• The Event Handler Enabled field allows us to enable or disable the events handler.

• The Event Handler field defined the command to be executed if the event handler is enabled.

• The Args field defined the arguments of the events handler command.

6.2.5 Host Extended Infos tab

Monitoring engine

• The URL field defined a URL that can be used to give more information on the host.

• The Notes field permits us to add optional notes concerning the host.

• The Action URL field defined a URL normally use for giving information on actions on the host (maintenance,
etc.).

• The Icon field indicates the icon use for the host.

• The Alt Icon field is the text use if the icon cannot be Display.

• The Severity level field indicates the severity level of the host.

The fields presented below are fields that are only use by the CGI of the scheduler (usually Nagios). Consequently,
they do not present much interest if Centreon Engine and Centreon Broker are in use.

• The Status Map Image field defined the logo for the scheduler CGI.

• The Geo coordinates field defined geographic coordinate (Latitude,Longitude) of the element. This is useful
for Centreon Map module.

• The 2d Coords and 3d Coords fields indicates the 2D and 3D coordinates use by the CGI.

Access groups

• The ACL Resource Groups (only displayed for non administrator) allows to link this host to an hostgroup in
order to visualize it (See Access control list chapter).

Additional Information

• The Status field allows us to enable or disable the host.

• The Comments field can be used to add a comment concerning the host.

6.3 Services

A service is a check point linked / attached to a host. E.g.: Percentage of partition use on a server, ink level in a printer.

All additions of services are done in the menu: Configuration ==> Services ==> Add.
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6.3.1 Configuration of the service

General information

• The Description field defined the name of the service.

• The Service template field indicates the model of service to which the service is linked.

Service State

• The field Is Volatile indicates if the service is volatile or not (normally only passive services are volatile).

• The Check Period field defined the time period during which the scheduler checks the status of the service.

• The Check Command field indicates the command use to check the availability of the service.

• The Args table defined the arguments given for the check command (the number of arguments varies according
to the check command chosen).

• The Max Check Attempts of the status field defined the number of checks to be carried out to confirm the status
of the service. When the status is validated, the notification process is engaged

• The Normal Check Interval field is expressed in minutes. It defined the interval between checks when the
service status is OK.

• The Retry Check Interval field is expressed in minutes. It defined the confirmation interval for the Not-OK
service status

6.3. Services
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• The Active Checks Enabled and Passive Checks Enabled fields enable / disable the type of check on the
service.

Macros

The Macros part serves to add customized macros. The macro name and macro value fields allow us to define the
name and value of the macro. The Password box can be used to hide the value of the macro.

To reinitialize to the default value (defined in template) click on .

To view the description of the macro, click on .

To delete the macro, click on .

To change the order of the macros, click on .

Notification

• The Notification Enabled field allows us to enable or disable the notifications for the object.

• The Inherit contacts from host field allows us to cause the contacts to be inherited from the configuration of
the host.

• If the Contact additive inheritance box is checked, Centreon does not overwrite the configuration of the parent
service model but adds the contacts in addition to the contacts defined at the parent model level.

• The Implied Contacts indicates the contacts that will receive the notifications.

• If Contact group additive inheritance box is checked, Centreon does not overwrite the configuration of the
parent service model but adds the contact groups in addition to the contact groups defined at the parent model
level.

• If Inherit only contacts/contact group from host box is checked, then when generating the configuration,
contact and/or host groups of contacts (or the following templates inheritance) will overwrite of the service or
its service models. This function disables entering contacts and contact groups for this service.

• In the Implied Contact Groups list all the contacts belonging to the contact groups defined will receive the
notifications.

• The Notification Interval field is expressed in minutes. It indicates the time between sending of notifications
when the status is Not-OK. If the value is defined as 0 the scheduler sends a single notification per status change.

• The Notification Type define the statuses for which a notification will be sent.

• The First notification delay time is expressed in minutes. It refers to the time delay to be respected before
sending the first notification when a Not-OK status is validated.

6.3.2 Relations tab

Relations

• The Linked with Hosts list allows us to define the host(s) to which to link this service.
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• The Linked with Servicegroups list allows us to link the service to one or more service groups.

SNMP traps

The Service Trap Relation field allows us to define the SNMP traps that will be able to change the behavior of the
service.

6.3.3 Data processing

• If the Obsess over service field is enabled, the monitoring feedback command of the host will be enabled.

• The Check freshness field allows us to enable or disable the check on the freshness of the result.

• The Freshness threshold field is expressed in seconds. If during this period no request for a change in the status
of the service (passive command) is received the check command is executed.

• The Flap Detection Enabled field allows us to enable or disable the detection of disruption in the statuses
(status value changing too often on a given period).

• The Low flap threshold and High flap threshold fields define the high and low thresholds for the detection of
disruption in percentage of status change.

• The Performance data processing field allows us to enable or disable performance data processing (and hence
the generation of performance graphics). This option is not necessary when Centreon Broker is use.

• The Retain status information and Retention non status information fields indicate if the information con-
cerning or not concerning the status is saved after every time the check command is repeated.

• The Stalking Options field defined the options to be recorded if retention is enabled.

• The Event handler enabled field allows us to enable or disable the events manager.

• The Event handler field defined the command to be executed if the event manager is enabled.

• The Args field defined the arguments of the events handler command.

6.3.4 Additional information on the service

Centreon

• Graph template: Defines the graphics model to be use to present the performance data linked to the service.

• Categories: Defines the category(s) to which the service belongs.

Monitoring engine

• The URL field defined a URL that can be used to give more information on the service.

• The Notes field permits us to add optional notes concerning the service.

• The Action URL field defined a URL normally use for giving information on actions on the service (mainte-
nance, etc.).

• The Icon field indicates the icon use for the service.

• The Alt icon field is the text use if the icon cannot be Displays.

• The Severity level field indicates the criticality level of the service.

6.3. Services
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Additional information

• The Status field allows us to enable or disable the service.

• The Comment field can be used to add a comment concerning the service.

6.3.5 Detachment of a service

If a service is linked to several hosts, it will be identical for each one of them. Hence it will not be possible to modify
the service of one host individually to change a property. This why it is possible to convert this service linked to
multiple hosts into a single service for each host:

1. In the list of services, select the service linked to multiple hosts (this service is usually highlighted in orange)

2. In the more actions.... menu click on Detach and confirm

There is now a single service per host.

6.4 Commands

6.4.1 Definition

A command is the definition of a line of command which uses a script or an application to perform an action. It is
possible execute this command by specifying arguments.

There are three types of command:

• Verification commands are used by the schedulers to verify the status of a host or of a service.

• Notification commands are used by the schedulers to alert the contacts (via mail, SMS, etc.).

• Discovery commands are used by the schedulers to discover some elements on monitored node.

• Miscellaneous commands are used by the additional modules (to perform certain actions), by the scheduler for
data processing, etc.

All the commands can be configured in the menu: Configuration ==> Commands.
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6.4.2 Adding a command

Before adding a command:

1. In the left menu select the type of command that you want to add (Checks, Notifications or Miscellaneous).

2. Click on Add

Note: The configuration fields of a command are the same regardless of the type of command chosen.

6.4.3 Configuration fields

• The command Name field defined the name of the command.

• The Command Type field allows us to choose the type of command.

• The Command Line field indicates the application or the script use with the command.

• The Enable shell box allows us to enable functions that are specific to a shell such as the pipe, etc.

6.4. Commands
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• The Argument Example and $HOSTADDRESS$ fields define examples of arguments (each argument starts
with a ”!”) and a test IP address respectively. These fields serve to execute the command line defined above via

the web interface by clicking on the blue arrow : .

• The Describe arguments button serves to add a description to arguments of the “$ARGn$” type. This descrip-
tion will be visible when using the command in a host or service form.

• The Clear arguments button deletes the description of arguments defined

• The Describe macros button serves to add a description to all macros. This description will be visible when
using the command in a host or service form.

• The Connectors field serves to link a Connector to the command. For more information on Connectors refer to
the chapter entitled: Perl Connector’s documentation and SSH Connector’s documentation.

• The Graph template field serves to link the command to a graphic model.

• The Comment field can be used to make a comment on the command.

6.4.4 Arguments and macros

In the Command Line field it is possible to import macros and arguments.

The arguments are used to be able to pass various settings to the scripts called up by the commands. During execution
of the command by the scheduler, each of the arguments and macros are replaced by their respective values. Each
argument appears in the form $ARGn$ where n is naturel whole number greater than 0.

E.g.: order line using the arguments : $USER1$/check-bench-process-DB -w $ARG1$ -c $ARG2$ -n $ARG3$

Note: Good practice requires replacing the arguments by custom macros.

6.5 Time periods

6.5.1 Definition

A time period is the definition of a time interval for each day of the week. These time periods enable the functionalities
of the scheduler over a given period of time.

Time periods apply to two types of actions:

• Execution of check commands

• Sending of notifications

6.5.2 Configuration

The configuration of time periods is done in the menu: Configuration ==> Users ==> Time periods.

Basic options

• The Time period name and Alias fields define the name and description of the time period respectively.

• The fields belonging to the Time range sub-category define the days of the week for which it is necessary to
define time periods.
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• The Exceptions table enables us to include days excluded from the time period.

Syntax of a time period

When creating a time period, the following characters serve to define the time periods :

• The character “:” separates the hours from the minutes. E.g.: HH:MM

• The character “-” indicates continuity between two time periods

• The character ”,” serves to separate two time periods

Here are a few examples:

• 24 hours a day and 7 days a week: 00:00-24:00 (to be applied on every day of the week).

• From 08h00 to 12h00 and from 14h00 to 18h45 on weekdays: 08:00-12:00,14:00-18:45 (to be applied on
weekdays only).

Time Range exceptions

The exceptions allow us to include exceptional days in the time period (overload of the definition of regular functioning
of the day).

E.g.: An administrator wants to define a time period which covers the times when the offices are closed i.e.:

• From 18h00 to 07h59 on weekdays

• Round the clock at weekends

• National holidays and exceptional closure days

6.5. Time periods
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To be able to define the national holidays days and the exceptional closure days, it is necessary to use the exceptions.

To add an exception, click on the button . For each exceptional day, you will need to define a time period. The table
below shows some possible examples :

Day(s) Time period Meaning
january 1 00:00-24:00 All day on the 1st of January, every year.
2014-02-10 00:00-24:00 All day on 10 February 2014
july 1 - august 1 00:00-24:00 All day, every day from July 1 to August 1, every year
november 30 08:00-19:00 From 08h00 to 19h00 every November 30, every year
day 1 - 20 00:00-24:00 All day from the 1st to 20th of every month
saturday -1 08:00-12:00,14:00-18:45 Every last Saturday of the month during opening hours
monday -2 00:00-24:00 All day every second to the last Monday of the month

Extended Settings

In the extended settings, it is possible to include or to exclude periods in the definition of the object.

Example of application: Let us take two time periods:

• One period is defined as 24 hours a day / 7 days a week, called 24x7

• Another which covers the office opening hours, called working_hours

To obtain the office closing hours, we simply have to create a time period in which we include the period 24x7 and
from which we exclude the working_hours period.

6.6 Contacts

6.6.1 Definition

The contacts in Centreon are used to:

• Log in to the Centreon web interface: each contact has its own rights of connection to the web interface.

• Be warned in case of necessity (notification).

To add a contact, simply go to the menu: Configuration ==> Users ==> Add.
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To display the matrix of notification of a contact, click on View contact notifications next to the Add menu).

6.6.2 General information

• The Alias/Login field defined the login to access the web interface.

• The Full Name field contains the name and first name of the user.

• The Email and Pager fields contain respectively the e-mail address and the telephone number of the user (in the
case of a notification by SMS or call for instance).

• The field Contact template used allows us to link the contact to a Model of contact.

• The Linked to Contact Groups list associated the contact to one or more groups of contacts.

• The Enable Notifications field allows us to enable the sending of notifications to the user.

• The Host / Service Notification Options field serves to define the statuses to which notifications are sent.

• The Host / Service Notification Period field serves to choose the time period in which notifications are sent.

• The Host / Service Notification Command field serves to choose the notification command to a host or a
service.

6.6.3 Centreon authentication

• The Reach Centreon Front-end field serves to authorize the user to access the Centreon web interface.

• The Password and Confirm Password fields contain the user password.

• The Default Language field serves to define the language of the Centreon interface for this user.

6.6. Contacts
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• The Admin field defined if this user is the administrator of the supervision platform or not.

• The Autologin key serves to define a connection key for the user. The user will no longer need to enter his / her
login and password but will use this key to log in directly. Connection syntax:

http://[IP_DU_SERVER_CENTRAL]/index.php?autologin=1&useralias=[login_user]&token=[value_autologin]

Note: The Possibility of automatic connection (auto login) should be enabled in the menu: Administration ==>
Options.

• The Authentication Source field specifies if the connection information comes from an LDAP directory or
information stored locally on the server.

• The Access list groups field serves to define an access group to a user (group use for access control (ACL)).

Note: A Administrative user is never concerned by access control even linked to an access group.

6.6.4 Additional information

• The Address fields allow us to specify the data of additional contacts (other e-mails, other telephone numbers,
etc.).

• The Status and Comment fields serve to enable or disable the contact and to make comments on it.

6.7 Groups

A group allows us to group together one or more objects. There are three kinds of groups: hosts, services and contacts.

The hosts groups and services groups serve mainly for viewing graphics or to group the objects. Contact groups are
used mainly for the configuration of ACLs.

6.7.1 Host Groups

To add a host group:

1. Go to the menu: Configuration ==> Hosts

2. In the left menu, click on Host Groups

3. Click on Add
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• The Host Group Name and Alias defines the name and the alias of the host group.

• The Linked Hosts list allows us to add hosts in the hostgroup.

• The Notes field allows us to add optional notes concerning the host group.

• The Notes URL field defined a URL which can be used to give more information on the hostgroup.

• The Action URL field defined a URL normally use to give information on actions on the hostgroup (mainte-
nance, etc.).

• The Icon field indicates the icon to be use for the host group.

• The Map Icon is the icon use for mapping.

• The RRD retention field is expressed in days, it serves to define the duration of retention of the services belong-
ing to this hostgroup in the RRD database. It will be the default duration defined in the menu: “ Administration
==> Options ==> CentStorage ” if this value is not defined.

• The Status and Comments fields allow to enable or disable the host group and to make comments on it.

6.7.2 Service Groups

To add a service group:

1. Go into the menu: Configuration ==> Services

2. In the left menu, click on Service Groups

3. Click on Add
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CENTREON 46-52 RUE ALBERT FR75014 PARIS

149



• The Service Group Name and Description fields describes the name and the description of the service group.

• The Linked Host Services list allows us to choose the various services that will be included in this group.

• The Linked Host Group Services list allows us to choose the services linked to a host group that will be part
of this group.

• The Linked Service Templates list allows to deploy a service based on this template on all hosts linked to this
group.

• The Status and Comments fields allow to enable or disable the service group and to make comment on it.

6.7.3 Contact Groups

To add a group of contacts:

1. Go into the menu: Configuration ==> Users

2. In the left menu, click on Contact Groups

3. Click on Add

• The Contact Group Name and Alias fields define the name and the description of the contact group.

• The Linked Contacts list allows us to add contacts to the contact group.
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• The Status and Comment fields allow to enable or disable the group of contacts and to make comment on it.

Note: For more information refer to the associated chapter covering groups.

6.8 Categories

Categories are used to define ACLs on the hosts and the services. The aim is to be able to classify the hosts or the
services within a category.

Centreon 2.4 includes a new functionality called “Severity”. As from version 2.5, the levels of criticality are linked to
a category, they have become a type of category. A criticality level is an indicator for defining the criticality of a host
or a service. The aim is to be able to handle the problems of hosts or services by order of priority. By this system, it is
thus possible to filter the objects in the “Supervision” views by critically.

6.8.1 Host categories

To add a category of hosts:

1. Go into the menu: Configuration ==> Hosts

2. In the left menu, click on Categories

3. Click on Add

• The Host Category Name and Alias fields contain respectively the name and the alias of the category of host.

• The Linked hosts list allows us to add hosts to the category.

• If a host template is added to Linked host template list all the hosts which inherit from this Model belong to
this category.

• The Severity type box signifies that the category of hosts has a criticality level.

• The Level and Icon fields define a criticality level and an associated icon respectively.

• The Status and Comment fields allow us to enable or disable the category of host and to comment on it.
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6.8.2 Categories of services

To add a category of services:

1. Go into the menu: Configuration ==> Services

2. In the left menu, click on Categories

3. Click on Add

• The Name and Description fields define the name and the description of the category of service.

• if a service template is added to Service Template Descriptions list all the services which inherit from this
Model belong to this category.

• The Severity type box signifies that the category of service has a criticality level.

• The Level and Icon fields define a criticality level and an associated icon respectively.

• The Status field allows us to enable or disable the category of services.

Note: For more information refer to the associated chapter covering categories.

6.9 Templates

6.9.1 Definition

A Template is a pre-configuration of settings of an object that could be used to configure it. The main advantage is to
be able to define default values for certain objects to speed up the creation of similar objects.

On creation of a Template, only the template name is mandatory. The other attributes are optional.

There are 3 types of templates:

• Hosts Templates

• Services Templates

• Contacts Templates

The advantages are:

• Simplified element definition

• No duplication of data
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• Facility of addition of new resources

• Predefined configurations assimilated to a “catalog of indicators”

• Templates can inherit from other templates.

6.9.2 Host Templates

Inheritance

A host or a host template can inherit from one or more host templates. This heritage may be:

• associative (addition of multiple host templates)

• parent-child type

Parent-child type inheritance

This is a predefinition of settings at “n” levels. The object inherits from its Template which can itself inherit from its
Template. If the child redefines a setting, this setting overwrites that defined in the higher level templates. Otherwise
it is added to the settings.

Associative type inheritance

This consists of adding together several templates within the same object in order to add together all the settings
available. If a host inherits from several host templates and if the same setting is defined on several templates, the host
templates situated above the other templates has priority in relation to its ancestors.

The diagram below shows a host inheriting from multiple host templates.
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Configuration

To add a host template:

1. Go into the menu: Configuration ==> Hosts

2. In the left menu, click on Templates

3. Click on Add

Note: Refer to the chapter covering configuration of hosts to configure a template because the form is identical.
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6.9.3 Services Templates

Inheritance

A service or a service template can only inherit from a single service template (parent-child type inheritance).

Configuration

To add a Service Template:

1. Go into the menu: Configuration ==> Services

2. In the left menu, click on Templates

3. Click on Add

Note: Refer to the chapter covering configuration of services to configure a template because the form is identical.

6.9.4 Best practice

Explanations

Good practice requires that services templates be associated with host’s templates: on creation of a host, the services
are generated automatically from host’s templates. There are two advantages in linking services templates to hosts
templates:

• The services generated automatically retain their granularity: it is possible to change the Attributes of a service
without affecting the other services obtained from this template

• The creation of new hosts is speeded up greatly: you simply have to define the host and the host’s templates
associated with it

E.g.: We create the srvi-web-01 host according to the template below:
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The host srvi-web-01 will automatically possess the following services:

• Load, CPU, Memory, disk-/ from services templates linked to the host template “Linux-Server-RedHat-5”

• Broken-jobs, hit-ratio, tablespaces, listener from services templates linked to the host template “DB-MySQL”

• Process and connection from services templates linked to the host template “Web-Server-Apache”

When the services of a host are generated from host’s templates, it is possible that certain services generated are not
checked by the supervision tool. In this case, it is necessary to disable the services that are not used (but not to delete
them). In case of deletion of services, regeneration of services of the host from host’s templates will re-create the
services deleted.
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Configuration

The linking of services templates with host’s templates takes place in the Relations tab of the services templates or
hosts templates.

6.9.5 Contact Templates

A contact or a contact template can only inherit one contact template.
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Configuration

To add a contact template:

1. Go into the menu: Configuration ==> Users

2. In the left menu, click on Contact Templates
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3. Click on Add

Note: Refer to the chapter covering configuration of contacts. In addition, the contacts templates are used for
automatic import of profiles via LDAP.

6.10 Simplified configuration of Centreon with IMP

6.10.1 What is IMP?

IMP (Instant Monitoring Platform) is a solution to allow to reduce the TTM (Time To Monitoring). Indeed, IMP
allows to reduce time to deploy your monitoring and reduce time to maintain in working condition your Centreon
platform. Templates of monitoring ready to use including monitoring procedure that allow to start your monitoring
less than 30 minutes after the installation of your Centreon platform.

The Plugin Packs (configuration pack), developed by Centreon, are based on the Centreon Plugins (monitoring probes),
offer a large range of functionality and is one of the richest in the market: +170 environments for almost 2000 moni-
toring indicators which allow to deploy your monitoring easily and quickly.

Want to use IMP? Please follow the instructions below.

6.10.2 Prerequisites

1. Centreon 3.4

To use Centreon IMP you need the latest version of Centreon 3.4. This version includes Centreon Web 2.8.

You can install Centreon 3.4 using the ISO of Centreon or by upgrading your Centreon platform. Please read docu-
mentation to install or upgrade your platform.

2. An Internet access

Your Centreon central monitoring server must have an access to Internet. This access allows to get the list of available
Plugin Packs and to install those on your platform.

Note: If your server doesn’t have a direct access to Internet, you can configure a proxy to access to Internet.

6.10.3 Link your Centreon platform to Centreon IMP

To get the Plugin Packs, your Centreon platform must have an access to Centreon user portal.

Without Centreon user portal, your Centreon server will have access to 6 Plugin Packs. If you create a Centreon user
portal account and you use it to connect your Centreon platform, you will have access to 5 more Plugin Packs. By
subscribing to Centreon IMP offer, you will have access to +170 Plugin Packs is around 2000 monitoring indicators
which allow to deploy your monitoring easily and quickly.

Without Account Simple Account With subscription
6 base Packs x x x
5 added Packs x x
+150 Packs x
total 6 Plugin Packs 11 Plugin Packs +170 Plugin Packs

What are Plugin Packs available for each level?

• Standard Plugin Packs:
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– Cisco standard (SNMP)

– Linux (SNMP)

– MySQL

– Printer standard (SNMP)

– UPS Standard (SNMP)

– Windows (SNMP)

– Centreon (central)

– Centreon DB

– Centreon Poller

– Centreon Map

– Centreon MBI

• With Centreon user portal account:

– DHCP

– DNS

– FTP

– HTTP

– LDAP

• With IMP subscription: All the packs in the catalog.

Note: Yes 11 is different from 6 but we prefer not to count the Centreon Plugin Packs that are only useful to monitor
your Centreon platform.

To connect your Centreon platform to Centreon user portal, please follow instructions below:

6.10.4 1. Go to Centreon user portal and create your account

Go on Centreon web site on subscription IMP page. Click on “Try it” on the first column of the comparative table of
offers.
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Create your user account. This account will be used to link your Centreon platform to the Centreon IMP to get Plugin
Packs.

Your account is now available. You can link your Centreon platform.
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6.10.5 2. Link your Centreon platform

Note: If the Administration -> Extensions -> Subscription is not available on your Centreon, please go to the
Administration -> Extensions -> Modules menu and install the following modules by clicking on the “install” icon
on the right:

• centreon-pp-manager

• centreon-license-manager

Go to the Administration -> Extensions -> Subscription menu and connect your Centreon Platform using your
Centreon user portal credentials. The credentials are your account to access to Centreon user portal.

By clicking on the arrow icon next to “Password” field you will connect your Centreon platform to Centreon portal.
The creation of an account on the Centreon user portal is free and allow to access to 11 Plugin Packs.
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Your platform is now connected: you can access to 6 more Plugin Packs.

Note: With your account you can connect multiple platforms at a time to do your tests.

6.10.6 3. Discover the catalog and install your first Plugin Packs

To install Plugin Packs, click on the Setup button to access to the Plugin Packs catalog, or go to the Configuration >
Plugin pack menu.
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List of Plugin Packs appears. Only part of the catalog can be accessed according to your subscription. If your
subscription is no longer valid or if you use Centreon IMP trial offer, only the first 11 Plugin Packs are available. The
non-available Plugin Pack will be freeze.

You can search Plugin Packs using:

• Keyword

• Category

• Status

• Last update

Yo access to the description of a pack, click on its icon.
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To install a pack, click on installation icon.

before installation after installation

Don’t forget that each pack use a plugin to work. Each monitoring procedure will help you to install the plugin needed.

Note: Install plugins on each poller is required. Otherwise your supervision will not work. Indeed, only the Centreon
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Plugins of the first 11 Plugin Packs have been installed by default on your Centreon servers. It is essential to follow
the deployment procedure of each Plugin Pack by clicking on the ”?” Icon.

6.10.7 4. Get your subscription!

You can subscribe to IMP according different period of renewal: 1 month, 6 months or 12 months. The price decreases
according to the duration of commitment.

After subscribing, go to the Administration -> Extensions -> Subscription menu and connect your Centreon platform
using your Centreon user portal credentials.

IF you purchased a subscription you can link your Centreon platform to your subscription. To do this please click on
the “Link” button.

Select your subscription and click on “Link” button to valid this step.

Please confirm this action.
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Now you have access to all Plugin Packs available in the catalog. Click on the “install” button to start the installation
of needed Plugin Packs.

Your Centreon IMP subscription ensures that the Plugin Packs are updated as technology requirements and needs
evolve. This may include enhancements or new additions.

If you decide to stop your Centreon IMP subscription, you will not have access to these updates and additions. The
Plugin Packs you have been using will not be uninstalled.

Note: If you wish to move your IMP subscription to another Centreon server, you need to ask Centreon customer
support. We didn’t yet add this functionality to your Centreon web site. Please contact us: imp at centreon dot com.

Note: If you have some difficulties to use IMP you can contact your technical team using imp at centreon dot com
email.

If you have any question, please read the Centreon IMP FAQ
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6.11 Advanced configuration

This is the advanced configuration for Centreon.

6.11.1 Macros

A macro is a variable used to retrieve certain values. A macro always starts and finishes by the “$” sign.

Standard macros

Standard macros are macros predefined in the source code of the monitoring engines. These different macros allow us
to retrieve the value of various objects from commands.

E.g.:

• The macro called $HOSTADDRESS$ enables us to retrieve the IP address of a host

• The macro called $CONTACTEMAIL$ enables us to retrieve the e-mail address of the contact

Note: A complete list of macros is available at the following address: List of macros

Custom macros

Definition

Customized macros are macros defined by the user at the creation of a host or a service. They are used in check com-
mands. Customized macros start with $_HOST for customized macros of hosts and by $_SERVICE for customized
macros of services.

There are several advantages to using customized macros instead of arguments:

• The function of the macro is defined in its name. The macro $_HOSTMOTDEPASSEINTRANET$ is easier to
read than $ARG1$

• The macros inherit models of hosts and of services, the hence it is possible to modify a single macro for a host
or a service. On the other hand, the arguments all need to be redefined if a single argument is changed

• The number of arguments is limited to 32, unlike customized macros which are unlimited

A macro of a host is used to define a variable that is specific to the host and which will not change regardless of the
service questioned: host connection identifiers, a port of connection to a particular service, an SNMP community, etc.
A macro of a service is used more to define settings specific to a service: a WARNING / CRITICAL threshold, a
partition to be questioned, etc.

Example

During the definition of a host, the following macros are created:
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To retrieve these macros in a check command, you need to call it using the following variables: $_HOSTUSER-
LOGIN$, $_HOSTUSERPASSWORD$.

On definition of a service, the following macros are created:

To retrieve these macros in a check command, you need to invoke them using the following variables: $_SERVI-
CEPARTITION$, $_SERVICEWARNING$, $_SERVICECRITICAL$.

A special case

The Community SNMP & Version fields in a host form automatically generates the following customized macros:
$_HOSTSNMPCOMMUNITY$ and $_HOSTSNMPVERSION$.

Resource macros

Macros of resources are global macros that are used by the monitoring engine. These macros can be invoked by any
type of command. They come in the form: $USERn$ where ‘n’ lies between 1 and 256.

In general, these macros are used to make reference to paths containing supervision probes. By default the $USER1$
macro is created, and its value is the following: /usr/lib/nagios/plugins.

To add a resources macro:

• Go into the menu: Configuration ==> Pollers ==> Resources

• Click on Add

• The Resource Name field defines the name of the resource macro. E.g.: $USER3$

• The MACRO Expression field defines the value of the macro.

• The Linked Instances list allows us to define which monitoring poller will be able to access this macro.

• The Status and Comment fields serve to enable / disable the macro and to comment on it.
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Environment macros

Environment macros (also called “to the demand” or “on demand” in English) allow us to retrieve information from
all the objects obtained from the supervision. They are used to retrieve, at given moment, the value of an object.

They are complementary to standard macros. E.g.:

• The standard macro $CONTACTEMAIL$ makes reference to the e-mail address of the contact who uses the
command of notification

• The environment macro $CONTACTEMAIL:centreon$ returns the e-mail address of the user: “centreon”

The complete documentation on macros “on demand” is available at this address: macro list.

Note: The use of these macros is not recommended because the search for a value of a setting of an object from
another object is a consumer in terms of resources.

Warning: The enabling of the setting Use large installation tweaks makes it impossible to use environment
macros.

6.11.2 Meta-services

Definition

A meta-service is a virtual service providing the aggregation of metrics from different services via a mathematical
operation. Meta-services are managed in the same way as a service i.e. they have thresholds, a notification process,
generate a performance graph, etc.

E.g.: It is possible to determine the total consumption of WAN traffic by adding together, within a meta-service, all
the services supervising the WAN traffic individually.

Types of computing

Several types of calculation are possible on the metrics retrieved:

• Average: calculate the average of the performance data

• Sum: calculate the sum of the performance data

• Min: retrieve the minimum of all the performance data

• Max: retrieve the maximum of all the performance data

Types of data sources

The result of the calculation is an item of performance data (metric) which generates a performance graph. To trace
the result most effectively, it is necessary to select the type of data source (GAUGE by default). The types of data
sources available are:

• The GAUGE type records an instantaneous value (temperature, humidity, processor, etc.)

• The COUNTER type records an incremental value in relation to the previous result

• The DRIFT type stores the derivative of the line from the last to the current value of the data. This can be useful
for capacities, for example for measuring the rate of people entering or leaving a room.
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• The ABSOLUTE type is for counters which reset on reading. It is used for fast counters that have a tendency
to over-run.

Note: More information on the RRDTools <http://oss.oetiker.ch/rrdtool/doc/rrdcreate.en.html>‘_ website

Configuration

To add a meta-service:

1. Go into the menu: Configuration ==> Services

2. In the left menu, click on Meta Services

3. Click on Add

General information

• The Meta Service Name field corresponds to the name of the meta-service Displayed in the interface.

• The Output format string (printf-style) field corresponds to the output message (‘output’) visible in Centreon.
The “%d” value corresponds to the value calculated by the meta-service

• The Warning level and Critical level correspond to the “WARNING” and “CRITICAL” thresholds of the
meta-service respectively.
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• The Calculation Type and Data source Type fields correspond to the calculations and to the description of the
data source respectively

• The Selection Mode field serves to select the services containing the metrics that will be used in the meta-service
calculation.

If the Service list selection mode is selected the metrics chosen will be obtained from services selected manually.

If the SQL matching selection mode is selected the services used will be selected automatically by Centreon via a
search based on the LIKE type SQL expression to be searched field. The metric to be used in this case will be selected
from the Metric drop down list.

Note: More information on PRINTF formatting PRINTF

Meta Service status

• The Check Period field defines the time period during which the scheduler checks the status of the meta-service.

• The Max Check Attempts field defines the number of checks to be made before confirming the status of the
meta-service: when the status is valid a notification is sent.

• The Normal Check Interval field is expressed in minutes. It defines the interval between checks when the
status of the meta-service is OK.

• The Retry Check Interval field is expressed in minutes. It defines the checking interval of the Not-OK status
of the meta-service.

Notification

• The Notification Enabled field serves to enable the notifications.

• The Linked Contacts Groups list serves to define the groups of contacts that will be alerted.

• The Notification Interval field is expressed in minutes and can be used to define the time interval between the
sending of two notifications.

• The Notification Period field can be used define the period of notification.

• The Notification Type field defines the types of notification sent.

Additional informations

• The Graphic Template list defines the graphic model used by this meta-service.

• The Status and Comments fields serve to enable / disable or comment on the meta-service.

Select services manually

If you have chosen the option Service list, in the screen containing all the meta-services:

1. Click on to select the metrics entering into the calculation of the meta-service. These metrics are called
indicators.

2. Click on Add
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• The Host field serves to select the host to which the service to be selected belongs.

• The Service field serves to choose the service (first list) as well as the metric in this service (second list).

• The Status and Comment fields serve to enable / disable or comment on the indicator.

3. Repeat the operation until you have added all the indicators necessary for the calculation of the meta-service.

Note: A meta-service should be considered as a regular service. It is necessary to generate the configuration of the
central scheduler, to export it and then restart the scheduler.

6.11.3 Dependencies

Principle

Dependencies are used to satisfy two main requirements :

• Limit the sending of notifications

• Target the alerts

The dependencies of objects are of two types:

• Physical dependencies between objects: a load balancing switch is situated upstream of a set of servers and
downstream of a router

• Logical dependencies between objects: the access to a website with authentication LDAP depends on the status
of the LDAP directory itself

Physical dependencies

Physical dependencies consist of taking into account physical links between equipment. This link can only be defined
for objects of the “Host” type.

The configuration of a physical dependencies takes place in the Relations tab of a configuration sheet of a host
(Configuration ==> Hosts ==> Add).

It is possible of define two settings:

• Parent hosts: signifies that the hosts selected are parents of this host (situated upstream). If all the parent
hosts selected become unavailable or impossible to reach the host itself will be considered by the scheduler as
impossible to reach.

• Child hosts: signifies that the host becomes the parent of all the child hosts selected.
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Note: All the parents of a host must be in a Not-OK status for the host itself to be considered impossible to reach. If
only one access path is down (physical dependencies link), the scheduler will continue to monitor this host.

Logical dependencies

Logical dependencies consist of installing logical links between multiple objects that may or not be of different types.
E.g.: a service is in charge of supervising the access to a web page requiring an authentication based on a LDAP. It
is logical that if the LDAP server is down, the access to the web page will be difficult or even impossible. In this
situation, the notification issued should only be communicated to the LDAP directory and not to the website.

Hosts

To configure a logical dependencies:

1. Go into the menu: Configuration ==> Notifications

2. In the left menu, under the title: Dependencies, click on Hosts

3. Click on Add

In this case, we have two types of host that come into play: one or more hosts (called master hosts) of which the status
controls the execution and notification of other hosts (called dependent hosts). If you use the Centreon Broker, it is
also possible to control the execution and notification of services (called dependent services) from master hosts.

• The Name and Description fields indicate the name and the description of the dependencies

• The Parent relationship field should be ignored if you use the Centreon Engine. If it is enabled, and if the
dependencies links of the master host become unavailable, the dependencies in the process of creation is not
taken into account.

• The Execution Failure Criteria field indicates the statuses of the master host(s) preventing the check of the
hosts or the dependent services

• The Notification Failure Criteria field indicates the statuses of the master host(s) preventing the sending of
notifications to the hosts or the dependent services

• The Hostnames list defines the master host(s)

• The Dependent Host Names list defines the dependent hosts

• The Dependent Services list defines the dependent services
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• The Comments field can be used to comment on the dependencies

Services

To add a dependencies at the services level:

1. Go into the menu: Configuration ==> Notifications

2. In the left menu, under the title: Dependencies, click on Services

3. Click on Add

In this case, we have two entities that come into play: the (“master”) services which control the execution and the
notification of other (“dependent”) services. If you use Centreon Broker, it is also possible of control the execution
and the notification of other hosts.

• The Name and Description fields indicate the name and description of the dependencies

• The Parent relationship field should be ignored if you use the Centreon Engine. If it is enabled, and if the
links of dependencies of the master service become unavailable the dependencies in the process of creation is
no longer taken into account.

• The Execution Failure Criteria field indicates the statuses of the master service(s) preventing the check of the
hosts or the dependent services

• The Notification Failure Criteria field indicates the statuses of the master service(s) preventing the sending of
notifications to the hosts or the dependent services

• The Services list defines the master service(s)

• The Dependent services list defines the dependent services

• The Dependent hosts list defines the dependent hosts

• The Comments field can be used to comment on the dependencies

Host groups

To add a dependencies at the host groups level:

1. Go into the menu: Configuration ==> Notifications
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2. In the left menu, under the title: Dependencies, click on Host Groups

3. Click on Add

Two types of host groups: a host group is called a master if it controls the execution and the notification of other
(“dependent”) host groups.

• The Name and Description fields indicate the name and the description of the dependencies

• The Parent relationship field should be ignored if you use the Centreon Engine. If it is enabled, and if the links
of dependencies of the master host group become unavailable the dependencies in the process of creation is no
longer taken into account.

• The Execution Failure Criteria field indicates the statuses of the master host group(s) preventing the check of
the dependent host groups

• The Notification Failure Criteria field indicates the statuses of the master host(s) preventing the sending of
notifications to the dependent host groups

• The Host groups name list defines the master host group(s)

• The Dependent host group name list defines the dependent host group(s)

• The Comments field can be used to comment on the dependencies

Service groups

To add a dependencies at the service groups level:

1. Go into the menu: Configuration ==> Notifications

2. In the left menu, under the title: Dependencies, click on Service Groups

3. Click on Add
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Two types of service group: a service group is called a “master” if it controls the execution and the notification of
other (“dependent”) service groups.

• The Name and Description fields indicate the name and the description of the dependencies

• The Parent relationship field should be ignored if you use the Centreon Engine. If it is enabled, and if the links
of dependencies of the master service group become unavailable the dependencies in the process of creation is
no longer taken into account.

• The Execution Failure Criteria field indicates the statuses of the master service group(s) preventing the check
of the dependent service groups

• The Notification Failure Criteria field indicates the statuses of the master host(s) preventing the sending of
notifications to the dependent service groups

• The Service group names list defines the group(s) of master services

• The Dependent service group names list defines the group(s) of dependent services

• The Comments field can be used to comment on the dependencies

Meta-services

To add a dependencies at the meta-services level:

1. Go into the menu: Configuration ==> Notifications

2. In the left menu, under the title: Dependencies, click on Meta Services

3. Click on Add
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Two types of meta-services: a meta-service is called a “master” if it controls the execution and the notification of other
(“dependent”) meta-services.

• The Name and Description fields indicate the name and description of the dependencies

• The Parent relationship field should be ignored if you use the Centreon Engine. If it is enabled, and if the links
of dependencies of the master meta-service become unavailable the dependencies in the process of creation is
no longer taken into account.

• The Execution Failure Criteria field Indicates which are the statuses of the meta-master service(s) that will
prevent the check of the meta-dependent services

• The Notification Failure Criteria field indicates the statuses of the meta-service(s) preventing the sending of
notifications to meta-dependent services

• The Meta-service name list defines the master meta-service(s)

• The Dependent meta-service names list defines the dependent meta-service(s)

• The Comments field can be used to comment on the dependencies

6.11.4 Notification escalation

Definition

Generally, if an alert is triggered, a notification serves to contact one or more contacts (or groups of contacts). In the
same way it is possible to send multiple notifications at regular time intervals.

An escalation of notifications serves to contact various groups of contacts during the notifications process or to change
the means of notification (replace mails by an SMS). The definition of a notification escalation to a host, a host group,
a service, a service group or a meta-service overwrites the normal configuration of notifications for this object.

E.g.: a service A is set to send notifications to a group of contacts “A” in case of Not-OK status. These notifications
are sent every 5 minutes. If during a certain number of notifications sent the status of the service is still Not-OK, it is
possible to contact the individuals of the group of contacts “B” etc...

Escalations of notification are convenient in the situation where level 1, level 2, level 3, etc., support level teams exist
within a company. When a problem appears the level 1 support team is contacted. If after a certain time the level 1
team has not succeeded in solving the problem, the level 2 team is alerted, etc.

Configuration

To add an escalation of notification:
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1. Go into the menu: Configuration ==> Notifications ==> Escalations

2. Click on Add

• The Escalation Name and Alias fields serve to define a name and an alias for the notification escalation.

• The First Notification field allows us to choose the notification number as of which the group of contacts is
alerted.

• The Last Notification allows us to choose the last notification number at which the group of contacts is alerted.
If the group of contacts is the last level of the escalation the value of this field is 0.

• The Notification Interval field defines the notification interval between alerts.

• The Escalation Period field defines the notification time period.

• The Hosts Escalation Options and Services Escalation Options service escalation fields define the statuses of
hosts and of services for which the escalation is used.

• The Linked Contact Groups defines the group of contacts to be contacted on triggering the escalation.

• The Comments field can be used to comment on the escalation.

Application of the escalation

To select the various objects that will be concerned by this escalation, the Hosts Escalation, Services Escalation,
Hostgroups Escalation, Meta Service Escalation and Servicegroups Escalation tabs serve to choose the objects to
which the escalations are applied.

6.11.5 Recurrent downtimes

Definition

A downtime period is a time period during which the notifications to a host or a service are disabled. Downtime
periods are convenient during maintenance operations on a host or a service: they allow us to avoid receiving false
positive.

Recurrent Downtime periods are Downtime periods that recurs repetitively.
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E.g.: A back-up of the virtual machines is performed every day from 20h00 to midnight. This type of back-up has a
tendency to saturate the CPU use of all the virtual machines. It is necessary to program recurrent Downtime periods
on the services concerned to avoid receiving notifications from 20h00 to midnight.

Note: The Downtime periods are taken into account in the calculation of the availability ratio of the resource in the
menu: “Dashboard”.

Types of Downtime periods

There are two types of Downtime periods:

• The fixed downtime period: This means that the downtime period takes place during exactly the time period
defined.

• The flexible downtime period: This means that if during the time period defined the service or the host returns
a Not-OK status the downtime period lasts a certain number of seconds (to be defined in the form) from the
moment when the host or the status returns a Not-OK status.

Configuration

To add a recurrent downtime period:

1. Go into the menu: Monitoring ==> Downtimes

2. In the left menu, click on Recurrent Downtimes

3. Click on Add

Configuration of Downtime periods

• The Name and Description fields serve to give a name and describe the recurrent downtime period.
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• The Enable field serves to enable or disable the downtime period.

• The Periods field serves to define one or more periods of recurrent downtime periods. To add a period, click on
the symbol.

It is possible to choose three types of period:

• Weekly: to choose the days of the week

• Monthly: to choose the days of the month

• Specific date: to choose specific dates

• The Days field defines the day(s) concerned.

• The Time period field contains the time period concerned (expressed in HH:MM - HH:MM).

• The Downtime type field defines the type of downtime period desired.

Note: It is possible to combine several types of periods within the same downtime period.

Relations

• The Linked with Hosts list can be used to choose the host(s) concerned by the recurrent downtime period.

• If Linked with Host Groups is chosen with the list Linked with the host group all the hosts belonging to this
group are concerned by the recurrent downtime period.

• The Linked with Services list can be used to choose the service(s) concerned by the recurrent downtime period.

• If a service group is chosen with the list Linked with Service Groups all the services belonging to this group
are concerned by the recurrent downtime period.

6.11.6 SNMP traps

Definition

SNMP traps are information sent using the SNMP protocol from monitored equipment to a poller server (satellite).
This information contains multiple Attributes including:

• Address of the equipment sending the information.

• The root OID (Object Identifier) corresponding to the identifier of the message received.

• The message sent via the SNMP trap which corresponds to a set of settings (1 to N).

In order to be able interpret the event received the Network supervisor server needs to possess in its configuration the
necessary elements to translate the event. For this it must have a database containing the OID and the descriptions,
this is what is called MIB files. There are two types of MIB:

• Standard MIBs which use standardized OIDs and which are implemented by numerous manufacturers on their
equipment.

• MIB manufacturers who are specific to each one and often to each equipment model.

MIB manufacturers can be retrieved from the equipment. Centreon allows us to store the definition of SNMP traps in
its MySQL database. The traps can subsequently be linked to passive services via the Relations tab of the definition
of a service.
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Architecture

With centreon 2.5.x, the management of the SNMP traps has been reviewed completely in comparison to the previous
versions:

• The ‘snmptt’ and ‘centtraphandler’ processes have been combined in a single process called ‘centreontrapd’.

• The ‘snmptthandler’ process is replaced by the ‘centreontrapdforward’ process.

• The satellites can have their own definition of SNMP traps within a SQLite dedicated base thus deleting the
access to the centreon MySQL server.

Processing of a trap by the central server

Here is the processing of an SNMP trap with centreon 2.5.x:

1. snmptrapd is the service enabling the retrieval of SNMP traps sent by the equipment (by default it listens on the
UDP 162 port).

2. Once the SNMP trap has been received, it is sent to the ‘centreontrapdforward’ script which writes the informa-
tion received in a buffer folder (by default /var/spool/centreontrapd/).

3. The ‘centreontrapd’ service reads the information received in the buffer folder and interprets the traps received
checking, in the centreon database, the actions necessary to process these events.

4. The ‘centreontrapd’ service transmits the information to the scheduler or the ‘centcore’ service (to send the
information to a remote scheduler) which changes the status and the information associated with service to
which the SNMP trap is linked.
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Processing of a trap by a satellite server

To keep a copy of the configuration of the SNMP traps on each satellite server, a SQLite database is charged with
keeping cached the information of the traps contained in the MySQL database. This SQLite database is automatically
generated by the central server. Here is the processing of an SNMP trap with centreon 2.5.x :

1. snmptrapd is the service serving to retrieve the SNMP traps sent by the equipment (by default it listens on the
UDP 162 port).

2. Once the SNMP trap is received, it is sent to the ‘centreontrapdforward’ script which writes the information
received in a buffer folder (by default /var/spool/centreontrapd/).

3. The ‘centreontrapd’ service reads the information received in the buffer folder and interprets the various traps
received checking in the SQLite database the actions to be taken to process the traps received.

4. The ‘centreontrapd’ service transmits the information to the scheduler which changes the status and the infor-
mation associated with the service to which the SNMP trap is linked.

Note: the Centcore process is responsible, as for the export of configuration of the supervision, to copy the SQLite
base on the remote collector.

Configuration of services

Snmptrapd

To call the ‘centreontrapdfoward’ script, the file /etc/snmp/snmptrapd.conf must contain the following lines:

disableAuthorization yes
traphandle default su -l centreon -c "/usr/share/centreon/bin/centreontrapdforward"

You can optimize the performances of snmptrapd by using the following options:
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• -On don’t try to convert the OIDs

• -t don’t log the traps to the syslog server

• -n don’t try to convert the IP addresses into host names

These options can be changed in the file /etc/sysconfig/snmptrapd:

OPTIONS="-On -d -t -n -p /var/run/snmptrapd.pid"

It is also possible to place the snmptrapd buffer folder in the RAM. For this, add the following line in the file /etc/fstab:

tmpfs /var/run/snmpd tmpfs defaults,size=128m 0 0

centreontrapdforward

To change the buffer folder towards which the information will be written, change the configuration file
/etc/centreon/centreontrapd.pm:

our %centreontrapd_config = (
spool_directory => ’/var/spool/centreontrapd/’,

);

1;

You can also map the folder in the RAM, by adding the following line in the file: /etc/fstab:

tmpfs /var/spool/centreontrapd tmpfs defaults,size=512m 0 0

centreontrapd

Two configuration files existent in centreontrapd:

• /etc/centreon/conf.pm contains the connection information to the MySQL database

• /etc/centreon/centreontrapd.pm contains the configuration of the centreontrapd service

Configuration of the service In the file /etc/centreon/centreontrapd.pm we advise changing three settings only (if
necessary):

• If the mode option is defined in 1 centreontrapd functions on a satellite server, otherwise it functions on a central
server (centreon).

• The centreon_user option can be used to change the user executing the actions.

• The spool_directory option can be used to change the buffer folder to be read (if you have changed it in the
‘centreontrapdforward’ configuration file).

Here is an example of possible configuration of the file /etc/centreon/centreontrapd.pm (the configuration file can
be changed with ‘-config-extra = xxx’):

our %centreontrapd_config = (
# Time in seconds before killing not gently sub process
timeout_end => 30,
spool_directory => "/var/spool/centreontrapd/",
# Delay between spool directory check new files
sleep => 2,
# 1 = use the time that the trap was processed by centreontrapdforward
use_trap_time => 1,
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net_snmp_perl_enable => 1,
mibs_environment => ’’,
remove_backslash_from_quotes => 1,
dns_enable => 0,
# Separator for arguments substitution
separator => ’ ’,
strip_domain => 0,
strip_domain_list => [],
duplicate_trap_window => 1,
date_format => "",
time_format => "",
date_time_format => "",
# Internal OID cache from database
cache_unknown_traps_enable => 1,
# Time in seconds before cache reload
cache_unknown_traps_retention => 600,
# 0 = central, 1 = poller
mode => 0,
cmd_timeout => 10,
centreon_user => "centreon",
# 0 => skip if MySQL error | 1 => don’t skip (block) if MySQL error (and keep order)
policy_trap => 1,
# Log DB
log_trap_db => 0,
log_transaction_request_max => 500,
log_transaction_timeout => 10,
log_purge_time => 600

);

1;

Configuration of the connection to the database
Note: On a poller, the database access should be configure in /etc/centreon/centreontrapd.pm file.

It is possible of configure the file /etc/centreon/conf.pm in two ways:

• Retain the connection to the MySQL server database (necessary for the central server and possible for the
satellite servers). Content of the file:

$centreon_config = {
VarLib => "/var/lib/centreon",
CentreonDir => "/usr/share/centreon/",
"centreon_db" => "centreon",
"centstorage_db" => "centreon_storage",
"db_host" => "localhost:3306",
"db_user" => "centreon",
"db_passwd" => "centreon"
};

1;

• Connect centreontrapd to the local SQLite database. Contents of the file:

$centreon_config = {
VarLib => "/var/lib/centreon",
CentreonDir => "/usr/share/centreon/",
"centreon_db" => "dbname=/etc/snmp/centreon_traps/centreontrapd.sdb",
"centstorage_db" => "dbname=/etc/snmp/centreon_traps/centreontrapd.sdb",
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"db_host" => "",
"db_user" => "",
"db_passwd" => "",
"db_type" => ’SQLite’,
};

1;

Centreon configuration

Add a manufacturer

Within centreon, the root OIDs of the SNMP traps is filed by manufacturer. To add a manufacturer:

1. Go into the menu: Configuration ==> SNMP traps

2. In the left menu, click on Manufacturer

3. Click on Add

• The Name and Alias fields define the name and the alias of the manufacturer

• The Description field provides an indication about the manufacturer

Importation of MIBs

It is also possible to import OIDs from MIBs provided by the manufacturers. To do this :

1. Go into the menu: Configuration ==> SNMP traps

2. In the left menu, click on MIBs

• The Manufacturer list can be used to choose the manufacturer to which the MIB that you are importing belongs

• The File (.mib) field can be used to load the MIB

3. Click on Import
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Note: The dependencies of the MIBS that you import must be present in the folder /usr/share/snmp/mibs. Once the
import is completed, delete the dependencies previously copied.

Note: Once the SNMP traps are imported, it is necessary to verify the “Monitoring” status associated with the events.
By default it will be “OK”.

Manual configuration of traps

Basic configuration It is also possible to create definitions of SNMP traps manually:

1. Go into the menu: Configuration ==> SNMP traps

2. Click on Add

• The field Trap name defines the name of the trap.

• The field OID defines the Root OID to be received for this trap to be considered as received.
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• The field Vendor name defines the name of the manufacturer to which the trap to be selected in the drop-down
list belongs.

• The field Output message of contains the message to be displayed in the event of reception of a trap containing
the OID configured above.

Note: By default, the MIB contains the definition of this variable (E.g.: “Link up on interface $2. State: $4.”, here $2
will be replaced by the 2nd argument received in the event.). In the opposite situation, the variable $* can be used to
display all the arguments contained in the trap.

Note: It is possible to construct the output message yourself. For this, use the MIB to know the arguments that will
be present in the body of the event and retrieve the arguments with the variables $n. As each argument is identified
by a OID, it is possible to use this OID directly to place it in the output message without knowing its position via the
variable @{OID}.

• The Default status field defines the “monitoring” status of the service in case of reception of the trap.

• If the Submit result box is checked the result is submitted to the Network supervisor engine.

• The Comments field (last field) contains by default the comment by the manufacturer of the SNMP trap. Most
of the time, this comment indicates the list of variables contained in the SNMP trap (see the next chapter on
advanced configuration).

Advanced configuration of the traps It is possible to determine the status of a service from the value of a setting
of the SNMP trap rather than from the Root OID. Previously the manufacturer defined an SNMP trap (Root OID) by
type of event to be sent (linkUp / linkDown). Today, the tendency is to define a Root OID by category of events and
then to define the event via a set of settings.

To do this, it is possible of define Advanced Matching mode by clicking on Add a new entry and by creating as
many rules as necessary. For each rule, define the settings:

• String defines the element on which the search will be applied (@OUTPUT@ defined all the Output messages
translated).

• Regexp defined the REGEXP type search to be applied.

• Status defines the status of the service in the event of concordance.

Note: The order is important in the rules of correspondence because the process will stop at the first rule of which the
correspondence is assured.

• The Disable submit result if no matched rules field disables the sending of information to the scheduling
engine if no correspondence with a rule is confirmed.

• If the Reschedule associated services box is checked the next check on the service, which should be ‘active’,
should be reprogrammed as soon as possible after reception of the trap.

• If the Execute special command box is checked the command defined in Special command is executed.

Very advanced configuration of the traps The Advanced tab serves to configure the behavior of the handling
process of the SNMP traps on its reception of the latter.
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• Enable routing is used to enable the routing of information.

• Route definition is used to define the command to be used for routing.

Before performing the processing of the event (translation of the Output message), it is possible to execute a command
called PREEXEC. To do this, it is possible to define PREEXEC command (SNMPTT type) by clicking on Add a
new entry and create as many rules as necessary.

• PREEXEC command defines the command to be executed.

Here is an example of use with the linkUP trap:

For a Cisco equipment, $2 == ifDescr contains the port number of the interface (GigabitEthernet0/1 for instance). The
best description of the interface is in the SNMP if Alias field.

The following command can be used to retrieve this value :

snmpget -v 2c -Ovq -c <community> <cisco switch> ifAlias.$1

To use the result of the PREEXEC command in the Output message, it is necessary to use the variable $p{n} where
‘n’ corresponds to the order of definition of the command.

Example:

"Interface $2 ( $p1 ) linkUP. State: $4." "$CA"

The result will have the form: Interface GigabitEthernet0/1 ( NAS Server ) linkUP. State: up

• The Insert trap’s information into database box, if checked, record the SNMP trap information in the database
field can be used define whether or not to classify the traps by day in the database.

• The Timeout field expressed in seconds is used to define the maximum processing time of the event including
the pre-processing commands (PREEXEC) and post-processing commands (special command).

• The Execution interval field expressed in seconds is used to define the maximum waiting time between two
processing operations of an event.
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• The Execution Type field is used to enable the Execution interval by defining the conditions by Root OID, by
the Root OID and host combination or, to disable this restriction, None.

• The Execution Method field is used to define if on reception of multiple same events (Root OID). The execution
is either Sequential or Parallel.

Variables

When adding a rule of correspondence or executing a special command it is possible to transmit arguments to the
String or Special command fields. These arguments are listed in the table below:

Macro name Description
@{NUMERIC_OID} Retrieval of the value of an argument via its OID, e.g.: @{.1.3.6.1.4.1.9.9.43.1.1.1}
$1, $2... Retrieval of the value of an argument via its order of appearance
$p1, $p2,... Value of the command: PREEXEC ($p1 = at the first command, $p2 at the second,

...)
$* All the arguments separated by a space
@HOSTNAME@ Host name (in centreon) to which the service is attached
@HOSTADDRESS@ IP address of the host sending the trap
@HOSTADDRESS2@ DNS name of the host sending the trap (if the server fails to effect a reverse DNS

resolution we retrieve the IP address)
@SERVICEDESC@ Service name
@TRAPOUTPUT@ ou
@OUTPUT@

Output of the traps

@STATUS@ Service state
@SEVERITYNAME@ Criticality name
@SEVERITYLEVEL@ Criticality level
@TIME@ Trap reception timestamp
@POLLERID@ ID of the poller having received the trap
@POLLERADDRESS@ IP address of the poller having received the trap
@CMDFILE@ Path to the command file of CentCore (central) or of centreon Engine (collector)

In addition, there are special variables that can be used in the Routing settings section at the level of the Routing
command if the option Enable routing is selected :

Macro name Description
@GETHOST-
BYADDR($1)@

Reverse DNS resolution used to find the DNS name DNS from the IP address
(127.0.0.1 -> localhost)

@GETHOSTBY-
NAME($1)@

DNS resolution used to find the IP address from the DNS name (localhost ->
127.0.0.1)

Applying the changes

To be able to export the OID present in the database in the configuration file to centreontrapd, follow the following
procedure:

1. Go into the menu: Configuration ==> SNMP traps

2. In the left menu, click on Generate

3. Select the poller to which you want to export the configuration files

4. Check Generate traps database and Apply configurations

5. In the drop-down list Send signal (the Reload option is preferable)

6. Click on the Generate button
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6.12 Main process description

6.12.1 The notification process in Centreon

Notifying a contact in Centreon

Before a contact can be notified in Centreon, it is necessary to go through several steps. If no notification escalation is
defined, the notification management process is standard. It is described below:

1. A service (or a host) is checked at regular intervals according to the check period defined for it (In the case of a
passive service, we wait for the status of the service to change)

2. If an anomaly occurs (Not-OK status), the service (or the host) goes into the SOFT state

3. After the Max Check Attempts has taken place and if the service (or the host) persists in retaining its Not-OK
status its state changes from SOFT to HARD. The monitoring engine caches the notification number to the
service (or the host): i.e. 0.

At each notification interval of the service (or the host) and until the end of the Not-OK status, the monitoring engine
performs the following operations:

4. The monitoring engine checks that the notification period defined for the service (or the host) allows the notifi-
cation for the service (or the host) when is switched into the HARD state. If the answer is yes, we go to the next
step otherwise we wait for period defined for the service (or the host) to allow notification.

5. The monitoring engine checks that the notification is enabled to the current status of the service (or of the host)

For every contact associated with the service (or the host):

6. The monitoring engine checks several settings:

• Is notification to this contact enabled?

• Does the notification period defined for the contact allow notification?

• Is the contact configured to be notified of the current status of the service (or the host)?

7. If these three conditions are confirmed, the monitoring engine alerts the contact using the notifications script
defined for the service or the host.

8. The monitoring engine increments the notification number by 1

The diagram below summarizes the notifications management in Centreon:
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Notifications escalation in Centreon

Notifications escalations allow two things:

• Notifying various contacts according to the number of notifications sent

• Changing the command of notification over time

In case of the use of notifications escalations, the retrieval of the list of contacts is a little different:

1. A service (or a host) is checked at regular intervals according to the check period defined for it

2. If an anomaly occurs (Not-OK status), the service (or the host) goes into the SOFT state

3. After the Max Check Attempts exceeded and if the service (or the host) persists in its Not-OK status its state
changes from SOFT to HARD. The monitoring engine caches the notification number for the service (or the
host): i.e. 0.

At each interval or sending of notification to the service (or the host) and until the end of the Not-OK status, the
monitoring engine performs the following operations:

1. If no notification escalation is defined for the service (or the host) and the current notification number, the
notification is processed in the same way as for a normal notification: the monitoring engine uses the notification
configuration defined for the service (or the host).

2. If a notification escalation is defined for the service (or the host) and the current notification number, the mon-
itoring engine bases itself on the configuration of the escalation to select the contacts to be notified and the
mechanism to be used.

3. The processing mechanism for a notification is the same as the sending of a normal notification

For information the configuration of notification escalations is defined in the chapter covering The notifications esca-
lations.

6.12.2 Managing logical dependencies

We have seen in the dependencies configuration chapter how to configure dependencies between objects (hosts, ser-
vices, host groups, etc.). This sub-chapter illustrates the use of these dependencies via a few actual cases.

Note: The dependencies are based on failure criteria that is “do not do if”. Do not notify if the service is in a Critical
state. Do not perform the check if the service is in a Critical, Alert, Unknown, ... state.

Services dependencies

A service is checked using a Selenium scenario. This scenario connects to a web interface with an identifier and a
password. This connection information is stored in a MySQL database.

Consequently, if the database server does not reply, the Selenium scenario cannot complete. It seems obvious that it
is necessary to create a logical dependency link between the service which uses the Selenium scenario and the service
that is responsible for checking the status of the MySQL server.

Moreover, considering that the Selenium scenario cannot perform properly, no performance data can be stored in the
database. So it is necessary not only to stop the notification for the service using the Selenium scenario but also the
check.

To create this dependency:

1. Go into the menu: Configuration ==> Notifications

2. In the left menu under Dependencies, click on Services
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3. Click on Add

4. Enter the name and the description of the dependency

5. For the Execution Failure Criteria and Notification Failure Criteria fields, check Warning, Critical, Unknown
and Pending

6. In the Services list select the service that is responsible for checking the status of the MySQL server

7. In the Dependent Services list, select the service that uses the Selenium scenario

8. Save

From now on, if the service responsible for checking the status of the MySQL server has “Warning”, “Critical”,
“Unknown” or “Pending” status, the service responsible for executing the Selenium scenario will not be executed until
the master recovers its OK status.

Hosts dependencies

Let us take the case of two hosts which operate as a cluster. Three hosts are created to be able to monitor this cluster:
a host A, a host B (both members of the cluster) and a host C (which centralizes the information from the cluster).

If host A or host B has a Not-OK status the services of host C will automatically be considered to be Not-OK. So it is
necessary to add a dependency which prevents the sending of notifications if host A or host B become faulty. However,
performance data feed-back must always be operational; this is why it is necessary to continue the monitoring of host
C.

To create this dependency:

1. Go into the menu: Configuration ==> Notifications

2. In the left menu under Dependencies, click on Hosts

3. Click on Add

4. Enter the name and the description of the dependency

5. For the Notification Failure Criteria field, check Warning, Critical, Unknown and Pending

6. In the Host Names list, select host A

7. In the Dependent Host Names list select host C

8. Save

Repeat this operation for host B.

Service Groups dependencies

Let us take the example of a set of Oracle services on which the ERP application bases itself. Two service groups are
needed:

• The Oracle Application group

• The ERP Application group

If the Oracle services become critical, the services of the ERP application are automatically critical. It is necessary
to create a dependency link to prevent the check and notification of the services of the application ERP if the Oracle
application is Not-OK.

To create this dependency:

1. Go into the menu: Configuration ==> Notifications
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2. In the left menu under Dependencies, click on Service Groups

3. Click on Add

4. Enter the name and the description of the dependency

5. For the Execution Failure Criteria and Notification Failure Criteria fields, check Critical and Pending

6. In the Service Group Names list select the service group Oracle Application

7. In the Dependent Service Group Names list, select the service group ERP Application

8. Save

6.12.3 Managing groups and categories

In Centreon, it is possible to group together one or more objects within different groups:

• Host Groups

• Service Groups

• Contact Groups

It is also possible to create categories of hosts or services.

Groups

Generally speaking, the groups are containers in which sets of objects having a common property can be grouped
together:

• Same material identity (Dell, HP, IBM, etc., servers), logical identity (network equipment) or geographical
identity (Europe, Asia, Africa, North America, etc.)

• Belonging to the same application (CMS application, etc.) or to a same sector of activity (Salary management,
etc.)

• Etc.

Service Groups and Host Groups

Host groups and service groups are used to group together objects by logical entities. They are used to:

• Configure ACLs to link a set of resources to a type of profile

• Allow viewing of availability reports per group. Generate a “Paris Agency” availability report for resources.

• Enable viewing the status of a set of objects by selecting in the search filters of a group of objects

• Search several performance graphs quickly by browsing the object tree structure by group and then by resource

Generally speaking, we try to group together hosts by functional level. E.g.: DELL and HP hosts or Linux, Windows,
etc., hosts. We also try to group services by application jobs. E.g.: Salary management application, ERP Application,
etc.

Note: For the hosts belonging to a host group, the retention of RRD files can be defined in the host group. This
definition overrides the global definition. In the event that the same host belongs to several groups each possessing a
retention definition, the highest value will be selected for the host.
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Contact Groups

Contact Groups are used to notify contacts:

• On definition of a host or of a service

• On definition of an escalation of notifications

In addition, the groups of contacts are also used during the definition of an access group.

Consequently, it is necessary to group together contacts in a logical way. Most of the time, they are grouped together
according to their roles in the information systems. E.g.: DSI, Windows Administrators, Linux Administrators, Person
in charge of the application of Salary Management, etc.

Categories

Generally speaking, the categories serve either to define a criticality level for a host or a service, or to group together
technically a set of objects (services linked to the execution of a request on a MariaDB DBMS, etc.). Good practice
requires that we group hosts or services together into categories to facilitate the filtration of these objects in ACL.
The categories are also used to define types of objects in the Centreon MAP module or to classify the objects within
sub-groups in the Centreon BI module.

6.12.4 Managing SNMP traps with Centreon

Receive SNMP traps with Centreon

This section presents the different stages in order to monitor equipment using SNMP traps.

Import of SNMP traps

To import SNMP traps, you must follow the following steps:

1. Create a Manufacturer linked to the SNMP trap that you created, see this section

2. Import MiB in the Centreon web interface, see this section

When import a MiB file, it’s possible that dependencies are necessary. In order to find the dependencies of your MIB,
you must open your MIB file using a standard text editor, then:

1. Locate the line that starts with IMPORTS

2. All dependencies required to import your MIB file are after the keyword FROM

Eg. :
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In the MIB file shown above, there are four dependencies required to import the MIB: SNMPv2-SMI, SNMPv2-TC,
SNMPv2-CONF, SNMP-FRAMEWORK-MIB. Once the import is complete, it is necessary to modify the definition
of the trap to change its default status:

1. Go into the menu Configuration ==> SNMP Traps

2. Click on the trap you want to modify.

Depending on the associated trap message, change the default status of the service. In case the status of the service
depends on the received message, use the advanced matching mode.

Create a passive service template

To facilitate the configuration of services using SNMP traps, it is more convenient to create a passive service template.
In this way, when creating a service there will be more than inherit the service from this model and link the trap or
SNMP traps linked to this service.

1. Go in the menu Configuration ==> Services

2. In the left menu click on Templates

3. Click on Add

The table below summarizes all the attributes of a passive service template:

Attributes Description
Service Configuration Tab
Alias TRAP
Service Template Name generic-passive-service
Check Period 24x7
Check Command check_centreon_dummy
Args Status : 0 Output : “No trap since 24 hours”
Max Check Attempts 1
Active Checks Enabled No
Passive Checks Enabled Yes
Data Processing Tab
Check Freshness TRAP
Freshness Threshold 86400 (24 hours)

Note: The check_centreon_dummy plugin will be called if no trap is received within 24 hours.
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Service creation

Then create the service and associate it with the passive service template. You just have to go to the Relations tab and
linked in the field Service Trap Relation, SNMP traps that can change the status of the service.

Now Generate configuration files to apply changes.

Send an example trap

You can test the reception of SNMP traps on your device. You can send an fake SNMP event to your monitoring server
using the utility line snmptrap orders.

Syntax:

snmptrap -v SNMP-VERSION -c COMMUNITY IP-DESTINATION UPTIME TRAP-OID PARAMETER-OID PARAMETER-TYPE PARAMETER-VALUE

With:

• SNMP-VERSION: SNMP version. For the syntax above is necessarily 2c

• COMMUNITY: SNMP Community

• DESTINATION-IP: SNMP trap destination IP. It could be the Centreon central server or a poller.

• TRAP-OID: OID of the SNMP trap

• UPTIME: Time in seconds since last restart of the device. When an empty string is specified, this argument is
automatically filled by the binary “snmptrap”.

Any additional parameters to SNMP trap must contain the following 3 variables. They must be repeated for each
additional parameter:

• PARAMETER-OID: OID of the SNMP trap

• PARAMETER-TYPE: Type of the parameter, ‘i’ for ” Integer ”, ‘s’ for ” String ”, etc.

• PARAMETER-VALUE: related to the parameter value. Quoting a string containing spaces

Trap example for sending “linkUp” event on ‘eth0’ interface:

snmptrap -v2c -c public 192.168.1.1 ’’ .1.3.6.1.6.3.1.1.5.4 ifIndex i 2 ifDescr s eth0 ifAdminStatus i 1 ifOperStatus i 1

Modify the output

Use all the arguments

For a SNMP trap, when configuring the output message, the argument $ * will display all the information (the value
of arguments) contained within the SNMP trap. However, it is possible to display only certain information contained
in the SNMP trap by calling unitary arguments.

Eg:
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The output message “Link down on interface $2. State: $4.” will display only the name of the interface and its status
($2 and $4 argument).

Where can I find the arguments?

The arguments are in the documentation of the MIB manufacturer or in the Comments field of the SNMP trap.

Eg:

To show:

• The index link, use the $1 argument

• The interface name , use the $2 argument

• The administrative state of the interface, use the $3 argument

• The state interface, use the $4 argument

Eg, the following output message displays all the arguments:

Link down on interface: $2 (index: $1). Operational state: $4, Administration state: $3

Active checks after trap reception

Reschedule associated services option to actively check the service after the trap reception.

The active service linked in the service configuration is executed.

Execute special command

Its possible with Centreontrapd to execute a special command after the reception of a SNMP trap. Just use the option
Execute special command followed by the description of this command.
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Use all the arguments (via OID)

It’s also possible to have directly an argument value without knowing arguments order ($1, $2, $3, etc.). to do this,
use the complete OID number of needed arguments.

Eg:

Link down on interface: @{.1.3.6.1.2.1.2.2.1.2} (index: @{.1.3.6.1.2.1.2.2.1.1}). Operational state: @{.1.3.6.1.2.1.2.2.1.8}, Administration state: @{.1.3.6.1.2.1.2.2.1.7}

Use an external variable

It’s also possible to modify the output message by retrieving information via scripts or external commands and get the
result to insert it in the output. To do this, within the definition of your SNMP trap, go to the Advanced tab and add
one (or more) preexec commands.

Eg:

The first command “snmpget -v 2c -Ovq -c public @HOSTADDRESS@ ifAlias.$1” and allows you to retrieve the
alias interface. The “$1” variable is for the argument 1 associated value of linkUp/linkDown traps.

The second command “snmpget -v 2c -Ovq -c public @HOSTADDRESS@ ifSpeed.$1” and allows you to retrieve
interface speed. The “$1” variable is for the argument 1 associated value of linkUp/linkDown traps.

In order to exploit the result of the first command in the output, you have to use $p1 argument. For exploiting the
result of the second command in output, you have to use $p2 argument.

Therefore, we can deduce the following output message:

Link down on interface: $2 (index: $1). Operational state: $4, Administration state: $3, Alias : $p1, Speed : $p2

Use a Regular expression

It’s also possible to modify the output by using a regular expression with Output Transform option. You just have to
define the regexp and it will be executed at trap reception.

For example:

s/\|/-/g

Will replace | in the output to -.

Route/Transfer SNMP traps

It’s possible to have a SNMP trap concentrator. Eg: Oracle GRID. Oracle GRID is responsible for federating infor-
mation for all Oracle servers if necessary, it’s the Oracle GRID server who sends the SNMP trap to the monitoring
server.

However, from a SNMP trap sent from Oracle GRID, we want to extract the IP address of the host and display the
message in the service trap not belonging to Oracle Grid but to the correct host.

To do this, perform the following steps:
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1. Create a generic trap, with the following parameters:

Attributes Description
Main Tab
Trap Name Trap name
OID OID of the trap
Default Status Trap default status
Output Message Custom output message
Advanced Tab
Enable routing Checked
Route definition $2 (In this example $2 argument is for IP address of the host)

2. Create a second trap definition:

Attributes Description
Main Tab
Trap Name Trap name (not the same as previous)
OID OID of the trap (same as previous))
Default Status Trap default status
Output Message Custom output message

3. Associate the first definition to a service (eg PING) of Oracle GRID server

4. Associate the second definition to a passive service of the host.

5. Generate SNMP traps definitions and restart centreontrapd

In the Route definition field you can use the following arguments:

Variable name Description
@GETHOST-
BYADDR($2)@

Reverse DNS resolution to know the DNS name from IP address (127.0.0.1 ->
localhost)

@GETHOSTBY-
NAME($2)@

DNS resolution to know the Ip address from the DNS (localhost -> 127.0.0.1)

Ignore SNMP Trap when resource is on downtime

Check Downtime allow centreontrapd to check if the service is not in Downtime status at trap reception. The submis-
sion can be canceled.

Note: It’s only possible with Centreon Broker and on central monitoring.

There are three ways to configure this:

• None : nothing to do, the trap is sent as normal;

• Real-Time : with this option, a trap sent with a current downtime, the service state is not updated;

• History : option used to do not acknowledge a trap snmp that concerning a past event during a downtime.

FAQ

As seen in Chapter SNMP traps, several elements are involved in the SNMP traps management. In case of problem, it
is necessary to check the proper functioning of its architecture, there are several things to check.
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Sender settings

The first point is to control the configuration of the equipment or application that issued the trap that you should have
received. Check IP address or DNS name, the SNMP community and version.

Firewall, routing

The second point is to control network firewalls and software permissions and the implementation of a specific routing.
If one or more network firewalls are present or if a port translation and/or IP address is in place, make sure the
connection is possible between the emitter and the poller. The use of network probes, debug network devices (firewalls
and routers) or software tcpdump/wireshark on the poller may help you to confirm receipt of data on UDP port 162.

Snmptrapd

After validation of the connection, check the operating status of snmptrapd process (which must be run-
ning) and its configuration options. It is possible to enable logging of the process. To do this change the
“/etc/sysconfig/snmptrapd.options” file and replace the “OPTIONS” line:

# snmptrapd command line options
# OPTIONS="-On -d -t -n -p /var/run/snmptrapd.pid"
OPTIONS="-On -Lf /var/log/snmptrapd.log -p /var/run/snmptrapd.pid"

Restart the process to take the changes into account. Thus, for any receiving SNMP traps, these events will be listed
in the “/var/log/snmptrapd.log” log.

In case you filter by SNMP community, check allowed communities in the configuration file
“/etc/snmp/snmptrapd.conf”. If after all these checks, SNMP traps are not included in the log, verify that the
process is listening on UDP port 162 for remote equipment using the command:

# netstat -ano | grep 162
udp 0 0 0.0.0.0:162 0.0.0.0:* off (0.00/0/0)

If not, change the listening port of the process.

Note: Don’t forget to deactivate the logs after your check. Otherwise, the volume of the logs can be very important.

Centreontrapdforward

Once the snmptrapd process is validated, check the centreontrapdforward process. The first step is to check the access
parameters of this process snmptrapd in the file “/etc/snmp/snmptrapd.conf”:

• Check that snmptrapd service executes centreontrapdforward. To do this, edit the file
/etc/snmp/snmptrapd.conf and verify that its contains:

traphandle default su -l centreon -c "/usr/share/centreon/bin/centreontrapdforward"

If path to the file is incorrect, change it and restart the snmptrapd process. You can check the proper functioning of
binary centreontrapdforward by checking the configuration part of centreontrapdforward.

Centreontrapd

The next process to check is Centreontrapd. This daemon allows to connect a SNMP trap to a passive service linked
to an host in Centreon using IP address or DNS from distant equipment. To check its operation, you should check the
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centreontrapd configuration settings.

You can check the proper functioning of binary centreontrapdforward by checking the configuration part of centreon-
trapd.

CentCore

CentCore daemon must be running to forward information from Centreontrapd to the monitoring engine as an external
command. Enable the debug mode via Administration ==> Options ==> Debug menu and restart process.

Note: You can edit debug severity level in /etc/sysconfig/centcore file.

If any external command are sent to the monitoring engine please check the path to “$cmdFile”” in
/etc/centreon/conf.pm configuration file. The path should be /var/lib/centreon/centcore.cmd for a central Centreon
server.

Poller

The monitoring engine must receive external commands from Centcore process in order to change status and out-
put of the passive service. Please check the event log. for Centreon Engine, the path is /var/log/centreon-
engine/centengine.log. you should find lines as:

[1352838428] EXTERNAL COMMAND: PROCESS_SERVICE_CHECK_RESULT;Centreon-Server;Traps-SNMP;2;Critical problem
[1352838433] PASSIVE SERVICE CHECK: Centreon-Server;Traps-SNMP;2;Critical problem

If only the external command appears but not the consideration thereof by the scheduler (“PASSIVE SERVICE
CHECK”), there may be a system clock problem synchronizing issue. The server is late and the order will be processed
later, either in advance and the order will not be taken into account.

Centreon

To display the result in Centreon the monitoring engine must forward using NEB module information to the broker to
store them into database. Centreon will display result from “centreon_storage” database. If you can reach Centreon
web interface you must see the change of the output and maybe the status of the passive service. If any change appears
a connection failure between the monitoring engine and the broker can be the root cause of this issue. Problems can
be:

• The monitoring engine doesn’t load the NEB module to connect to the distant broker.

• The NEB module settings are wrong to connect to the distant broker.

• A firewall stops the connection.

Detailed diagram

You will find below a detailed diagram of all the processes used and/or present at the reception of an SNMP trap:
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6.13 Deploying a configuration

6.13.1 Procedure

On creation/deletion/change of objects via the configuration interface, the changes performed are not applied automat-
ically to the scheduler. To apply the changes performed, it is necessary to follow the procedure below.

Note: It should always be done in 2 steps.

First step

1. Go into the menu: Configuration ==> Pollers

2. Choose the pollers which you want to export configuration

3. Click on Apply configuration

1. Check the boxes: Generate Configuration Files and Run monitoring engine debug (-v)

2. Click on Export
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Check that no error appears during generation.

Note: If there are errors, correct the errors and repeat the first step.

Second step

1. Uncheck the boxes: Generate Configuration Files and Run monitoring engine debug (-v)

2. Then check the boxes: Move Export Files and Restart Monitoring Engine

3. Click on Export

Note: The Post generation command option can be used to request the execution of the command post-generation
set at the configuration of the scheduler.

6.13. Deploying a configuration
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6.13.2 Explanations

Multiple options are available in the configuration generation page:

1. Generate Configuration Files: Generates the scheduler configuration files in a temporary directory. This
configuration is generated from objects configured via the web interface

2. Run monitoring engine debug (-v): Enables the scheduler to check the generated configuration

3. Move Export Files: Moves the configuration files from the temporary directory to the scheduler directory

4. Restart Monitoring Engine: Restarts the scheduler to apply the new configuration files

5. Post generation command: Executes the command post-generation set at the configuration of the scheduler
level

Once setup is finished, supervision will allow you to get informations on the health status of your IT systems. For
having more information regarding the operation interface, please refer to the exploitation guide.
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CHAPTER 7

Exploitation

7.1 Presentation of the main banner

Centreon 18.10 introduces a new main banner. This one is divided in four sections:

• State of monitoring platform

• Hosts status summary

• Services status summary

• User profil

7.1.1 State of monitoring platform

This part summarizes the state of the different servers of the Centreon platform. Two icons displayed:

• If all servers are connected to the Centreon Central server.

• If the data transfer process has latency.

Note: By clicking on the pollers icon you will be able to view the various issues and directly access the server
configuration menu.

7.1.2 Hosts status summary

This part presents a summary of the status of the hosts monitored by the platform.

By clicking on each colored circle representing a status (Down, Unreachable, Up), it is possible to directly access the
Monitoring > Status Details > Hosts filtered:
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Note: Only statuses not acknowledged or not in downtime are displayed.

If hosts are in Pending state, a colored sticker is present on the hosts icon:

To access to detail, click hosts icon or on the arrow:

You will be able to visualize the total number of monitored hosts and their distributions by status. By clicking on each
status (Down, Unreachable, Up, Pending) you will access directly to the Monitoring > Status Details > Hosts menu
filtered.

7.1.3 Services status summary

This part presents a summary of the status of the services monitored by the platform.

By clicking on each colored circle representing a status (Critical, Warning, Unknown, Ok), it is possible to directly
access the Monitoring > Status Details > Services filtered:
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Note: Only statuses not acknowledged or not in downtime are displayed.

If services are in Pending state, a colored sticker is present on the services icon:

To access to detail, click services icon or on the arrow:

You will be able to visualize the total number of monitored services and their distributions by status. By clicking on
each status (Critical, Warning, Unknown, OK, Pending) you will access directly to the Monitoring > Status Details
> Services menu filtered.

7.1.4 User profile

This last part displays the time according to the timezone selected in your profile and allows you to edit your profile
by clicking on the icon.

You can also copy the direct connection url (autologin), and log out of the Centreon interface.

7.1. Presentation of the main banner
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7.2 General

7.2.1 How to use select box

Multiple selection

There’s a variety of way to do multiple selections with Centreon’s select box

Using Shift key

You can select a range of items by holding “Shift” key between two selected items, by clicking on a first element then
a second one.

Using Control key

You can select multiple items by holding “Ctrl” key when you select an item. This feature work only on Linux and
Windows.

Select all action

You can select all elements of a select by clicking on the “Select all” button in dropdown.

This action add to selection all element even the element not visible in select dropdown. This selection is filtered using
the search fields.
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Full title on hover

When you hover a selected or unselected element, his title appears fully inside a popover.

7.3 Custom views

7.3.1 Presentation

The custom views allow each user to have his own monitoring view. A view may contain 1 to 3 columns. Each column
can contain widgets.

A widget is a module allowing certain information to be viewed on certain objects. It is possible to insert multiple
widgets of different types in the same view. By default, Centreon offers widgets allowing to obtain information on:
hosts, host groups, services, service groups. Finally, the last widget allows to view real time performance graphs.

7.3.2 Views Management

All the manipulations below take place in the page entitled Home ==> Custom Views. This page is also the first page
displayed when a user logs into Centreon.

Add view

To add a view, click on Add view.

7.3. Custom views
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• The View name field indicates the name of the view which will be visible by the user

• The Layout field allows to choose the number of columns in the view

To change an existing view, click on Edit view.

Note: The reduction in the number of columns removes the widgets associated with the column.

Share view

It is possible to share an existing view with one or more users. To do this, click on Share view.

• If the Locked field is defined as Yes, the other users cannot change the view

• The User List field allows to define the users with whom the view is shared

• The User Group List field allows to define the user groups with which the view is shared

Insert widget

To add a widget, click on Add widget.
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• The Widget Title field is used to define a name for our widget

• Choose from the table below the widget type you want to add

Customize widget

It is possible to move a widget by drag-and-drop from the title bar. To reduce a widget, click on . By default, the

information contained in the widget is refreshed regularly. To refresh it manually, click on .

To customize your widget, click on .

Delete widget

It is possible to delete the widget by clicking on .

7.3.3 Widgets Details

The paragraphs below detail the attributes of each widget after clicking on .

7.3. Custom views
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Host widget

Filters

• The Host Name Search field can be used to make a search on one hostname

• If the Display Up box is checked, the hosts with UP status will be displayed

• If the Display Down box is checked, the hosts with DOWN status will be displayed

• If the Display Unreachable box is checked, the hosts with UNREACHABLE status will be displayed

• The Acknowledgement Filter list allows to display the acknowledged or not acknowledged hosts (if the list is
empty, the two types of hosts will be displayed)

• The Downtime Filter list allows to display the hosts that are subject or not subject to a downtime (if the list is
empty, the two types of hosts will be displayed)

• The State Type list allows to display the hosts in SOFT or HARD states (if the list is empty, the two types of
hosts will be displayed)

• The Hostgroup list allows to display the hosts belonging to a certain host group (if the list is empty, all the hosts
will be displayed)

• The Results list limits the number of results

Columns

• If the Display Host Name box is checked, the host name will be displayed

• If the Display Output box is checked, the message associated with the status of the host will be displayed

• The Output Length list can be used to limit the length of the message displayed

• If the Display Status box is checked, the status of the host is displayed

• If the Display IP box is checked, the IP address of the host is displayed

• If the Display last Check box is checked, the date and the time of the last check is displayed

• If the Display Duration box is checked, the time during which the host has retained its status is displayed

• If the Display Hard State Duration box is checked, the time during which the host has retained its HARD state
is displayed

• If the Display Tries box is checked, the number tries before the validation of the status is displayed

• The Order By list allows to classify the hosts in alphabetical order according to multiple settings

Misc

• The Refresh Interval (seconds) field allows to define the time before data refreshment

Service widget

Filters

• The Host Name field can be used to make a search on one hostname

• The Service Description field can be used to make a search on service name
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• If the Display Ok box is checked, the services with OK status will be displayed

• If the Display Warning box is checked, the services with WARNING status will be displayed

• If the Display Critical box is checked, the services with CRITICAL status will be displayed

• If the Display Unknown box is checked, the services with UNKNOWN status will be displayed

• If the Display Pending box is checked, the services with PENDING status will be displayed

• The Acknowledgment Filter list allows to display the services acknowledged or not acknowledged (if the list
is empty, the two types of hosts will be displayed)

• The Downtime Filter list allows to display the services that are subject or not subject to a downtime (if the list
is empty, the two types of hosts will be displayed)

• The State Type list allows to display the services with SOFT or HARD states (if the list is empty, the two types
of hosts will be displayed)

• The Hostgroup list allows to display the services belonging hosts belonging to a certain host group (if the list
is empty, all the services will be displayed)

• The Servicegroup list allows to display the services belonging to a certain service group (if the list is empty, all
the services will be displayed)

• The Results list limits the number of results

Columns

• If the Display Host Name box is checked, the host name will be displayed

• If the Display Service Description box is checked, the name of the service will be displayed

• If the Display Output box is checked, the message associated with the status of the host will be displayed

• The Output Length list can be used to limit the length of the message displayed

• If the Display Status box is checked, the status of the host is displayed

• If the Display last Check box is checked, the date and the time of the last check is displayed

• If the Display Duration box is checked, the time during which the host has retained its status is displayed

• If the Display Hard State Duration box is checked, the time during which the host has retained its HARD state
is displayed

• If the Display Tries box is checked, the number of tries before the validation of the status is displayed

• The Order By list allows to classify the services in alphabetical order according to multiple settings

Misc

• The Refresh Interval (seconds) field allows to define the time before data refreshment

Performance Graph widget

• The Service field is used to choose the service for which the graph will be displayed

• The Graph period list is used to choose the time period for which the graph will be displayed

• The Refresh Interval (seconds) field allows to define the time before data refreshment
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Host Group widget

• The Hostgroup Name Search field can be used to choose the host groups displayed

• If the Enable Detailed Mode box is checked, all the host names and the services associated with these hosts
will be displayed for the hostgroups selected

• The Results list allows us to limit the number of results

• The Order By list is used to classify the service in alphabetical order according to multiple settings

• The Refresh Interval (seconds) field allows to define the time before data refreshment

Service Group widget

• The Servicegroup Name Search field can be used to choose the service groups displayed

• If the Enable Detailed Mode box is checked, all the host names and the services associated with these hosts
will be displayed for the service groups selected

• The Results list allows us to limit the number of results

• The Order By list is used to classify the service in alphabetical order according to multiple settings

• The Refresh Interval (seconds) field allows to define the time before data refreshment

7.4 Realtime monitoring

The Monitoring menu can be used to view the evolution of the supervision of its information system in real time.

7.4.1 Object status

Statuses are indicators for the hosts or the services. Each status has a precise meaning for the object. To each status
corresponds a code generated by the monitoring plugin according to thresholds defined by the user.

Host status

The table below summarizes all the possible statuses for a host.

Status Exit code Description
UP 0 The host is available and reachable
DOWN 1 The host is unavailable
UNREACHABLE 2 The host is unreachable

Service status

The table below summarizes all the possible statuses for a service.

Status Exit code Description
OK 0 The service presents no problem
WARNING 1 The service has reached the warning threshold
CRITICAL 2 The service has reached the critical threshold
UNKNOWN 3 The status of the service cannot be checked (e.g.: SNMP agent down, etc.)
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Advanced statuses

In addition to the standard statuses, new statuses can be used to add additional information:

• The PENDING status is a status displayed for a service or a host freshly configured but which has not yet been
checked by the scheduler.

• The UNREACHABLE status is a status indicating that the host (parental relationship) is situated downstream
of a host with a DOWN status.

• The FLAPPING status is a status indicating that the status change percentage of the object is very high. This
percentage is obtained from calculations performed by the network monitoring engine.

• The ACKNOWLEDGED status is a status indicating that the incident of the service or of the host has been taken
into account by a user.

• The DOWNTIME status is a status indicating that the incident of the service or of the host occurred during a
downtime period.

SOFT and HARD states

A host or a service can have two states:

• SOFT: Signifies that an incident has just been detected and that it has to be confirmed.

• HARD: Signifies that the status of the incident is confirmed. Once the status is confirmed, the notification
process is engaged (sending of a mail, SMS, etc.).

Status confirmation

An incident (Not-OK status) is confirmed as of the moment when the number of validation attempts has reached its
end. The configuration of an object (host or service) requires a regular check interval, a number of attempts to confirm
a Not-OK status and an irregular check interval. As soon as the first incident is detected, the state is “SOFT” until its
confirmation into “HARD”, triggering the notification process.

Example:

A service has the following check settings:

• Max check attempts: 3

• Normal check interval: 5 minutes

• Retry check interval: 1 minute

Let us imagine the following scenario:

• Instant t + 0: The service is checked, it has the OK status.

• Instant t + 5: The second check shows that the service has the CRITICAL status. The service goes into the
SOFT state (attempt 1/3).

• Instant t + 6: The third check is performed, the service still has the CRITICAL status in SOFT (attempt 2/3).

• Instant t + 7: The fourth check shows that the service still has the CRITICAL status (attempt 3/3). The number
of tests has been completed; the state is configured (HARD). The notification process is triggered.

• Instant t + 8: The service recovers OK status. It goes directly into the HARD state. The notification process is
triggered.

• Instant t + 13: The service has the WARNING status. It goes into the SOFT state (attempt 1/3).
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• Instant t + 14: The service still has the WARNING status (attempt 2/3).

• Instant t + 15: The service has the CRITICAL status. It remains in the SOFT state because it has changed status.

7.4.2 Generic actions

By default, during viewing of statuses of hosts or services, the monitoring data is refreshed automatically (15 seconds
by default). Nevertheless, several icons can be used to check the refreshing of the data. The table below summarizes
the functions of these icons:

Icon Description

Serves to refresh the results manually.

Serves to put the automatic data refreshment into pause.

Serves to restart automatic data refreshment.

7.4.3 Hosts

Viewing

To view the status of hosts, go into the menu Monitoring > Status Details > Hosts

You can use filter to adapt the view.

• To view the hosts with a problem but not acknowledged, choose Unhandled Problems in Host Status filter.

• To view all the hosts with a problem, choose Host Problems in Host Status filter.

• To view all the hosts, choose All in Host Status filter.

• To view the hosts classified by host groups, click on Hostgroups Summary menu
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Host tables

The table below gives a description of all the columns of the table displayed when viewing hosts:

Column
name

Description

S Displays the severity level of the host.

Hosts Displays the name of the host. The icon indicates that the notifications for this host are

disabled. The icon can be used to view all the performance graphs for this host.
Status Serves to view the status of the host.
IP Address Indicates the IP address of the host.
Last Check Displays the date and the time of the last check.
Duration Displays the time that the host a has kept its current status.
Hard State
Duration

Displays the time that the host a has kept its current hard state (does not appear when viewing of all
the hosts).

Tries Displays the number of tries before confirming the state.
Status
information

Displays the message explaining the status of the host.

Note: The severity column and the associated filter appear if at least one object displayed has a severity level.

Available filters

You can filter the result presented via the following filters:
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• Host: can be used to filter by name of host via an SQL LIKE type search.

• Status: can be used to filter by the status of hosts.

• Severity: can be used to filter by severity.

• Poller: can be used to filter the hosts by poller. Only the hosts of the poller selected will be displayed.

• Hostgroup: can be used to filter by host group. Only the hosts of the host group selected will be displayed.

Note: The search on text fields only starts after entry of at least 3 characters.

Host groups table

The table below gives a description of all the columns of the table displays when of the viewing host groups:

Column name Description
Host Group List of available groups of hosts.
Hosts Status Allows to display the number of hosts in UP, DOWN, UNREACHABLE or in PENDING status.
Services Status Allows to display the number of services in OK, WARNING, CRITICAL or in PENDING status.

Available filters

You can filter result by selecting poller in the select box. Only hosts monitored by poller will be displayed.

Host details

When you click on a host, the following screen appears:
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Services

Here is the listing of all services linked to the host.

Status details

The table below summarizes the attributes of this part:

Attributes Description
Host Status Displays the status of the host.
Status information Displays the information of the status of the host.
Performance Data Displays performance data associated to the check.
Current Attempt Displays the number of attempts before status validation.
State Type Displays the type of state (‘SOFT’ or ‘HARD’).
Last Check Displays the last check of the host.
Next Check Displays the next scheduled check of the host.
Latency Displays the latency in seconds between the scheduled check and the real check

execution.
Execution Time Displays the execution time of the check.
Last State Change Displays when the status of the host changed.
Current State Duration Displays the date and time from which the host is in the present state.
Last Notification Displays the sent date and time of the last notification.
Next Notification Displays the sent date and time of the next notification.
Current Notification
Number

Displays the number of sent notifications.

Is This Host Flapping? Indicates if the host is in flapping state.
Percent State Change Displays the percentage change of state.
In Scheduled Downtime? Indicates if the host is in scheduled downtime.
Last Update Displays the date and time of the last information update.

Options and controls available

Options and controls allow you to perform a number of actions on the host. Options are described in the chapter
Exploitation guide.

Links

The Links container allows to display the hostgroups linked to the host.

Notifications

The Notifications container allows to display the contacts and contactgroups linked to the host which will receive
notifications.

7.4.4 Services

Viewing

To view the status of service, go into the Monitoring > Status Details > Services menu.
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The grey search bar can be used to filter the result displays. You can use filter to adapt the view.

• To view the services problems but not acknowledged, choose Unhandled Problems in Service Status filter

• To view all the services in non-OK status, choose Service Problems in Service Status filter

• To view all the services, choose All in Service Status filter

• To view all services (short by host) in any status, click on Services Grid menu and choose for Display Details

• To view the number of services (short by host and by status), click on Services Grid menu and choose for
Display Summary
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• To view the all services (short by host’s groups) in any status, click on Services by Hostgroup menu and choose
for Display Details

• To view the number of services (short by host’s groups), click on Services by Hostgroup menu and choose for
Display Summary
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• To view the all services (short by services groups), click on Services by Servicegroup menu and choose for
Display Details

• To view the number of services (short by services groups), click on Services by Servicegroup menu and choose
for Display Summary
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• To view the meta services, go to Monitoring > Status Details > Services menu and filter with meta host.

Services table

The table below gives a description of all the columns of the table displayed when viewing services:
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Column
name

Description

S Displays the severity level of the service.

Host Displays the name of host. The icon allows to access to host’s page details.

Services Displays the name of service. The icon indicates that notifications are disabled for this

service. The icon Allows to display performance graphs of the service. The icon
allows to access to service’s page details.

Duration Displays the duration of the actual status.
Last
Check

Displays the date and time of the last check.

Tries Displays the number of attempts before status validation.
Status in-
formation

Displays the message explaining the status of the service.

Note: The severity column and the associated filter appear if at least one object displayed has a severity level.

Note: The Hard State Duration doesn’t appear in All Services menu.

Tables of objects groups

The table below gives a description of all the columns of the table of services sorted by groups:

Column name Description
Host or Host Groups
Hosts or Service Group
Hosts

Allows to display hosts or hosts linked to hostgroups or hosts linked to
servicegroups. The icon allows to display all services linked to the host. The

icon allows to display all performance graphs of services linked to the host.
Status Displays the status of the host.
Services information Displays the status of services (details mode) or the number of services classified by

status (summary mode).

Service details

When you click on a service, the following screen appears:
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Status details

The table below summarizes the attributes of this part:
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Attributes Description
Service Status Displays the status of the service.
Status information Displays the information of the status of the service.
Extended status
information

Displays long output of the service.

Performance Data Displays performance data associated to the check.
Current Attempt Displays the number of attempts before status validation.
State Type Displays the type of state (‘SOFT’ or ‘HARD’).
Last Check Type Indicates if the last type of check is ‘active’ or ‘passive’.
Last Check Displays the last check of the service.
Next Scheduled Active
Check

Displays the next scheduled check of the service.

Latency Displays the latency in seconds between the scheduled check and the real check
execution.

Check Duration Displays the execution time of the check.
Last State Change Displays when the status of the service changed.
Current State Duration Displays the date and time from which the host is in the present state.
Last Service Notification Displays the sent date and time of the last notification.
Current Notification
Number

Displays the number of sent notifications.

Is This Service Flapping? Indicates if the service is in flapping state.
Percent State Change Displays the percentage change of state.
In Scheduled Downtime? Indicates if the host is in scheduled downtime.
Last Update Displays the date and time of the last information update.

Options and controls available

Options and controls allow you to perform a number of actions on the host. Options are described in the chapter
Exploitation guide.

Detailed graph and status graph

The Detailed Graph and Status Graph allow to display performance graphs and the history chart statutes for this
service.

Host and Service Shortcuts

Options are described in the chapter Exploitation guide.

Links

The Links container allows to display:

• The groups of hosts which this service is linked.

• The groups of services which this service is linked.

• The categories of services which this service is linked.
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Notifications

The Notifications container allows to display the contacts and contactgroups linked to the host which will receive
notifications.

7.4.5 Downtime

To visualize downtimes:

1. Go to the menu Monitoring > Downtimes > Downtimes

The table below gives a description of all the columns:

Column name Description
Host Name Indicates the name of host.
Services Indicates the name of service.
Start Time and End Time Displays the start and end date and time.
Duration Displays the duration of the downtime.
Author Displays the name of user who set the downtime.
Comments Displays the comments linked to the downtime.
Started Indicates if the downtime is started or not.
Fixed Indicates if the start and end datetime if fix or not.

Available filters

You can filter the result presented via the following filters:

• Host: can be used to filter by name of host via an SQL LIKE type search.

• Service: can be used to filter by name of service via an SQL LIKE type search.

• Output: can be used to filter by output of services.

• Author: can be used to filter by author.

• Display Finished Downtime: allows to display recurring finished downtime.

• Display Downtime Cycle: allows to display recurring downtime.

Note: The search on text fields only begins entering the third character.

7.4.6 Comments

To visualize comments:

1. Go to the menu Monitoring > Downtimes >Comments
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The table below gives a description of all the columns:

Column name Description
Host Name Indicates the name of host.
Services (only available of services page) Indicates the name of service.
Entry Time Displays the date and time when comment had been written.
Author Displays the name of user who set the comment.
Comments Displays the content of the comment.
Persistent Indicates if the comment is persistent when the monitoring engine restarts.

Available filters

You can filter the result presented via the following filters:

• Host: can be used to filter by name of host via an SQL LIKE type search.

• Service: can be used to filter by name of service via an SQL LIKE type search.

• Output: can be used to filter by output of services.

Note: The search on text fields only begins entering the third character.

7.5 Performance graphs management

7.5.1 Graphs

Definition

Centreon can be used to generate graphs from monitoring information. There are two types of graph:

• Performance graphs serve to view the evolution of services intuitively. E.g.: filling level of a hard disc, network
traffic, etc.

• History graphs (or status graphs) serve to view the evolution of the statuses of a service.

Performance graphs always have a time period for the x-axis and a unit as the y-axis (Volts, Octets, etc.). History
graphs always have a time period for the x-axis, their y-axes do not vary. Only the color of the graph can be used to
view the status of the object:

• Green for OK status

• Orange for WARNING status

• Red for CRITICAL status

• Grey for UNKNOWN status
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Example of performance graphs:

Visualization

Performance graphs

There are several ways to view performance graphs:

• Viewing the graph in the list of services (Monitoring > Status Details > Services) by mouse-over the icon

• Viewing the graph from the page of details of an object by clicking on View graphs for host

• Go into the menu: Monitoring > Performances to view multiple graphs

Status graphs

In the same way as for the performance graphs, there are several ways of accessing status history graphs:

• From the detail page of an object (see the chapter covering real time monitoring)

• From the menu: Monitoring > Performances, by first selecting a specific service and then checking the Display
Status box.

Viewing multiple graphs

To view all graphs, go into the menu: Monitoring > Performances.
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All the filter on the top of the page allow you to select the graph you want on the period you want.

The option Hosts show all graphs to all hosts linked.

The option Services show only graph of the selected services.

The option Graph Period can be used to select the time period over which we want to view the graphs. The drop-down
list can be used to select predefined time periods.

It is possible to choose the time period manually using the fields From and To, this replaces the predefined selection.

Several actions are possible on the graphs:

• Split components: separates multiple curves of a graph into multiple graphs each containing one curve

• Display Status: Displays the history graphs linked to performance graphs displayed

To use the data from graphs, it is possible to:

• View the performance graph on one day, one week, one month or one year by clicking on the performance
graphs of your choice

• Back-up the graph by clicking on the icon

• Download all the data contained in the graph in the .csv format by clicking on the icon

7.5.2 Customizing graphs

Graphs template

Definition

Graph models are models which can be used to shape graph layouts. Graph models can be used to configure multiple
presentation settings including the y-axis measurement, the width and the height of the graph, or colors, etc.
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Configuration

To add a new graph model:

1. Go into the menu: Monitoring > Performances

2. In the left menu, click on Templates

3. Click on Add

General informations

• The field Template name can be used to define a name for the graph model.

• The Vertical label field contains the legend for the y-axis (type of datameasured).

• The Width and Height fields are expressed in pixels and express respectively the width and the height of the
model.

• The Lower limit field defines the minimum limit of the y-axis.

• The Upper limit field defines the maximum limit of the y-axis.

• The Base list defines the calculation base for the data during the scaling of the graph y-axis. Use 1024 for
measurements like the Bytes (1 KB = 1 024 Bytes) and 1 000 for measurements like the volt (1 kV = 1 000
Volts).

Note: If the box Size to max is checked, the graph will automatically be scaled to the scale of the maximum value
ordinates shown on the given period.
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Using a graph template

You can add this layout model on edition of the object for:

• A service (or a model of service) by going into the Service Extended Info tab in configuration form.

• A command

Curves

Definition

A curve is the representation of the evolution performance data (metrics produced from the collection of data) visible
via performance graphs. A graph may contain multiple curves. It is possible to customize the curves by changing
certain settings: curve profile, position of the curves on the graph, legend and additional information (average, total
value, etc.).

Configuration

To add a new curve model:

1. Go into the menu: Monitoring > Performances

2. In the left menu, click on Curves

3. Click on Add
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• The Template Name field defines the name of the model.

• The Hosts/Service Data Source lists defines the host/service for which this curve will be used. If this informa-
tion is not filled in, this curve definition will be applied to all services in which this metric appears.

• The Data Source Name field can be used to select the metric which will use this definition. The List of known
metrics list can be used to choose the already existing metrics used by the services.

• If the Stack box is checked, this curve will be stacked on the others (useful to see the proportion of one metric
in relation to another).

• If the Order box is checked, the Order list can be used to define the order display / stacking of the curve (the
smaller the number, the closer it will be to the x-axis).

• If the Invert box is checked, the curve is reversed (opposite to the absolute value) in relation to the y-axis (useful
for seeing the proportion of the incoming traffic compared to the outgoing traffic).

• The Thickness list expresses the thickness of the line of the curve (expressed in pixels).

• The Line color field defines the color of the curve.

• The Area color field concerns the filling color of the curve if the Filling option is checked, (see below). It
contains 3 fields that correspond with the colors of the OK, WARNING and CRITICAL statuses respectively.

• The Transparency field defines the level of transparency of the contour color.

• If the Filling box is checked, all the curve is filled with the color of the area defined according to the status.
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The attributes below concern the information situated under the graph.

• The Legend field defines the legend of the curve.

• If the Display only the legend box is checked, the curve will be masked but the legend will be visible.

• The Empty lines after this legend list can be used to define a certain number of empty lines after the legend.

• If the Print max value box is checked, the maximum value reached by the curve will be displayed.

• If the Print min value box is checked, the minimum value reached by the curve will be displayed.

• If the Round the min and max box is checked, the minimum and maximum values will be rounded.

• If the Print Average box is checked, the average of the points of the curve will be displayed.

• If the Print last value box is checked, the last value collected from the curve will be displayed.

• If the Print total value box is checked, the total value is displayed (sum of all the values of the curve on the
selected period).

• The Comment field can be used to comment on the curve.

Some examples of curves

Stacked curves:

Reversed curves:

Curves with filling:
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Virtual metrics

Definition

The virtual metrics are the display of curves resulting from the processing / aggregation of data from a set of data. The
set of data corresponds to various values of curves on the period covered by the graph. The creation of virtual metrics
is based on the RPN (Reverse Polish Notation) language.

Two types of sets of data are available:

• CDEF: this command creates a new set of points starting from one or more series of data. The aggregation is
performed on each point (data).

• VDEF: the result of each aggregation is a value and a time component. This result can also be used in the
miscellaneous graph and printing elements.

CDEF v. VDEF The CDEF type works on a set of points (data table). The result of the processing (e.g.: multipli-
cation by 8 to convert bits into Bytes) will be a set of points. The VDEF type enables us to extract the maximum from
a set of points.

Note: For more information on the RPN type notation, refer to the official RRD documentation

Configuration

To add a virtual metric:

1. Go into the menu: Monitoring > Performances

2. In the left menu, click on Metrics (under Virtuals)

3. Click on Add
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• The field Metric name defines the name of the metric.

• The Host/Service Data Source list can be used to define the service from which to work the metrics.

• The DEF Type field defines the type of data set used to calculate the virtual curve.

• The RPN (Reverse Polish Notation) Function field defines the formula to be used to calculate the virtual
metric.

Note: It is not possible to add together the metrics of different services. However, it is possible to add virtual metrics
for the calculation of a new metric.

• The Metric Unit field defines the units of the metric.

• The Warning threshold field defines the alert threshold to be displayed on the graph.

• The Critical threshold field defines the critical threshold to be displayed on the graph.

• If the Hidden Graph and Legend box is checked, the curve and the legend are hidden.

• The Comment field can be used comment on the metric.

7.6 Monitoring management

7.6.1 Acknowledging a problem

Principle

When a host or a service presents an incident and this incident is confirmed, the notification process is triggered, it can
generate a notification sent to a contact. If the problem persists and depending on the configuration produced (resend
a notification at regular time intervals, escalation of notification, etc.) it is possible that other alerts be send.

The acknowledgment of an incident can be used to stop the notification process (sending of notifications) until the host
or the service recovers its nominal status.

Example of use:
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A service is charged with checking the health of the hard disks in a disc array. A hard disk goes down on a disk array,
a notification is sent. The supervision operator acknowledges the service specifying that a team is in the process of
dealing with the problem. Notifications are no longer sent. The service will return to its nominal state after a change
of disk.

Note: The acknowledgment of an incident signifies the taking into account of the problem by a user of the supervision
(and not the correction of the incident which can only be effective when the check returns to its nominal state).

Practice

To acknowledge an incident, there are two solutions:

From real time monitoring

1. Go into the menu: Monitoring ==> Status Details ==> Hosts (or services)

2. Select the object(s) that you want acknowledge

3. In the menu: More actions click on Hosts: Acknowledge or on Services: Acknowledge

The following window appears:

• If the Sticky box is checked, the acknowledgment will be maintained in case of a change of Not-OK status (E.g.:
DOWN to REACHABLE or WARNING to CRITICAL). Otherwise, the acknowledgment disappears and the
notification process is reactivated.

• If the Notify box is checked, a notification is sent to the contacts linked to the object to warn that the incident
on the resource has been acknowledged (in the situation the contact possesses the activity acknowledgment
notification filter).

• If the Persistent box is checked, the acknowledgment will be maintained in the case of a restart of the scheduler.
Otherwise, the acknowledgment disappears and the notification process is reactivated.

• The Comment field is generally used to provide the reason of the acknowledgment, it is mandatory

• If the Acknowledge services attached to hosts box is checked, all the services linked to the host will be
acknowledged (option visible only if we acknowledge a host).
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• If the Force active checks box is checked, a command will be sent to the scheduler to recheck the resource as
soon as possible.

To delete the acknowledgment of an incident on an object:

1. Go into the menu: Monitoring ==> Status Details ==> Hosts (or services)

2. Select the objects you want to delete the acknowledgment

3. In the menu: More actions, click on Hosts: Disacknowledge or on Services: Disacknowledge

From the detailed sheet of an object

From of the detail page of an object, click on the icon associated with the Acknowledged field in the Options
frame

You will access the dedicated page enabling you to acknowledge the incident.

Note: The fields are identical to the window obtained from the real time monitoring menu.

7.6.2 Add comment

Principle

Centreon allows us to add comments on an object. This Comment is visible by anyone having access to the resource
(host or service). A comment has the following properties:

• Hostname

• Servicename if the comment is associated with a service

• Date of entry of the comment

• Author of the comment

• The contents of the comment

• The validity of the comment against a restart of the scheduler

Practice

There are two solutions to add a comment:

From the detailed sheet of an object

1. Access to the details page of the object

2. In the category Host/Service Commands, click on Add a comment for this host/this service

From the Comment menu

1. Go into the menu: Monitoring ==> Downtimes ==> Comments

2. Click on Add a Service Comment or Add a Host Comment
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Attributes

The following window appears:

• The Host Name field defines the host concerned by the comment.

• If you have chosen to add a comment to a Service, the Service field can be used to select the service concerned
by the comment.

• If the Persistent box is checked, the comment will be maintained in the event of a restart of the scheduler.

• The Comments field contains the comment itself.

7.6.3 Programming a downtime period

Principle

A downtime period is a time period during which the notifications to a resource are disabled. Downtimes period are
used during a programmed maintenance operation, they save us receiving false-positive alerts.

Note: It is important to select the all the resources necessary to prevent false-positives and false-negatives. In addition,
the time spent in this state is taken into account during the generation of the availability data.

There are two types of downtime:

• The fixed downtime: it starts and stops at the preview time.

• The flexible downtime: it starts during the preview time window as soon as an incident is detected and finishes
when preview time in seconds expires.

Practice

There are three different possibilities to define a downtime:

• From the detail sheets of a host or of the service

• From the real time monitoring interface

• From the Downtime menu

From the detailed sheet of an object

1. Access the detail page of an object

2. In the category: Commands, click on Schedule downtime for this host/service
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From real time monitoring

1. Go into the menu: Monitoring ==> Status Details ==> Hosts (or services)

2. Select the(s) object(s) on which you want to program a downtime period

3. In the menu: More actions..., click on Hosts : Set Downtime or Services : Set Downtime

From the Downtime menu

1. Go into the menu: Monitoring ==> Downtimes ==> Downtimes

2. Click on Add a service downtime or Add a host downtime

Attributes

• The Host Name field defines the host concerned by the downtime

• The Service field defines the service concerned by the downtime

• If the Fixed box is checked the downtime is fixed. Otherwise, it is flexible

• If the downtime is flexible, the Duration field defines the length of the downtime

• The Start Time and End Time fields define the beginning and end date of the downtime

• The Comments field can be used to indicate why the downtime is defined

7.6.4 Management of checks

Principle

It is possible to temporarily enable or disable check on a host or a service.

Warning: Changes to settings checks do not affect the configuration of the object in the database. These changes
are made on the supervision in real time, they are canceled if the scheduler is restarted.

Practice

From the detailed sheet of an object

1. Access the details page of the object

2. In the category: Options go to the line: Active checks to check the state of the checks.

To:

• Enable the check, click on

• Disable the check, click on
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From real time monitoring

1. Go into the menu: Monitoring ==> Status Details ==> Hosts (or services)

2. Select the object(s) on which you want to enable or disable the check

3. In the menu: More actions... click on:

• Hosts : Disable Check or Services: Disable Check to stop the check on a host or a service

• Hosts: Enable Check or Services: Enable Check to enable the check of a host or of a service

7.6.5 Submitting a result

Principle

For passively checked services, it is possible send a result manually to the scheduler so that it is taken into account.

Practice

To submit a result, access the details page of the object. In the category Service Commands click on Submit result
for this service

Attributes

• The Host Name and Service fields define the host and the service the result will be submitted

• The Check result field defines the status of the service

• The Check output field defines the message to be displayed for the service

• The Performance data field can be used to define performance data for the generation of graphs

7.6.6 Management of notifications

Principle

It is possible to temporarily enable or disable the notification of a host or a service.

Warning: Changes the notifications settings do not affect the configuration of the object in the database. These
changes are made on the real time monitoring, they are canceled if the scheduler is restarted.

Practice

There are two ways of managing the notifications:
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From the detailed sheet of an object

1. Access the details page of the object

2. In the category: Options go to the line: Service Notifications

To:

• Enable the notification, click on

• Disable the notification, click on

From real time monitoring

1. Go into the menu: Monitoring ==> Status Details ==> Hosts (or services)

2. Select the host(s) / service(s) you want enable or disable the notification

3. In the menu: More actions... click on:

• Hosts: Disable Notification or Services: Disable Notification to stop the notification of a host or of a service

• Hosts: Enable Notification or Services: Enable Notification to enable the notification of a host or a service

7.6.7 Reprogramming checks

Principle

By default, the checks (checks on a service) are executed at regular intervals following the configuration defined by
the user. It is possible to interact on the check scheduling pile to change the programming of the checks.

There are two types of programming:

• Normal programming: the service check is given priority in the scheduler queue (asap).

• Forced programming: the service check is given priority in the scheduler queue (asap) even if the time of the
execution request is outside the check period or if the service is not of the active type.

Practice

There are two ways of forcing the check of a service:

From the detailed sheet of the object

1. Access the detail page of the object

2. In the category Host Commands (or Service Commands), click on Re-schedule the next check for this host
/ service or Re-schedule the next check for this host / service (forced)
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From real time monitoring

1. Go into the menu: Monitoring ==> Status Details ==> Hosts (or services)

2. Select the objects to for which you want to force the check

3. In the menu: More actions... click on Schedule immediate check or Schedule immediate check (Forced)

7.7 Reporting

7.7.1 Dashboard

Description

The availability reports of monitoring objects from Centreon web interface allows to display the availability rate about
hosts, hostgroup or servicegroup on a selected period.

Visualization

To access to availability reports:

1. Go into the menu: Reporting ==> Dashboard

2. In the left menu, click on Host

3. Select defined host in Host list

• The Reporting Period allows to select a predefined period or to define it manually using From to to fields.
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• The Host state table displays the availability rates of object.

• The State Breakdowns For Host Services table displays the availability of linked objects.

• The timeline allows you to see intuitively the status of the object in short time.

Moreover, clicking on a day in the timeline, you get the report of the day:

It is also possible to view web reports:

• The groups of hosts: Click on Host Groups in the left menu
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• The groups of services: Click on Service Groups in the left menu
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The allows to export data into CSV file.

Note: It is also possible to access to availability of a service by clicking on the service name in the host or servicegroup
report.
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7.8 Event logs

7.8.1 Definition

Event logs allow us to:

• View the changes of status and state of the monitored objects

• See the notifications sent and their recipients

These logs can be viewed over a given time.

7.8.2 Viewing

To view the event logs, go into the menu: Monitoring ==> Event logs.
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The upper menu can be used to select the hosts and/or the services event logs to be viewed. You can choose a selection
of services or hosts in a list contained in servicegroup or hostgroup.

The Message Type and status field can be used to select the search filters to display the events required.

The Log Period field can be used to select the time period for which we want to view the events. The drop-down
list can be used to select generic time periods. If the drop-down list is empty it is possible to choose the time period
manually using the From and To fields.

The table can be used to view the results.

7.8.3 Filtering the logs

Type of logs

It is possible to display several types of log on the given period:

• Services with the WARNING status by checking Alerts

• Errors (hosts not available or services with the CRITICAL status) by checking Errors

• Confirmed incidents on hosts or services (“HARD”) by clicking on Hard only

• Notifications sent by clicking on Notifications

Status of the host or the service

Note: The choice made here affects the checked boxes in Message Type. It is also possible to view the different
messages by selecting the status desired for the hosts or services manually.

7.8.4 Results

The table below describes the columns of the table of results.

Column name Description
Day Show log date
Time Show log time
Object Name Show object name (host and/or service)
Status Show object status
Type Show object state (‘SOFT’ or ‘HARD’)
Retry Show number of try since actual status
Output Show output for the host or the service
Contact Show contact (only for notification)
Command Show the notification command (only for notification)
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CHAPTER 8

Administration

8.1 Access control list

Access control lists (ACL) serve to limit users’ access to the web interface Centreon via miscellaneous rules. The
ACL are also used to create multiple user profiles making possible to focalise on a precise set of resources.

Note: The management of access checks is a function specific to Centreon, the export of the configuration to the
monitoring engine is not necessary to enable them.

Access groups are groups containing the Centreon users. For each access group, it is possible to define three types of
access:

• Access filters to resources serve to limit access to Centreon objects (hosts, services, etc.)

• Access filters to menus serve to limit access to Centreon menus

• Access filters on actions serve to limit access to actions that the user can undertake on a monitoring engine or
on the resources themselves (program a downtime, stop a monitoring engine, etc.)

Note: A user can belong to several access groups thus making it possible to add together all the access authorizations.

The ACLs respect very strict rules:

• Centreon administrators are not subject to ACLs (property of the contact).

• A user (non-administrator) who does not belong to any access group has no right on the monitoring platform
(screen empty after logging in).

• The ACLs are recalculated every minute; this why it is sometimes necessary to wait a few seconds before seeing
the change applied to the profile.

Note: The addition of additional modules to Centreon sometimes makes it possible to add additional filters to the
access groups. E.g.: Centreon modules BI, BAM and MAP can be subjected to filters.

8.1.1 Access groups

To add an access group:

1. Go into the menu: Administration ==> ACL

2. Click on Add
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General information

• The Group Name and Alias fields define the name and the alias of the group

• The Linked Contacts list can be used to link contacts to the access group

• The Linked Contact Groups list can be used to link groups of contacts to the access group

• The Status field can be used to enable or disable the access group

Note:
The contact group can be groups coming from the LDAP directory connected to the Centreon interface.

Groups created in Centreon interface should not have the same name as LDAP groups to avoid problems.

Authorizations information

The lists presented in this tab can be used to link the various types of access already created to the access group.

8.1.2 Resources Access

The access filters for the resources serve to limit the viewing of objects (hosts, host groups, services and service
groups) to a user profile.

To add resources access filter:

1. Go into the menu: Administration ==> ACL

2. In the left menu, click on Resources Access
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3. Click on Add

Note: Once the filters on the resources are set, you can to view the result via the menu: Check User View, next to
the add option.

General information

• The Access list name and Description fields define the name and the description of the filter

• The Linked groups list can be used to link access groups to this resource filter

• The Status and Comments fields serve to enable / disable the filter and to comment on it

Hosts Resources

The Hosts Resources tab enables us to add:

• Hosts

• Host groups

If the Include all hosts or Include all hostgroups box is checked, all newly created objects will be added to the filter
automatically.

Note: It is possible to explicitly exclude hosts from the filter (useful in cases where only 1 or 2 hosts must not be part
of the filter) if Include all hosts* or Include all hostgroups options are checked.

Services Resources

The Services Resources tab can be used to add service groups to the filter.
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Meta Services

The Meta-Services tab can be used to add meta-services to the filter.

Filters

• The Poller Filter list can be used to select the hosts according to monitoring poller (if none is selected all the
pollers are taken into account)

• The Host Category Filter list can be used to filter the hosts by category

• The Service Category Filter list can be used to filter the services by category

Warning: The filters by poller or by category of object are inclusion filters (UNION). Only the objects belonging
to these filters in addition to groups of objects (hosts and services) will be visible.

8.1.3 Menus Access

The access filters to the menu serve to limiter the access to various menus of the Centreon interface. The menus are
ranked as follows:

• Level 1 menus (Home, Monitoring, Views, etc.)

• Level 2 menus (Monitoring ==> Hosts, Monitoring ==> Services, etc.)

• Level 3 context menus (Monitoring ==> Services ==> By Hosts / Details)

• Level 4 context menus (Monitoring ==> Services ==> By Hosts / Details ==> Problems)

Note: To access to a level of menu ‘n-1’, the user must have access to the menu of level ‘n’ otherwise he will not be
able to view the menu via the interface. If this is not the case the user will have to access directly to the page concerned
via a direct link (autologin, etc.).

To add an access filter to the menus:

1. Go into the menu: Administration ==> ACL

2. In the left menu, click on Menus Access

3. Click on Add
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• The ACL Definition and Alias fields define the name and the alias of the access filter

• The Status field is used to enable or disable the filter

• The Linked Groups list can be used to associate an access group to the filter

• The Accessible Pages can be used to associate menus to the filter (The parent menu should be checked to be
able to access the child menu)

• The Comments field gives indications on the filter

Warning: On the access definition to the Configuration ==> Hosts and Configuration ==> Service menus, it is
possible to give read only or read / write access to various objects.

Note: At each addition of a new Centreon module possessing a web interface accessible via a new menu, it should be
added in the access groups so that the users can access.
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8.1.4 Actions Access

Filters on actions enable us to limit access to actions that can be effective on resources (hosts and services) and on
monitoring engines (stopping notifications, restarting the scheduler, etc.).

To add an access filter to the actions:

1. Go into the menu: Administration ==> ACL

2. In the left menu, click on Actions Access

3. Click on Add

• The Action Name and Description fields contain the name of the filter and its description

• The Linked Groups list serves to associate an access group to the filter

The table below describes the general access functionalities:

Field Associated actions
Display Top Counter The monitoring overview will be displayed at the top of all pages
Display Top Counter pollers statistics The monitoring poller status overview will be displayed at the top of all pages.
Display Poller Listing The poller filter will be available to users in the monitoring consoles

The table below describes the access to the configuration generation:

Field Associated actions
Generate Configuration
Files

Allows users to generate, test and export configuration to pollers and to restart the
monitoring scheduler

Generate SNMP Trap
configuration

Allows users to generate and export configuration of the SNMP traps for the
Centreontrapd process on pollers and to restart this one

The table below describes all the actions that can be authorized on the scheduler:
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Field Associated actions
Shutdown Monitoring Engine Allows users to stop the monitoring systems
Restart Monitoring Engine Allows users to restart the monitoring systems
Enable/Disable notifications Allows users to enable or disable notifications
Enable/Disable service checks Allows users to enable or disable service checks
Enable/Disable passive service checks Allows users to enable or disable passive service checks
Enable/Disable passive host checks Allows users to enable or disable passive host checks
Enable/Disable Event Handlers Allows users to enable or disable event handlers
Enable/Disable Flap Detection Allows users to enable or disable flap detection
Enable/Disable Obsessive service checks Allows users to enable or disable obsessive service checks
Enable/Disable Obsessive host checks Allows users to enable or disable obsessive host checks
Enable/Disable Performance Data Allows users to enable or disable performance data processing

The table below describes all the actions that can be authorized on services:

Field Associated actions
Enable/Disable Checks for a service Allows users to enable or disable checks of a service
Enable/Disable Notifications for a service Allows users to enable or disable notifications of a ser-

vice
Acknowledge a service Allows users to acknowledge a service
Re-schedule the next check for a service Allows users to re-schedule next check of a service
Re-schedule the next check for a service (Forced) Allows users to re-schedule next check of a service by

placing its priority to the top
Schedule downtime for a service Allows users to schedule downtime on a service
Add/Delete a comment for a service Allows users to add or delete a comment of a service
Enable/Disable Event Handler for a service Allows users to enable or disable the event handler pro-

cessing of a service
Allows users to enable or disable flap detection of a ser-
vice

Allows users to enable or disable flap detection of a ser-
vice

Enable/Disable passive checks of a service Allows users to enable or disable passive checks of a
service

Submit result for a service Allows users to submit result to a service

Display executed command by monitoring engine
Allow the display of the executed command for a service

The table below describes the all the actions that can be authorized on hosts:

Field Associated actions
Enable/Disable Checks for a host Allows users to enable or disable checks of a host
Enable/Disable Notifications for a host Allows users to enable or disable notifications of a host
Acknowledge a host Allows users to acknowledge a host
Disaknowledge a host Allows users to disacknowledge a host
Schedule the check for a host Allows users to re-schedule next check of a host
Schedule the check for a host (Forced) Allows users to re-schedule next check of a host by placing its priority

to the top
Schedule downtime for a host Allows users to schedule downtime on a host
Add/Delete a comment for a host Allows users to add or delete a comment of a host
Enable/Disable Event Handler for a host Allows users to enable or disable the event handler processing of a

host
Enable/Disable Flap Detection for a host Allows users to enable or disable flap detection of a host
Enable/Disable Checks services of a
host

Allows users to enable or disable all service checks of a host

Enable/Disable Notifications services of
a host

Allows users to enable or disable service notifications of a host

Submit result for a host Allows users to submit result to a host
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• The Status field is used to enable or disable the filter

8.1.5 Reload ACL

It is possible of reload the ACLs manually:

1. Go into the menu: Administration ==> ACL

2. In the left menu, click on Reload ACL

3. Select the user(s) you want to reload the ACL

4. In the More actions menu, click on Reload ACL

8.2 Distributed architecture

The Centreon distributed architectures are describe into the architecture chapter:

• Distributed architecture

• Distributed architecture with Remote server

8.2.1 Install a poller

Select your installation method:

Using Centreon el7 ISO

Installation

The installation process is identical to a Centreon Central server installed from the ISO file of Centreon.

Note: Refer to the documentation: installation

For the question Which server type would you like to install? choose the option Poller server.
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SSH Key exchange

The communication between a central server and a poller server is done by SSH.

You should exchange the SSH keys between the servers.

If you don’t have any private SSH keys on the central server for the centreon user:

# su - centreon
$ ssh-keygen -t rsa

Generate a password for the centreon user on the new server:

# passwd centreon

Copy this key on the new server:

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

Configure new poller in Centreon

Since Centreon 18.10, a new wizard is available to define a new poller to a Centreon platform.

8.2. Distributed architecture
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Note: It is possible to configure a new Poller manually, however Centreon recommends using the following procedure.

Go to the Configuration > Pollers menu and click Add server with wizard to configure a new poller.

Select Add a Centreon Poller and click Next:

Set the name, the IP address of the poller and the IP address of the Centreon Central server and click Next:

Note: The IP address of the poller is the IP address or the FQDN to access to this poller since Centreon Central
server.

The IP address of the Centreon Central server is the IP address or the FQDN to access to the Centreon Central server
since the poller.

If you want to link this poller to the Centreon Server, click Apply:
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Else, if you want to link this poller to an existing Remote Server, select the Remote Server in the list. Then click
Apply:

Note: If you want to change the sense of the flow between the Centreon Server (or the Remote Server and the Poller,
check the Advanced: reverse Centreon Broker communication flow checkbox.

Wait a few seconds, the wizard will configure your new server.

The Poller is now configured:

Go to the Simplified configuration of Centreon with IMP chapter to configure your first monitoring.

Using Centreon packages

Installation

SELinux should be disabled. In order to do this, you have to edit the file /etc/selinux/config and replace “enforcing”
by “disabled”:

SELINUX=disabled

Note: After saving the file, please reboot your operating system to apply the changes.

A quick check of SELinux status:

$ getenforce
Disabled

Add firewall rules or disable the firewall by running following commands:
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# systemctl stop firewalld
# systemctl disable firewalld
# systemctl status firewalld

To install Centreon software from the repository, you should first install centreon-release package which will provide
the repository file.

Centreon repository installation:

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

The repository is now installed.

Perform the command:

# yum install centreon-poller-centreon-engine

SSH Key exchange

The communication between a central server and a poller server is done by SSH.

You should exchange the SSH keys between the servers.

If you don’t have any private SSH keys on the central server for the centreon user:

# su - centreon
$ ssh-keygen -t rsa

Generate a password for the centreon user on the new server:

# passwd centreon

Copy this key on the new server:

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

Configure new poller in Centreon

Since Centreon 18.10, a new wizard is available to define a new poller to a Centreon platform.

Note: It is possible to configure a new Poller manually, however Centreon recommends using the following procedure.

Go to the Configuration > Pollers menu and click Add server with wizard to configure a new poller.

Select Add a Centreon Poller and click Next:
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Set the name, the IP address of the poller and the IP address of the Centreon Central server and click Next:

Note: The IP address of the poller is the IP address or the FQDN to access to this poller since Centreon Central
server.

The IP address of the Centreon Central server is the IP address or the FQDN to access to the Centreon Central server
since the poller.

If you want to link this poller to the Centreon Server, click Apply:
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Else, if you want to link this poller to an existing Remote Server, select the Remote Server in the list. Then click
Apply:

Note: If you want to change the sense of the flow between the Centreon Server (or the Remote Server and the Poller,
check the Advanced: reverse Centreon Broker communication flow checkbox.

Wait a few seconds, the wizard will configure your new server.

The Poller is now configured:

Go to the Simplified configuration of Centreon with IMP chapter to configure your first monitoring.

8.2.2 Install a Remote Server

The installation of a Remote Server is quite similar to install a Centreon. Select your installation method:

Using Centreon el7 ISO

Installation

Step 1: Starting up the server To install Centreon, start up your server from the Centreon ISO image in version
el7. Start up with Install CentOS 7:
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Step 2: Choosing a language Choose the language for the installation process then click on Done:

Step 3: Selecting components Click on the Installation Type menu:

You can choose different options:
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• Central with database: Install Centreon (web interface and database), monitoring engine and broker.

• Central without database: Install Centreon (web interface only), monitoring engine and broker.

• Poller: Install poller (monitoring engine and broker only).

• Database: Install database server (use with Central server without database option).

Step 4: System configuration

Partitioning the disk Click on the Installation Destination menu:
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Select the hard disk drive and the I will configure partitioning option, then click on Done:

Using the + button create, your own partitioning file system following the instructions in documentation prerequisites,
then click on Done:

A confirmation window appears. Click on Accept Changes to validate the partitioning:
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Configuring the network Click on the Network & Hostname menu:

Enable all network interfaces and define hostname, then click on Done:
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Configuring the timezone Click on the Date & Time menu:

Select timezone, then click on the configuration button:
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To enable or add a NTP server, click on OK, then on Done:

Beginning the installation Once configuration is complete, click on Begin Installation:
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Click on Root Password:

Define and confirm root user password. Click on Done:
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Wait for installation process to finish:

When the installation is complete, click on Reboot:
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Updating the system packages

Connect to your server using a terminal and execute the command:

# yum update

Accept all GPG keys:
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Then restart your server with the following command:

# reboot

Configuration

Log in to Centreon web interface via the URL: http://[SERVER_IP]/centreon. The Centreon setup wizard is displayed.
Click on Next.

The Centreon setup wizard checks the availability of the modules. Click on Next.
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Click on Next.

Click on Next.
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Provide the information on the admin user, then click on Next.

By default, the ‘localhost’ server is defined and the root password is empty. If you use a remote database server,
change these entries. In this case, you only need to define a password for the user accessing the Centreon databases,
i.e., ‘Centreon’. Click on Next.
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Note: If the Add innodb_file_per_table=1 in my.cnf file under the [mysqld] section and restart MySQL Server.
error message appears, perform the following operations:

1. Log in to the ‘root’ user on your server.

2. Modify this file:

/etc/my.cnf

3. Add these lines to the file:

[mysqld]
innodb_file_per_table=1

4. Restart mysql service:

# systemctl restart mysql

5. Click on Refresh.

The Centreon setup wizard configures the databases. Click on Next.
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At this point, you will be able to install the Centreon server modules.

Click on Install.

Once installation is complete, click on Next.

At this point, an advertisement informs you of the latest Centreon news and products. If your platform is connected to
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the internet, you will receive the up-to-date information. If you are not online, only information on the current version
will be displayed.

The installation is complete. Click on Finish.

You can now log in.

You can change the default language of the web interface:

1. Click on your profile on the top right of the banner

2. Click on Edit profile

3. Select your language in the **Language* field
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4. Click on Save

Enable Remote Server option

Connect to your Remoter Server and execute following command:

# /usr/share/centreon/bin/centreon -u admin -p centreon -a enableRemote -o CentreonRemoteServer -v @IP_CENTREON_CENTRAL

Note: Replace @IP_CENTREON_CENTRAL by the IP of the Centreon server seen by the poller

This command will enable Remote Server mode:

Starting Centreon Remote enable process:

Limiting Menu Access...Success
Limiting Actions...Done

Notifying Master...Success

Set ’remote’ instance type...Done

Centreon Remote enabling finished.

SSH Key exchange

The communication between a central server and a poller server is done by SSH.

You should exchange the SSH keys between the servers.

If you don’t have any private SSH keys on the central server for the centreon user:

# su - centreon
$ ssh-keygen -t rsa

Generate a password for the centreon user on the new server:

# passwd centreon

Copy this key on the new server:

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER
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Configure new Remote Server in Centreon

Since Centreon 18.10, a new wizard is available to define a new Remote Server to a Centreon platform

Note: It is possible to configure a new Poller manually, however Centreon recommends using the following procedure.

Go to the Configuration > Pollers menu and click Add server with wizard to configure a new poller.

Select Add a Centreon Remote Server and click Next:

If you define a new Server, select Manual input option and fill the form:
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If you enabled the Remote Server option during the installation of your server, select the option Select a Remote
Server, then select your server and fill the form:

Note: The Database user and Database password are the credentials defined during the installation of the Remote
Server

Click on Next

Select the poller(s) to link to this Remote Server , then click on Apply:

The wizard will configure your new server:
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The Remote Server is now configured:

Go to the Simplified configuration of Centreon with IMP chapter to configure your first monitoring.

Using Centreon packages

Pre-installation steps

SELinux should be disabled. To do this, you first have to edit the file /etc/selinux/config and replace “enforcing” by
“disabled”:

SELINUX=disabled

Note: After saving the file, please reboot your operating system to apply the changes.

A quick check of SELinux status:

$ getenforce
Disabled

Installing the repository

Redhat Software collections repository To install Centreon you will need to set up the official software collections
repository supported by Redhat.

Note: Software collections are required in order to install PHP 7 and associated libs (Centreon requirement).

Software collections repository installation:
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# yum install centos-release-scl

The repository is now installed.

Centreon repository To install Centreon software from the repository, you should first install the centreon-release
package which will provide the repository file.

Centreon repository installation:

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

The repository is now installed.

Installing a Centreon central server

This chapter describes the installation of a Centreon central server.

Installing Centreon central server with database Run the command:

# yum install centreon
# systemctl restart mysql

Installing Centreon central server without database Run the command:

# yum install centreon-base-config-centreon-engine

Installing MySQL on the dedicated server Run the commands:

# yum install centreon-database
# systemctl restart mysql

Note: centreon-database package installs a database server optimized for use with Centreon.

Database management system The MySQL database server should be available to complete installation (locally or
not). MariaDB is recommended.

It is necessary to modify LimitNOFILE limitation. Setting this option into /etc/my.cnf will NOT work.

Run the commands:

# mkdir -p /etc/systemd/system/mariadb.service.d/
# echo -ne "[Service]\nLimitNOFILE=32000\n" | tee /etc/systemd/system/mariadb.service.d/limits.conf
# systemctl daemon-reload
# systemctl restart mysql

Setting the PHP timezone You must set the PHP timezone. Perform the command:

# echo "date.timezone = Europe/Paris" > /etc/opt/rh/rh-php71/php.d/php-timezone.ini
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Note: Change Europe/Paris to your timezone.

After saving the file, please do not forget to restart the apache server:

# systemctl restart httpd

Configuring/disabling the firewall Add firewall rules or disable the firewall by running following commands:

# systemctl stop firewalld
# systemctl disable firewalld
# systemctl status firewalld

Launching services during system bootup To make services automatically start during system bootup run these
commands on the central server:

# systemctl enable httpd
# systemctl enable snmpd
# systemctl enable snmptrapd
# systemctl enable rh-php71-php-fpm
# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

Note: If MySQL database is on a dedicated server, execute the enable command of mysql on the database server.

Concluding the installation Before starting the web installation process, you will need to execute:

# systemctl start rh-php71-php-fpm
# systemctl start httpd
# systemctl start mysqld
# systemctl start cbd
# systemctl start snmpd
# systemctl start snmptrapd

Configuration

Log in to Centreon web interface via the URL: http://[SERVER_IP]/centreon. The Centreon setup wizard is displayed.
Click on Next.
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The Centreon setup wizard checks the availability of the modules. Click on Next.

Click on Next.
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Click on Next.

Provide the information on the admin user, then click on Next.

By default, the ‘localhost’ server is defined and the root password is empty. If you use a remote database server,
change these entries. In this case, you only need to define a password for the user accessing the Centreon databases,
i.e., ‘Centreon’. Click on Next.
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Note: If the Add innodb_file_per_table=1 in my.cnf file under the [mysqld] section and restart MySQL Server.
error message appears, perform the following operations:

1. Log in to the ‘root’ user on your server.

2. Modify this file:

/etc/my.cnf

3. Add these lines to the file:

[mysqld]
innodb_file_per_table=1

4. Restart mysql service:

# systemctl restart mysql

5. Click on Refresh.

The Centreon setup wizard configures the databases. Click on Next.
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At this point, you will be able to install the Centreon server modules.

Click on Install.

Once installation is complete, click on Next.

At this point, an advertisement informs you of the latest Centreon news and products. If your platform is connected to
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the internet, you will receive the up-to-date information. If you are not online, only information on the current version
will be displayed.

The installation is complete. Click on Finish.

You can now log in.

You can change the default language of the web interface:

1. Click on your profile on the top right of the banner

2. Click on Edit profile

3. Select your language in the **Language* field
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4. Click on Save

Enable Remote Server option

Connect to your Remoter Server and execute following command:

# /usr/share/centreon/bin/centreon -u admin -p centreon -a enableRemote -o CentreonRemoteServer -v @IP_CENTREON_CENTRAL

Note: Replace @IP_CENTREON_CENTRAL by the IP of the Centreon server seen by the poller

This command will enable Remote Server mode:

Starting Centreon Remote enable process:

Limiting Menu Access...Success
Limiting Actions...Done

Notifying Master...Success

Set ’remote’ instance type...Done

Centreon Remote enabling finished.

SSH Key exchange

The communication between a central server and a poller server is done by SSH.

You should exchange the SSH keys between the servers.

If you don’t have any private SSH keys on the central server for the centreon user:

# su - centreon
$ ssh-keygen -t rsa

Generate a password for the centreon user on the new server:

# passwd centreon

Copy this key on the new server:

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER
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Configure new Remote Server in Centreon

Since Centreon 18.10, a new wizard is available to define a new Remote Server to a Centreon platform

Note: It is possible to configure a new Poller manually, however Centreon recommends using the following procedure.

Go to the Configuration > Pollers menu and click Add server with wizard to configure a new poller.

Select Add a Centreon Remote Server and click Next:

If you define a new Server, select Manual input option and fill the form:
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If you enabled the Remote Server option during the installation of your server, select the option Select a Remote
Server, then select your server and fill the form:

Note: The Database user and Database password are the credentials defined during the installation of the Remote
Server

Click on Next

Select the poller(s) to link to this Remote Server , then click on Apply:

The wizard will configure your new server:
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The Remote Server is now configured:

Go to the Simplified configuration of Centreon with IMP chapter to configure your first monitoring.

8.2.3 Status of the Pollers and Remote Servers

The status of the Centreon platform is available usng the Administration > Platform Status menu.

Broker Statistics

To view the statistics of the Centreon Broker components, go to the menu Administration > Platform Status >
Broker Statistics menu and select the poller:
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Engine Statistics

It is also possible to view the performance of monitoring engines as performance graphs. Administration > Platform
Status > Engine Statistics menu and select the poller:
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8.2.4 Advanced configuration of Poller

Centreon Broker and firewall

Sometimes it is not possible to initialize the Centreon Broker flow from the poller (or Remote Server) to the Centreon
Central server of the Remote Server.

Centreon has developed the possibility to initialize the flow from the Centreon Central server to the poller or the
Remote Server to the poller.

Go to Configuration > Pollers > Broker configuration menu and click on the Centreon Broker SQL configuration
of the Centreon Central server or the Remote Server.

Go to the Input tab and add a new TCP - IPv4 entry.

Set the Name of the configuration, the TCP Connection port to connected to the Poller and the Host to connect to,
then Save your configuration.

Go to Configuration > Pollers > Broker configuration menu and click on the Broker module of your poller.

Go to Output tab and modify the Output 1 - IPv4 form:
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1. Remove the entry for Host to connect to

2. Control the Connection port

3. Set Yes for One peer retention option.

Click Save and generate configuration of impacted servers.

Centreon Broker Flow Authentication

If you wish to authenticate pollers that are sending data to your monitoring system then you can optionaly use Centreon
Broker authentication mechanism, which is based on X.509 certificates.

First generate a Certificate Authority certificate with OpenSSL. ca.key will be the private key (to store securely), while
ca.crt will be the public certificate with which we will authenticate incoming connections:
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$> openssl req -x509 -newkey rsa:2048 -nodes -keyout ca.key -out ca.crt -days 365

Now we can generate certificates using the CA key:

$> openssl req -new -newkey rsa:2048 -nodes -keyout central.key -out central.csr -days 365
$> openssl req -new -newkey rsa:2048 -nodes -keyout poller.key -out poller.csr -days 365
$> openssl x509 -req -in central.csr -CA ca.crt -CAkey ca.key -CAcreateserial -out central.crt -days 365 -sha256
$> openssl x509 -req -in poller.csr -CA ca.crt -CAkey ca.key -CAcreateserial -out poller.crt -days 365 -sha256

Place central.key, central.crt and ca.crt on the Centreon central server (in /etc/centreon-broker for example) and
poller.key, poller.crt and ca.crt on your poller.

Now we need to configure Centreon Broker to use these files. Go to Configuration > Pollers > Broker configuration.
For central-broker-master, in the Input tab, you need to set the following parameters for central-broker-master-input.

• Enable TLS encryption = Yes

• Private key file = /etc/centreon-broker/central.key

• Public certificate = /etc/centreon-broker/central.crt

• Trusted CA’s certificate = /etc/centreon-broker/ca.crt

Similarly for your poller, you will need to modify it’s TCP output in the Output tab with the following parameters.

• Enable TLS encryption = Yes

• Private key file = /etc/centreon-broker/poller.key

• Public certificate = /etc/centreon-broker/poller.crt

• Trusted CA’s certificate = /etc/centreon-broker/ca.crt

Regenerate the configuration of the affected pollers (Configuration > Pollers) and you’re good.

Centreontrapd Configuration

Poller

It is necessary to change the configuration files of Centreontrapd so that the service can question the SQLite database
(see the chapter: SNMP traps).

Remote Server

The configuration of Centreontrapd on a Remote Poller is identical as a Centreon Central Server.
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To go further with Centreon Broker

This section aims to help user understand how Centreon Broker works and how it should be configured. It references
Centreon’s best practices and describe the various options used by Centreon Broker.

General Overview

Centreon Broker is at is core a simple multiplexing engine. It takes events from Inputs and send them to various
Outputs. Inputs are typically other instances of Centreon Broker over TCP/IP, while Outputs can be a SQL database,
other brokers, a BI/BAM engine, Centreon Map, etc.

Each Input or Output has a type that describe what it does and several parameters, some of them mandatory and other
optional. Additionally, an Output can have a Failover that will start when the Output is in an error state to allow
retention of data.

An important distinction to make is the standalone Centreon Broker versus a Centreon Broker installed as Centreon
Engine’s module. Both have the exact same capabilities and support the same Inputs and Outputs. The difference is that
Centreon Broker configured as a module will be automatically started when Centreon Engine starts and automatically
generates the events associated to this Centreon Engine. Often, those modules only have one Output to an instance of
Centreon Broker acting as a concentrator.

Main Configuration Page

This section lists all the instances of Centreon Broker configured in your park, either in standalone or module mode.
Each instance has a name, is associated with a poller, has a number of Inputs, Outputs, and Loggers, and can be
‘enabled’ or ‘disabled’.

A poller of type ‘Central’ will have three instances of Centreon Broker by default. One Centreon Broker installed
as a module for Centreon Engine (here called central-module-master), one Centreon Broker acting as a stand-alone
concentrator (here called central-broker-master) and one Centreon Broker specialized in generating the RRD data
used by the graphs (here called central-rrd-master). A best practice is to always use a separate instance of Centreon
Broker to generate RRD data. This way, an issue in the RRD stack will not cause any issue in your main monitoring.

As expected, central-module-master has only one Output and zero Input. Configured as a module to Centreon Engine,
it generates events on its own and forward them to the standalone instance of Centreon Broker.

A poller generally only have an instance of Centreon Broker, configured as a module for Centreon Engine.

Broker General Configuration Page

This section lists all the general options associated with an instance of Centreon Broker.

Main options:

Poller The poller where this instance lives.

Name The name of this instance.

Config file name The name of the configuration file used by this instance.

Retention path When an Output is in an error state, a Failover is launched. Failovers save data in files called retention
files. Those in turn are saved in the directory specified here. Best practice is ‘/var/lib/centreon-broker/’

Status This is used to enable or disable this instance.

Log options:
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Write timestamp If activated, each log entry is preceded by the timestamp of the time it was written down. This is
useful to know when an error occurred. Best practice is ‘Yes’.

Write thread id If activated, each log entry is preceded by the ID of the thread being executed at this instant. This is
only useful for advanced debugging purpose. Best practice is ‘No’.

Advanced Options:

Statistics Centreon Broker has a mechanism of on-demand status reporting that can be enabled here. This is used by
Centreon Web to check the status of this instance at any time, to know which Inputs and Outputs are in an error
state, and to generate various statistics on event processing. Best practice is ‘Yes’.

Correlation Centreon Broker has a mechanism of top-level correlation. This should only be activated if top-level
correlation has been properly configured in Centreon Web. In all other cases, default to ‘No’.

Event queue max size The max size of the in-memory queue, in events. If the number of events in memory exceeds
this number, Centreon Broker will start to use ‘temporary files’ to prevent Broker from using too much memory
at the cost of additional disk I/O. The exact number can be tweaked to use more or less memory. A good default
is ‘50000’.

If ‘Statistics’ is enabled, on-demand status can be queried manually through a file placed in /var/lib/centreon-
broker/name.stats.

Broker Input Configuration Page

This section lists all the Inputs activated for this instance of Centreon Broker. Centreon Broker can have as many
Inputs as needed.

Inputs read events from a TCP connection. All Inputs have the following parameters:

Name The name of the input. Must be unique.

Serialization protocol The protocol that was used to serialize the data. Can be either ‘BBDO’ or ‘NDO’. NDO is an
old textual protocol that suffers from very poor performance, poor density of data, and poor security. BBDO
is a next-gen binary protocol that is effective and secure. NDO is deprecated. It should never be used in new
installation. Best practice is ‘BBDO’.

Compression If compression was used to serialize the data. Can be ‘auto’, ‘yes’, or ‘no’. If left on ‘auto’ Centreon
Broker will detect if compression was used while doing a TCP handshake (or assume no compression was used
for files). Default to ‘auto’ for TCP, ‘no’ for files.

Filter category The categories of events accepted by this Input. If empty, no restriction on events accepted. If filled,
only events of the given type will be processed. Input that accept data from Centreon Engines’ Broker module
should be set to accept only ‘Neb’ events.

Connection Port Which port will be used for the connection. Mandatory.

Host to connect to This important parameter will decide if this input will listen or attempt to initiate a connection.
Left empty, this input will listen on its given port. If filled, this input will attempt to initiate a connection to the
given host/port.

Enable TLS encryption Enable the encryption of the flux. For the encryption to work, the private key file, the public
certificate and the trusted CA’s certificate need to be set on both end. Default to ‘auto’, i.e ‘no’ unless TCP
negotiation has been activated and the remote endpoint has activated encryption.

Private Key File The private key file used for the encryption.

Public certificate The public certificate used for the encryption.

Trusted CA’s certificate The trusted CA certificate used for the encryption.
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Enable negotiation Enable negotiation. If ‘yes’, this Input will try to negotiate encryption and compression with the
remote endpoint.

One peer retention mode By default, a listening input will accept any number of incoming connections. In ‘one peer
retention’ mode only one connection is accepted at the same time, on a first-come first-serve basis. Default to
‘no’.

To reiterate, TCP Input can either listen on a given port or can attempt to initiate a connection if a host is given. This
allow flexible network topology.

Broker Logger Configuration Page

This section lists all the loggers activated for this instance of Centreon Broker. Centreon Broker can have as many
loggers as needed.

For each logger, the parameters are:

Type 4 types of loggers are managed by Centreon Broker.

1. ‘File’: This logger will write its log into the file specified into its ‘name’ parameter.

2. ‘Standard’: This logger will write into the standard output if named ‘stdout’ or ‘cout’ or into the standard
error output if named ‘stderr’ or ‘cerr’.

3. ‘Syslog’: This logger will write into the syslog as provided by the system, prefixed by ‘centreonbroker’.

4. ‘Monitoring’: This logger will write into the log of Centreon Engine. It can only be activated if this
instance of Centreon Broker is a module.

Name The name of this logger. This name must be the path of a file if the logger has the type ‘File’ or ‘stdout’, ‘cout’,
‘stderr’ or ‘cerr’ if the logger has the type ‘Standard’. This option is mandatory.

Configuration messages Should configuration messages be logged? Configuration messages are one-time messages
that pop-up when Centreon Broker is started. Default is ‘Yes’.

Debug messages Should debug messages be logged? Debug messages are messages used to debug Broker’s behavior.
They are extremely verbose and should not be used in a production environment. Default is ‘No’.

Error messages Should error messages be logged? Error messages are messages logged when a runtime error occurs.
They are generally important. Default is ‘Yes’.

Informational messages Should informational messages be logged? Informational messages are messages that are
used to provide an information on a specific subject. They are somewhat verbose. Default is ‘No’.

Logging level The level of the verbosity accepted by this logger. The higher the verbosity, the more messages will be
logged. Default to ‘Base’.

Additionally, the type ‘File’ has the following parameter:

Max file size The maximum size of log file in bytes. When the file has reached its limit, old data will be overwritten
in a round robin fashion.

A Broker will usually have at least one ‘File’ logger which will log Configuration and Error messages. Others can be
configured freely. A maximal logger (every category to ‘Yes’ and logging level to ‘Very detailed’) is valuable to debug
some issues, but be warned that it will generate a very large amount of data quickly.

Broker Output Configuration Page

This section lists all the Outputs activated for this instance of Centreon Broker. Centreon Broker can have as many
Outputs as needed.
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For each Outputs, the parameters are:

Type There is a several types for Outputs managed by Centreon Broker.

1. ‘TCP - IPV4’ and ‘TCP - IPV6’: This Output forwards data to another server, either another Centreon
Broker or Centreon Map.

2. File: This Output write data into a file.

3. RRD: This Output will generate RRD data from performance data.

4. Storage: This Output will write metrics into the database and generate performance data.

5. SQL: This Output will write real time status into Centreon’s database.

6. Dumper Reader: This Output will read from a database when Broker is asked to synchronize databases.

7. Dumper Writer: This Output will write into a database when Broker is asked to synchronize databases.

8. BAM Monitoring: This Output will generate BAM data from raw events and update real time BAM status.

9. BAM Reporting: This Output will write long term BAM logs that can then be used by BI.

Failover A Failover is an Output that will be started when this Output is in error state. Example are TCP connections
gone haywire, MySQL server suddenly disconnecting, etc. By default, each Output has an automatic Failover
that will automatically store data in retention files and replay it when the primary Output recover from its error
state. This is what you want in 99% of the case. Otherwise, you can specify here another Output that will act as
a Failover if this is what you need.

Retry interval When this Output is in error state, this parameter control how much time the Output will wait before
retrying. Default is one attempt every 30 seconds.

Buffering timeout When this Output is in error state, Centreon Broker will wait this much time before launching
the Failover. This is mainly useful if you want to make Centreon Broker wait for another software to initialize
before activating its Failover. In all other cases, this should not be used. Default is 0 seconds.

Filter category The categories of events accepted by this Output. If empty, no restriction on events accepted. If filled,
only events of the given type will be processed. The exact best practices are Output specific.

1. ‘BAM Reporting’ should only accept ‘Bam’ events.

2. ‘Dump Writer’ should only accept ‘Dumper’ events.

3. ‘RRD’ should only accept ‘Storage’ events.

In all other cases, no restriction should be configured.

Events generated by an Output are re-injected into Centreon Broker’s event queue.

Some Outputs only works when consuming data generated by another Output. A ‘RRD’ Output consumes data from a
Storage Output, a ‘Dumper Writer’ consumes data from a ‘Dumper Reader’, and a ‘BAM Reporting’ Output consumes
data from a ‘BAM Monitoring’ Output.

Centreon Web needs at least an active Output ‘SQL’ to activate its real time monitoring capabilities. The Outputs
‘Storage’ and ‘RRD’ are needed to activate Centreon Web metric plotting. The Output ‘BAM Monitoring’ is needed
for real time BAM data and the Output ‘BAM Reporting’ for BI report.

Due to the fully distributed nature of Centreon Broker, producer and consumer Outputs can be located on logically or
physically different instances, as long as they are connected to each other.

Important: Centreon Web 2.x features two databases, the configuration database and the real time database. Those
are respectively called ‘centreon’ and ‘centreon-storage’. Different Outputs expect different database in their configu-
ration.
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Output Type Expected database
SQL centreon-storage
Storage centreon-storage
Dumper Reader centreon
Dumper Writer centreon
BAM Monitoring centreon
BAM Reporting centreon-storage

TCP Outputs TCP Outputs forward events to a a remote endpoint. As with TCP Inputs, TCP Output can either
listen on a given port or can attempt to initiate a connection if a host parameter is given. This allow flexible network
topology.

Outputs of type ‘TCP’ have the following parameters:

Serialization protocol The protocol that will be used to serialize the data. Can be either ‘BBDO’ or ‘NDO’. NDO is
an old textual protocol that suffers from very poor performance, poor density of data, and poor security. BBDO
is a next-gen binary protocol that is effective and secure. NDO is deprecated. It should never be used in new
installation. Best practice is ‘BBDO’.

Enable negotiation Enable negotiation. If ‘yes’, this Output will try to negotiate encryption and compression with
the remote endpoint.

Connection Port Which port will be used for the connection. Mandatory.

Host to connect to This important parameter will decide if this Output will listen or attempt to initiate a connection.
Left empty, this Output will listen on its given port. If filled, this Output will attempt to initiate a connection to
the given host/port.

Enable TLS encryption Enable the encryption of the flux. For the encryption to work, the private key file, the public
certificate and the trusted CA’s certificate need to be set on both end. Default to ‘auto’, i.e ‘no’ unless TCP
negotiation has been activated and the remote endpoint has activated encryption.

Private Key File The private key file used for the encryption.

Public certificate The public certificate used for the encryption.

Trusted CA’s certificate The trusted CA certificate used for the encryption.

One peer retention mode By default, a listening Output will accept any number of incoming connections. In ‘one
peer retention’ mode only one connection is accepted at the same time, on a first-come first-serve basis. Default
to ‘no’.

Compression If compression should be used to serialize the data. Can be ‘auto’, ‘yes’, or ‘no’. If left on ‘auto’
Centreon Broker will detect if compression is supported by the endpoint during a TCP negotiation. Default to
‘auto’ for TCP.

Compression Level The level of compression that should be used, from 1 to 9. Default (or if not filled) is 6. The
higher the compression level is, the higher the compression will be at the cost of processing power.

Compression Buffer The size of the compression buffer that should be used. Best practice is ‘0’ or nothing.

File Outputs File Outputs send events into a file on the disk. Additionally, they have the capability of replaying the
data of this file if used as a Failover Output. Most ‘File’ Outputs will be used as Failovers.

Outputs of type ‘File’ have the following parameters:

Serialization protocol The protocol that will be used to serialize the data. Can be either ‘BBDO’ or ‘NDO’. NDO is
an old textual protocol that suffers from very poor performance, poor density of data, and poor security. BBDO
is a next-gen binary protocol that is effective and secure. NDO is deprecated. It should never be used in new
installation. Best practice is ‘BBDO’.
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File path The path of the file being written to.

Compression If compression should be used to serialize the data. Can be ‘auto’, ‘yes’, or ‘no’. ‘auto’ is equal to ‘no’
for files.

Compression Level The level of compression that should be used, from 1 to 9. Default (or if not filled) is 6. The
higher the compression level is, the higher the compression will be at the cost of processing power.

Compression Buffer The size of the compression buffer that should be used. Best practice is ‘0’ or nothing.

RRD Outputs RRD Outputs generate RRD data (used by Centreon Web to generate graphs) from metrics data
generated by a ‘Storage’ Output. Best practice is to isolate this Output on its own instance of Centreon Broker to
ensure that an issue in the RRD stack will not have any effect on the main instance of Centreon Broker.

Outputs of type ‘RRD’ have the following parameters:

RRD file directory for metrics The directory where the RRD files of the metrics will be written. A good default is
/var/lib/centreon/metrics/.

RRD file directory for statuses The directory where the RRD files of the statuses will be written. A good default is
/var/lib/centreon/statuse/

TCP port The port used by RRDCached, if RRDCached has been configured on this server. If not, nothing.

Unix socket The Unix socket used by RRDCached, if RRDCached has been configured on this server. If not, nothing.

Write metrics Should RRD metric files be written? Default ‘yes’.

Write status Should RRD status files be written? Default ‘yes’.

Storage Outputs Perfdata storage Outputs save metric data into a database and generate RRD data used by the
‘RRD’ Output. This Output usually generates a lot of queries and is very performance intensive. If Centreon Broker
is slow, tweaking the Maximum Queries Per Transaction parameter of this Output is the first optimization to attempt.

This Output can be tasked to rebuild ‘RRD’ data from a database of stored metric data. This is usually a costly, slow
process, during which it is still able to process new metric data, though not as quickly.

Outputs of type ‘Storage’ have the following parameters:

DB Type The type of the database being accessed. MariaDB is a state-of-the-art database that has been extensively
tested with Centreon. We advice the use of MariaDB.

DB Port The port of the database being accessed.

DB User The user used by this Output to connect to this database.

DB Name The name of this database. In Centreon term, this is the database containing the real-time monitoring data,
generally called ‘centreon-storage’.

DB Password The password used by this Output to connect to this database.

Maximum queries per transaction This parameter is used to batch several queries in large transaction. This allow
fine performance tuning but can generate latency if not enough queries are generated to fill those batches. The
Default is 20000 queries per transaction. If you have very low load and unexpectedly high latency, try lowering
this number. If you have a very high load and high latency, try raising this number.

Transaction commit timeout How many seconds are allowed to pass before a forced commit is made. Default is
infinite. If you have very low load and unexpectedly high latency, try 5 seconds.

Replication enabled Should Centreon Broker check that the replication status of this database is complete before
trying to insert data in it? Only useful if replication is enabled for this database.

Rebuild check interval in seconds The amount of seconds between each rebuild check. Default 300 seconds.
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Store in performance data in data_bin Should this Output saves the metric data in the database? Default ‘yes’. If
‘no’, this Output will generate RRD data without saving them into the database, making a rebuild impossible.

Insert in index data Insert new ids into the database. Default ‘no’. This should never be modified unless prompted
by Centreon Support or explicitly written down into a documentation.

SQL Outputs SQL Outputs save real time status data into the real time database used by Centreon Web. This is the
most important Output for the operation of Centreon Web.

Moreover, this Output has a garbage collector that will clean old data from the database occasionally. This is an
optional process, as old data is marked ‘disabled’, and can actually be useful to keep around for debugging purpose.

Outputs of type ‘SQL’ have the following parameters:

DB Type The type of the database being accessed. MariaDB is a state-of-the-art database that has been extensively
tested with Centreon. We advice the use of MariaDB.

DB Port The port of the database being accessed.

DB User The user used by this Output to connect to this database.

DB Name The name of this database. In Centreon term, this is the database containing the real-time monitoring data,
generally called ‘centreon-storage’.

DB Password The password used by this Output to connect to this database.

Maximum queries per transaction This parameter is used to batch several queries in large transaction. This allow
fine performance tuning but can generate latency if not enough queries are generated to fill those batches. The
Default is 20000 queries per transaction. If you have very low load and unexpectedly high latency, try lowering
this number. If you have a very high load and high latency, try raising this number.

Transaction commit timeout How many seconds are allowed to pass before a forced commit is made. Default is
infinite. If you have very low load and unexpectedly high latency, try 5 seconds.

Replication enabled Should Centreon Broker check that the replication status of this database is complete before
trying to insert data in it? Only useful if replication is enabled for this database.

Cleanup check interval How many seconds between each run of the garbage collector cleaning old data in the
database? Default is never.

Instance timeout How many seconds before an instance is marked as ‘unresponding’ and all of its hosts and services
marked as ‘unknown’. Default is 300 seconds.

Lua Outputs Lua Outputs send metrics information into a script by a key-value system. The Lua script should be
on your server.

Path The path of the Lua script in your server.

Filter category The categories of events accepted by this Output. If empty, no restriction on events accepted. If filled,
only events of the given type will be processed. Outputs that accept data from Centreon Engine’s Broker module
should be set to accept only ‘Neb’ events.

Lua parameter

Type Type of the metric value.

Name/Key Name of the metric value.

Value Value of the metric.
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Dumper Reader/Writer A Dumper Reader/Writer pair is used to synchronize part of a database between two in-
stances of Centreon Broker. In the future there will be an extensive synchronization mechanism, but today it is mainly
used to synchronize BA for the BAM Poller Display mechanism.

The BAM Poller Display configuration documentation explains how to properly configure those Outputs.

Outputs of type ‘Dumper Reader’ and ‘Dumper Writer’ have the following parameters:

DB Type The type of the database being accessed. MariaDB is a state-of-the-art database that has been extensively
tested with Centreon. We advice the use of MariaDB.

DB Port The port of the database being accessed.

DB User The user used by this Output to connect to this database.

DB Name The name of this database. In Centreon term, this is the database containing the configuration data, gener-
ally called ‘centreon’.

DB Password The password used by this Output to connect to this database.

8.3 Knowledge Base

In Centreon Open Source suite since 2.8.0 version, Knowledge Base allow you to easily associate a wiki with Centreon
Web.

It creates links between hosts and services and specific procedure on wiki.

To make things more flexible, procedures can be associated with templates.

Knowledge Base is the solution to link easily a wiki to Centreon.

8.3.1 Prerequisites

Centreon & Monitoring engine

Knowledge Base is linked to Centreon since the 2.8.0 release.

The prerequisites are the same as for Centreon Web in its 2.8.x version.

Mediawiki

Centreon Knowledge Base requires MediaWiki to be installed (version = 1.31) on your system . Mediawiki is
provided with RPM packages on Centreon repository.

You can download MediaWiki here and access the documentation here.

8.3.2 Configure the access to the wiki

Before starting with Knowledge Base, you need to configure it to access the wiki database.

For this go to Administration > Parameters > Knowledge Base and complete the form
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8.3.3 User Guide

Definition

A procedure is basically a technical documentation allowing operators to know what to do when an alert is raised in
Centreon.

Procedures can be of different natures:

• describe actions to solve a problem

• escalate the issue to another team

• open a support ticket

• warn users that a specific service is down

A procedure can be defined for an host or a service.

Displayed procedure: template and overload

To avoid too much workload on the procedure deployment, the functionality allows administrator to setup a single
procedure for hosts/services.

8.3. Knowledge Base
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So a procedure can be specified for a given host/service but can be specified as well for a host/service template.

If a procedure is defined at template level, all children of the template will have the procedure attached as well unless
overloaded by a specific one. The mechanism is identical to template system in Centreon with inheritance.

Centreon Knowledge Base function is designed to avoid adding or updating manually several times the same proce-
dure in knowledge base.

When a user clicks on a host procedure:

• if a specific procedure is defined for this host, its wiki page is displayed

• if no specific procedure is defined bu the host template has a procedure, the host template wiki page is displayed

• if host template has no procedure defined, parents template will be checked for a defined procedure

• finally if no procedure is defined in the template tree, a message will warn that there is no procedure defined for
this host

It’s the same for services.

Create / Update / Delete a procedure

Navigate in Centreon front-end to Configuration -> Knowledge Base.

The module allows to:

• List Hosts / Services / Host Templates / Service Templates and attached procedures

• Create / View / Edit / View history for a Host / Services / Host Templates / Service Templates

• List Hosts / Services / Host Templates / Service Templates without procedure defined

Centreon Knowledge Base uses a wiki to store its knowledge database. All creation / edition is done through it.

Link from monitoring front end

The technical procedure is available in Centreon front-end through a link icon:

By clicking on link icon, the user is redirected to the corresponding procedure.

If the link icon is on the left of a host name, the wiki page containing the procedure for the host will be displayed.

If the link icon is on the right of a service name, the wiki page containing the procedure for the service will be
displayed.
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Synchronization

There’s a cron job that updates hosts, services and hosts/services templates configuration.

For example, if you create a page in the wiki using the usual pattern (ex: Host:Centreon-Server or
Service:Centreon-Server Disk-/),

It will add the link to the page in the URL field of object’s extended information.

Best practice for deployment

To deploy procedures in the best way, we strongly advice you to use the multi level inheritance system.

The best practice is to define procedures at template level as much as you can.

Here is an example of an host template configuration tree:

• Linux > Generic-hosts

• Windows > Generic-hosts

• RedHat > Linux

• Debian > Linux

• Active-Directory > Windows

• LDAP > Linux

To setup procedures for the RedHat host template, just proceed as indicated in Link from monitoring front end.

In the template tree we see that the RedHat template inherits from two other templates: Linux and Generic-hosts. In
this example all hosts using the RedHat host template will have the new procedure defined attached.

We could setup a procedure at a higher level in the template tree, it will impact more hosts.

For example if we define a procedure for Linux host template, all hosts using RedHat, Debian and LDAP host
templates will have the procedure attached by inheritance. Because Linux is the parent template.

Behavior is the same for service templates.

Warning: To delete a procedure link for specific host / service / template, edit the object and empty the URL field
in Extended Information tab.
If the object inherits from any template of a procedure, the empty value will overload and delete the procedure
link.

8.4 Extensions

8.4.1 Modules

The modules can be used to add additional functionalities to Centreon. It is possible to install modules using the YUM
utility or source files (*.tar.gz).

There are 3 kinds of modules:

• Community modules, under license GPL v2, developed by the Centreon community

• Core modules, under license GPL v2, developed by the Centreon team

• Proprietary modules, subject to a license, developed by Centreon
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To install a module:

1. Install the module from the associated documentation (most often in the directory:
/usr/share/centreon/www/modules on the central server)

2. Go into the menu: Administration > Extensions > Modules

Vous have two choices:

• Click on the icon to start installation of one module,

• Click on Install/Update all button to install all modules.

The table below summarizes the columns of the page:

Column Description
Name Contains module name
Real
name

Contains module complete name

Informa-
tions

Contains information about the module

Release Indicates the module version
Author Indicates the module author
Expira-
tion
date

Indicates license expiration date

Installed Indicates if the module is installed or not
Status Indicates the module status : installed, installed but without license, unknown etc.
Actions Serves to perform actions on a module :

To install a module, click on
To configure a module, click on

To delete a module, click on , and then confirm the deletion

To update a module, click on and then follow the process

8.4.2 Widgets

Widgets enable us to construct customized views, dealt with in the chapter covering widgets.

To install a widget:

1. Install the widget from the associated documentation (most commonly in the directory entitled:
/usr/share/centreon/www/widgets on the central server)

2. Go into the menu: Administration > Extensions > Widgets
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Vous have two choices:

• Click on the icon to start installation of one widget,

• Click on Install/Update all button to install all widgets.

The table below summarizes the columns of the page:

Col-
umn

Description

Title Contains widget name
De-
scrip-
tion

Contains information about the widget

Ver-
sion

Indicates widget version

Author Indicates widget author
Ac-
tions

Serves to perform actions on a widget:

To install a widget, click on

To delete a widget, click on , and then confirm the deletion

To update a widget, click on and then follow the process

8.5 Medias

Medias are images used by the Centreon web interface. These images are used to represent the monitored resource in
a more intuitive way, propose backgrounds for cartography modules, etc.

8.5.1 Image management

All the images are stored in the folder entitled: /usr/share/centreon/www/img/media of the Centreon server.

There are two methods for adding images to this folder:

• Do it manually
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• Use automatic synchronization: this method has the advantage of being able to import multiple images at the
same time.

Manual addition

To add an image in Centreon:

1. Go into the menu: Administration ==> Parameters ==> Media

2. Click on Add

The following window is displayed:

• Existing or new directory field can be used to add a new folder in the image folder or to choose an existing
folder into which the image can be copied

• Image or archive field can be used to select the image or the set of images contained in an archive which will
be imported

• Comments field can be used to describe the image

Synchronizing the images

To synchronize one or more images in the Centreon medias:

1. Copy your images in the image folder (the images may be situated in folders)

2. Make sure that the user who executes your web server has the read rights on these images

3. Go into the menu: Administration ==> Options ==> Media

4. Click on Synchronize Media Directory

The following window imports the new images:
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8.6 Administration options of the Centreon platform

The following options enable us to change the settings of the Centreon architecture.

8.6.1 Centreon UI

This part covers the configuration of the general options of the Centreon web interface.

1. Go into the menu: Administration > Parameters > Centreon UI

The following window is displayed:

8.6. Administration options of the Centreon platform
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• Directory indicates the directory where Centreon is installed

• Centreon Web Directory field indicates the web directory on which Centreon is installed

• Limit per page (default) field defines the number of objects displayed per Configuration page

• Limit per page for Monitoring field defines the number of objects displayed per page in the Monitoring menu

• Graph per page for Performances field defines the maximum number of displayed charts on Performance
page

• Number of elements loaded in select field defines the maximum number in select box

• Sessions Expiration Time field, expressed in minutes, indicates the maximum session duration

• Refresh Interval for statistics field, expressed in seconds, indicates the refreshment interval for the statistics
page

• Refresh Interval for monitoring field, expressed in seconds, indicates the refreshment interval for the objects
on the monitoring page

• Sort problems by field is used to choose how to sort the incidents in the Monitoring menu

• Order sort problems field indicates the display order for incidents, by rising or falling order of gravity

• Display downtime and acknowledgment on chart allows to display downtime and acknowledgment on chart

• Display comment on chart allows to display comment from service on chart

• Enable Autologin box authorizes the users to log into the web interface via the autologin mechanism

• Display Autologin shortcut box serves to display the connection short-cut at the top right

• Enable SSO authentication box enables SSO authentication

• SSO mode field indicates if the authentication should take place only by SSO or using local authentication as
well (Mixed). The mixed mode requires trusted client addresses.
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• SSO trusted client addresses field indicates which are hte IP/DNS of the trusted clients (corresponding to the
reverse proxy) for SSO. The trusted clients are separated by comas.

• SSO blacklist client addresses field indicates which are hte IP/DNS rejected.

• SSO login header field indicates the variables of the header that will be used as a login / pseudo (i.e
HTTP_AUTH_USER).

• SSO pattern matching login field indicates the pattern to search for in the username.

• SSO pattern replace login field indicates the replace string.

• Timezone field indicates timezone of your monitoring server.

• Centreon Support Email field indicates the e-mail address of the Customer’s service support centre for
the Centreon platform. This e-mail address will be displayed at the bottom of the page on the link Centreon
Support

Warning: SSO feature has only to be enabled in a secured and dedicated environment for SSO. Direct access to
Centreon UI from users have to be disabled.

Proxy configuration

The proxy configuration is mandatory to use CEntreon IMP offer.

Define needed information:

• Proxy URL

• Proxy port

• Proxy user

• Proxy password

Once you defined settings, test your configuration by clicking on the Text Proxy Configuration button. If your
configuration is correct, a message will indicate success:

8.6.2 Monitoring

This part covers the general options of the real time monitoring interface.

1. Go into the menu: Administration > Parameters > Monitoring
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2. Click on Monitoring

• Interval Length field indicates the time interval in seconds used to program the checks and notifications

• Images Directory field defines the image directory in which the medias are stored

• Plugins Directory field defines the directory where monitoring plugins are stored

• Start script for broker daemon field contains the path to the init script of the broker

• Directory + Mailer Binary field contains the path to the executable file for sending e-mails

• Maximum number of hosts to show and Maximum number of services to show lists contain the maximum
number of hosts or services to be displayed in the overall view (menu: Home > Home)

• Page refresh interval field defines the data refreshment interval in the overall view

• The boxes in the Default acknowledgment settings and Default downtime settings categories define the op-
tions by default that will be checked or not during definition of an acknowledgment or of a downtime

8.6.3 CentCore

This part can be used set the operation of the CentCore process.

1. Go into the menu: Administration > Parameters > Centcore
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• Enable Broker Statistics Collection field enables the retrieval of statistics from the Centreon Broker by Cent-
Core. This can be a blocking option because the reading of the pipe can be a blocking action

• Timeout value for Centcore commands field can be used to define a timeout for local commands and com-
mands via SSH process.

8.6.4 LDAP

This part can be used to configure the connection to LDAP directories.

To add a new directory:

1. Go into the menu: Administration > Options > LDAP

2. Click on Add

• Configuration name and Description fields define the name and the description of the LDAP server

• Enable LDAP authentication field serves to enable authentication via the LDAP server

• Store LDAP password field can be used to store user passwords in the database, useful to authenticate users in
the event of loss of connection with the LDAP

8.6. Administration options of the Centreon platform
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• Auto import users field serves to import the users of the LDAP directory automatically into Centreon. By
clicking on Import users manually, you can chose the users that you want to import

Note: If the Auto import users option is checked, the LDAP settings of any new user who logs into the Centreon
interface will automatically be imported into Centreon (name, first name, e-mail address, etc.). ACL profiles will be
applied on access (link to ACL). However, if this option is not checked, only the users imported manually will be able
to authenticate.

• LDAP search size limit field can be used to limit the size of user searches

• LDAP search timeout field can be used define the maximum time for the LDAP search

• Contact template field defines the contact template that will be linked to all the users imported from this LDAP
directory

• Use service DNS field indicates if it is necessary to use the DNS server to solve the IP address of the LDAP
directory

• LDAP servers field can be used to add one or more LDAP directories to which Centreon will connect

The table below summarizes the settings to add an LDAP server:

Column Description
Host address Contains the IP address or DNS name of the LDAP server
Port Indicates the connection port to access the LDAP
SSL Indicates if the SSL protocol is used for the connection to the server
TLS Indicates if the TLS protocol is used for the connection to the server

• Bind user and Bind password fields define the user name and the password for logging to the LDAP server

• Protocol version field indicates the version of the protocol using to login

• Template list can be used to pre-configure the search filters for users on the LDAP directory. These filters serve
to propose, by default, a search on the MS AD or of Posix type directories.

Note: Before any import, check the default settings proposed. If you have not selected a Model, you will need to
define the search filters manually by filling in the fields.

With CentOS 7, it’s possible to not check server certificate, follow procedure :

Add the following line in file “/etc/openldap/ldap.conf” :

TLS_REQCERT never

Then restart Apache :

service httpd restart

8.6.5 RRDTool

This part can be used to configure the RRDTool graphs generation engine and the sizes of the typefaces used for their
presentation.

1. Go into the menu: Administration > Parameters > RRDTool
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• Directory + RRDTOOL Binary field defines the path to the RRDTool executable

• The fields belonging to the categories Title Properties, Unit Properties, Axis Properties, Legend Properties
and Watermark Properties are used to define the typeface and character size for the property selected

• Enable RRDCached field serves to enable the RRDcached process (only works with the Centreon Broker)

• TCP Port field defines the port on which RRDcached listens (don’t enable the TCP connection)

• UNIX Socket path field defines the path to the Unix socket

Warning: Don’t enable RRDCacheD unless your monitoring platform encounters too many disk accesses con-
cerning the writing of data in RRD files.

8.6.6 Debug

This part can be used to configure the enabling of the logging of activity on Centreon processes.

1. Go into the menu: Administration > Parameters > Debug

8.6. Administration options of the Centreon platform
CENTREON 46-52 RUE ALBERT FR75014 PARIS

319



• Logs Directory field defines the path where event logs will be recorded

• Authentication debug box can be used to log authentications to the Centreon interface

• Monitoring Engine Import debug box enables logging of the scheduler debugging

• RRDTool debug box enables logging of the RRDTool graph engine debugging

• LDAP User Import debug box enables logging of debugging of the import of LDAP users

• SQL debug box enables the logging of SQL requests executed by the Centreon interface

• Centcore Engine debug box enables logging of Centcore process debugging

• Centreontrapd debug box enables logging of the Centreontrapd process debugging

8.7 Logging configuration changes

8.7.1 Principle

By default, Centreon retains all user actions concerning changes to configuration in a log. To access this data, go into
the menu: Administration ==> Logs.

The grey search bar can be used to filter the information presented via filters:

• Object used to filter on object name (host, service, contact, SNMP trap definition, group, etc.)
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• User used to filter by change author

• Object Type used to filter by object type

8.7.2 Practice

E.g.: To see all the actions effective by the user: admin, enter “admin” in the User field and click on Search.

The table below defines the columns in the results table:

Column Name Description
Time Indicates the date of the event
Modification type Contains the type of action effective. There are several

types of action possible:
• Added: Indicates that the object has been added
• Changed: Indicates that the object has been

changed
• Deleted: Indicates that the object has been deleted
• Massive Change: Indicates a massive change of

configuration on objects.
• Enabled: Indicates that the object has been en-

abled
• Disabled: Indicates that the object has been dis-

abled

Type Indicates object type
Object Indicates object name
Author Indicates the user having effective this change

By clicking on the name of an object, you can view the history of the changes effective on it.

The table below defines the columns of the changes table:
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Column Name Description
Date Date of the change
Contact Name Name of the person having effective the change
Type Modification type

The last column describes the change itself :
• Field name: Describes the field that has been

changed
• Before: Indicates the previous value
• After: Indicates the new value

8.8 Backup

8.8.1 How it works

Daily execution

The backup script is executed on a daily basis with a cron job located in /etc/cron.d/centreon:

##########################
# Cron for Centreon-Backup
30 3 * * * root /usr/share/centreon/cron/centreon-backup.pl >> /var/log/centreon/centreon-backup.log 2&>1

Each day at 3:30 AM, backup script checks if backup is planned on current day.

Backup types

There are two types of backup : database and configuration files.

Database backup

Database backup can be processed on two databases : centreon and centreon_storage

There are two kinds of database backup:

• MySQLdump : mysqldump command is used to backup databases. Be careful, mysqldump can take long time
on large databases.

• LVM Snapshot : Binary copy of MySQL files is done. You need to have a specific LV for MySQL (i.e.
/var/lib/mysql) and 1GB of space in its VG.

Backup format :

• yyyy-mm-dd-centreon.sql.gz

• yyyy-mm-dd-centreon_storage.sql.gz

Configuration files backup

All configuration files of central server can be saved : MySQL, Apache, PHP, SNMP, centreon, centreon-broker)

Backup format :

• yyyy-mm-dd-Monitoring-Engine.tar.gz (centreon-engine configuration files)
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• yyyy-mm-dd-Central.tar.gz (other configuration files)

8.8.2 Configuration

This part covers the configuration of centreon-backup.

1. Go into the menu: Administration ==> Parameters ==> Backup

The following window is displayed:

• Backup enabled Enable/Disable backup

• Backup directory Directory where backup will be stored

• Temporary directory Directory used during backup process

• Backup database centreon Enable backup on centreon database

• Backup database centreon_storage Enable backup on centreon_storage database

• Backup type Type of backup (MySQLdump or LVM snapshot)

• Full backup Period for full backup

• Partial backup Period for partial backup (only available with LVM snapshot backup)

• Backup retention Retention for backups (in days)

• Backup configuration files Enable backup of configuration files

8.8. Backup
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• MySQL configuration file path Path for MySQL configuration file

• SCP export enabled Enable SCP export of backups

• Remote user Remote user for SCP export

• Remote host Remote host for SCP export

• Remote directory Remote directory for SCP export

Warning: Temporary directory can not be a folder of Backup directory.

8.8.3 Restore of Centreon central server

Restore process is divided in two main steps:

• Re-install the Centreon platform following the installation documentation. Do not forget to upgrade system.

• Restore Centreon-Engines configuration files and Centreon databases

Configurations file restore

Before databases restore, you have first to restore configuration files:

# cd /var/backup
# tar -xvf YYYY-MM-DD-central.tar.gz
# cd backup/central/etc/centreon
# cp * /etc/centreon/

Databases restore

Once Centreon server reinstalled (same Centreon version), unzip centreon and centreon_storage databases backup:

# mysql
mysql> drop database centreon;
mysql> drop database centreon_storage;
mysql> CREATE database centreon;
mysql> CREATE database centreon_storage;
mysql> GRANT ALL ON centreon.* TO ’centreon’@’<centreon_ip_address>n’ IDENTIFIED BY ’password’ ;
mysql> GRANT ALL ON centreon_storage.* TO ’centreon’@’<centreon_ip_address>’ IDENTIFIED BY ’password’ ;
mysql> exit;
# gzip -d YYYY-MM-DD-centreon.sql.gz
# mysql centreon < YYYY-MM-DD-centreon.sql
# gzip -d YYYY-MM-DD-centreon_storage.sql.gz
# mysql centreon_storage < YYYY-MM-DD-centreon_storage.sql

This may take a while due to the size of “centreon_storage” databases.

Note: Password is stored in configuration files previously restored. For example $mysql_passwd field in file
“/etc/centreon/conf.pm”.

Note: The default configuration does not define any password for mysql root user. That’s why we can connect to
database using only command “mysql”.
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SSH keys restore

This step is to restore the SSH key linked to user centreon and centreon-engine within a distributed environment.
Restoration must be done manually. We must therefore initially extract this archive into a temporary directory and
move the files one by one according to their location:

# cd /var/backup
# tar -xvf AAAA-MM-JJ-centreon-engine.tar.gz
# cd backup/ssh
# mkdir -p /var/spool/centreon/.ssh/
# chmod 700 /var/spool/centreon/.ssh/
# cp -p id_rsa /var/spool/centreon/.ssh/
# cp -p id_rsa.pub /var/spool/centreon/.ssh/

Connection test from central to poller:

# su - centreon
# ssh <poller_ip_address>

Answer “Yes” to the ask question. This is about add poller print on the central server.

Note: You have to do this operations only if you work with a distributed environment.

Plugins restore

Plugins have been backuped in the archive: “YYYY-MM-DD-centreon-engine.tar.gz.” Restoration must be done
manually. We must therefore initially extract this archive into a temporary directory and move the files one by one
according to their location.

On each poller, you have to do:

# cd /var/backup
# tar -xvf YYYY-MM-DD-centreon-engine.tar.gz
# cd backup/plugins
# cp -pRf * /usr/lib/nagios/plugins

Init script restore

Some checkpoints of Oracle or SAP entail modifying the init script scheduler to add environment variables. If you
changed the init script of your scheduler, you will have to restore it. Extract the archive into a temporary directory and
move the files according to their location:

# cd /var/backup
# tar -xvf YYYY-MM-DD-centreon-engine.tar.gz
# cd backup
# cp init_d_centengine /etc/init.d/centengine

Monitoring agent restore

In case you’re using NRPE or NSCA agents, you have to reinstall and then restore configuration:

# cd /var/backup
# tar -xvf YYYY-MM-DD-centreon-engine.tar.gz
# cd backup/etc
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# cp nrpe.cfg /etc/centreon-engine/
# cp nsca.cfg /etc/centreon-engine/

Note: You have to do this only if you’re using the monitoring agents.

Generate Centreon-Engine configuration files within centreon

Last step is to generate the Centreon-Engine configuration files within Centreon.

Graphs rebuild

Once your monitoring platform is restored and all is doing well, you can rebuild RRD files in order to restore all
performance graphs. To rebuild performance graphics, go to the menu Administration -> Options -> Centstorage
-> Manage. On this page, you must select all the services and click “Rebuild RRD Database”.

Your server is now restored.

8.9 Databases partitioning

8.9.1 Overview

Centreon Partitioning module is integrated to Centreon Web, features and advantages are:

• It allows you to partition MariaDB table according to data date. Giving optimization of request execution time.

• Data purge is improved, it’s now just needed to delete old partitions.

• Extent of MariaDB crash are limited. Only needed to rebuild concerned partitions.

• Existent partitions can be partitioned

Note: There are some limitations: - Maximum number of partitions (for a MariaDB table) is 1024 - Foreign keys are
not supported

Since Centreon Web 2.8.0 version, tables logs, data_bin, log_archive_host and log_archive_service are partitioned
during installation.

More details about MariaDB partitioning here.

8.9.2 Prerequisites

The following packages are required:

• php-mysql

• Pear-DB

• MariaDB (>= 10.1)

MariaDB open_files_limit parameter must be set to 32000 in [server] section :

[server]
open_files_limit = 32000
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Note: If you install Centreon via the dedicated ISO, this parameter is already configured. If you do it on your RedHat
or CentOS Linux version, you will be able to do it manually. Don’t forget to restart mariadb processes if you change
this value in my.cnf.

If you use systemd, you need to create file “/etc/systemd/system/mariadb.service.d/mariadb.conf” :

[Service]
LimitNOFILE=32000

Then reload systemd and MariaDB :

$ systemctl daemon-reload
$ systemctl restart mariadb

Contents:

User guide

Configuration

Centreon Partitioning uses XML configuration files. There are already some configuration files for Centreon tables.

Example with partitioning-data_bin.xml
<?xml version="1.0" encoding="UTF-8"?>
<centreon-partitioning>
<table name="data_bin" schema="centreon_storage">

<activate>1</activate>
<column>ctime</column>
<type>date</type>
<duration>daily</duration>
<retention>365</retention>
<retentionforward>10</retentionforward>
<backup>

<folder>/var/backups/</folder>
<format>%Y-%m-%d</format>

</backup>
<createstmt>

CREATE TABLE IF NOT EXISTS ‘data_bin‘ (
‘id_metric‘ int(11) DEFAULT NULL,
‘ctime‘ int(11) DEFAULT NULL,
‘value‘ float DEFAULT NULL,
‘status‘ enum(’0’,’1’,’2’,’3’,’4’) DEFAULT NULL,
KEY ‘index_metric‘ (‘id_metric‘)

) ENGINE=MyISAM DEFAULT CHARSET=utf8;
</createstmt>

</table>
</centreon-partitioning>

Explanation Centreon Partitioning offers to create daily partitions. For that, your table has to have a Unix timestamp
column (time in seconds since 1970). The meaning of XML attributes/values:

• attributes ‘name’ and ‘schema’: table name and database name respectively

• tag ‘column’: column name with the Unix timestamp
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• tag ‘type’: only “date” value

• tag ‘duration’: only “daily” (future version could have: “weekly”, “monthly”)

• tag ‘timezone’: your server timezone (you can have the timezone value in file ‘/etc/sysconfig/clock’ for CentOS)

• tag ‘retention’: number of days keeping

• tag ‘retentionforward’: number of partition created by advance (useful for range partitioning)

Exploitation

Table Migration The command line does the following procedure:

• Rename existing table (‘xxx’ will be ‘xxx_old’)

• Create an empty partitioned table

• Migrate data in partitioned table (with ‘SELECT INSERT’ statement)

Warning: You need to make some checks before:

• Enough space on MariaDB Server (at least twice the size of the table. Indexes and Data)

• No data in futures (time is used for the partitioning)

• Enough memory on database server

Warning: the ‘SELECT INSERT’ statement will lock the table and maybe your production in some points (per
example table migration of ‘logs’).

Table migration is done by using the option ‘-m’:

# php /usr/share/centreon/bin/centreon-partitioning.php -m data_bin

If the table migration is ok, the old table can be deleted with the following commands:

# mysql centreon_storage
mysql> DROP TABLE data_bin_old;

Table Update After the table partitioned is done, current updates are needed. A cron script is executed every days:

0 4 * * * centreon /usr/bin/php /usr/share/centreon/cron/centreon-partitioning.php >> /var/log/centreon/centreon-partitioning.log 2>&1

Monitoring

Plugins Packs You can monitor the partitioning using Plugins Packs. You have to install the pack “Centreon DB”.

The service “Partitioning” will show you useful information.

On Web UI The menu Administration => Server Status shows you all information needed about partitioning
system. This menu lists all partitions on all MariaDB tables.
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Global information about health state of databases are present.

8.10 Custom URI

It is possible to update the URI of Centreon. For example, /centreon can be replaced by /monitoring.

To update the Centreon URI, you need to follow those steps:

• Remove this folder on central server : centreon/www/static

• Replace /centreon occurences by /your_custom_uri in centreon/www/index.html

• Replace /centreon occurences by /your_custom_uri in centreon/www/.htaccess

• Navigate to your Centreon URL

8.10. Custom URI
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CHAPTER 9

Upgrade

This chapter describes how to upgrade your Centreon monitoring platform.

This procedure is linked to your initial version of Centreon. You will have to Use packages if you installed using
Centreon ISO or RPM, and sources files if you installed from sources. Before upgrading Centreon, please don’t forget
to

make a backup.

Warning: If you try to migrate a platform using Centreon Poller Display 1.6.x, please refer to the following
migration procedure.

9.1 Upgrading to Centreon 18.10

This chapter describes how to upgrade your platform to Centreon 18.10.

Warning: At the end of this procedure, Centreon EMS users will have to request new licenses to Centreon
support.

Warning: This procedure only applies on Centreon platform installed from Centreon 3.4 packages on Red Hat /
CentOS version 7 distributions.
If this is not the case, refer to the migration procedure.

To upgrade your Centreon MAP server, refer to the associated documentation.

To upgrade your Centreon MBI server, refer to the associated documentation.

9.1.1 Performing a backup

Be sure that you have fully backed up your environment for the following servers:

• Central server

• Database server
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9.1.2 Centreon Central Server Upgrade

Upgrading the repository

To install Centreon you will need to set up the official software collections repository supported by Redhat.

Note: Software collections are required in order to install PHP 7 and associated libs (Centreon requirement).

Run the following command:

# yum install centos-release-scl

Upgrading the Centreon repository.

Run the following command:

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

Updating the Centreon solution

Clean yum cache:

# yum clean all

Upgrade all components:

# yum update centreon\*

Note: Accept new GPG keys from repositories as needed.

Complementary actions

PHP timezone needs to be set. Perform the command:

# echo "date.timezone = Europe/Paris" > /etc/opt/rh/rh-php71/php.d/php-timezone.ini

Note: Change Europe/Paris to your timezone.

Restart the services by running the following commands:

# systemctl enable rh-php71-php-fpm
# systemctl start rh-php71-php-fpm
# systemctl restart httpd
# systemctl restart cbd
# systemctl restart centengine

Finalizing the upgrade

Log into Centreon web interface to continue upgrade process:

Click on Next:
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Click on Next:

The release notes describes main changes, click on Next:

9.1. Upgrading to Centreon 18.10
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The process performs the various upgrades, click on Next:
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Your Centreon server is now up to date, click on Finish to access to log in page:

To upgrade your Centreon BAM module, refer to the associated documentation.

9.1.3 Upgrading the Pollers

Upgrading the repository

Run the following command:

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

9.1. Upgrading to Centreon 18.10
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Upgrading the Centreon solution

Upgrade all components:

# yum update centreon*

Note: Accept new GPG keys from repositories as needed.

Complementary actions

Restart the services by executing the following commands:

# systemctl restart cbd
# systemctl restart centengine

9.1.4 Centreon Poller Displat update

Refer to the migration procedure for Poller Display.

9.2 From sources

In order to upgrade Centreon from sources, download the latest Centreon package.

9.2.1 Shell installation

Extract the package:

$ tar xvfz centreon-web-2.8.x.tar.gz

Change the directory:

$ cd centreon-web-2.8.x

Run the upgrade script:

$ ./install -u /etc/centreon

Where /etc/centreon is to be replaced by configuration directory.

Prerequisites check

If [Step 01] is successful, you should not have any problem here. Otherwise, go back to [Step 01] and install the
prerequisites:

###############################################################################
# #
# Centreon (www.centreon.com) #
# Thanks for using Centreon #
# #
# v2.8.1 #
# #
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# infos@centreon.com #
# #
# Make sure you have installed and configured #
# sudo - sed - php - apache - rrdtool - mysql #
# #
###############################################################################
------------------------------------------------------------------------

Checking all needed binaries
------------------------------------------------------------------------
rm OK
cp OK
mv OK
/bin/chmod OK
/bin/chown OK
echo OK
more OK
mkdir OK
find OK
/bin/grep OK
/bin/cat OK
/bin/sed OK
------------------------------------------------------------------------

Detecting old installation
------------------------------------------------------------------------
Finding configuration file in: /etc/centreon OK
You seem to have an existing Centreon.

Main components

Load the previous installation parameters:

Do you want to use the last Centreon install parameters ?
[y/n], default to [y]:
> y

Using: /etc/centreon/instCentCore.conf
/etc/centreon/instCentPlugins.conf
/etc/centreon/instCentStorage.conf
/etc/centreon/instCentWeb.conf

Answer y to components you want to upgrade:

Do you want to install : Centreon Web Front
[y/n], default to [n]:
> y

Do you want to install : Centreon CentCore
[y/n], default to [n]:
> y

Do you want to install : Centreon Nagios Plugins
[y/n], default to [n]:
> y

Do you want to install : Centreon Snmp Traps process
[y/n], default to [n]:
> y
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Convert variables for upgrade:

Upgrade Centreon Web Front

New information is required.

The path to binaries for Centreon Web:

------------------------------------------------------------------------
Start CentWeb Installation

------------------------------------------------------------------------

Where is your Centreon binaries directory
default to [/usr/local/centreon/bin]
>
Path /usr/local/centreon/bin OK

The path for extra data for Centreon Web:

Where is your Centreon data information directory
default to [/usr/local/centreon/data]
>

Do you want me to create this directory ? [/usr/local/centreon/data]
[y/n], default to [n]:
> y
Path /usr/local/centreon/data
/usr/bin/perl OK
Finding Apache user : www-data
Finding Apache group : www-data

The group of Centreon applications : This group is used for access rights between monitoring applications:

What is the Centreon group ? [centreon]
default to [centreon]
>

Do you want me to create this group ? [centreon]
[y/n], default to [n]:
> y

The user of Centreon applications:

What is the Centreon user ? [centreon]
default to [centreon]
>

Do you want me to create this user ? [centreon]
[y/n], default to [n]:
> y

The user of broker module.

This user is used for adding rights to Centreon on the configuration and logs directories. If left empty, it will use the
Monitoring Engine user instead.

For example:

• Centreon Broker : centreon-broker
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• ndo2db : nagios

What is the Broker user ? (optional)
>

The path to monitoring engine log directory.

For example:

• Centreon Engine : /var/log/centreon-engine

• Nagios : /var/log/nagios

What is the Monitoring engine log directory ?
> /var/log/nagios

The path to monitoring plugins:

Where is your monitoring plugins (libexec) directory ?
default to [/usr/lib/nagios/plugins]
>

Path /usr/lib/nagios/plugins OK
Add group centreon to user www-data OK
Add group centreon to user nagios OK
Add group nagios to user www-data OK
Add group nagios to user centreon OK

------------------------------------------------------------------------
Configure Sudo

------------------------------------------------------------------------

The path to Monitoring engine init script.

For example :

• Centreon Engine : /etc/init.d/centengine

• Nagios : /etc/init.d/nagios

What is the Monitoring engine init.d script ?
> /etc/init.d/nagios

The path to broker module configuration directory.

For example :

• Centreon Broker : /etc/centreon-broker

• NDO : /etc/nagios

Where is the configuration directory for broker module ?
> /etc/nagios

The path to broker daemon init script.

For example :

• Centreon Broker : cbd

Where is the init script for broker module daemon ?
> cbd
Your sudo has been configured previously

Replace or not your sudoers file. For more security, you can backup the file /etc/sudoers.
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Do you want me to reconfigure your sudo ? (WARNING)
[y/n], default to [n]:
> y
Configuring Sudo OK

------------------------------------------------------------------------
Configure Apache server

------------------------------------------------------------------------
Create ’/etc/apache2/conf.d/centreon.conf’ OK
Configuring Apache OK

Do you want to reload your Apache ?
[y/n], default to [n]:
> y
Reloading Apache service OK
Preparing Centreon temporary files
Change right on /usr/local/centreon/log OK
Change right on /etc/centreon OK
Change macros for insertBaseConf.sql OK
Change macros for sql update files OK
Change macros for php files OK
Change right on /etc/nagios3 OK
Disconnect users from WebUI
All users are disconnected OK
Copy CentWeb in system directory
Install CentWeb (web front of centreon) OK
Change right for install directory
Change right for install directory OK
Install libraries OK
Write right to Smarty Cache OK
Copying libinstall OK
Change macros for centreon.cron OK
Install Centreon cron.d file OK
Change macros for centAcl.php OK
Change macros for downtimeManager.php OK
Change macros for eventReportBuilder.pl OK
Change macros for dashboardBuilder.pl OK
Install cron directory OK
Change right for eventReportBuilder.pl OK
Change right for dashboardBuilder.pl OK
Change macros for centreon.logrotate OK
Install Centreon logrotate.d file OK
Prepare export-mysql-indexes OK
Install export-mysql-indexes OK
Prepare import-mysql-indexes OK
Install import-mysql-indexes OK
Prepare indexes schema OK
Install indexes schema OK

------------------------------------------------------------------------
Pear Modules
------------------------------------------------------------------------
Check PEAR modules
PEAR 1.4.9 1.9.4 OK
DB 1.7.6 1.7.14 OK
DB_DataObject 1.8.4 1.10.0 OK
DB_DataObject_FormBuilder 1.0.0RC4 1.0.2 OK
MDB2 2.0.0 2.4.1 OK
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Date 1.4.6 1.4.7 OK
HTML_Common 1.2.2 1.2.5 OK
HTML_QuickForm 3.2.5 3.2.13 OK
HTML_QuickForm_advmultiselect 1.1.0 1.5.1 OK
HTML_Table 1.6.1 1.8.3 OK
Archive_Tar 1.1 1.3.7 OK
Auth_SASL 1.0.1 1.0.6 OK
Console_Getopt 1.2 1.2.3 OK
Net_SMTP 1.2.8 1.6.1 OK
Net_Socket 1.0.1 1.0.10 OK
Net_Traceroute 0.21 0.21.3 OK
Net_Ping 2.4.1 2.4.5 OK
Validate 0.6.2 0.8.5 OK
XML_RPC 1.4.5 1.5.5 OK
SOAP 0.10.1 0.13.0 OK
Log 1.9.11 1.12.7 OK
Archive_Zip 0.1.2 0.1.2 OK
All PEAR modules OK

------------------------------------------------------------------------
Centreon Post Install

------------------------------------------------------------------------
Create /usr/local/centreon/www/install/install.conf.php OK
Create /etc/centreon/instCentWeb.conf OK
Convert variables for upgrade:

Upgrade Centreon Storage

New information is required.

------------------------------------------------------------------------
Start CentStorage Installation

------------------------------------------------------------------------
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
install www/install/createTablesCentstorage.sql OK
CentStorage status Directory already exists PASSED
CentStorage metrics Directory already exists PASSED
Change macros for centstorage binary OK
Install CentStorage binary OK
Install library for centstorage OK
Change right : /var/run/centreon OK
Change macros for centstorage init script OK
Replace CentCore default script Macro OK

Do you want me to install CentStorage init script ?
[y/n], default to [n]:
> y
CentStorage init script installed OK
CentStorage default script installed OK

Do you want me to install CentStorage run level ?
[y/n], default to [n]:
> y
update-rc.d: using dependency based boot sequencing
insserv: warning: current start runlevel(s) (3 5) of script ’centstorage’ overwrites defaults (2 3 4 5).
Change macros for logAnalyser OK
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Install logAnalyser OK
Change macros for logAnalyser-cbroker OK
Install logAnalyser-cbroker OK
Change macros for nagiosPerfTrace OK
Install nagiosPerfTrace OK
Change macros for purgeLogs OK
Install purgeLogs OK
Change macros for purgeCentstorage OK
Install purgeCentstorage OK
Change macros for centreonPurge.sh OK
Install centreonPurge.sh OK
Change macros for centstorage.cron OK
Install CentStorage cron OK
Change macros for centstorage.logrotate OK
Install Centreon Storage logrotate.d file OK
Create /etc/centreon/instCentStorage.conf OK
Convert variables for upgrade:

Upgrade Centreon Core

New information is required.

------------------------------------------------------------------------
Start CentCore Installation

------------------------------------------------------------------------
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change CentCore Macro OK
Copy CentCore in binary directory OK
Change right : /var/run/centreon OK
Change right : /var/lib/centreon OK
Change macros for centcore.logrotate OK
Install Centreon Core logrotate.d file OK
Replace CentCore init script Macro OK
Replace CentCore default script Macro OK

Do you want me to install CentCore init script ?
[y/n], default to [n]:
> y
CentCore init script installed OK
CentCore default script installed OK

Do you want me to install CentCore run level ?
[y/n], default to [n]:
> y
update-rc.d: using dependency based boot sequencing
insserv: warning: current start runlevel(s) (3 5) of script ’centcore’ overwrites defaults (2 3 4 5).
Create /etc/centreon/instCentCore.conf OK
Convert variables for upgrade:

Upgrade Centreon Plugins

New information is required.

------------------------------------------------------------------------
Start CentPlugins Traps Installation
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------------------------------------------------------------------------
Finding Apache user : www-data
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change macros for CentPluginsTraps OK
Change macros for init scripts OK
Installing the plugins Trap binaries OK
Backup all your snmp files OK
Change macros for snmptrapd.conf OK
Change macros for snmptt.ini OK
SNMPTT init script installed OK
SNMPTT default script installed OK
update-rc.d: using dependency based boot sequencing
Install : snmptrapd.conf OK
Install : snmp.conf OK
Install : snmptt.ini OK
Install : snmptt OK
Install : snmptthandler OK
Install : snmpttconvertmib OK
Generate SNMPTT configuration OK
Create /etc/centreon/instCentPlugins.conf OK

The end of upgrade:

###############################################################################
# #
# Go to the URL : http://localhost/centreon/ #
# to finish the setup #
# #
# Report bugs at https://github.com/centreon/centreon/issues #
# #
# Thanks for using Centreon. #
# ----------------------- #
# Contact : infos@centreon.com #
# http://www.centreon.com #
# #
###############################################################################

9.2.2 Web installation

During the web installation, follow these steps.

9.2. From sources
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Presentation

Check dependencies

This step checks the dependencies on php modules.
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Release notes

Upgrade the database

This step upgrades database model and data, version by version.

9.2. From sources
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Finish
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CHAPTER 10

Migrate to Centreon 18.10

This chapter presents the procedure for migrating from a supervision platform to Centreon 18.10:

10.1 Migrating from a Centreon 3.4 platform

10.1.1 Prerequisites

This procedure, which only applies to a Centreon 3.4 platform installed on a 64-bit GNU/Linux distribution, has the
following prerequisites:

Components Version
Centreon Web 2.8.x
Centreon Broker 3.0.x
Centreon Engine 1.8.x

Note: If your platform has been installed from Centreon ISO or Centreon 3.4 repositories on CentOS or Red Hat
version 7, refer to the update documentation.

10.1.2 Migrating

Warning: If your Centreon platform has a Centreon redundancy system, please contact your Centreon support.

Warning: If you try to migrate a platform using Centreon Poller Display 1.6.x, please refer to the following
migration procedure.

Installing the new server

Install your new Centreon central server from the ISO or from packages and finish the installation process by connect-
ing to the Centreon web interface.

Note: It is preferable to set the same password for the ‘centreon’ user during the web installation process.
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Synchronizing the data

Connect to your old Centreon server and synchronize following directories:

# rsync -avz /etc/centreon root@IP_New_Centreon:/etc
# rsync -avz /etc/centreon-broker root@IP_New_Centreon:/etc
# rsync -avz /var/log/centreon-engine/archives/ root@IP_New_Centreon:/var/log/centreon-engine
# rsync -avz --exclude centcore/ --exclude log/ /var/lib/centreon root@IP_New_Centreon:/var/lib
# rsync -avz /var/spool/centreon/.ssh root@IP_New_Centreon:/var/spool/centreon

Note: Replace IP_New_Centreon by the IP or the new Centreon server.

If your DBMS is installed on the same server as the Centreon central server, execute the following commands:

1. Stop mysqld on both Centreon servers:

# systemctl stop mysqld

2. On the new server, remove data in /var/lib/mysql/:

# rm -Rf /var/lib/mysql/*

3. On the old server, synchronize data:

# rsync -avz /var/lib/mysql/ root@IP_New_Centreon:/var/lib/mysql/

4. If you migrate your DMBS from 5.x to 10.x, it’s necessary to execute this command on the new server :

# mysql_upgrade

5. Start the mysqld process on the new server:

# systemctl start mysqld

Synchronizing the plugins

Synchronizing the monitoring plugins is more complex and depends on your installation. The main directories to
synchronize are:

1. /usr/lib/nagios/plugins/

2. /usr/lib/centreon/plugins/

Note: It is mandatory to install the required dependencies to run the plugins.

Upgrading Centreon

On the new server, force the update by moving the content of the /usr/share/centreon/installDir/install-18.10.0-
YYYYMMDD_HHMMSS directory to the /usr/share/centreon/www/install directory:

# cd /usr/share/centreon/installDir/
# mv install-18.10.0-YYYYMMDD_HHMMSS/ ../www/install/

Go to http://[New_Centreon_IP]/centreon URL and perform the upgrade.

Note: If you changed the ‘centreon’ password during the installation process you must follow these steps:

1. Edit /etc/centreon/centreon.conf.php file
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2. Edit /etc/centreon/conf.pm file

3. Edit the Centreon Broker central configuration, using Centreon web interface and change the password for
Perfdata generator and Broker SQL database output.

If the IP of your Centreon server has changed, edit configuration for all the Centreon Broker modules on your pollers
and change the IP to connect to the Centreon central server (output IPv4).

Then generate the configuration of all your pollers and export it.

Upgrading the modules

Please refer to the documentation of each module both to verify compatibility with Centreon 18.10 and perform the
upgrade.

10.2 Migration of a platform with Poller Display

10.2.1 Migrate your Centreon Central

If the module centreon-poller-display-central-1.6.x is installed:

1. Go to Administration > Extensions > Modules menu and uninstall the centreon-poller-display-central

2. Remote the associated package:

# yum remove centreon-poller-display-central

If your server uses a CentOS or Red Hat v7 operating system, refer to the update procedure to update your Poller
Display server; else refer to the migration procedure.

Note: If you have Centreon EMS modules, it is necessary to update these repositories. Contact your Centreon support
for these. Then ask new licenses for those.

10.2.2 Migration a server from Centreon Poller Display to Remote Server

1. Go to the Administration > Extensions > Modules menu and uninstall the Centreon Poller Display module.

2. If the module was installed using an RPM package, remove this one using the following command:

# yum remove centreon-poller-display

Note:
If you have Centreon EMS modules, it is necessary to update these repositories.

Contact your Centreon support for these. Then ask new licenses for those.

3. If your server use a CentOS or Red Hat v7 operating system, refer to the update procedure to update your Poller
Display server; else refer to the migration procedure.

4. Go to Administration > Extensions > Modules menu and install the centreon-license-manager module.

5. Execute the following command:

10.2. Migration of a platform with Poller Display
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# /usr/share/centreon/bin/centreon -u admin -p centreon -a enableRemote -o CentreonRemoteServer -v @IP_CENTREON_CENTRAL

Note: Replace @IP_CENTREON_CENTRAL by the IP of the Centreon server seen by the poller

This command will enable Remote Server mode:

Starting Centreon Remote enable process:

Limiting Menu Access...Success
Limiting Actions...Done

Notifying Master...Success

Set ’remote’ instance type...Done

Centreon Remote enabling finished.

6. SSH Key exchange:

If you don’t have any private SSH keys on the central server for the Centreon user:

# su - centreon
$ ssh-keygen -t rsa

Copy this key on the new server:

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

7. On the Centreon Central server, edit all pollers and attach them to the Remote Server using the selection list.

Note: Do not forget to generate configuration of your Remote Server.

Note: A Centreon Remote Server is a server that is self-administered. Thus, the configuration of the LDAP directory,
users and ACLs are specific to this server and must be configured via the Administration menu.

10.3 Nagios Reader to Centreon CLAPI

Nagios Reader to Centreon CLAPI is a free and open source project to analyze Nagios CFG configuration files and
to transform monitoring configuration to Centreon CLAPI command in order to import configuration into Centreon
web interface.

10.3.1 Prerequisites

First of all you need a Centreon server installed and ready to use. Please see the documentation to install a Centreon
server based on Centreon.

10.3.2 Installation

This script uses the Perl-Nagios-Object library to read CFG files. To install it please follow this steps on your Na-
gios(R) server
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CentOS:

$ yum install perl-Module-Build

Debian:

$ apt-get install libmodule-build-perl

$ cd /tmp
$ wget http://search.cpan.org/CPAN/authors/id/D/DU/DUNCS/Nagios-Object-0.21.20.tar.gz
$ tar xzf Nagios-Object-0.21.20.tar.gz
$ cd Nagios-Object-0.21.20
$ perl Build.PL
$ ./Build
$ ./Build test
$ ./Build install

Download script from GitHub on your Nagios(R) server:

$ cd /tmp
$ git clone https://github.com/centreon/nagiosToCentreon.git
$ cd nagiosToCentreon

10.3.3 Usage

On a fresh Centreon server the default poller is named “Central”. If you rename it or if you want to link this Nagios
configuration to a predefined poller you have to change the poller name on line 65:

my $default_poller = "Central";

To display help use the command:

$ perl nagios_reader_to_centreon_clapi.pl --help
######################################################
# Copyright (c) 2005-2015 Centreon #
# Bugs to http://github.com/nagiosToCentreon #
######################################################

Usage: nagios_reader_to_centreon_clapi.pl
-V (--version) Show script version
-h (--help) Usage help
-C (--config) Path to nagios.cfg file

To run the script please use the following command:

$ perl nagios_reader_to_centreon_clapi.pl --config /usr/local/nagios/etc/nagios.cfg > /tmp/centreon_clapi_import_commands.txt

Export the file /tmp/centreon_clapi_import_commands.txt on your Centreon server.

Run the following command to import configuration into Centreon on your Centreon server:

$ /usr/share/centreon/bin/centreon -u admin -p @PASSWORD -i /tmp/centreon_clapi_import_commands.txt

Note: Replace @PASSWORD by password of admin Centreon web user.

10.3. Nagios Reader to Centreon CLAPI
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CHAPTER 11

CEIP Program

Joining the Centreon Customer Experience Improvement Program

11.1 Customer Experience Improvement Program (CEIP)

Centreon is continually striving to understand and anticipate our customer needs in order to deliver world-class prod-
ucts and solutions. The Customer Experience Improvement Program (CEIP) will deliver benefits to the customers by
allowing us to understand how you use our software, so that we can provide you with a continuous enhancement of
your Centreon software experience. The program is voluntary and anonymous. Customers who choose to participate
agree to share:

• Information such as the operating system version of the Centreon main server of the platform as well as the
name and version of the DBMS.

• Centreon product information such as number of servers and version numbers of components installed on the
Centreon main server (modules & widgets).

• Centreon information such as number of hosts, services, groups of hosts & services.

• The timezone of the Centreon server.

During the installation or upgrade processus, you will be asked to participate in the improvement program. Keep the
box checked to join the improvement program.

11.2 Frequently Asked Questions

11.2.1 What are the possible configuration settings of the CEIP program?

Participation in the program is enabled by default, but this can be modified in the web interface. The options are:

• Enabled

• Disabled

Users can change the option from Administration > Parameters > Centreon UI > Send anonymous statistics menu
at any time.
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11.2.2 What will Centreon do with the information that is collected?

The information collected will be used to better understand how customers use Centreon products, and how to improve
Centreon products by fixing issues and delivering the most useful new features in a much more streamlined manner.

11.2.3 Is the collected information anonymous?

YES! Moreover, Centreon takes all necessary precautions to protect the security of the information that is collected,
transmitted and stored. We only collect data of Centreon product(s). The program takes only those actions described on
this page, and only if you decide to participate. This program cannot collect information without your full knowledge
or consent.

11.2.4 How does the Centreon Experience Improvement Program work?

This is an automated process that requires no effort to participate. It is transparent to users. Customers simply choose
to participate, granting Centreon permission to securely receive anonymous data.

11.2.5 Will I receive spam if I participate in the program?

You will not receive any e-mail from Centreon about this program, regardless of whether or not you participate. We
do not collect personal information as part of this program that will be used to identify you or contact you.

11.2.6 Do I need an Internet connection?

An internet connection is required to participate in this program. However, you do not need to be connected all the
time. When an internet connection becomes available, the information is automatically transmitted with minimal
impact to your connection.

11.2.7 Can I see the data that is collected before it is sent to Centreon?

No, the information cannot be displayed. This program is designed to work for thousands of users without affecting
their product use, so the data is sent automatically. The data is also encoded and compressed so that it can be processed
efficiently.

11.2.8 How long does the program last?

Information is collected as long as you use the product version for which you have agreed to participate or until you
decide to stop participating in the program.

11.2.9 What is the anonymous installation ID used for?

Upon the first startup of the Centreon server, a random number is generated: the anonymous installation ID.

11.2.10 Which products support the Centreon Experience Improvement Program?

The CEIP program covers the Centreon central server.
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CHAPTER 12

FAQ

12.1 About the new Release Plan

Why is the new version called 18.10 instead of 2.9?

There are two reasons. To make it easier to support Centreon, all software components and modules now use the
same version number as the Centreon solution. And because we will now release one new version every six months,
this version number follows the YY.MM format, where YY is the year of release, MM is the month. This is further
explained in this blog post.

How long will Centreon 3.4.6 / Centreon Web 2.8.x be supported?

We will fix critical bugs on Centreon 3.4.6 and its software components, such as Centreon Web 2.8.x, until October
2019.

How long will Centreon 18.10 be supported?

We will fix software bugs on Centreon 18.10 until April 2020.

When can I expect the next version of Centreon?

The next version of Centreon will be released in April 2019 and be called Centreon 19.04.

Can you provide Roadmaps of incoming versions?

Centreon will release one new version every six months. Please see this chapter.

12.2 Upgrading to Centreon 18.10

Which Centreon software version can be upgraded to Centreon 18.10?

Platforms running Centreon 2.6, 2.7 and 2.8 can easily be upgraded to Centreon 18.10. When running older versions
of Centreon, it may be wise to first upgrade to Centreon 2.6 and then to 18.10.

I’m running Centreon open source version 2.x, can I freely upgrade to 18.10?

Yes, you can upgrade to Centreon open source 18.10, which is free of charge.

I’m running Centreon EPP, MAP, BAM and/or MBI, can I upgrade to 18.10?

If you have a valid support contract, you are entitled to upgrade your platform to Centreon 18.10. You must contact
the support team to get access to the new repositories. You will also need new software license keys.

I’m running Centreon EPP, MAP, BAM and/or MBI, are the current version of these modules compatible with
Centreon 18.10?
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No, you should upgrade your entire platform to Centreon 18.10 and thus upgrade these modules to their new 18.10
version.

I purchased an online subscription to the IMP solution, can I upgrade to 18.10?

Yes, if you have a valid IMP subscription you are entitled to upgrade your platform to Centreon 18.10.

Which operating system is Centreon 18.10 based on?

Centreon 18.10 is based on CentOS 7 and is not compatible with older versions of CentOS.

I’m running a Centreon platform based on CentOS 6, can I upgrade to 18.10?

Yes, you may apply a migration procedure to migrate your Centreon from a version based on CentOS 6 to Centreon
18.10. Please see this chapter.

What is the difference between updating and migrating a Centreon Server?

If your platform is already based on CentOS 7, a simple software update is enough to upgrade it to Centreon 18.10.
If your platform is still based on CentOS 6, a migration procedure is required to upgrade it to 18.10. Please see this
chapter.

Where can I find the procedure to update my Centreon Server?

Please see this chapter.

Where can I find the procedure to migrate my Centreon Server?

Please see this chapter.

When migrating from CentOS 6 to CentOS 7, should I migrate the Centreon Pollers at the same time as the
Central Server?

Centreon Pollers may be migrated one at a time. Centreon 18.10 Central Server is compatible with the previous version
of Centreon Pollers.

Some of my Centreon Pollers use the optional Poller Display module, when upgrading to Centreon 18.10 should
I upgrade them to the new Remote Server functionality?

Yes, Poller Display is not compatible with Centreon 18.10. This is further explained in the Remote Server section of
this FAQ.

12.3 Software License keys for Centreon EPP, MAP, BAM and MBI

I’m running Centreon EPP, MAP, BAM and/or MBI, why do I need to change my software license keys when
upgrading to Centreon 18.10?

The technology we use for software license keys and the format of license keys has changed with Centreon 18.10.
Older license keys are not compatible with Centreon 18.10.

Where can I get new software license keys?

Please contact the support team. You will be asked for your server fingerprint.

Where can I find the fingerprint of my Centreon Server?

In the Centreon user interface, access to Administration > Extensions > Subscription menu.

12.4 Centreon Remote Server

Is Remote Server included in the open source version of Centreon?
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Yes, the new Centreon Remote Server functionality is included in the Centreon 18.10 open source, free-to-download
solution.

Is Remote Server in addition to Poller Display or replacing it?

Centreon Remote Server is replacing the Poller Display module. The Poller Display module is not compatible with
Centreon 18.10. The Centreon Remote Server functionality is an integral part of Centreon 18.10 and does not require
any additional module.

What is the difference between Poller Display and Remote Server?

Poller Display is an additional module to Centreon, whereas Centreon Remote Server is an integral part of Centreon
18.10. Adding and configuring a Centreon Remote Server is done in four simple steps from the Centreon graphical
user interface. Centreon Remote Server combines features from both Poller Display version 1.5 and 1.6 in a better
integrated, more robust package.

Is Poller Display compatible with Centreon 18.10?

The Poller Display module is not compatible with Centreon 18.10.

How can I upgrade from Poller Display to Remote Server?

Please see this chapter.

12.5 Customer Experience Improvement Program (CEIP)

Where can I find information on the Centreon Customer Experience Improvement Program (CEIP)?

A dedicated FAQ is available in the documentation.

12.6 GDPR Compliance

In a Managed Service Provider (MSP) context, the Centreon platform delivers monitoring services to the MSP’s
customers.

12.6.1 Storing User Identification information

For each MSP’s customer, the Centreon Central Server stores in its SQL database the identification information of the
users that can access the monitoring service:

• name

• alias (login), password

• email address

• phone number (optional, for notification purpose)

The Central Server also stores the service parameters of each user:

• default language, timezone

• notification parameters

• ACL groups

Information management:

• Each user can access to his/her own information from the Administration > Parameters > MyAccount menu.

12.5. Customer Experience Improvement Program (CEIP)
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• The users can be created, changed or deleted from the Configuration > Users menu by any user which ACL
grant access to this menu.

12.6.2 Logging User actions

If a user is allowed to change the monitoring configuration (as defined by its ACL), a log message with the user alias
is stored on the Centreon Central Server SQL database each time a configuration action is performed by this user:

• These logs can be listed in the Administration > Logs menu, filtered by user.

• These logs can only be deleted by accessing the SQL database and deleting any relevant record.

12.6.3 HTTP Transactions

Centreon recommends securing the monitoring platform by activating the HTTPS mode on the Apache server. A
signed official certificate is required to ensure a minimum level of security.

12.6.4 Authentication

In order to stay consistent with your security policy and to better manage user lifecycle and approvals, Centreon has
an option to enable linking to an Active Directory or LDAP directory. Centreon recommends enabling this option and
not using a local account.

12.6.5 Backup

Centreon provides a Centreon data extraction module to enable the implementation of a supervisory data backup
policy. Centreon strongly recommends to set up this module and especially not to leave the data on the supervision
platform.

12.7 Centreon administration platform

12.7.1 How does the Empty all services data action work?

In order to preserve global performance, this action won’t remove all data from the database right after you launched
it. Entries will be removed from index_data and metrics tables but not from data_bin.

The main reason for that is data_bin quickly stores a huge amount of data and uses the MyISAM engine which
doesn’t support per-row locking. If you try to remove too many entries simultaneously, you could block all your
database for several hours.

Anyway, it doesn’t mean the data will stay into your database indefinitely. It will be removed in the future, depending
on you data retention policy.

12.7.2 My dashboard on several days is undetermined, what should I look into?

This is a bug from some mysql versions with partitioned tables (https://bugs.mysql.com/bug.php?id=70588). Replac-
ing ‘=’ by LIKE in queries fixes the problem but reduces performance.

We therefore recommend to update your SGBD : MySQL 5.5.36, 5.6.16, 5.7.4, MariaDB 10.0.33, 10.1.29, 10.2.10.
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12.7.3 No graph seems to be generated, what should I look into?

There are various things to check when RRDs don’t seem to be generated.

Disk space

By default, the graph files (.rrd) are stored in /var/lib/centreon/metrics, it is obviously necessary to have
enough space in your filesystem.

Permissions

Can the .rrd files be written in the /var/lib/centreon/metrics directory? Process that usually writes in this
directory is either centstorage or cbd.

Plugins

Does your plugin return the correct output? Refer to the Plugin API documentation for more information

Centreon Broker

Centreon Broker must be configured properly, refer to this documentation for more information.

The cbd rrd daemon must be running:

# systemctl status cbd
cbd.service - Centreon Broker watchdog
Loaded: loaded (/etc/systemd/system/cbd.service; enabled; vendor preset: disabled)
Active: active (running) since mer. 2018-07-18 17:46:03 CEST; 2 months 9 days ago
Process: 21410 ExecReload=/bin/kill -HUP $MAINPID (code=exited, status=0/SUCCESS)

Main PID: 9537 (cbwd)
CGroup: /system.slice/cbd.service

-9537 /usr/sbin/cbwd /etc/centreon-broker/watchdog.xml
-9539 /usr/sbin/cbd /etc/centreon-broker/central-rrd.xml
-9540 /usr/sbin/cbd /etc/centreon-broker/central-broker.xml

12.8 Centreon platform performance

This is a guide on improving Centreon’s performance

12.8.1 Databases

The database server is one of the central components of Centreon. Its performance has a direct impact on the end user
application’s speed. Centreon uses two or three databases depending on your monitoring broker:

• centreon – Storing metadata

• centreon_storage – Real-time monitoring and history

Indexes

Databases use indexes to speed up queries. In case indexes are missing queries are executed slower.

12.8. Centreon platform performance
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Synchronizing indexes

Starting with Centreon 2.4.0 for each release, index information files are generated. They are found in data folder
usually located next to the bin or www folders. They are JSON files and there is one for each database:

• centreonIndexes.json – Indexes for centreon database

• centreonStorageIndexes.json – Indexes for centreon_storage database

• centreonStatusIndexes.json – Indexes for centreon_status database

Check if your database is desynchronized:

$ cd CENTREONBINDIR
$ ./import-mysql-indexes -d centreon -i ../data/centreonIndexes.json

If any differences are detected you can synchronize your database. The process usually takes several minutes BUT if
your database contains a lot of data and no index exists the process may take up to 2 hours. Make sure you have
enough free space on the disk because indexes may require a lot of space:

$ ./import-mysql-indexes -d centreon -i ../data/centreonIndexes.json -s

Note: Indexes used by foreign keys cannot be synchronized.
-s or --sync options should be used in order to alter the database. If you need to specify the username and/or
password you can use -u and -p options respectively.

InnoDB optimizations

This section is not documented yet.

Databases schema

Centreon database schema can be view here :
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Centreon storage database schema can be view here :

12.8.2 RRDCacheD

RRDCacheD is a process to reduce disk I/O during the update of performance’s graphs and status’ graphs. The
RRDCacheD process is loaded by the Centreon Broker module and mutualise I/O disques instead of recording one by
one the data from the collect.

362
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapter 12. FAQ



Installation

The RRDCacheD process is available in rrdtool package and already installed on your server.

Configuration

Main settings

Edit the /etc/sysconfig/rrdcached file and complete information:

# Settings for rrdcached
OPTIONS="-m 664 -l unix:/var/rrdtool/rrdcached/rrdcached.sock -s rrdcached -b /var/rrdtool/rrdcached -w 3600 -z 3600 -f 7200"
RRDC_USER=rrdcach

Note: The order of setting is pretty important. If -m 664 is define before -l
unix:/var/rrdtool/rrdcached/rrdcached.sock option then rights will be incorrect on socket.

Options are following one:

Option Description
-w Data are written every x seconds on disk (3600s in example represent 1h)
-z Should be less than -w option. RRDCacheD uses a range value from [0:-z] to do not write in RRDs in

same time.
-f Timeout in cache before write data to disk.

Note: Please modify values with you needs.

Groups configuration

Create groups using commands:

# usermod -a -g rrdcached centreon-broker
# usermod -a -g rrdcached apache
# usermod -a -g centreon rrdcached
# usermod -a -g centreon-broker rrdcached

Restart Apache process:

# /etc/init.d/httpd restart

Start RRDCacheD process:

# /etc/init.d/rrdcached start

Centreon web configuration

Go to Administration -> Options -> RRDTool menu, enable process and set unix socket path:

12.8. Centreon platform performance
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Warning: Instead of configuration was made into Administration you need to generate and export configuration
of central server and restart cbd process to apply changes.

Centreon web interface

RRDCacheD don’t update performances graphs in real time. If a blank range appears on right of performances graphs
it means that cache are not yet written to disk.

Warning: If the RRDCacheD process crash (in theory because it’s a stable process) data will be lost! It is not
possible to get data unless rebuild all graphs from Centreon web.
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CHAPTER 13

How to

With Centreon, you can monitor many environments of your IT systems. Servers, applications, UPS, website, network
equipments: all this systems have their specificities. That’s why the Centreon Company provides Plugin packs based
on Centreon Plugins. In order to help you to implement you monitoring easily, this documentation section will give
you keys to setup them into you Centreon.

13.1 Implement SSO

13.1.1 How SSO works with Centreon ?

This is an example of architecture with LemonLDAP :
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1. The user signs in SSO authentication portal

2. The authentication portal checks user access on LDAP server

3. The LDAP server returns user information

4. The authentication portal creates a session to store user information and returns SSO cookie to the user

5. The user is redirected to Centreon Web and catched by the SSO handler which checks user access

6. The SSO handler sends request to Centreon Web with login header (i.e HTTP_AUTH_USER)

7. Centreon Web checks user access by login on LDAP server

8. The LDAP server returns user information

9. Centreon Web returns information to the handler

10. The SSO handler transfers information to the user
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13.1.2 How to configure SSO in Centreon ?

You can configure SSO in Administration > Parameters :

For more information, please refer here

13.1.3 Security warning

SSO feature has only to be enabled in a secured and dedicated environment for SSO. Direct access to Centreon UI
from users have to be disabled.

If you have experiences that you want to share to the Centreon community, please don’t hesitate to push it on GitHub.
Your howto will be integrated into official Centreon Documentation.

13.1. Implement SSO
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CHAPTER 14

Developer

14.1 How to write a module

You want to create a new module for Centreon 2 or to adapt an existing one? You’re at the right place!

You should know Centreon contains a page dedicated to the installation and the uninstallation of modules (Administra-
tion > Modules). To make the module appears on this page, its directory must be placed inside Cetreon’s modules/
directory. Example:

/usr/local/centreon/www/modules/module-Dummy

An empty module template can be found inside Centreon’s repository.

14.1.1 Basis

The essential elements your module’s directory must contain are presented below (* = required):

[conf.php]*:

// Short module’s name. Must be equal to your module’s directory name
$module_conf[’dummy’][’name’] = "dummy";
// Full module’s name
$module_conf[’dummy’][’rname’] = "Dummy Module";
// Module’s version
$module_conf[’dummy’][’mod_release’] = "2.0";
// Additional information
$module_conf[’dummy’][’infos’] = "First of all";
// Allow your module to be uninstalled
$module_conf[’dummy’][’is_removeable’] = "1";
// Module author’s name
$module_conf[’dummy’][’author’] = "Centreon Team";
// 1: the module executes an SQL file for installation and/or uninstallation
// 0: the module doesn’t execute any SQL file
$module_conf[’dummy’][’sql_files’] = "1";
// 1: the module executes a PHP file for installation and/or uninstallation
// 0: the module doesn’t execute any SQL file
$module_conf[’dummy’][’php_files’] = "1";

[infos > infos.txt]

This file can contain various information about your module.

[php > install.php]
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This PHP file is executed at module installation if it is configured inside the conf.php file.

[php > uninstall.php]

This PHP file is executed at module uninstallation if it is configured inside the conf.php file.

[sql > install.sql]

This SQL file is executed during the module installation if it is configured inside the conf.php file. If you want your
module to be available from Centreon menus, you must insert new entries into the topology table of the centreon
database. An example is available inside the Dummy module.

[sql > uninstall.sql]

This SQL file is executed during the module uninstallation if it is configured inside the conf.php file. It can also remove
your module from Centreon menus.

[generate_files > *.php]

The PHP files contained inside the generate_files directory will be executed during the monitoring engine
configuration files generation (inside Configuration > Monitoring Engines). Those files must generate configuration
files.

[UPGRADE > dummy-x.x > sql > upgrade.sql]

Centreon provides an upgrade system for modules. To use it, just add a directory under UPGRADE named using the
following pattern: <module name>-<version>. When clicking on the upgrade button, Centreon will search for
scripts to execute, following the logical order of versions.

For example, if the version 1.0 of the dummy module is installed and the following directories exist:

$ ls UPGRADE
dummy-1.1 dummy-1.2

Centreon will execute the scripts in the following order : 1.1, 1.2. A configuration file in each upgrade directory is
present in order to allow (or not) the execution.

You’re free to organize the remaining files (your module’s content) as you like.

14.1.2 Advanced

That’s great, you know how to install a module! As an empty module is not really useful, put your imagination at
work. Knowing that you can do almost everything, it should not be too complicated :-).

Connecting to the database

You can use the centreon, centstorage and ndo databases by calling the following file:
centreon/www/class/centreonDB.class.php.

For example, execute requests like this:

<?
$pearDB = new CentreonDB();
$pearDB->query("SELECT * FROM host");
?>
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Existing functions

You can access most of the functions already developed within Centreon using include() statements. They’re
generally stored in centreon/www/class/.

Before developing your own function, check the existing code, it could spare your time!

14.2 How to write a widget

Centreon (since version 2.4) offers a custom view system which allows user to view one or different widgets in the
same page : Home > Custom views.

You may have specific needs that are not yet covered by our widget catalog and this tutorial will explain to you how
to write your first widget for Centreon.

14.2.1 Should I make a widget or a module?

If you are wondering if you should be making a module or a widget, then ask yourself if your project is meant to
contain many menus or is it rather a plain page which is going to display little information?

Of course, you could make a widget that would only work with a certain module.

14.2.2 Directory structure

Widgets work pretty much like Modules. They have to be placed in the following directory:

# centreon/www/widgets/name-of-your-widget/

Your widget must contain one mandatory file named configs.xml at its root.

14.2.3 Configuration file

This is the XML configuration file of our Dummy widget:

<configs>
<title>Dummy</title>
<author>Centreon</author>
<email>contact@centreon.com</email>
<website>http://www.centreon.com</website>
<description>Dummy widget</description>
<version>1.0.3</version>
<keywords>dummy, widget, centreon</keywords>
<screenshot></screenshot>
<thumbnail>./widgets/dummy/resources/logoCentreon.png</thumbnail>
<url>./widgets/dummy/index.php</url>
<autoRefresh></autoRefresh>
<preferences>

<preference label="text preference" name="text preference" defaultValue="default value" type="text"/>
<preference label="boolean preference" name="boolean preference" defaultValue="1" type="boolean"/>
<preference label="date" name="date" defaultValue="" type="date"/>
<preference label="host preference" name="host preference" defaultValue="" type="host"/>
<preference label="list preference" name="list preference" defaultValue="none" type="list">

<option value="all" label="all"/>

14.2. How to write a widget
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<option value="none" label="none"/>
</preference>
<preference label="range preference" name="range preference" defaultValue="5" type="range" min="0" max="50" step="5"/>
<preference label="host search" name="host search" defaultValue="notlike _Module_%" type="compare"/>

</preferences>
</configs>

Now, let’s see what these tags refer to.

Basic tags

* = Mandatory tag

Tag nameDescription
title* Title of your widget
author* Your name
email Your email address
website URL of your project
descrip-
tion*

Short description of your widget

version* Version of your widget. Increment this number whenever you publish a new version.
keywords A few key words that describe your widget
screenshot Screenshot that shows the best side of your widget. Screenshot should be placed within your widget

directory.
thumbnail Logo of your project. Best size is 100px x 25px. Thumbnail shoud be placed within your widget

directory.
url* Path of the main page of your widget
autorefresh This parameter is not implemented yet

Parameter attributes

* = Mandatory parameter

Tag
attributes

Description

label* Label of the parameter
name* Name of the parameter that will be used for retrieving its value
default-
Value*

Default Value of the parameter

requirePer-
mission

Value can be “1” or “0”. When set to 1, this parameter will not be shown to unauthorized users.

type* Parameter type, must be one of the following: text,boolean,date,list,range,compare,host,hostgroup,
hostTemplate,servicegroup,serviceTemplate

min* For range type only. It refers to the minimum value of the range parameter
max* For range type only. It refers to the maximum value of the range parameter
step* For range type only. It refers to the step value of the range parameter
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Parameter type

Type name Description
text Renders a text input element
boolean Renders a checkbox
date Renders two text input elements. One for the date of

start, the other one for the date of end.
list Renders a selectbox. The selectbox will be populated

with the option tags which have to be defined within the
preference tag.

range Renders a selectbox which will be populated with values
depending on the min, max and step definitions.

compare Renders a selectbox and a text input. Selectbox will con-
tain SQL operands such as:
> : greater than
< : less than
>= : greater or equal
<= : less or equal
= : equal
!= : not equal
LIKE : can be used with the wildcard %%
NOT LIKE : can be used with the wildcard %%

host Renders a selectbox populated with a list of hosts.
hostgroup Renders a selectbox populated with a list of hostgroups.
hostTemplate Renders a selectbox populated with a list of host tem-

plates.
servicegroup Renders a selectbox populated with a list of service-

groups.
serviceTemplate Renders a selectbox populated with a list of service tem-

plates.

The preference window would look like this as a result:

14.2.4 Code

All languages are separated in differents files, one file for each language. The file “configs.xml” call the php’s file and
the php’s file call html’s file etc...

We use Smarty, it’s an engine and template’php compiler (http://smarty.net).

To use Smarty you need to :
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require_once $centreon_path . ’GPL_LIB/Smarty/libs/Smarty.class.php’;

1.configuration of smarty:

$path = $centreon_path . "www/widgets/Dummy/src/";
$template = new Smarty();
$template = initSmartyTplForPopup($path, $template, "./", $centreon_path);

2.creating php template to be use in html:

$template->assign(’widgetId’, $widgetId);
$template->assign(’autoRefresh’, $autoRefresh);
$template->assign(’data’, $data);

3.affectation of html’s file to execute:

$template->display(’dummy.ihtml’);

To call template php’s variable in the html look dummy.ihtml

To do request in database:

initialization of databases’s centreon, centreon storage and recovering preferences:

try {
global $pearDB;

$db_centreon = new CentreonDB("centreon");
$db = new CentreonDB("centstorage");
$pearDB = $db_centreon;

$widgetObj = new CentreonWidget($centreon, $db_centreon);
$preferences = $widgetObj->getWidgetPreferences($widgetId);
$autoRefresh = 0;
if (isset($preferences[’refresh_interval’])) {

$autoRefresh = $preferences[’refresh_interval’];
}

} catch (Exception $e) {
echo $e->getMessage() . "<br/>";
exit;
}

then request in database with class’ methods.

14.3 How to write a Stream Connector

14.3.1 Overview

Centreon Stream Connector is a feature introduced in Centreon 3.4.6. It allows one to export Centreon data (events
and metrics) to an external storage or application such as ElasticSearch, Splunk, InfluxDB, files, etc.

In a Centreon platform, the component that carries information between the remote pollers and the Centreon central
server is called Centreon Broker. This broker stores received data into the Centreon local storage: MariaDB and
RRDtool.

The following diagram explains the transfer of collected data and insertion into storages:
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The Stream Connector functionality is a new Centreon Broker output getting data from Centreon Broker Master (also
known as Centreon Broker SQL) to aggregate and forward it to external storage:

This output loads a Lua script called a Stream Connector, which job is to handle, aggregate and enrich the data before
forwarding it to the defined protocol:

Because it is an output of Centreon Broker, the principle of creating retention files upon interrupting external storage
access is retained. In the same way, it is possible to filter input on the categories of flow to handle.

14.3.2 Requirements

To use the Centreon Stream connector functionality you need to update your Centreon platform to Centreon 3.4.6:

• Centreon Web >= 2.8.18

• Centreon Broker >= 3.0.13

• Lua >= 5.1.x

14.3.3 Creating a new Lua script

The complete technical documentation is available here. In this how-to, we will write two scripts:
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• The first one, easy, that explains the basics of Stream Connectors. Its goal is to export data to a log file.

• The second one is more exigent for the reader, it exports performance data to the TSDB InfluxDB but is easily
adaptable to export to another TSDB.

Programming language

Centreon chose the Lua programming language to let you handle, aggregate and transfer data. Lua is a programming
language that is easy to use. You can find more information with the Lua official documentation

Storage of Lua scripts

Broker’s Lua scripts can be stored in any directory readable by the centreon-broker user.

We recommend to store them in /usr/share/centreon-broker/lua.

Note: In a near future, this directory will be in the default path of the Lua scripts launched by broker. It will then be
easier to use user defined Lua libraries because you will just have to add your libraries there like stream connectors.

Write all information into a file

Store raw data

Let’s start with the first script. Our goal is to store all events given by Broker in a log file. We will call our stream
connector bbdo2file.lua.

As we said previously, we will store this file into the /usr/share/centreon-broker/lua directory on the Centreon central
server.

If the directory does not exist, as root, we can create it with the following command:

mkdir -p /usr/share/centreon-broker/lua

Centreon Broker provides several log functions to write logs, warnings or errors into a file. We will use one of these
functions info() to write Broker events. See technical documentation for more information.

The function info() makes part of the broker_log object. To call it, the syntax is the following:

broker_log:info(level, text)

• level is an integer from 1 (most important) to 3 (least important).

• text is the text to write as log.

Note: Did you notice the separator between broker_log and info, yes it is a colon! Objects functions, also called
methods are called like this in Lua.

Let’s start our script. The more important function in a stream connector is the write() function. Each time an event is
received from a poller through Broker, this function is called with the event as an argument.

Note: You will never have to call the write() function by yourself, it is always Broker’s work to do so. And it would
be a fault to make such a call. In other words, there should not be any call to the write() function in your script.

See technical documentation for more information.
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Here is the bbdo2file.lua first version:

function init(conf)
broker_log:set_parameters(3, "/var/log/centreon-broker/bbdo2file.log")

end

function write(d)
for k,v in pairs(d) do
broker_log:info(3, k .. " => " .. tostring(v))

end
return true

end

Note: Information about the initialization of the Broker’s log function and its parameters are given here see technical
documentation.

Let’s explain what we are doing in this script.

We must provide an init() function, it is described in the technical documentation.

This function is called during the stream connector initialization. Here, we use it to initialize the broker_log object.
To achieve this, we call the broker_log::set_parameters() method that needs two parameters :

• A max level (from 1 to 3). If you give 2 here, only logs of levels 1 and 2 will be returned.

• A file to write the logs in. This file must be in a writable directory for the centreon-broker user.

The second function is the write() function. We already said its argument is a Broker event. This type of object is a
collection of keys/values. For example:

{
"check_hosts_freshness": false,
"active_host_checks": true,
"category": 1,
"event_handlers": true,
"instance_id": 1,
"last_command_check": 1522836592,
"type": 65552,
"global_service_event_handler": "",
"obsess_over_services": false,
"passive_service_checks": true,
"last_alive": 1522836593,
"active_service_checks": true,
"check_services_freshness": true,
"flap_detection": false,
"global_host_event_handler": "",
"notifications": true,
"obsess_over_hosts": false,
"passive_host_checks": true,
"element": 16

}

In all events, you will find category, element and type.

• Information about the category can be found here in the bbdo documentation

• The element is the sub-category (also called type in the bbdo documentation).

• The type is a number built from the category and the element (binary concatenation).

In this example, the category is 1 and the element is 16. So, by reading the documentation, we can say this event is a
NEB event with sub-category instance-status.
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To finish with the write() function, we make a loop on the d event parameters. For each step, k is a key and v is the
corresponding value. And we send to the log file a string k .. ” => ” .. tostring(v) that means the concatenation of k,
=> and v converted into a string. You will see an example of the result below.

Another possibility would be to use the broker.json_encode(d) function that converts any Lua object to a json string
representation of it. So, we could write the function like this:

function write(d)
broker_log:info(3, broker.json_encode(d))
return true

end

Note: You can notice that broker.json_encode(d) is made of broker and json_encode(d) separated by a dot and not
a colon. This is because broker is not a Lua object. In fact, you can see it as a functions set provided by Centreon
Broker.

Once your file /usr/share/centreon-broker/lua/bbdo2file.lua is ready, verify it is readable by the centreon-broker
user (or the centreon-engine user who is the owner of the centreon-broker group), if it is not the case, as root you
can enter:

# chown centreon-engine:centreon-engine /usr/share/centreon-broker/lua/bbdo2file.lua

Then configure the new output into Centreon Web interface in Configuration > Pollers > Broker configuration >
Central Broker. In Output tab select Generic – Stream connector and click Add:

Define the name of this output and the path to the Lua connector:

378
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapter 14. Developer



Then click Save and go to generate the configuration and restart cbd.

Once the Centreon Broker will be restarted on your Centreon central server, data will appear in your /var/log/centreon-
broker/bbdo2file.log log file:

mer. 28 mars 2018 14:27:35 CEST: INFO: flap_detection => true
mer. 28 mars 2018 14:27:35 CEST: INFO: enabled => true
mer. 28 mars 2018 14:27:35 CEST: INFO: host_id => 102
mer. 28 mars 2018 14:27:35 CEST: INFO: last_time_ok => 1522240053
mer. 28 mars 2018 14:27:35 CEST: INFO: state => 0
mer. 28 mars 2018 14:27:35 CEST: INFO: last_update => 1522240054
mer. 28 mars 2018 14:27:35 CEST: INFO: last_check => 1522240053
mer. 28 mars 2018 14:27:35 CEST: INFO: execution_time => 0.005025
mer. 28 mars 2018 14:27:35 CEST: INFO: acknowledged => false
mer. 28 mars 2018 14:27:35 CEST: INFO: service_id => 778
mer. 28 mars 2018 14:27:35 CEST: INFO: active_checks => true
mer. 28 mars 2018 14:27:35 CEST: INFO: notify => false
mer. 28 mars 2018 14:27:35 CEST: INFO: max_check_attempts => 3
mer. 28 mars 2018 14:27:35 CEST: INFO: obsess_over_service => true
mer. 28 mars 2018 14:27:35 CEST: INFO: check_type => 0
mer. 28 mars 2018 14:27:35 CEST: INFO: last_hard_state_change => 1522165654
mer. 28 mars 2018 14:27:35 CEST: INFO: category => 1
mer. 28 mars 2018 14:27:35 CEST: INFO: perfdata => used=41986296644o;48103633715;54116587930;0;60129542144 size=60129542144o
mer. 28 mars 2018 14:27:35 CEST: INFO: check_interval => 5
mer. 28 mars 2018 14:27:35 CEST: INFO: output => Disk /var - used : 39.10 Go - size : 56.00 Go - percent : 69 %
mer. 28 mars 2018 14:27:35 CEST: INFO: check_command => check-bench-disk
mer. 28 mars 2018 14:27:35 CEST: INFO: check_period => 24x7
mer. 28 mars 2018 14:27:35 CEST: INFO: type => 65560
mer. 28 mars 2018 14:27:35 CEST: INFO: last_hard_state => 0

Note: This log file will grow quickly, do not forget to add a log rotate.

Use parameters

The Centreon Broker log functions should be used for log only. To write into a file, we must use the Lua dedicated
function. Moreover, it is possible to use parameters to define the name of the log file.
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So it is time to improve our Stream Connector:

function init(conf)
logFile = conf[’logFile’]
broker_log:set_parameters(3, "/var/log/centreon-broker/debug.log")

end

function writeIntoFile(output)
local file,err = io.open(logFile, ’a’)
if file == nil then
broker_log:info(3, "Couldn’t open file: " .. err)

else
file:write(output)
file:close()

end
end

function write(d)
for k,v in pairs(d) do
writeIntoFile(k .. " => " .. tostring(v) .. "\n")

end
return true

end

Did you notice that expression local file,err = io.open(logFile, ‘a’)?

Lua is able to store several variables at the same time. Also, Lua functions can return several variables!

For example, if you want to swap variables a and b, you can enter:

a, b = b, a

Another example that illustrates several values returned:

function fib(a, b)
return b, a + b

end

So, this call to io.open returns two variables, a first variable file that is a file descriptor used to access the file and a
second variable not always defined that contains error if one occurs or nil (not defined) otherwise.

The init() function allows to get parameters and define these from Centreon web interface. See technical documenta-
tion for more information. Here, we add the possibility to choose the destination file name. The conf table has a key
logFile defined in the web interface. The corresponding value is the file name used to store events.

Edit your Broker output to declare this parameter:
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It is important that the name of the parameter in the web interface matches the key name in the conf table. Here, it is
logFile.

Then click Save and go to generate the configuration and restart cbd.

Data are stored into /var/log/centreon-broker/bbdo2file.log log file as this:

name => error
category => 3
interval => 300
rrd_len => 3456000
value => 0
value_type => 0
type => 196612
ctime => 1522315660
index_id => 4880
element => 4
state => 0
category => 3
interval => 300
rrd_len => 3456000
is_for_rebuild => false
service_id => 1056
type => 196609
ctime => 1522315660
host_id => 145
element => 1
is_for_rebuild => false
metric_id => 11920

Manipulate data

Here, we continue to improve our stream connector by choosing what events to export and also by improving outputs.

We will select only the NEB category and the events regarding hosts and services status.

We know that NEB is the category 1, also service status is the sub-category 24, whereas host status is the sub-category
14.

So, only events with the following criteria:

• category = 1

14.3. How to write a Stream Connector
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• element = 14 or element = 24

are interesting for us.

Moreover, we would prefer to have a host name instead of a host id and a service description instead of a service id.

At last, we would be interested to get status information and outputs.

NEB Events with elements 14 and 24 give almost all we want except host names and service descriptions.

To get those two information, we will have to use the broker_cache object. This one is filled when pollers are restarted
or reloaded. So, do not forget to restart your pollers if you want something in your broker_cache object!

If the cache is well filled, it is easy to get a host name from the host id:

broker_cache:get_hostname(host_id)

And it is also easy to get the service description from the host id and service id:

broker_cache:get_service_description(host_id, service_id)

To install the filter on events, there is a useful function called filter() that takes two parameters into account: category,
element.

This function, if defined, is called just before write(). If it returns true, the write() function will be called, otherwise,
the event will be thrown away.

Let’s complete our Lua script:

function init(conf)
logFile = conf[’logFile’]
broker_log:set_parameters(3, "/var/log/centreon-broker/debug.log")

end

local function writeIntoFile(output)
local file,err = io.open(logFile, ’a’)
if file == nil then
broker_log:info(3, "Couldn’t open file: " .. err)

else
file:write(output)
file:close()

end
end

function write(d)
local output = ""

local host_name = broker_cache:get_hostname(d.host_id)
if not host_name then
broker_log:info(3, "Unable to get name of host, please restart centengine")
host_name = d.host_id

end

if d.element == 14 then
output = "HOST:" .. host_name .. ";" .. d.host_id .. ";" .. d.state .. ";" .. d.output
writeIntoFile(output)
broker_log:info(output)

elseif d.element == 24 then
local service_description = broker_cache:get_service_description(d.host_id, d.service_id)
if not service_description then
broker_log:info(3, "Unable to get description of service, please restart centengine")
service_description = d.service_id
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end
output = "SERVICE:" .. host_name .. ";" .. d.host_id .. ";" .. service_description .. ";" .. d.service_id .. ";" .. d.state .. ";" .. d.output
writeIntoFile(output)
broker_log:info(output)

end
return true

end

function filter(category, element)
-- Get only host status and services status from NEB category
if category == 1 and (element == 14 or element == 24) then
return true

end
return false

end

Just several remarks on this new script before showing what we get.

In the init() function, we access the logFile key in the conf table by using conf[’logFile’]. Whereas, in the write()
function, we access the element key in the d table by using d.element...

In fact, the two syntaxes are allowed : d.element is the same value than d[’element’].

Another remark, in the write() function we can see something like:

if not host_name then

And in the writeIntoFile() function, we can see that:

if file == nil then

Do they mean the same thing? Where is the difference?

You must know that in Lua, a variable is considered to be true if it is defined and not false:

so, the following code

if toto then
print("Good")

else
print("Bad")

end

will write Good if toto is defined and not false. More precisely, it will write Good in the following cases:

• toto=12

• toto=true

• toto=”A string”

• toto=0 (surprising!)

It will write Bad in these cases:

• toto=nil (by default a variable is nil, which means not defined)

• toto=false

The /var/log/centreon-broker/bbdo2file.log file will now contain:

HOST:srv-DC-djakarta;215;0;OK - srv-DC-djakarta: rta 0.061ms, lost 0%
SERVICE:mail-titan-gateway;92;disk-/usr;623;0;Disk /usr - used : 42.98 Go - size : 142.00 Go - percent : 30 %
SERVICE:mail-sun-master;87;memory-stats;535;0;Memory usage (Total 13.0GB): 0.12GB [buffer:0.00GB] [cache:0.01GB] [pages_tables:0.00GB] [mapped:0.00GB] [active:0.07GB] [inactive:0.00GB] [apps:0.02GB] [unused:12.88GB]
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SERVICE:mail-saturn-frontend;86;traffic-eth1;512;0;Traffic In : 4.73 Mb/s (4.73 %), Out : 4.79 Mb/s (4.79 %) - Total RX Bits In : 396.01 Gb, Out : 393.88 Gb
SERVICE:mail-saturn-frontend;86;memory-stats;515;0;Memory usage (Total 16.0GB): 8.89GB [buffer:0.43GB] [cache:0.95GB] [pages_tables:0.27GB] [mapped:0.15GB] [active:3.92GB] [inactive:0.29GB] [apps:2.88GB] [unused:7.11GB]
SERVICE:mail-neptune-frontend;80;traffic-eth1;392;0;Traffic In : 4.82 Mb/s (4.82 %), Out : 6.48 Mb/s (6.48 %) - Total RX Bits In : 398.40 Gb, Out : 396.44 Gb
HOST:srv-DC-casablanca;207;0;OK - srv-DC-casablanca: rta 2.042ms, lost 0%
SERVICE:mail-neptune-frontend;80;memory-stats;395;0;Memory usage (Total 9.0GB): 0.54GB [buffer:0.03GB] [cache:0.00GB] [pages_tables:0.01GB] [mapped:0.00GB] [active:0.48GB] [inactive:0.00GB] [apps:0.01GB] [unused:8.46GB]
SERVICE:mail-mercury-frontend;82;traffic-eth1;432;0;Traffic In : 8.28 Mb/s (8.28 %), Out : 1.23 Mb/s (1.23 %) - Total RX Bits In : 397.71 Gb, Out : 400.34 Gb
SERVICE:mail-mercury-frontend;82;memory-stats;435;0;Memory usage (Total 12.0GB): 1.58GB [buffer:0.00GB] [cache:0.63GB] [pages_tables:0.00GB] [mapped:0.00GB] [active:0.75GB] [inactive:0.00GB] [apps:0.19GB] [unused:10.42GB]
SERVICE:mail-mars-frontend;84;traffic-eth1;472;0;Traffic In : 7.24 Mb/s (7.24 %), Out : 3.36 Mb/s (3.36 %) - Total RX Bits In : 399.93 Gb, Out : 395.67 Gb
SERVICE:mail-mars-frontend;84;memory-stats;475;0;Memory usage (Total 3.0GB): 1.19GB [buffer:0.01GB] [cache:0.59GB] [pages_tables:0.00GB] [mapped:0.00GB] [active:0.15GB] [inactive:0.04GB] [apps:0.39GB] [unused:1.81GB]
SERVICE:mail-jupiter-frontend;85;traffic-eth1;492;0;Traffic In : 1.41 Mb/s (1.41 %), Out : 9.08 Mb/s (9.08 %) - Total RX Bits In : 388.86 Gb, Out : 394.85 Gb
SERVICE:mail-jupiter-frontend;85;memory-stats;495;0;Memory usage (Total 12.0GB): 0.57GB [buffer:0.04GB] [cache:0.23GB] [pages_tables:0.02GB] [mapped:0.02GB] [active:0.07GB] [inactive:0.03GB] [apps:0.16GB] [unused:11.43GB]
SERVICE:mail-io-backend;88;traffic-eth1;547;0;Traffic In : 1.51 Mb/s (1.51 %), Out : 7.12 Mb/s (7.12 %) - Total RX Bits In : 389.61 Gb, Out : 390.54 Gb
SERVICE:mail-io-backend;88;diskio-system;551;0;Device /dev/sda: avg read 4.78 (MB/s) and write 9.08 (MB/s)

14.3.4 Export performance data to InfluxDB

Now, you have already seen many things about stream connectors. It is time to create something more useful!

InfluxDB is a Time Series database. We will use this storage to insert performance data collected by the Centreon
platform. For this example, we will use the predefined InfluxDB Docker.

To send data to InfluxDB, we need parameters to access to InfluxDB storage:

• http_server_address: IP address of the storage

• http_server_port: 8086 by default

• http_server_protocol: http or https

• influx_database: name of database

• influx_user: user to access to database if defined

• influx_password: password of user to access to database if defined

In order to not saturate the storage, we will add all events in a queue and once its max size is reached, we will send
data by bulk.

We need to define the size of the queue and the maximum delay before sending events:

• max_buffer_size

• max_buffer_age

To create this queue, we introduce a code a little more complicated. We construct an object event_queue. It is
composed of parameters such as events, influx_database and methods like new(), add().

To understand how to create such an object in Lua, we recommend the Lua documentation here for classes and there
for metatables.

To send data to a server, we provide a broker_tcp_socket object.

Its API is very simple (too simple?). This socket is a TCP socket, it does not support encryption and it can be tricky to
send data in http. Here is an example:

-- Here, we create our socket
local socket = broker_tcp_socket.new()

-- We establish the connection with the server
socket:connect(address, port)

-- Now, we can send data
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socket:write("This is a text to send")

-- If, we want an answer, we also have a function to read
local content = socket:read()

-- When exchanges are finished, we can close the socket
socket:close()

For our purpose, we do not use broker_tcp_socket because of its limitations. We want to be able to send data to an
https server.

A prerequisite is to install the lua-socket library. This library provides several functionalities, we need two of them:

• http socket

• ltn12

To access them, Lua provides the require function.

Let’s introduce the beginning of our new Stream Connector.

The queue parameters

-- We declare the objects to import here
local http = require("socket.http")
local ltn12 = require("ltn12")

-- Here are predefined queue parameters
local event_queue = {

__internal_ts_last_flush = nil,
http_server_address = "",
http_server_port = 8086,
http_server_protocol = "http",
events = {},
influx_database = "mydb",
influx_user = "",
influx_password = "",
max_buffer_size = 5000,
max_buffer_age = 5

}

In this table, we give default values to parameters that can possibly be changed during the init() call. This table will
be used to store important data for the script and is also our queue object.

A method to create the queue

To declare this table as a Lua object, we need a constructor. So, here it is:

-- Constructor of the event_queue
function event_queue:new(o, conf)
o = o or {}
setmetatable(o, self)
self.__index = self
for i,v in pairs(conf) do
if self[i] and i ~= "events" and string.sub(i, 1, 11) ~= "__internal_" then

broker_log:info(1, "event_queue:new: getting parameter " .. i .. " => " .. v)
self[i] = v

else
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broker_log:warning(1, "event_queue:new: ignoring parameter " .. i .. " => " .. v)
end

end
self.__internal_ts_last_flush = os.time()
broker_log:info(2, "event_queue:new: setting the internal timestamp to " .. self.__internal_ts_last_flush)
return o

end

Note: In this function, we use a Lua sugar “o = o or {}” that means o stays the same if it is true, otherwise it is
affected with an empty table {}.

Another point to notice is the ~= operator that means different from.

And to finish on this function, the variable self is implicitly defined when we declare an object’s method. Its meaning
is the same as this in Java or in C++. It represents the object we are working on.

A method to add event in queue

We have a queue object. It would be great to use it like this:

-- We construct it
local queue = event_queue:new(nil, conf)

-- We add an event to it
queue:add(event)

-- When the queue is full, we would like to do something like this
queue:flush()

Let’s do it! Below, we present an add() method that retrieves a host name and service description from the cache,
builds a string from the event and pushes it on its stack.

function event_queue:add(e)
local metric = e.name
-- time is a reserved word in influxDB so I rename it
if metric == "time" then
metric = "_" .. metric

end

-- retrieve objects names instead of IDs
local host_name = broker_cache:get_hostname(e.host_id)
local service_description = broker_cache:get_service_description(e.host_id, e.service_id)

-- what if we could not get them from cache
if not host_name then
broker_log:warning(1, "event_queue:add: host_name for id " .. e.host_id .. " not found. Restarting centengine should fix this.")
host_name = e.host_id

end
if not service_description then
broker_log:warning(1, "event_queue:add: service_description for id " .. e.host_id .. "." .. e.service_id .. " not found. Restarting centengine should fix this.")
service_description = e.service_id

else
service_description = service_description:gsub(" ", "_")

end

-- we finally append the event to the events table
metric = metric:gsub(" ", "_")

386
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapter 14. Developer



broker_log:info(3, ’event_queue:add: adding ’ .. service_description .. ",host=" .. host_name .. " " .. metric .. "=" .. e.value .. " " .. e.ctime .. ’000000000" to event list.’)
self.events[#self.events + 1] = service_description .. ",host=" .. host_name .. " " .. metric .. "=" .. e.value .. " " .. e.ctime .. "000000000\n"

-- then we check whether it is time to send the events to the receiver and flush
if #self.events >= self.max_buffer_size then
broker_log:info(2, "event_queue:add: flushing because buffer size reached " .. self.max_buffer_size .. " elements.")
self:flush()
return true

elseif os.time() - self.__internal_ts_last_flush >= self.max_buffer_age then
broker_log:info(2, "event_queue:add: flushing " .. #self.events .. " elements because buffer age reached " .. (os.time() - self.__internal_ts_last_flush) .. "s and max age is " .. self.max_buffer_age .. "s.")
self:flush()
return true

else
return false

end
end

A method to flush the queue

Once the events added in the queue and the maximum size of the queue or the timeout is reached, events will be sent
to the InfluxDB storage.

This function builds data from the queue and sends them to the storage. If an error occurs, it dumps a log error.

It is here that we use the http and ltn12 objects loaded at the beginning of the script.

function event_queue:flush()
broker_log:info(2, "event_queue:flush: Concatenating all the events as one string")
-- we concatenate all the events
local http_post_data = ""
local http_result_body = {}
for i, raw_event in ipairs(self.events) do
http_post_data = http_post_data .. raw_event

end
broker_log:info(2, ’event_queue:flush: HTTP POST request "’ .. self.http_server_protocol .. "://" .. self.http_server_address .. ":" .. self.http_server_port .. "/write?db=" .. self.influx_database .. ’"’)
broker_log:info(3, "event_queue:flush: HTTP POST data are: ’" .. http_post_data .. "’")

-- build url
local influxdb_url = self.http_server_protocol .. "://" .. self.http_server_address .. ":" .. self.http_server_port .. "/write?db=" .. self.influx_database
-- add authentication if needed
if string.len(self.influx_user) >= 1 and string.len(self.influx_password) >= 1 then
influxdb_url = influxdb_url .. "&u=" .. self.influx_user .. "&p="..self.influx_password

end

local hr_result, hr_code, hr_header, hr_s = http.request{
url = influxdb_url,
method = "POST",
-- sink is where the request result’s body will go
sink = ltn12.sink.table(http_result_body),
-- request body needs to be formatted as a LTN12 source
source = ltn12.source.string(http_post_data),
headers = {

-- mandatory for POST request with body
["content-length"] = string.len(http_post_data)

}
}
-- Handling the return code
if hr_code == 204 then
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broker_log:info(2, "event_queue:flush: HTTP POST request successful: return code is " .. hr_code)
else
broker_log:error(1, "event_queue:flush: HTTP POST request FAILED: return code is " .. hr_code)
for i, v in ipairs(http_result_body) do
broker_log:error(1, "event_queue:flush: HTTP POST request FAILED: message line " .. i .. ’ is "’ .. v .. ’"’)

end
end

-- now that the data has been sent, we empty the events array
self.events = {}
-- and update the timestamp
self.__internal_ts_last_flush = os.time()

end

The init() function to get parameters and create the queue

In this case, the init() function creates the queue with parameters defined by users in the web interface or uses default
parameters already defined in the queue. This alternative is managed by the queue constructor.

function init(conf)
broker_log:set_parameters(1, "/var/log/centreon-broker/stream-connector-influxdb.log")
broker_log:info(2, "init: Beginning init() function")
queue = event_queue:new(nil, conf)
broker_log:info(2, "init: Ending init() function, Event queue created")

end

Note: queue is not defined as local, this is important so that it is accessible from all the functions.

The write() function to insert events in queue

The write() function is only used to insert filtered events into the queue:

function write(e)
broker_log:info(3, "write: Beginning write() function")
queue:add(e)
broker_log:info(3, "write: Ending write() function\n")
return true

end

The filter() function to select only performance data events

To select only performance data, we need to select category 3 (“Storage”) and element 1 for metric:

function filter(category, element)
if category == 3 and element == 1 then
return true

end
return false

end

Complete script

The complete script can be downloaded here.
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Configure Centreon Broker

Configure the new output into Centreon Web interface in Configuration > Pollers > Broker configuration > Central
Broker. In Output tab select Generic – Stream connector and click Add:

Define the name of this output and the path to the Lua connector:

Then click Save and go to generate the configuration and restart cbd.

Note: Don’t forget to restart “centengine” too to create the Centreon Broker cache.

If you install the Grafana dashboard, you can visualize the stored data:
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Discover other Centreon Stream Connectors

Centreon provides a Github repository to host Lua scripts developed by Centreon and the community. Please go to the
dedicated Github.

Need help to develop your Stream connector? You want to share your experience with the community? Join the
Centreon community Slack channel.

14.4 How to translate Centreon

If you want to contribute to translate Centreon, this new tutorial is for you! Discover how to translate Centreon web
interface and how to help us to add new language in Centreon.

14.4.1 Install translation environment

Download the following archive and copy it on a Linux server.

Execute the following commands:

$ unzip centreon-translation.zip
$ cd centreon-translation

Your environment to translate Centreon is now ready.

14.4.2 First generation

During the first generation, the script will clone Centreon sources from GitHub on your server.

Execute the following command:

$ bash make-translation.sh

At the end of execution, two files are available:

• messages.pot to translate Centreon web interface menu and forms

• help.pot to translate help tooltips in configuration forms

Rename messages.pot to messages.po and help.po to help.po

You can now start translation of Centreon by editing files with a PO file editor like poedit.

Note: Keep always your *.po files for next translation.

14.4.3 Use your translation

On your Centreon server, install gettext:

$ sudo yum install gettext

Create the locale directory for your Centreon:

$ sudo mkdir -p /usr/share/centreon/www/locale/‘locale | grep LC_MESSAGES | cut -d \" -f 2‘/LC_MESSAGES
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Note: /usr/share/centreon is the Centreon installed directory.

If you want to translate Centreon in other language than use by your Centreon server, you have to define manually the
locale.

For example, for Brazilian users, execute the following command:

$ sudo mkdir -p /usr/share/centreon/www/locale/pt_BR/LC_MESSAGES

Compile translated files:

$ msgfmt messages.po -o messages.mo
$ msgfmt help.pot -o help.mo

Copy compiled translated files:

$ sudo cp *.mo /usr/share/centreon/www/locale/‘locale | grep LC_MESSAGES | cut -d \" -f 2‘/LC_MESSAGES

Change rights on directory:

$ sudo chown -R apache.apache /usr/share/centreon/www/locale/‘locale | grep LC_MESSAGES | cut -d \" -f 2‘

Restart Apache:

$ sudo service httpd restart

Connect to your Centreon web interface, edit your profile and select new language:

Save the form and access to another menu, your interface will be translated.

14.4.4 Upgrade translation

Centreon developers released every month a new version of Centreon Web. So translation could be modified with
every new release.

To maintain translation up-to-date follow this steps:

$ bash make-translation.sh

At the end of execution, two files up-to-date are available:

• messages.pot to translate Centreon Web interface menu and forms
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• help.pot to translate help tooltips in configuration forms

Merge this files with previous translation (messages.po and help.po):

$ msgmerge help.po help.pot -o new_help.po
$ msgmerge messages.po messages.pot -o new_messages.po

Follow chapter “Use your translation” to upgrade translation for Centreon.

14.4.5 Participate to Centreon project

Once your translation is up-to-date, you can ask to the Centreon team to add your translation to Centreon project. This
will allow for all person using Centreon to have access to your translation on their Centreon platform.

• Create an account on GitHub

• Fork centreon/centreon project on GitHub

• Add your translated *.mo and *.po files to lang/<your_lang>/LC_MESSAGES directory

• Commit your change on your project

• Create a pull request on centreon/centreon project

• We will add your translation to Centreon.

Thank you for your help!
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CHAPTER 15

API

Contents:

15.1 API Rest

15.1.1 Introduction

Welcome to the Centreon API rest documentation. This documentation is for developers familiar with HTTP requests
and JSON. It explains various API operations, related request and response structure, and error codes. If you are not
familiar with the JSON API, we recommend you to use the Centreon command line API documentation.

This documentation is available in english only.

15.1.2 Permissions

To perform API calls using a specific Centreon user, you need permissions to do so.

There are two types of permission:

You can give access to the configuration for a specific Centreon user. To do so you have to edit user settings on the
menu Configuration > Users > Contacts/Users, edit user and on second tab check box Reach API Configuration.

You can give access to the realtime for a specific Centreon user. To do so you have to edit user settings on the menu
Configuration > Users > Contacts/Users, edit user and on second tab check box Reach API Realtime.

If you want both then check both checkboxes

15.1.3 Authentication

Using POST method and the URL below:

api.domain.tld/centreon/api/index.php?action=authenticate

Body form-data:

Parameter Type Value
username Text The user name you use to login on Centreon
password Text Your Centreon password

The response is a json flow getting back the authentication token
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{
"authToken": "NTc1MDU3MGE3M2JiODIuMjA4OTA2OTc="
}

This token will be used later on the other API actions.

15.1.4 Realtime information

Host Status

All monitoring information regarding hosts are available in throw the Centreon API.

Using GET method and the URL below:

api.domain.tld/centreon/api/index.php?object=centreon_realtime_hosts&action=list

Header:
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Parameters

You can pass a list of parameters in order to select the data you want.

Parameters values
viewType select the predefined filter like in the monitoring view: all, unhandled, problems
fields the fields list that you want to get separated by a ”,”
status the status of hosts that you want to get (up, down, unreachable, pending, all)
hostgroup hostgroup id filter
instance instance id filter
search search pattern applyed on host name
criticality a specific criticity
sortType ASC ou DESC
limit number of line you want
number page number
order the order type (selected in the field list)

Field list :
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Fields Description
id host id
name host name
alias host alias (description of the host)
address host address (domain name or ip)
state host state (UP = 0, DOWN = 2, UNREA = 3)
state_type host state type (SOFT = 0, HARD = 1)
output Plugin output - state message
max_check_attempts maximum check attempts
check_attempt current attempts
last_check last check time
last_state_change last time the state change
last_hard_state_change last time the state change in hard type
acknowledged acknowledged flag
instance name of the instance who check this host
instance_id id of the instance who check this host
criticality criticality fo this host
passive_checks accept passive results
active_checks active checks are enabled
notify notification is enabled
action_url shortcut for action URL
notes_url shortcut for note URL
notes note
icon_image icone image for this host
icon_image_alt title of the image
scheduled_downtime_depth scheduled_downtime_depth
flapping is the host flapping ?

Using GET method and the URL below:

api.domain.tld/centreon/api/index.php?object=centreon_realtime_hosts&action=list&limit=60&viewType=all&sortType=name&order=desc&fields=id,name,alias,address,state,output,next_check

Service Status

All monitoring information regarding services are available in throw the Centreon API. With this call, you can also
get host informations in the same time that service information. This web service provide the same possibility that the
service monitoring view.

Using GET method and the URL below:

api.domain.tld/centreon/api/index.php?object=centreon_realtime_services&action=list

Header:
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Parameters

You can pass a list of parameters in order to select the data you want.
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Parameters values
viewType select the predefined filter like in the monitoring view: all, unhandled, problems
fields the fields list that you want to get separated by a ”,”
status the status of services that you want to get (ok, warning, critical, unknown, pending, all)
hostgroup hostgroup id filter
servicegroup servicegroup id filter
instance instance id filter
search search pattern applied on service
searchHost search pattern applied on host
searchOutput search pattern applied on output
criticality a specific criticity
sortType ASC ou DESC
limit number of line you want
number page number
order the order type (selected in the field list)

Field list :

Fields Description
host_id host id
host_name host name
host_alias host alias (description of the host)
host_address host address (domain name or ip)
host_state host state (UP = 0, DOWN = 2, UNREA = 3)
host_state_type host state type (SOFT = 0, HARD = 1)
host_output Plugin output - state message
host_max_check_attempts maximum check attempts for host
host_check_attempt current attempts
host_last_check last check time
host_acknowledged acknowledged flag
instance name of the instance who check this host
instance_id id of the instance who check this host
host_action_url shortcut for action URL
host_notes_url shortcut for note URL
host_notes note
description service description - service name
display_name service display name
service_id service id
state service state
state_type service state type (SOFT = 0, HARD = 1)
output service output returned by plugins
perfdata service perfdata returned by plugins
current_attempt maximum check attempts for the service
last_update last update date for service
last_state_change last time the state change
last_hard_state_change last time the state change in hard type
next_check next check time for service
max_check_attempts maximum check attempts for service
action_url shortcut for action URL
notes_url shortcut for note URL
notes notes
icone_image icone image for service
passive_checks accept passive results
active_checks active checks are enabled

Continued on next page
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Table 15.1 – continued from previous page
Fields Description
acknowledged acknowledged flag
notify notification is enabled
scheduled_downtime_depth scheduled_downtime_depth
flapping is the host flapping ?
event_handler_enabled is the event-handfler enabled
criticality criticality fo this service

Example:

Using GET method and the URL below:

api.domain.tld/centreon/api/index.php?action=list&object=centreon_realtime_services&limit=60&viewType=all&sortType=name&order=desc&fields=id,description,host_id,host_name,state,output

Submit results

You can use the centreon API to submit information to the monitoring engine. All information that you submit will be
forwarded to the centreon engine poller that host the configuration.

To provide information, Centreon need to have specific and mandatory information.

The user must be admin or have access to “Reach API Configuration”.

For the service submission please provide the following information :

Fields Description
host host name
service service description
status status id (0, 1, 2, 3) or ok, warning, critical, unknown
output a specific message
perfdata (optional) all performance metric following the nagios plugin API
updatetime the check time (timestamp)

For the host submission please provide the following information :

Fields Description
host host name
status status id (0, 1, 2, 3)
output a specific message
updatetime the check time (timestamp)

To send status, please use the following URL using POST method:

api.domain.tld/centreon/api/index.php?action=submit&object=centreon_submit_results

Header
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Example of service body submit: The body is a json with the parameters provided above formated as below:

{
"results": [
{

"updatetime": "1528884076",
"host": "Centreon-Central"
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"service": "Memory",
"status": "2"
"output": "The service is in CRITICAL state"
"perfdata": "perf=20"

},
{

"updatetime": "1528884076",
"host": "Centreon-Central"
"service": "fake-service",
"status": "1"
"output": "The service is in WARNING state"
"perfdata": "perf=10"

}
]

}

Example of body response: :: The response body is a json with the HTTP return code and a message for each submit:

{
"results": [
{

"code": 202,
"message": "The status send to the engine"

},
{

"code": 404,
"message": "The service is not present."

}
]

}

15.1.5 Configuration

Getting started

Most of the actions available (about 95%) in the command line API is available in the rest API.

Here is an example for listing hosts using rest API.

Using POST method and the URL below:

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header:
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Body:

{
"action": "show",
"object": "HOST"

}

• The key action corresponds to the option -a in Centreon CLAPI, the value show corresponds to the -a option
value.
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• The key object corresponds to the option -o in Centreon CLAPI, the value HOST corresponds to the -o option
value.

The equivalent action using Centreon CLAPI is:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a show

Response: The response is a json flow listing all hosts and formated as below:

{
"result": [
{

"id": "12",
"name": "mail-uranus-frontend",
"alias": "mail-uranus-frontend",
"address": "mail-uranus-frontend",
"activate": "1"

},
{

"id": "13",
"name": "mail-neptune-frontend",
"alias": "mail-neptune-frontend",
"address": "mail-neptune-frontend",
"activate": "1"

},
{

"id": "14",
"name": "srvi-mysql01",
"alias": "srvi-mysql01",
"address": "srvi-mysql01",
"activate": "1"

}
]

}

Note: Some actions need the values key ( the option -v in Centreon CLAPI ). Depending on the called action, the
body can contain values key. We will see that in detail later.

API Calls

All API calls you can do on objects are described below. Note that you need to be authenticate before each call.

API calls on the Host object are fully-detailed below. For the next objects, only the actions available are listed, so just
follow the same approach as for the host object for an API call.

Host

List hosts

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
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key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "show",
"object": "host"

}

Response

{
"result": [

{
"id": "79",
"name": "mail-uranus-frontend",
"alias": "mail-uranus-frontend",
"address": "mail-uranus-frontend",
"activate": "1"

},
{
"id": "80",
"name": "mail-neptune-frontend",
"alias": "mail-neptune-frontend",
"address": "mail-neptune-frontend",
"activate": "1"

},
{
"id": "81",
"name": "mail-earth-frontend",
"alias": "mail-earth-frontend",
"address": "mail-earth-frontend",
"activate": "1"

}
]
}

Add host

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "add",
"object": "host",
"values": "test;Test host;127.0.0.1;generic-host;central;Linux-SerVers"

}
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Response

{
"result": []

}

Delete host

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "del",
"object": "host",
"values": "test"

}

Response

{
"result": []

}

Set parameters

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setparam",
"object": "host",
"values": "test;ParameterToSet;NewParameter"

}

Available parameters

Parameter Description
2d_coords 2D coordinates (used by statusmap)
3d_coords 3D coordinates (used by statusmap)

Continued on next page
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Table 15.2 – continued from previous page
Parameter Description
action_url Action URL
activate Whether or not host is enabled
active_checks_enabled Whether or not active checks are enabled
address Host IP Address
alias Alias
check_command Check command
check_command_arguments Check command arguments
check_interval Normal check interval
check_freshness Check freshness (in seconds)
check_period Check period
checks_enabled Whether or not checks are enabled
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
event_handler Event handler command
event_handler_arguments Event handler command arguments
event_handler_enabled Whether or not event handler is enabled
first_notification_delay First notification delay (in seconds)
flap_detection_enabled Whether or not flap detection is enabled
flap_detection_options Flap detection options
icon_image Icon image
icon_image_alt Icon image text
max_check_attempts Maximum number of attempt before a HARD state is declared
name Host name
normal_check_interval value in minutes
notes Notes
notes_url Notes URL
notifications_enabled Whether or not notification is enabled
notification_interval Notification interval
notification_options Notification options
notification_period Notification period
obsess_over_host Whether or not obsess over host option is enabled
passive_checks_enabled Whether or not passive checks are enabled
process_perf_data Process performance data command
retain_nonstatus_information Whether or not there is non-status retention
retain_status_information Whether or not there is status retention
retry_check_interval Retry check interval
snmp_community Snmp Community
snmp_version Snmp version
stalking_options Comma separated options: ‘o’ for OK, ‘d’ for Down, ‘u’ for Unreachable
statusmap_image Status map image (used by statusmap
host_notification_options Notification options (d,u,r,f,s)
timezone Timezone

Response

{
"result": []

}
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Set instance poller

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setinstance",
"object": "host",
"values": "test;Poller-2"

}

Response

{
"result": []

}

Get macro

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getmacro",
"object": "host",
"values": "mail-uranus-frontend"

}

Response Here is a response example

{
"result": [
{
"macro name": "ALIVENUM",
"macro value": "1",
"is_password": "",
"description": "",
"source": "generic-host-bench"

},
{
"macro name": "ALIVEWARNING",
"macro value": "3000,80",
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"is_password": "",
"description": "",
"source": "generic-host-bench"

},
{
"macro name": "ALIVECRITICAL",
"macro value": "5000,100",
"is_password": "",
"description": "",
"source": "generic-host-bench"

}
]
}

Set macro

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setmacro",
"object": "host",
"values": "mail-uranus-frontend;MacroName;NewValue"

}

To edit an existing custom macro, The MacroName used on the body should be defined on the Custom Marco of the
chosen host. If the marco doesn’t exist, it will be created.

Response

{
"result": []

}

Delete macro

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body
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{
"action": "delmacro",
"object": "host",
"values": "mail-uranus-frontend;MacroName"

}

The MacroName used on the body is the macro to delete. It should be defined on the Custom Marco of the chosen
host.

Response

{
"result": []

}

Get template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "gettemplate",
"object": "host",
"values": "mail-uranus-frontend"

}

Response Here is a response example

{
"result": [
{

"id": "3",
"name": "Servers-Linux"

},
{

"id": "62",
"name": "Postfix-frontend"

},
{

"id": "59",
"name": "Cyrus-murder-frontend"

}
]
}

Set template

POST
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api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "settemplate",
"object": "host",
"values": "mail-uranus-frontend;MyHostTemplate"

}

The MyHostTemplate used on the body should exist as a host template. The new template erase templates already
exist.

Response :: { “result”: [] }

Add template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addtemplate",
"object": "host",
"values": "mail-uranus-frontend;MyHostTemplate"

}

The MyHostTemplate used on the body should exist as a host template. The new template is added without erasing
template already linked

Response :: { “result”: [] }

Delete template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body
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{
"action": "deltemplate",
"object": "host",
"values": "mail-uranus-frontend;MyHostTemplate"

}

The MyHostTemplate used on the body should exist as a host template.

Response :: { “result”: [] }

Apply template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "applytpl",
"object": "host",
"values": "mail-uranus-frontend"

}

Response :: { “result”: [] }

Get parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getparent",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": [
{

"id": "219",
"name": "mail-uranus-frontdad"
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}
]

}

Add parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addparent",
"object": "host",
"values": "mail-uranus-frontend;fw-berlin"

}

Response

{
"result": []

}

To add more than one parent to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;fw-berlin|fw-dublin"

The add action add the parent without overwriting he previous configuration.

Set parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setparent",
"object": "host",
"values": "mail-uranus-frontend;fw-berlin"

}

Response
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{
"result": []

}

To set more than one parent to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;fw-berlin|fw-dublin"

The set action overwrite the previous configuration before setting the new parent.

Delete parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delparent",
"object": "host",
"values": "mail-uranus-frontend;fw-berlin"

}

Response

{
"result": []

}

To delete more than one parent, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;fw-berlin|fw-dublin"

Get contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getcontactgroup",
"object": "host",
"values": "mail-uranus-frontend"

}
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Response

{
"result": [

{
"id": "6",
"name": "Mail-Operators"

}
]
}

Add contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addcontactgroup",
"object": "host",
"values": "mail-uranus-frontend;Supervisors"

}

Response

{
"result": []

}

To add more than one contactgroup to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;Supervisors|Guest"

The add action add the contact without overwriting he previous configuration.

Set contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body
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{
"action": "setcontactgroup",
"object": "host",
"values": "mail-uranus-frontend;Supervisors"

}

Response

{
"result": []

}

To set more than one contactgroup to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;Supervisors|Guest"

The set action overwrite the previous configuration before setting the new contactgroup.

Delete contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delcontactgroup",
"object": "host",
"values": "mail-uranus-frontend;Guest"

}

Response

{
"result": []

}

To delete more than one contactgroup, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;Guest|Supervisors"

Get contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part
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Body

{
"action": "getcontact",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": [

{
"id": "20",
"name": "user-mail"

}
]
}

Add contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addcontact",
"object": "host",
"values": "mail-uranus-frontend;admin"

}

Response

{
"result": []

}

To add more than one contact to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;admin|SuperAdmin"

The add action add the contact without overwriting he previous configuration.

Set contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi
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Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setcontact",
"object": "host",
"values": "mail-uranus-frontend;admin"

}

Response

{
"result": []

}

To set more than one contact to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;admin|SuperAdmin"

The set action overwrite the previous configuration before setting the new contact.

Delete contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delcontact",
"object": "host",
"values": "mail-uranus-frontend;Guest"

}

Response

{
"result": []

}

To delete more than one contact, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;admin|SuperAdmin"

Get hostgroup

POST
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api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "gethostgroup",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": [
{

"id": "53",
"name": "Linux-Servers"

},
{

"id": "63",
"name": "Mail-Cyrus-Frontend"

}
]

}

Add hostgroup

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addhostgroup",
"object": "host",
"values": "mail-uranus-frontend;Mail-Postfix-Frontend"

}

Response

{
"result": []

}

To add more than one hostgroup to a host, use the character ‘|’. Ex:
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"values": "mail-uranus-frontend;Mail-Postfix-Frontend|Linux-Servers"

The add action add the hostgroup without overwriting he previous configuration.

Set hostgroup

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "sethostgroup",
"object": "host",
"values": "mail-uranus-frontend;Linux-Servers"

}

Response

{
"result": []

}

To set more than one hostgroup to a host, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;Linux-Servers|Mail-Postfix-Frontend"

The set action overwrite the previous configuration before setting the new hostgroup.

Delete hostgroup

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delhostgroup",
"object": "host",
"values": "mail-uranus-frontend;Linux-Servers"

}

Response
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{
"result": []

}

To delete more than one hostgroup, use the character ‘|’. Ex:

"values": "mail-uranus-frontend;Linux-Servers|Mail-Postfix-Frontend"

Enable

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "enable",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": []

}

Disable

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "disable",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": []

}
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ACL

Object

• ACL

Actions

• reload

• lastreload

Action ACL

Object

• ACLACTION

Actions

• show

• add

• del

• setparam

• getaclgroup

• grant

• revoke

ACL groups

Object

• ACLGROUP

Actions

• show

• add

• del

• setparam

• getmenu

• getaction

• getresource

• getcontact

• getcontactgroup

• setmenu

• setaction

• setresource
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• addmenu

• addaction

• addresource

• delmenu

• delaction

• delresource

• setcontact

• setcontactgroup

• addcontact

• addcontactgroup

• delcontact

• delcontactgroup

Menu ACL

Object

• ACLMENU

Actions

• show

• add

• del

• setparam

• getaclgroup

• grant

• revoke

Resource ACL

Object

• ACLRESOURCE

Actions

• show

• add

• del

• setparam

• getaclgroup

• grant

• revoke
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Centreon Broker

Object

• CENTBROKERCFG

Actions

• show

• add

• del

• setparam

• listinput, listoutput, listlogger, listcorrelation, listtemporary, liststats

• getinput , getoutput, getlogger, getcorrelation, gettemporary, getstats

• addinput, addoutput, addlogger, addcorrelation, addtemporary, addstats

• delinput, deloutput, dellogger, delcorrelation, deltemporary, delstats

• setinput, setoutput, setlogger, setcorrelation, settemporary, setstats

CGI CFG

Object

• CGICFG

Actions

• show

• add

• del

• setparam

Commands

Object

• CMD

Actions

• show

• add

• del

• setparam
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Contacts

Object

• CONTACT

Actions

• show

• add

• del

• setparam

• enable

• disable

Contact templates

Object

• CONTACTTPL

Actions

• show

• add

• del

• setparam

• enable

• disable

Contact groups

Object

• CG

Actions

• show

• add

• del

• setparam

• enable

• disable

• getcontact

• addcontact

• setcontact
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• delcontact

Dependencies

Object

• DEP

Actions

• show

• add

• del

• setparam

• listdep

• addparent

• addchild

• delparent

• delchild

Downtimes

Object

• DOWNTIME

Actions

• show

• add

• del

• listperiods

• addweeklyperiod

• addmonthlyperiod

• addspecificperiod

• addhost, addhostgroup, addservice, addservicegroup

• delhost, delhostgroup, delservice, delservicegroup

• sethost, sethostgroup, setservice, setservicegroup

Host template

Object

• HTPL

Actions APPLYTPL and SETINSTANCE actions on HTPL

• show
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• add

• del

• setparam

• getmacro

• setmacro

• delmacro

• getparent

• addparent

• setparent

• delparent

• getcontactgroup

• addcontactgroup

• setcontactgroup

• delcontactgroup

• getcontact

• addcontact

• setcontact

• delcontact

• gethostgroup

• addhostgroup

• sethostgroup

• delhostgroup

• setseverity

• unsetseverity

• enable

• disable

Host categories

Object

• HC

Actions

• show

• add

• del

• getmember

• addmember
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• setmember

• setseverity

• unsetseverity

• delmember

Hostgroups

Object

• HG

Actions

• show

• add

• del

• setparam

• getmember

• addmember

• setmember

• delmember

Instances ( Pollers)

Object

• INSTANCE

Actions

• show

• add

• del

• setparam

• gethosts

Service templates

Object

• STPL

Actions

• show

• add

• del

• setparam
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• addhosttemplate

• sethosttemplate

• delhosttemplate

• getmacro

• setmacro

• delmacro

• getcontact

• addcontact

• setcontact

• delcontact

• getcontactgroup

• setcontactgroup

• delcontactgroup

• gettrap

• settrap

• deltrap

Services

Object

• SERVICE

Actions

• show

• add

• del

• setparam

• addhost

• sethost

• delhost

• getmacro

• setmacro

• delmacro

• setseverity

• unsetseverity

• getcontact

• addcontact

• setcontact
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• delcontact

• getcontactgroup

• setcontactgroup

• delcontactgroup

• gettrap

• settrap

• deltrap

Service groups

Object

• SG

Actions

• show

• add

• del

• setparam

• getservice

• gethostgroupservice

• addservice

• setservice

• addhostgroupservice

• sethostgroupservice

• delservice

• delhostgroupservice

Service categories

Object

• SC

Actions

• show

• add

• del

• setparam

• getservice

• getservicetemplate

• addservice
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• setservice

• addservicetemplate

• setservicetemplate

• delservice

• delservicetemplate

• setseverity

• unsetseverity

Time periods

Object

• TIMEPERIOD

Actions

• show

• add

• del

• setparam

• getexception

• setexception

• delexception

Traps

Object

• TRAP

Actions

• show

• add

• del

• setparam

• getmatching

• addmatching

• delmatching

• updatematching
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Vendors

Object

• VENDOR

Actions

• show

• add

• del

• setparam

• generatetraps

15.1.6 Code errors

Code Messages
200 Successful
400

• Missing parameter
• Missing name parameter
• Unknown parameter
• Objects are not linked

401 Unauthorized
404

• Object not found
• Method not implemented into Centreon API

409
• Object already exists
• Name is already in use
• Objects already linked

500 Internal server error (custom message)

15.2 Command Line API

Centreon CLAPI is a Centreon API that enables users to configure their monitoring system through command lines.

This documentation aims to introduce all the actions you can perform with Centreon CLAPI, from adding host objects
to restarting a remote monitoring poller.

Contents:

15.2.1 Overview

Centreon CLAPI aims to offer (almost) all the features that are available on the user interface in terms of configuration.
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Features

• Add/Delete/Update objects such as hosts, services, host templates, host groups, contacts etc...

• Generate configuration files

• Test configuration files

• Move configuration files to monitoring pollers

• Restart monitoring pollers

• Import and export objects

Basic usage

All actions in Centreon CLAPI will require authentication, so your commands will always start like this:

# cd /usr/share/centreon/bin
# ./centreon -u admin -p centreon [...]

Obviously, the -u option is for the username and the -p option is for the password. The password can be in clear or the
encrypted in the database.

Note: If your passwords are encoded with SHA1 in database (MD5 by default), use the -s option:

# ./centreon -u admin -p centreon -s [...]

15.2.2 Poller management

List available pollers

In order to list available pollers, use the POLLERLIST command:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERLIST
poller_id;name
1;Local Poller
2;Remote Poller

Generate local configuration files for a poller

In order to generate configuration files for poller “Local Poller” of id 1, use the POLLERGENERATE command:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERGENERATE -v 1
Configuration files generated for poller 1

You can generate the configuration using the poller name:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERGENERATE -v "Local Poller"
Configuration files generated for poller ’Local Poller’
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Test monitoring engine configuration of a poller

In order to test configuration files for poller “Remote Poller” of id 2, use the POLLERTEST command:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERTEST -v 1
OK: Nagios Poller 2 can restart without problem...

You can test the configuration using the poller name:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERTEST -v "Local Poller"
Warning: Nagios Poller poller can restart but configuration is not optimal. Please see debug bellow :
---------------------------------------------------------------------------------------------------
[1440681047] [15559] Reading main configuration file ’/usr/share/centreon//filesGeneration/nagiosCFG/5/nagiosCFG.DEBUG’.
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/hosts.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/hostTemplates.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/serviceTemplates.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/services.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/misccommands.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/checkcommands.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/contactgroups.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/contactTemplates.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/contacts.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/hostgroups.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/servicegroups.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/timeperiods.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/escalations.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/dependencies.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/connectors.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-command.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-contact.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-contactgroup.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-dependencies.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-escalations.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-host.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-services.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-timeperiod.cfg’
[1440681047] [15559] Reading resource file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/resource.cfg’
[1440681047] [15559] Checking global event handlers...
[1440681047] [15559] Checking obsessive compulsive processor commands...
[1440681047] [15559]
[1440681047] [15559] Checked 55 commands.
[1440681047] [15559] Checked 0 connectors.
[1440681047] [15559] Checked 7 contacts.
[1440681047] [15559] Checked 0 host dependencies.
[1440681047] [15559] Checked 0 host escalations.
[1440681047] [15559] Checked 0 host groups.
[1440681047] [15559] Checked 1 hosts.
[1440681047] [15559] Checked 0 service dependencies.
[1440681047] [15559] Checked 0 service escalations.
[1440681047] [15559] Checked 0 service groups.
[1440681047] [15559] Checked 1 services.
[1440681047] [15559] Checked 5 time periods.
[1440681047] [15559]
[1440681047] [15559] Total Warnings: 1
[1440681047] [15559] Total Errors: 0

---------------------------------------------------------------------------------------------------
Return code end : 0
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Move monitoring engine configuration files

In order to move configuration files for poller “Local Poller” of id 1 to the final engine directory, use the CFGMOVE
command:

[root@centreon core]# ./centreon -u admin -p centreon -a CFGMOVE -v 2
OK: All configuration will be send to ’Remote Poller’ by centcore in several minutes.
Return code end : 1

You can move the configuration files using the poller name:

[root@centreon core]# ./centreon -u admin -p centreon -a CFGMOVE -v "Remote Poller"
OK: All configuration will be send to ’Remote Poller’ by centcore in several minutes.
Return code end : 1

Restart monitoring engine of a poller

In order to restart the monitoring process on poller “Local Poller” of id 1, use the the POLLERRESTART command:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERRESTART -v 2
OK: A restart signal has been sent to ’Remote Poller’
Return code end : 1

You can restart the poller using its name:

[root@centreon core]# ./centreon -u Remote Poller -p centreon -a POLLERRESTART -v "Remote Poller"
OK: A restart signal has been sent to ’Remote Poller’
Return code end : 1

All in one command

Use the APPLYCFG command in order to execute all of the above with one single command:

[root@centreon core]# ./centreon -u admin -p centreon -a APPLYCFG -v 1

You can execute using the poller name:

[root@centreon core]# ./centreon -u admin -p centreon -a APPLYCFG -v "Remote Poller"

This will execute POLLERGENERATE, POLLERTEST, CFGMOVE and POLLERRELOAD.

Reload monitoring engine of a poller

In order to reload the monitoring process on poller “Remote Poller” of id 2, use the POLLERRELOAD command:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERRELOAD -v 2
OK: A reload signal has been sent to Remote Pollerpoller’
Return code end : 1

You can reload poller using its name:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERRELOAD -v "Remote Poller"
OK: A reload signal has been sent to ’Remote Poller’
Return code end : 1
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Execute post generation commands of a poller

In order to execute post generation commands of a poller, use the POLLEREXECCMD command:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLEREXECCMD -v 2
Running configuration check...done.
Reloading nagios configuration...done

You can execute post generation commands of a poller using its name:

[root@centreon core]# ./centreon -u admin -p centreon -a POLLEREXECCMD -v "Remote Poller"
Running configuration check...done.
Reloading nagios configuration...done

15.2.3 Object management

ACL

Overview

Object name: ACL

Reload

In order to reload ACL, use the RELOAD command:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACL -a reload

Lastreload

In order to check when the ACL was last reloaded, use the LASTRELOAD command:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACL -a lastreload
1329833702

If you wish to get a human readable time format instead of a timestamp, use the following command:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACL -a lastreload -v "d-m-Y H:i:s"
21-02-2012 15:17:01

You can change the date format:

Format character Description
d Day
m Month
Y Year
H Hour
i Minute
s Second
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Action ACL

Overview

Object name: ACLACTION

Show

In order to list available ACL Actions, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a show
id;name;description;activate
1;Simple User;Simple User;1
[...]

Columns are the following:

Column Description
ID
Name
Description
Activate 1 when ACL Action is enabled, 0 otherwise

Add

In order to add an ACL Action, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a add -v "ACL Action test;my description"

Required fields:

Column Description
Name
Description

Del

If you want to remove an ACL Action, use the DEL action. The Name is used for identifying the ACL Action to
delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a del -v "ACL Action test"

Setparam

If you want to change a specific parameter of an ACL Action, use the SETPARAM action. The Name is used for
identifying the ACL Action to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a setparam -v "ACL Action test;description;my new description"

Arguments are composed of the following columns:
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Order Column description
1 Name of ACL action rule
2 Parameter name
3 Parameter value

Parameters that you may change are the following:

Column Description
name
description
activate 1 when ACL Action is enabled, 0 otherwise

Getaclgroup

If you want to retrieve the ACL Groups that are linked to a specific ACL Action, use the GETACLGROUP command.

Arguments are composed of the following columns:

Order Column description
1 Name of ACL action rule

Example::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a getaclgroup -v "ACL Action test"
id;name
1;ALL
3;Operators

Grant and Revoke

If you want to grant or revoke actions in an ACL Action rule definition, use the following commands: GRANT,
REVOKE.

Arguments are composed of the following columns:

Order Column description
1 Name of ACL action rule
2 Actions to grant/revoke

Example::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a grant -v "ACL Action test;host_acknowledgement|service_acknowledgement"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a revoke -v "ACL Action test;host_schedule_downtime|service_schedule_downtime"

The ‘*‘ wildcard can be used in order to grant or revoke all actions::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a grant -v "ACL Action test;*"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a revoke -v "ACL Action test;*"

Below is the list of actions that you can grant/revoke:

Action Description
global_event_handler Permission to globally enable/disable event handlers
global_flap_detection Permission to globally enable/disable flap detection

Continued on next page
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Table 15.3 – continued from previous page
Action Description
global_host_checks Permission to globally enable/disable host active checks
global_host_obsess Permission to globally enable/disable obsess over host
global_host_passive_checks Permission to globally enable/disable host passive checks
global_notifications Permission to globally enable/disable notifications
global_perf_data Permission to globally enable/disable performance data
global_restart Permission to restart the monitoring engine
global_service_checks Permission to globally enable/disable service active checks
global_service_obsess Permission to globally enable/disable obsess over service
global_service_passive_checks Permission to globally enable/disable service passive checks
global_shutdown Permission to shut down the monitoring engine
host_acknowledgement Permission to acknowledge hosts
host_checks Permission to enable/disable host active checks
host_checks_for_services Permission to enable/disable active checks of a host’s services
host_comment Permission to put comments on hosts
host_event_handler Permission to enable/disable event handlers on hosts
host_flap_detection Permission to enable/disable flap detection on hosts
host_notifications Permission to enable/disable notification on hosts
host_notifications_for_services Permission to enable/disable notification on hosts’ services
host_schedule_check Permission to schedule a host check
host_schedule_downtime Permission to schedule a downtime on a host
host_schedule_forced_check Permission to schedule a host forced check
host_submit_result Permission to submit a passive check result to a host
poller_listing Permission to see the Poller list on the monitoring console
poller_stats Permission to see the poller statistics (on top screen)
service_acknowledgement Permission to acknowledge services
service_checks Permission to enable/disable service active checks
service_comment Permission to put comments on services
service_event_handler Permission to enable/disable event handlers on services
service_flap_detection Permission to enable/disable flap detection on services
service_notifications Permission to enable/disable notification on services
service_passive_checks Permission to enable/disable service passive checks
service_schedule_check Permission to schedule a service check
service_schedule_downtime Permission to schedule a downtime on a service
service_schedule_forced_check Permission to schedule a service forced check
service_submit_result Permission to submit a passive check result to a service
top_counter Permission to see the quick status overview (top right corner of the screen)

ACL Groups

Overview

Object name: ACLGROUP

Show

In order to list available ACL Groups, use the SHOW action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a show
id;name;alias;activate
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1;ALL;ALL;1
[...]

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias
Activate 1 when ACL Group is enabled, 0 otherwise

Add

In order to add an ACL Group, use the ADD action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a add -v "ACL Group test;my alias"

Required fields are:

Column Description
Name Name
Alias Alias

Del

If you want to remove an ACL Group, use the DEL action. The Name is used for identifying the ACL Group to
delete::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a del -v "ACL Group test"

Setparam

If you want to change a specific parameter of an ACL Group, use the SETPARAM action. The Name is used for
identifying the ACL Group to update::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a setparam -v "ACL Group test;alias;my new alias"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL Group
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
name
alias
activate 1 when ACL Group is enabled, 0 otherwise
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Getmenu

If you want to retrieve the Menu Rules that are linked to a specific ACL Group, use the GETMENU action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getmenu -v "ACL Group test"
id;name
1;Configuration
3;Reporting
4;Graphs
2;Monitoring + Home

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group

Getaction

If you want to retrieve the Action Rules that are linked to a specific ACL Group, use the GETACTION action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getaction -v "ACL Group test"
id;name
1;Simple action rule

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group

Getresource

If you want to retrieve the Resource Rules that are linked to a specific ACL Group, use the GETRESOURCE action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getresource -v "ACL Group test"
id;name
1;All Resources

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group

Getcontact and Getcontactgroup

If you want to retrieve the Contacts that are linked to a specific ACL Group, use the GETCONTACT action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getcontact -v "ACL Group test"
id;name
1;user1

If you want to retrieve the Contact Groups that are linked to a specific ACL Group, use the GETCONTACTGROUP
action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getcontactgroup -v "ACL Group test"
id;name
1;usergroup1
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Arguments are composed of the following columns:

Order Column description
1 Name of ACL group

Setmenu, Setaction, Setresource, Addmenu, Addaction, Addresource

If you want to link rules to a specific ACL Group, use the following actions: SETMENU, SETACTION, SETRE-
SOURCE, ADDMENU, ADDACTION, ADDRESOURCE:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a setmenu -v "ACL Group test;Menu rule 1|Menu rule 2"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a addresource -v "ACL Group test;All Routers"

Command type Description
set* Overwrites previous definitions. Use the delimiter | to set multiple rules
add* Appends new rules to the previous definitions. Use the delimiter | to add multiple rules

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group
2 Name of the ACL rule to link

Delmenu, Delaction, Delresource

If you want to remove rules from a specific ACL Group, use the following actions: DELMENU, DELACTION,
DELRESOURCE:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a delaction -v "ACL Group test;Ack rule|Downtime rule"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group
2 Name of the ACL rule to remove

Setcontact, Setcontactgroup, Addcontact, Addcontactgroup

If you want to link contacts or contact groups to a specific ACL Group, use the following actions: SETCONTACT,
SETCONTACTGROUP, ADDCONTACT, ADDCONTACTGROUP:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a setcontact -v "ACL Group test;user1"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a addcontactgroup -v "ACL Group test;usergroup1"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group
2 Contact/Contact group to add/set
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Command
type

Description

set* Overwrites previous definitions. Use the delimiter | to set multiple contacts/contact groups
add* Appends new contacts/contact groups to the previous definitions. Use the delimiter | to add

multiple rules

Delcontact, Delcontactgroup

If you want to remove rules from a specific ACL Group, use the following actions: DELCONTACT, DELCON-
TACTGROUP:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a delcontact -v "ACL Group test;user1"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group
2 Contact/Contact group to remove from ACL group

Menu ACL

Overview

Object name: ACLMENU

Show

In order to list available ACL Menus, use the SHOW action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a show
id;name;alias;comment;activate
1;Configuration;Configuration;;1
2;Monitoring + Home;Monitoring + Home;;1
3;Reporting;Reporting;;1
4;Graphs;Graphs;just a comment;1
[...]

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias
Comment Comment
Activate 1 when ACL Menu is enabled, 0 otherwise

Add

In order to add an ACL Menu, use the ADD action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a add -v "ACL Menu test;my alias"
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Required fields are:

Column Description
Name Name
Alias Alias

Del

If you want to remove an ACL Menu, use the DEL action. The Name is used for identifying the ACL Menu to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a del -v "ACL Menu test"

Setparam

If you want to change a specific parameter of an ACL Menu, use the SETPARAM action. The Name is used for
identifying the ACL Menu to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a setparam -v "ACL Menu test;alias;my new alias"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL menu rule
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
name Name
alias Alias
activate 1 when ACL Menu is enabled, 0 otherwise
comment Comment

Getaclgroup

If you want to retrieve the ACL Groups that are linked to a specific ACL Menu, use the GETACLGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a getaclgroup -v "ACL Menu test"
id;name
1;ALL
3;Operators

Arguments are composed of the following columns:

Order Column description
1 Name of ACL menu rule

Grant and Revoke

If you want to grant in Read/Write, Read Only or revoke menus in an ACL Menu rule definition, use the following
actions: GRANTRW, GRANTRO, REVOKE

Let’s assume that you would like to grant full access to the [Monitoring] menu in your ACL Menu rule::
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[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a grantrw -v "ACL Menu test;1;Monitoring"

Then, you would like to grant access to the [Home] > [Poller statistics] menu::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a grantrw -v "ACL Menu test;1;Home;Poller statistics"

Then, you would like to grant access in read only to the [Configuration] > [Hosts] menu::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a grantro -v "ACL Menu test;1;Configuration;Hosts"

Then, you decide to revoke access from [Monitoring] > [Event Logs]::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a revoke -v "ACL Menu test;1;Monitoring;Event Logs"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL menu rule
2 Grant/revoke children menus
3 Menu name to grant/revoke
n Possible sub menu name

Resource ACL

Overview

Object name: ACLRESOURCE

Show

In order to list available ACL Resources, use the SHOW action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a show
id;name;alias;comment;activate
1;All Resources;All Resources;;1
[...]

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias
Comment Comment
Activate 1 when ACL Resource is enabled, 0 otherwise

Add

In order to add an ACL Resource, use the ADD action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a add -v "ACL Resource test;my alias"

Required fields are:
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Column Description
Name Name
Alias Alias

Del

If you want to remove an ACL Resource, use the DEL action. The Name is used for identifying the ACL Resource to
delete::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a del -v "ACL Resource test"

Setparam

If you want to change a specific parameter of an ACL Resource, use the SETPARAM action. The Name is used for
identifying the ACL Resource to update::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a setparam -v "ACL Resource test;alias;my new alias"

Arguments are composed of the following columns:

Order Column description
1 Name of ACL resource rule
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
name Name
alias Alias
activate 1 when ACL Resource is enabled, 0 otherwise

Getaclgroup

If you want to retrieve the ACL Groups that are linked to a specific ACL Resource, use the GETACLGROUP action::

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a getaclgroup -v "ACL Resource test"
id;name
1;ALL
3;Operators

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group

Grant and revoke

Arguments are composed of the following columns:

Order Column description
1 Name of ACL group
2 Name of resource
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If you want to grant or revoke resources in an ACL Resource rule definition, use the following commands:

Command Description Example Wildcard ‘*’
supported

grant_host Put host name(s) [...] -a grant_host -v “ACL Resource
Test;srv-esx”

Yes

grant_hostgroup Put hostgroup
name(s)

[...] -a grant_hostgroup -v “ACL Resource
Test;Linux servers”

Yes

grant_servicegroup Put servicegroup
name(s)

[...] -a grant_servicegroup -v “ACL Resource
Test;Ping”

Yes

grant_metaservice Put metaservice
name(s)

[...] -a grant_metaservice -v “ACL Resource
Test;Traffic Average”

No

addhostexclusion Put host name(s) [...] -a addhostexclusion -v “ACL Resource
Test;srv-test|srv-test2”

No

revoke_host Put host name(s) [...] -a revoke_host -v “ACL Resource
Test;srv-esx”

Yes

revoke_hostgroup Put hostgroup
name(s)

[...] -a revoke_hostgroup -v “ACL Resource
Test;Linux servers”

Yes

re-
voke_servicegroup

Put servicegroup
name(s)

[...] -a revoke_servicegroup -v “ACL Resource
Test;Ping”

Yes

re-
voke_metaservice

Put metaservice
name(s)

[...] -a revoke_metaservice -v “ACL Resource
Test;Traffic Average”

Yes

delhostexclusion Put host name(s) [...] -a delhostexclusion -v “ACL Resource
Test;srv-test|srv-test2”

Yes

addfilter_instance Put instance
name(s)

[...] -a addfilter_instance -v “ACL Resource
Test;Monitoring-2”

No

addfil-
ter_hostcategory

Put host category
name(s)

[...] -a addfilter_hostcategory -v “ACL Resource
Test;Customer-1”

No

addfil-
ter_servicecategory

Put service category
name(s)

[...] -a addfilter_servicecategory -v “ACL
Resource Test;System”

No

delfilter_instance Put instance
name(s)

[...] -a delfilter_instance -v “ACL Resource
Test;Monitoring-2”

Yes

delfil-
ter_hostcategory

Put host category
name(s)

[...] -a delfilter_hostcategory -v “ACL Resource
Test;Customer-1”

Yes

delfil-
ter_servicecategory

Put service category
name(s)

[...] -a delfilter_servicecategory -v “ACL
Resource Test;System”

Yes

Note: Use delimiter “|” for defining multiple resources.

Centreon broker

Overview

Object name: CENTBROKERCFG

Show

In order to list available Centreon Broker CFG, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a show
config id;config name;instance
1;Central CFG;Central
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2;Sattelite CFG;Sattelite
[...]

Columns are the following:

Order Description
1 ID
2 Name of configuration
3 Instance that is linked to broker cfg

Add

In order to add a Centreon Broker CFG, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a add -v "broker cfg for poller test;Poller test"

Required fields are:

Order Description
1 Name of configuration
2 Instance that is linked to broker cfg

Del

If you want to remove a Centreon Broker CFG, use the DEL action. The Name is used for identifying the configuration
to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a del -v "broker cfg for poller test"

Setparam

If you want to change a specific parameter of a Centreon Broker configuration, use the SETPARAM action. The
configuration name is used for identifying the configuration to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a setparam -v "broker cfg for poller test;name;new broker cfg name"

Arguments are composed of the following columns:

Order Column description
1 Name of Centreon Broker configuration
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
filename Filename of configuration (.xml extension)
name Name of configuration
instance Instance that is linked to Centreon Broker CFG
event_queue_max_size Event queue max size (when number is reached, temporary output will be used).
cache_directory Path for cache files
daemon Link this configuration to cbd service (0 or 1)
correlation_activate Enable correlation (0 or 1)
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Listinput, Listoutput and Listlogger

If you want to list specific input output types of Centreon Broker, use one of the following commands: listinput
listoutput listlogger

Example:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a listoutput -v "broker cfg for poller test"
id;name
1;Storage
2;RRD
3;PerfData

Columns are the following :

Column Description
ID I/O ID
Name I/O Name

Getinput, Getoutput and Getlogger

In order to get parameters of a specific I/O object, use one of the following commands:

• getinput

• getoutput

• getlogger

Example:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a getoutput -v "broker cfg for poller test;3"
parameter key;parameter value
db_host;localhost
db_name;centreon_storage
db_password;centreon
db_port;3306
db_type;mysql
db_user;centreon
interval;60
length;
name;PerfData
type;storage

The ID is used for identifying the I/O to get.

Columns are the following :

Order Description
1 Parameter key of the I/O
2 Parameter value of the I/O

Addinput, Addoutput and Addlogger

In order to add a new I/O object, use one of the following commands:

• ADDINPUT

• ADDOUTPUT
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• ADDLOGGER

Example:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a addlogger -v "broker cfg for poller test;/var/log/centreon-broker/central-module.log;file"
[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a listlogger -v "broker cfg for poller test"
id;name
1;/var/log/centreon-broker/central-module.log

Arguments are composed of the following columns:

Order Column description
1 Name of Centreon Broker CFG
2 Name of the I/O object
3 Nature of I/O object

Delinput, Deloutput and Dellogger

In order to remove an I/O object from the Centreon Broker configuration, use one of the following commands:

• DELINPUT

• DELOUTPUT

• DELLOGGER

Example:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a dellogger -v "broker cfg for poller test;1"

The I/O ID is used for identifying the object to delete.

Setintput, Setoutput and Setlogger

In order to set parameters of an I/O object, use one of the following commands:

• SETINPUT

• SETOUTPUT

• SETLOGGER

Example:

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a setlogger -v "broker cfg for poller test;1;debug;no"

Arguments are composed of the following columns:

Order Column description
1 Name of Centreon Broker CFG
2 ID of I/O object
3 Parameter name
4 Parameter value, for multiple values, use the ”,” delimiter

You may get help with the following CLAPI commands:

• GETTYPELIST

• GETFIELDLIST
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• GETVALUELIST

Example:

[root@localhost core]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a gettypelist -v "output"
type id;short name;name
27;bam_bi;BI engine (BAM)
16;sql;Broker SQL Database
32;correlation;Correlation
28;db_cfg_reader;Database configuration reader
29;db_cfg_writer;Database configuration writer
11;file;File
3;ipv4;IPv4
10;ipv6;IPv6
26;bam;Monitoring engine (BAM)
14;storage;Perfdata Generator (Centreon Storage)
13;rrd;RRD File Generator
30;graphite;Storage - Graphite
31;influxdb;Storage - InfluxDB

[root@localhost core]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a getfieldlist -v "ipv4"
field id;short name;name
3;ca_certificate;Trusted CA’s certificate;text
2;host;Host to connect to;text
46;negotiation;Enable negotiation;radio
48;one_peer_retention_mode;One peer retention;radio
1;port;Connection port;int
4;private_key;Private key file.;text
12;protocol*;Serialization Protocol;select
5;public_cert;Public certificate;text
6;tls;Enable TLS encryption;radio

Note: Note that the “protocol” entry is followed by a star. This means that you have to use one of the possible values.

This is how you get the list of possible values of a given field:

[root@localhost core]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a getvaluelist -v "protocol"
possible values
ndo

The following chapters describes the parameters of each Object type

input ipv4:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

compression Compression (zlib) Enable or not data stream
compression.

•

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

•

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in in-
put

•

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. •

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

•

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

•

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

•

private_key Private key file. Private key file path when
TLS encryption is used.

•

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

•

tls Enable TLS encryption Enable TLS encryption. •

ipv6:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

compression Compression (zlib) Enable or not data stream
compression.

•

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

•

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in in-
put

•

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. •

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

•

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

•

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

•

private_key Private key file. Private key file path when
TLS encryption is used.

•

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

•

tls Enable TLS encryption Enable TLS encryption. •

file:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

compression Compression (zlib) Enable or not data stream
compression.

•

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

•

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

max_size Maximum size of file Maximum size in bytes. •

path File path Path to the file. •

protocol Serialization protocol Serialization protocol. ndo

logger file:

ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
•

debug Debug messages Enable or not debug mes-
sages logging.

•

error Error messages Enable or not error mes-
sages logging.

•

info Informational messages Enable or not informational
messages logging.

•

level Logging level How much messages must
be logged.

high,low,medium

max_size Max file size in bytes The maximum size of log
file.

•

name Name of the logger For a file logger this is the
path to the file. For a stan-
dard logger, one of ‘stdout’
or ‘stderr’.

•

standard:
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ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
•

debug Debug messages Enable or not debug mes-
sages logging.

•

error Error messages Enable or not error mes-
sages logging.

•

info Informational messages Enable or not informational
messages logging.

•

level Logging level How much messages must
be logged.

high,low,medium

name Name of the logger For a file logger this is the
path to the file. For a stan-
dard logger, one of ‘stdout’
or ‘stderr’.

•

syslog:

ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
•

debug Debug messages Enable or not debug mes-
sages logging.

•

error Error messages Enable or not error mes-
sages logging.

•

info Informational messages Enable or not informational
messages logging.

•

level Logging level How much messages must
be logged.

high,low,medium

monitoring:

ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
•

debug Debug messages Enable or not debug mes-
sages logging.

•

error Error messages Enable or not error mes-
sages logging.

•

info Informational messages Enable or not informational
messages logging.

•

level Logging level How much messages must
be logged.

high,low,medium

name Name of the logger For a file logger this is the
path to the file. For a stan-
dard logger, one of ‘stdout’
or ‘stderr’.

•

output ipv4:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

compression Compression (zlib) Enable or not data stream
compression.

•

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

•

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

•

failover Failover name Name of the output which
will act as failover

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in
output

•

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. •

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

•

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

•

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

•

private_key Private key file. Private key file path when
TLS encryption is used.

•

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

•

tls Enable TLS encryption Enable TLS encryption. •

ipv6:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

compression Compression (zlib) Enable or not data stream
compression.

•

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

•

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

•

failover Failover name Name of the output which
will act as failover

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in
output

•

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. •

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

•

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

•

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

•

private_key Private key file. Private key file path when
TLS encryption is used.

•

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

•

tls Enable TLS encryption Enable TLS encryption. •

file:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

compression Compression (zlib) Enable or not data stream
compression.

•

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

•

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

•

failover Failover name Name of the output which
will act as failover

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in
output.

•

max_size Maximum size of file Maximum size in bytes. •

path File path Path to the file. •

protocol Serialization protocol Serialization protocol. ndo

rrd:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

failover Failover name Name of the output which
will act as failover

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in
output.

•

metrics_path RRD file directory for met-
rics

RRD file direc-
tory, for example
/var/lib/centreon/metrics

•

path Unix socket The Unix socket used to
communicate with rrd-
cached. This is a global
option, go to Administra-
tion > Options > RRDTool
to modify it.

•

port TCP port The TCP port used to com-
municate with rrdcached.
This is a global option, go to
Administration > Options >
RRDTool to modify it.

•

status_path RRD file directory for sta-
tuses

RRD file direc-
tory, for example
/var/lib/centreon/status

•

write_metrics Enable write_metrics Enable or not
write_metrics.

•

write_status Enable write_status Enable or not write_status. •

store_in_data_bin Enable store_in_data_bin Enable or not store in per-
formance data in data_bin.

•

storage:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

failover Failover name Name of the output which
will act as failover

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in
output.

•

check_replication Replication enabled When enabled, the broker
engine will check whether
or not the replication is up
to date before attempting to
update data.

•

db_host DB host IP address or hostname of
the database server.

•

db_name DB name Database name. •

db_password DB password Password of database user. •

db_port DB port Port on which the DB server
listens

•

db_type DB type Target DBMS. db2,ibase,mysql,oci,odbc,postgresql,sqlite,tds
db_user DB user Database user. •

interval Interval length Interval length in seconds. •

length RRD length RRD storage duration in
seconds.

•

queries_per_transaction Maximum queries per
transaction

The maximum queries per
transaction before commit.

•

read_timeout Transaction commit time-
out

The transaction timeout be-
fore running commit.

•

rebuild_check_interval Rebuild check interval in
seconds

The interval between check
if some metrics must be re-
build. The default value is
300s

•

store_in_data_bin Enable store_in_data_bin Enable or not store in per-
formance data in data_bin.

•

sql:
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
•

failover Failover name Name of the output which
will act as failover

•

retry_interval Retry interval Time in seconds to wait be-
tween each connection at-
tempt.

•

category Filter category Category filter for flux in
output.

•

check_replication Replication enabled When enabled, the broker
engine will check whether
or not the replication is up
to date before attempting to
update data.

•

db_host DB host IP address or hostname of
the database server.

•

db_name DB name Database name. •

db_password DB password Password of database user. •

db_port DB port Port on which the DB server
listens

•

db_type DB type Target DBMS. db2,ibase,mysql,oci,odbc,postgresql,sqlite,tds
db_user DB user Database user. •

queries_per_transaction Maximum queries per
transaction

The maximum queries per
transaction before commit.

•

read_timeout Transaction commit time-
out

The transaction timeout be-
fore running commit.

•

Commands

Overview

Object name: CMD

Show

In order to list available commands, use SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a show
id;name;type;line
1;check-ping;check;$USER1$/check_ping -H $HOSTADDRESS$ -w $ARG1$ -c $ARG2$
2;check_dummy;check;$USER1$/check_dummy -o $ARG1$ -s $ARG2$
[...]

Columns are the following:
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Column Description
Command ID
Command name
Command type check, notif, misc or discovery
Command line System command line that will be run on execution

Add

In order to add a command use ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a ADD -v ’check-host-alive;check;$USER1$/check_ping -H $HOSTADDRESS$ -w 3000.0,80% -c 5000.0,100% -p 1’

Required columns are the following:

Column Description
Command name
Command type check, notif, misc or discovery
Command line System command line that will be run on execution

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

If you want to remove a command use DEL action:

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a del -v ’check-host-alive’

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

If you want to change a specific parameters for a command, use the SETPARAM command:

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a setparam -v ’check-host-alive;type;notif’
[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a setparam -v ’check-host-alive;name;check-host-alive2’

Parameters that you can change are the following:

Parameter Description
name Name of command
line Command line
type check, notif, misc or discovery
graph Graph template applied on command
example Example of arguments (i.e: !80!90)
comment Comments regarding the command

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Contacts

Overview

Object name: CONTACT

Show

In order to list available contacts, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o contact -a show
id;name;alias;email;pager;gui access;admin;activate
4;Guest;guest;guest@localhost;;0;0;0
5;Supervisor;admin;root@localhost;;1;1;1
6;User;user;user@localhost;;0;0;0

Columns are the following :

Column Description
ID ID of contact
Name Name of contact
Alias Alias of contact (also login id)
Email Email of contact
Pager Phone number of contact
GUI Access 1 (can access UI) or 0 (cannot access UI)
Admin 1 (admin) or 0 (non admin)
activate 1 (enabled) or 0 (disabled)

Add

In order to add a contact, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o CONTACT -a ADD -v "user;user;user@mail.com;mypassword;1;1;en_US;local"

The required parameters are the following:

Parameter Description
Name Name of contact
Alias (login) Alias of contact (also login id)
Email Email of contact
Password Password of contact
Admin 1 (admin) or 0 (non admin)
GUI Access 1 (can access UI) or 0 (cannot access UI)
Language Language pack has to be installed on Centreon
Authentication type local or ldap

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one contact, use the DEL action. The contact name is used for identifying the contact you would
like to delete:
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[root@centreon core]# ./centreon -u admin -p centreon -o contact -a del -v "user"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

If you want to change a specific parameter for a contact, use the SETPARAM action:

[root@centreon core]# ./centreon -u admin -p centreon -o contact -a setParam -v "contact alias;hostnotifcmd;command name"
[root@centreon core]# ./centreon -u admin -p centreon -o contact -a setParam -v "contact alias;svcnotifcmd;command name"
[root@centreon core]# ./centreon -u admin -p centreon -o contact -a setParam -v "contact alias;hostnotifperiod;period name"
[root@centreon core]# ./centreon -u admin -p centreon -o contact -a setparam -v "contact alias;timezone;Europe/Berlin"

The required parameters are the following:

Parameter Description
Contact alias Alias of contact to update
Parameter Parameter to update
Value New value of parameter

Parameters that you can change are the following:

Parameter Description
name Name
alias Alias
comment Comment
email Email Address
password User Password
access Can reach centreon, 1 if user has access, 0 otherwise
language Locale
admin 1 if user is admin, 0 otherwise
authtype ldap or local
hostnotifcmd host notification command(s). Multiple commands can be defined with delimiter “|”
svcnotifcmd service notification command(s). Multiple commands can be defined with delimiter “|”
hostnotifperiod host notification period
svcnotifperiod service notification period
hostnotifopt can be d,u,r,f,s,n
servicenotifopt can be w,u,c,r,f,s,n
address1 Address #1
address2 Address #2
address3 Address #3
address4 Address #4
address5 Address #5
address6 Address #6
ldap_dn LDAP domain name
enable_notifications 1 when notification is enable, 0 otherwise
autologin_key Used for auto login
template Name of the template to apply to the contact
timezone Timezone

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Enable

In order to enable a contact, use the ENABLE action:

[root@centreon core]# ./centreon -u admin -p centreon -o contact -a enable -v "test"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Disable

In order to disable a contact, use the DISABLE action:

[root@centreon core]# ./centreon -u admin -p centreon -o contact -a disable -v "test"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Contact templates

Overview

Object name: CONTACTTPL

Refer to the CONTACT object

Contact Groups

Overview

Object name: CG

Show

In order to list available contact groups, use the SHOW action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a show
id;name;alias;members
Guest;Guests Group;guest-user1,guest-user2
Supervisors;Centreon supervisors;Admin

Columns are the following:

Column Description
Name
Alias
Members List of contacts that are in the contact group

Add

In order to add a contact group, use the ADD action:
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[root@centreon core]# ./centreon -u admin -p centreon -o CG -a ADD -v "Windows;Windows admins"

Required fields are the following:

Column Description
Name Name
Alias Alias

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one contact group, use the DEL action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a DEL -v "Windows"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to change the name or the alias of a contactgroup, use the SETPARAM action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a setparam -v "Windows;name;Windows-2K"
[root@centreon core]# ./centreon -u admin -p centreon -o CG -a setparam -v "Cisco;alias;Cisco-Routers"

Parameters that you can change are the following:

Parameter Description
name Name
alias Alias

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Enable

In order to enable a contact group, use the ENABLE action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a enable -v "Guest"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Disable

In order to disable a contact group, use the DISABLE action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a disable -v "Guest"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Getcontact

In order to view the contact list of a contact group, use the GETCONTACT action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a getcontact -v "Guest"
id;name
1;User1
2;User2

Columns are the following:

Column Description
ID Id of contact
Name Name of contact

Addcontact and Setcontact

In order to add a contact to a contact group, use the ADDCONTACT or SETCONTACT action where ‘add’ will
append and ‘set’ will overwrite previous definitions:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a addcontact -v "Guest;User1"
[root@centreon core]# ./centreon -u admin -p centreon -o CG -a setcontact -v "Guest;User1|User2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontact

In order to remove a contact from a contact group, use the DELCONTACT action:

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a delcontact -v "Guest;User1"
[root@centreon core]# ./centreon -u admin -p centreon -o CG -a delcontact -v "Guest;User2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Dependencies

Overview

Object name: DEP

Show

In order to list available dependencies, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a show
id;name;description;inherits_parent;execution_failure_criteria;notification_failure_criteria
62;my dependency;a description;1;n;n

Columns are the following:
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Column Description
ID Unique ID of the dependency
Name Name
Description Short description of the dependency
inherits_parent Whether or not dependency inherits higher level dependencies
execution_failure_criteria Defines which parent states prevent dependent resources from being checked
notification_failure_criteria Defines which parent states prevent notifications on dependent resources

Add

In order to add a new dependency, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADD \
-v "my new dependency;any description;HOST;dummy-host"

The required parameters are the following:

Order Description
1 Name of the dependency
2 Description of the dependency
3 Dependency type: HOST, HG, SG, SERVICE, META
4 Name of the parent resource(s)

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete a dependency, use the DEL action. The dependency name is used for identifying the dependency
you would like to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DEL -v "my dependency"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific parameter for a dependency, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a setparam \
-v "my dependency;name;my new dependency name"

You may change the following parameters:

Parameter Description
name Name
description Description
comment Comment
inherits_parent 0 or 1
execution_failure_criteria o,w,u,c,p,d,n
notification_failure_criteria o,w,u,c,p,d,n

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Listdep

If you want to retrieve the dependency definition of a dependency object, use the LISTDEP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a LISTDEP -v "my dependency"
parents;children
HostParent1|HostParent2;HostChild1|HostChild2,ServiceChild2

Addparent and Addchild

If you want to add a new parent or a new child in a dependency definition, use the ADDPARENT or ADDCHILD
action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADDPARENT \
-v "my dependency;my_parent_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADDCHILD \
-v "my dependency;my_child_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADDCHILD \
-v "my dependency;my_child_host2,my_child_service2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delparent and Delchild

In order to delete a parent or a child in a dependency definition, use the DELPARENT or DELCHILD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DELPARENT \
-v "my dependency;my_parent_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DELCHILD \
-v "my dependency;my_child_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DELCHILD \
-v "my dependency;my_child_host2,my_child_service2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Downtimes

Overview

Object name: DOWNTIME

Show

In order to list available recurring downtimes, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a show
id;name;description;activate
1;mail-backup;sunday backup;1
2;my downtime;a description;1
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Columns are the following:

Column Description
ID Unique ID of the recurring downtime
Name Name
Description Short description of the recurring downtime
Activate Whether or not the downtime is activated

In order to show resources of a downtime, use the Show action with parameters:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a show -v "mail-backup;host"

The parameters are the following:

Order Description
1 Name of the downtime
2 (optional) Object type (host, hg, service, sg)

Add

In order to add a new downtime, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADD -v "my new downtime;any description"

The required parameters are the following:

Order Description
1 Name of the downtime
2 Description of the downtime

Del

In order to delete a downtime, use the DEL action. The downtime name is used for identifying the recurring downtime
you would like to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a DEL -v "my downtime"

Setparam

In order to set a specific parameter for a downtime, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a setparam -v "my downtime;name;my new downtime name"

You may change the following parameters:

Parameter Description
name Name
description Description

Listperiods

If you want to retrieve the periods set on a recurring downtime, use the LISTPERIODS action:
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[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a LISTPERIODS -v "my downtime"
position;start time;end time;fixed;duration;day of week;day of month;month cycle
1;1;23:00:00;24:00:00;1;;7;;all
2;1;00:00:00;02:00:00;1;;;1,2;none
3;1;13:45:00;14:40:00;1;;5;;first

Columns are the following:

Column Description
Position Position of the period; used for deleting a period from a

recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed Type of downtime (1 = fixed, 0 = flexible)
Duration Duration of downtime when in flexible mode (seconds)
Day of week 1 - 7 (1 = monday ... 7 = sunday)
Day of month 1 - 31
Month cycle

“all”, “none”, “first” or “last”. Determines when the downtime
will be effective on specific weekdays (i.e: all
Sundays, last Sunday of the month, first Sunday
of the month...)

Addweeklyperiod

In order to add a weekly period, use the ADDWEEKLYPERIOD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDWEEKLYPERIOD \
-v "my downtime;00:00;04:00;0;7200;saturday,sunday"

The above example will set a downtime every saturday and sunday between 00:00 and 04:00.

Parameter Description
Name Name of the recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed 0 for flexible downtime, 1 for fixed
Duration Duration of downtime when in flexible mode (seconds)
Day of week Can be written with letters or numbers (1 to 7 or monday to sunday)

Addmonthlyperiod

In order to add a monthly period, use the ADDMONTHLYPERIOD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDMONTHLYPERIOD \
-v "my downtime;19:00;22:00;1;;14,21"

The above example will set a downtime on every 14th and 21st day for all months.
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Parameter Description
Name Name of the recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed 0 for flexible downtime, 1 for fixed
Duration Duration of downtime when in flexible mode (seconds)
Day of month 1 to 31

Addspecificperiod

In order to add a specific period, use the ADDSPECIFICPERIOD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDSPECIFICPERIOD \
-v "my downtime;19:00;22:00;1;;wednesday;first"

The above example will set a downtime on every first wednesday for all months.

Parameter Description
Name Name of the recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed 0 for flexible downtime, 1 for fixed
Duration Duration of downtime when in flexible mode (seconds)
Day of week Can be written with letters or numbers (1 to 7 or monday to sunday)
Month cycle first or last

Addhost, addhostgroup, addservice, addservicegroup

If you want to associate a host, host group, service or service group to a recurring downtime, use the ADDHOST,
ADDHOSTGROUP, ADDSERVICE or ADDSERVICEGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDHOST -v "my downtime;host_1"
[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDSERVICE -v "my downtime;host_1,service_1"

Use the “|” delimiter in order to define multiple relationships.

Delhost, delhostgroup, delservice, delservicegroup

If you want to remove a host, host group, service or service group from a recurring downtime, use the DELHOST,
DELHOSTGROUP, DELSERVICE or DELSERVICEGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a DELHOST -v "my downtime;host_1"
[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a DELSERVICE -v "my downtime;host_1,service_1"

Sethost, sethostgroup, setservice, setservicegroup

The SETHOST, SETHOSTGROUP, SETSERVICE AND SETSERVICEGROUP actions are similar to their
ADD counterparts, but they will overwrite the relationship definitions instead of appending them:

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDHOST -v "my downtime;host_1|host_2"
[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDSERVICE -v "my downtime;host_1,service_1|host_2,service_2"

Use the “|” delimiter in order to define multiple relationships.
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Real time Downtimes

Overview

Object name: RTDOWNTIME

Show host real time downtime

In order to list available real time downtimes, use the SHOW action:: You can use the value “HOST” to display all
the downtimes:

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a show -v "HOST;generic-host"
id;host_name;author;actual_start_time;actual_end_time;start_time;end_time;comment_data;duration;fixed
6;generic-host;admin;2017/09/28 14:21;N/A;2017/09/26 17:00;2017/09/30 19:00;’generic-comment’;3600;1

Columns are the following :

Column Description
id Name of the downtime
Host_name Name of the host
Author Name of the author
Actual_start_time Actual start date in case of flexible downtime
Actual_end_time Actual end date in case of flexible downtime
Start_time Beginning of downtime
End_time End of downtime
Comment_data Short description of the real time downtime
Duration Duration of Downtime
Fixed Downtime starts and stops at the exact start and end times

Show service real time downtime

In order to list available real time downtimes, use the SHOW action:: You can use the value “SVC” to display all the
downtimes:

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a show -v "SVC;generic-host,generic-service"
id;host_name;service_name;author;start_time;end_time;comment_data;duration;fixed
42;generic-host;generic-service;admin;2017/09/28 14:21;N/A;2017/09/26 17:00;2017/09/30 19:00;’generic-comment’;3600;1

Columns are the following :

Column Description
id Name of the downtime
Host_name Name of the host
Service_name Name of the service
Author Name of the author
Actual_start_time Actual start date in case of flexible downtime
Actual_end_time Actual end date in case of flexible downtime
Start_time Beginning of downtime
End_time End of downtime
Comment_data Short description of the real time downtime
Duration Duration of Downtime
Fixed Downtime starts and stops at the exact start and end times

468
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapter 15. API



Real time Downtime for : Addhost, addhostgroup

If you want to associate a host, host group to a real time downtime, use the ADD action:: To set the value of the
start/end, use following format : YYYY/MM/DD HH:mm:

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "HOST;central;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments;1"
[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "HG;linux-servers;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments;1"

The required parameters are the following :

Order Description
1 Value you want to associate
2 Name of the host (Name of the service)
3 Beginning of downtime
4 End of downtime
5 Type of downtime (1 = fixed, 0 = flexible)
6 Duration of downtime for flexible mode (seconds)
7 Short description of the real time downtime
8 Apply downtime on linked services (0/1)

Real time Downtime for : addservice, addservicegroup

If you want to associate a service or service group to a real time downtime, use the ADD action:: To set the value of
the start/end, use following format : YYYY/MM/DD HH:mm:

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "SVC;central,ping|central,memory;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments"
[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "SG;servicegroup1;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments"

The required parameters are the following :

Order Description
1 Value you want to associate
2 Name of the host (Name of the service)
3 Beginning of downtime
4 End of downtime
5 Type of downtime (1 = fixed, 0 = flexible)
6 Duration of downtime for flexible mode (seconds)
7 Short description of the real time downtime

Add instance real time downtime

In order to add a new real time downtime for a poller, use the ADD action:: To set the value of the start/end, use
following format : YYYY/MM/DD HH:mm:

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "INSTANCE;Central;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments

The required parameters are the following :
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Order Description
1 Value you want to associate
2 Name of the poller
3 Beginning of downtime
4 End of downtime
5 Type of downtime (1 = fixed, 0 = flexible)
6 Duration of downtime for flexible mode (seconds)
7 Short description of the real time downtime

Cancel a real time downtime

In order to cancel a real time downtime, use the CANCEL action:: To get the value of the id, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a CANCEL -v "6|42"

The required parameters are the following :

Order Description
1 Id of downtime

CENGINE CFG

Overview

Object name: ENGINECFG

Show

In order to list available Centreon Engine conf, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a show
id;name;instance;comment
1;Centreon Engine CFG 1;Central;Default CentreonEngine.cfg
[...]

Columns are the following :

Order Description
1 Centreon Engine ID
2 Centreon Engine configuration name
3 Instance that is linked to centreon-engine.cfg
4 Comments regarding the configuration file

Add

In order to add a Centreon Engine conf, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a add -v "Centreon Engine cfg for poller NY;Poller-NY;Just a small comment"

Required fields are:
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Order Description
1 Centreon Engine configuration name
2 Instance that is linked to centreon-engine.cfg
3 Comment regarding the configuration file

Del

If you want to remove a Centreon Engine conf, use the DEL action. The name is used for identifying the configuration
to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a del -v "Centreon Engine cfg for poller NY"

Setparam

If you want to change a specific parameter of a Centreon Engine conf, use the SETPARAM action. The name is used
for identifying the configuration to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a setparam -v "Centreon Engine cfg for poller NY;cfg_dir;/usr/local/nagios/etc"

Arguments are composed of the following columns:

Order Column description
1 Name of Centreon Engine configuration
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
nagios_name Name
instance Instance that is linked to centreon-engine.cfg
broker_module example: [...] -v “Engine CFG

NY;broker_module;/usr/lib64/nagios/cbmod.so
/etc/centreon-broker/central-module.xml”, you can
use a | delimiter for defining multiple broker modules

nagios_activate 1 if activated, 0 otherwise

• Centreon CLAPI handles pretty much all the options
available in a centreon-engine configuration file. Be-
cause the list is quite long, it is best to refer to the official
documentation of Centreon Engine

Addbrokermodule

If you want to add new broker module without removing existing modules, use the ADDBROKERMODULE::
[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a addbrokermodule -v “Centreon Engine
cfg for poller NY;/usr/lib64/centreon-engine/externalcmd.so”

Arguments are composed of the following columns:

Order Column description
1 Name of Centreon Engine configuration
2 Module name
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To add multiple modules in one line, it will put the separator “|” between the name of the modules::
[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a addbrokermodule -v “Centreon
Engine cfg for poller NY;/usr/lib64/centreon-engine/externalcmd.so|/etc/centreon-broker/central-module.xml”

Delbrokermodule

If you want to delete broker module, use the DELBROKERMODULE:: [root@centreon ~]# ./centreon -u admin
-p centreon -o ENGINECFG -a delbrokermodule -v “Centreon Engine cfg for poller NY;/usr/lib64/centreon-
engine/externalcmd.so”

Arguments are composed of the following columns:

Order Column description
1 Name of Centreon Engine configuration
2 Module name

To delete multiple modules in one line, it will put the separator “|” between the name of the modules::
[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a delbrokermodule -v “Centreon
Engine cfg for poller NY;/usr/lib64/centreon-engine/externalcmd.so|/etc/centreon-broker/central-module.xml”

Host templates

Overview

Object name: HTPL

Refer to the HOST object

Note: You cannot use the APPLYTPL and SETINSTANCE actions on HTPL objects.

If you are looking for service templates association to host templates refer to ADDHOSTTEM-
PLATE/SETHOSTTEMPLATE command from STPL object.

Hosts

Overview

Object name: HOST

Show

In order to list available hosts, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a show
id;name;alias;address;activate
82;sri-dev1;dev1;192.168.2.1;1
83;sri-dev2;dev2;192.168.2.2;1
84;sri-dev3;dev3;192.168.2.3;0
85;sri-dev4;dev4;192.168.2.4;1
86;sri-dev5;dev5;192.168.2.5;1
87;sri-dev6;dev6;192.168.2.6;1
94;sri-dev7;dev7;192.168.2.7;1
95;sri-dev8;dev8;192.168.2.8;1
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Columns are the following :

Column Description
ID ID of host
Name Host name
Alias Host alias
IP/Address IP of host
Activate 1 when enabled, 0 when disabled

Add

In order to add a host, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a ADD -v "test;Test host;127.0.0.1;generic-host;central;Linux"

Required parameters:

Order Description
1 Host name
2 Host alias
3 Host IP address
4 Host templates; for multiple definitions, use delimiter |
5 Instance name (poller)
6 Hostgroup; for multiple definitions, use delimiter |

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one host, use the DEL action. You have to list the available hosts in order to identify the one you
want to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a DEL -v "test"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to change parameters on a host configuration, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;alias;Development test "
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;address;192.168.1.68"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;check_period;24x7"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;timezone;Europe/Berlin"

You may edit the following parameters:

Parameter Description
geo_coords Geo coordinates
2d_coords 2D coordinates (used by statusmap)
3d_coords 3D coordinates (used by statusmap)
action_url Action URL

Continued on next page
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Table 15.4 – continued from previous page
Parameter Description
activate Whether or not host is enabled
active_checks_enabled Whether or not active checks are enabled
address Host IP Address
alias Alias
check_command Check command
check_command_arguments Check command arguments
check_interval Normal check interval
check_freshness Enables check freshness
check_period Check period
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
event_handler Event handler command
event_handler_arguments Event handler command arguments
event_handler_enabled Whether or not event handler is enabled
first_notification_delay First notification delay (in seconds)
flap_detection_enabled Whether or not flap detection is enabled
flap_detection_options Flap detection options ‘o’ for Up, ‘d’ for Down, ‘u’ for Unreachable
host_high_flap_threshold High flap threshold
host_low_flap_threshold Low flap threshold
icon_image Icon image
icon_image_alt Icon image text
max_check_attempts Maximum number of attempt before a HARD state is declared
name Host name
notes Notes
notes_url Notes URL
notifications_enabled Whether or not notification is enabled
notification_interval Notification interval
notification_options Notification options
notification_period Notification period
recovery_notification_delay Recovery notification delay
obsess_over_host Whether or not obsess over host option is enabled
passive_checks_enabled Whether or not passive checks are enabled
process_perf_data Process performance data command
retain_nonstatus_information Whether or not there is non-status retention
retain_status_information Whether or not there is status retention
retry_check_interval Retry check interval
snmp_community Snmp Community
snmp_version Snmp version
stalking_options Comma separated options: ‘o’ for OK, ‘d’ for Down, ‘u’ for Unreachable
statusmap_image Status map image (used by statusmap
host_notification_options Notification options (d,u,r,f,s)
timezone Timezone

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getparam

In order to get specific parameters on a host configuration, use the GETPARAM action:
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[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getparam -v "test;alias"
alias : test
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;alias|alia|timezone"
alias : test
timezone : Europe/Berlin
Object not found:alia

You may edit the following parameters:

Parameter Description
2d_coords 2D coordinates (used by statusmap)
3d_coords 3D coordinates (used by statusmap)
action_url Action URL
activate Whether or not host is enabled
active_checks_enabled Whether or not active checks are enabled
address Host IP Address
alias Alias
check_command Check command
check_command_arguments Check command arguments
check_interval Normal check interval
check_freshness Enables check freshness
check_period Check period
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
event_handler Event handler command
event_handler_arguments Event handler command arguments
event_handler_enabled Whether or not event handler is enabled
first_notification_delay First notification delay (in seconds)
flap_detection_enabled Whether or not flap detection is enabled
flap_detection_options Flap detection options ‘o’ for Up, ‘d’ for Down, ‘u’ for Unreachable
host_high_flap_threshold High flap threshold
host_low_flap_threshold Low flap threshold
icon_image Icon image
icon_image_alt Icon image text
max_check_attempts Maximum number of attempt before a HARD state is declared
name Host name
notes Notes
notes_url Notes URL
notifications_enabled Whether or not notification is enabled
notification_interval Notification interval
notification_options Notification options
notification_period Notification period
recovery_notification_delay Recovery notification delay
obsess_over_host Whether or not obsess over host option is enabled
passive_checks_enabled Whether or not passive checks are enabled
process_perf_data Process performance data command
retain_nonstatus_information Whether or not there is non-status retention
retain_status_information Whether or not there is status retention
retry_check_interval Retry check interval
snmp_community Snmp Community
snmp_version Snmp version
stalking_options Comma separated options: ‘o’ for OK, ‘d’ for Down, ‘u’ for Unreachable
statusmap_image Status map image (used by statusmap

Continued on next page
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Table 15.5 – continued from previous page
Parameter Description
host_notification_options Notification options (d,u,r,f,s)
timezone Timezone

Setinstance

In order to set the instance from which a host will be monitored, use the SETINSTANCE action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setinstance -v "Centreon-Server;Poller 1"

Getmacro

In order to view the custom macro list of a host, use the GETMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getmacro -v "Centreon-Server"
macro name;macro value;is_password;description
$_HOSTMACADDRESS$;00:08:C7:1B:8C:02;0;description of macro

Setmacro

In order to set a custom host macro, use the SETMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setmacro -v "Centreon-Server;warning;80;0;description of macro"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setmacro -v "Centreon-Server;critical;90;0;description of macro"

Note: If the macro already exists, this action will only update the macro value. Otherwise, macro will be created.

Delmacro

In order to delete a macro host, use the DELMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delmacro -v "Centreon-Server;warning"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delmacro -v "Centreon-Server;critical"

Gettemplate

In order to view the template list of a host, use the GETTEMPLATE action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a gettemplate -v "Centreon-Server"
id;name
2;generic-host
12;Linux-Servers

Addtemplate and Settemplate

In order to add a host template to an existing host, use the ADDTEMPLATE or the SETTEMPLATE action, where
add will append and set will overwrite previous definitions:
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[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addtemplate -v "Centreon-Server;srv-Linux"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a settemplate -v "Centreon-Server;hardware-Dell"

Note: All service templates linked to the new host template will be automatically deployed on the existing host. (no
longer the case with version later than 1.3.0, use the ‘applytpl’ action manually)

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Deltemplate

In order to remove a host template to an existing host, use the DELTEMPLATE action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a deltemplate -v "test;srv-Linux|hardware-Dell"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Applytpl

When a template host undergoes modified link-level service template, the change is not automatically reflected in hosts
belonging to that template. For the change to take effect, it must then re-apply the template on this host. For this, use
the APPLYTPL action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a applytpl -v "test"
All new services are now created.

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getparent

In order to view the parents of a host, use the GETPARENT action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getparent -v "Centreon-Server"
id;name
43;server-parent1
44;server-parent2

Addparent and Setparent

In order to add a host parent to an host, use the ADDPARENT or SETPARENT actions where add will append and
set will overwrite the previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addparent -v "host;hostParent1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparent -v "host;hostParent1|hostParent2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delparent

In order to remove a parent, use the DELPARENT action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delparent -v "Centreon-Server;server-parent1|server-parent2"

Getcontactgroup

In order to view the notification contact groups of a host, use the GETCONTACTGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getcontactgroup -v "Centreon-Server"
id;name
17;Administrators

Addcontactgroup and Setcontactgroup

If you want to add notification contactgroups to a host, use the ADDCONTACTGROUP or SETCONTACTGROUP
actions where add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addcontactgroup -v "Centreon-Server;Contactgroup1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setcontactgroup -v "Centreon-Server;Contactgroup1|Contactgroup2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontactgroup

If you want to remove notification contactgroups from a host, use the DELCONTACTGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delcontactgroup -v "Centreon-Server;Contactgroup2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getcontact

In order to view the notification contacts of a host, use the GETCONTACT action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getcontact -v "Centreon-Server"
id;name
11;guest

Addcontact and Setcontact

If you want to add notification contacts to a host, use the ADDCONTACT or SETCONTACT actions where add will
append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addcontact -v "Centreon-Server;Contact1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setcontact -v "Centreon-Server;Contact1|Contact2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delcontact

If you want to remove a notification contacts from a host, use the DELCONTACT action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delcontact -v "Centreon-Server;Contact2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Gethostgroup

In order to view the hostgroups that are tied to a host, use the GETHOSTGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a gethostgroup -v "Centreon-Server"
id;name
9;Linux-Servers

Addhostgroup and Sethostgroup

If you want to tie hostgroups to a host, use the ADDHOSTGROUP or SETHOSTGROUP actions where add will
append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addhostgroup -v "Centreon-Server;Hostgroup1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a sethostgroup -v "Centreon-Server;Hostgroup1|Hostgroup2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delhostgroup

If you want to remove hostgroups from a host, use the DELHOSTGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delhostgroup -v "Centreon-Server;Hostgroup2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setseverity

In order to associate a severity to a host, use the SETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setseverity -v "Centreon-Server;Critical"

Required parameters:

Order Description
1 Host name
2 Severity name

Unsetseverity

In order to remove the severity from a host, use the UNSETSEVERITY action:
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[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a unsetseverity -v "Centreon-Server"

Required parameters:

Order Description
1 Host name

Enable

In order to enable an host, use the ENABLE action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a enable -v "test"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Disable

In order to disable a host, use the DISABLE action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a disable -v "test"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Host categories

Overview

Object name: HC

Show

In order to list available host categories, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a show
id;name;alias;members
1;Linux;Linux Servers;host1
2;Windows;Windows Server;host2
3;AS400;AS400 systems;host3,host4

Columns are the following:

Column Description
Name Name of host category
Alias Alias of host category

Add

In order to add a host category, use the ADD:
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[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a add -v "Databases;Databases servers"

Required parameters are the following:

Order Description
1 Name of host category
2 Alias of host category

Del

In order to delete a host category, use the DEL action. The name is used for identifying the host category you want to
delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a DEL -v "Databases"

Getmember

In order to view the list hosts in a host category, use the GETMEMBER action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a getmember -v "Linux"
id;name
14;Centreon-Server
15;srv-test

Addmember and Setmember

In order to add a host or a host template into a host category, use the ADDMEMBER or SETMEMBER action where
add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a addmember -v "Linux;host7"
[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a setmember -v "Windows;host7|host8|host9"

The needed parameters are the following:

Order Description
1 Host category name
2 Host names to add/set. For multiple definitions, use the | delimiter

Setseverity

In order to turn a host category into a severity, use the SETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a setseverity -v "Critical;3;16x16/critical.gif"

The needed parameters are the following:

Order Description
1 Host category name
2 Severity level - must be a number
3 Icon that represents the severity
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Unsetseverity

In order to turn a severity into a regular host category, use the UNSETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a unsetseverity -v "Critical"

The needed parameters are the following:

Order Description
1 Host category name

Delmember

In order to remove a host or a host template from a host category, use the DELMEMBER action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a delmember -v "Linux;host7"
[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a delmember -v "Windows;host8"

The needed parameters are the following:

Order Description
1 Host category name
2 Host names to remove from host category

Host groups

Overview

Object name: HG

Show

In order to list available host groups, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a show
id;name;alias
53;Linux-Servers;All linux servers
54;Windows-Servers;All windows servers
55;Networks;All other equipments
56;Printers;All printers
58;Routers;All routers
59;Switches;All switches
60;Firewall;All firewalls
61;Unix-Servers;All Unix servers

Columns are the following:

Column Description
ID ID
Name Name
Alias Alias
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Add

In order to add a hostgroup, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a add -v "SAP;SAP servers"

The required parameters are the following:

Order Description
1 Name of host group
2 Alias of host group

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one hostgroup, use the DEL action. The host group name is used for identifying the host group you
would like to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a DEL -v "SAP"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific parameter for a host group, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a setparam -v "SAP;name;hg1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a setparam -v "SAP;alias;hg2"

You may change the following parameters:

Parameter Description
name Name
alias Alias
comment Comment
activate 1 when enabled, 0 otherwise
notes Notes
notes_url Notes URL
action_url Action URL
icon_image Icon image
map_icon_image Map icon image

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getmember

If you want to retrieve the members of a host group, use the GETMEMBER action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a getmember -v "Linux-Servers"
id;name
34;Centreon-Server
35;srv-web
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Addmember and Setmember

If you want to add members to a specific host group, use the SETMEMBER or ADDMEMBER action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a setmember -v "Linux-Servers;srv-test|srv-test2"
[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a addmember -v "Linux-Servers;srv-new"

Action Description
set* Overwrites previous definitions. Use the delimiter | to set multiple members
add* Appends new members to the existing ones. Use the delimiter | to add multiple members

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delmember

If you want to remove members from a specific host group, use the DELMEMBER action:

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a delmember -v "Linux-Servers;srv-test"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Host group services

Overview

Object name: HGSERVICE

Refer to the SERVICE object

Note: HGSERVICE works just like SERVICE, you only need to replace the host name with the host group name.

Instances (Pollers)

Overview

Object name: INSTANCE

Show

In order to list available instances, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a show
id;name;localhost;ip address;activate;status;init script;monitoring engine;bin;stats bin;perfdata;ssh port
1;Central;1;127.0.0.1;1;0;/etc/init.d/nagios;NAGIOS;/usr/local/nagios/bin/nagios;/usr/local/nagios/bin/nagiostats;/usr/local/nagios/var/service-perfdata;22
[...]

Columns are the following:
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Column Description
ID ID
Name Name
Localhost 1 if it is the main poller, 0 otherwise
IP Address IP address of the poller
Activate 1 if poller is enabled, 0 otherwise
Status 1 if poller is running, 0 otherwise
Init script Init script path
Bin Path of the Scheduler binary
Stats Bin Path of the Nagios Stats binary
SSH Port SSH Port

Add

In order to add an instance you use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a add -v "Poller test;10.30.2.55;22;NAGIOS"

Required fields are:

Column Description
Name
Address IP address of the poller
SSH Port SSH port

Del

If you want to remove an instance, use the DEL action. The Name is used for identifying the instance to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a del -v "Poller test"

Setparam

If you want to change a specific parameter of an instance, use the SETPARAM command. The Name is used for
identifying the instance to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a setparam -v "Poller test;ns_ip_address;10.30.2.99"

Arguments are composed of the following columns:

Order Column description
1 Name of instance
2 Parameter name
3 Parameter value

Parameters that you may change are:
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Column Description
name
localhost 1 if it is the main poller, 0 otherwise
ns_ip_address IP address of the poller
ns_activate 1 if poller is enabled, 0 otherwise
init_script Init script path
nagios_bin Path of the Scheduler binary
nagiostats_bin Path of the Nagios Stats binary
ssh_port SSH Port
centreonbroker_cfg_path Centreon Broker Configuration path
centreonbroker_module_path Centreon Broker Module path

Gethosts

If you want to list all hosts that are monitored by a poller, use the GETHOSTS action. The Name is used for
identifying the instance to query:

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a GETHOSTS -v "Poller test"
14;Centreon-Server;127.0.0.1
17;srv-website;10.30.2.1

Returned info is the following:

Order Description
1 Host ID
2 Host name
3 Host address

LDAP configuration

Overview

Object name: LDAP

Show

In order to list available LDAP configurations, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a show
id;name;description;status
3;ad;my ad conf;1
2;openldap;my openldap conf;1
[...]

Columns are the following:

Order Description
1 ID
2 Configuration name
3 Configuration description
4 1 when enabled, 0 when disabled
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Add

In order to add an LDAP configuration, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a add -v "my new configuration;my description"

Required fields are:

Order Description
1 Configuration name
2 Configuration description

Del

If you want to remove an LDAP configuration, use the DEL action. The Configuration Name is used for identifying
the LDAP configuration to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a del -v "my new configuration"

Setparam

If you want to change a specific parameter of an LDAP configuration, use the SETPARAM action. The Configuration
Name is used for identifying the LDAP configuration to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a SETPARAM -v "my new configuration;description;my new desc"

Parameters use the following order:

Order Description
1 Configuration to update
2 Parameter key
3 Parameter value

Parameters that you may change are the following:
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Key Description
name Configuration name
description Configuration description
enable 1 when enabled, 0 when disabled
alias Alias
bind_dn Bind DN
bind_pass Bind password
group_base_search Group base search
group_filter Group filter
group_member Group member
group_name Group name
ldap_auto_import Enable or disable auto import (0 or 1)
ldap_contact_tmpl Contact template to use on import
ldap_dns_use_domain Use domain or not (0 or 1)
ldap_search_limit Search size limit
ldap_search_timeout Timeout delay (in seconds)
ldap_srv_dns DNS server (only used when ldap_dns_use_domain is set to 1)
ldap_store_password Store password in database or not (0 or 1)
ldap_template Possible values: Posix, Active Directory
protocol_version Protocol version (2 or 3)
user_base_search User base search
user_email User email
user_filter User filter
user_firstname User firstname
user_lastname User lastname
user_name User name
user_pager User phone number
user_group User group

Showserver

In order to show the server list of an LDAP configuration, use the SHOWSERVER action. The Configuration Name
is used for identifying the LDAP configuration to query:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a SHOWSERVER -v "openldap"
id;address;port;ssl;tls;order
2;10.30.2.3;389;0;0;1

Addserver

In order to add a server to an LDAP configuration, use the ADDSERVER action:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a ADDSERVER -v "openldap;10.30.2.15;389;0;1"

Required parameters are the following:

Order Description
1 Configuration name
2 Server address
3 Server port
4 Use SSL or not
5 Use TLS or not
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Delserver

In order to remove a server from an LDAP configuration, use the DELSERVER action. The server ID is used for
identifying the server to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a DELSERVER -v 2

Setparamserver

In order to update the server parameters of an LDAP configuration, use the SETPARAMSERVER action. The server
ID is used for identifying the server to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a SETPARAMSERVER -v "2;use_ssl;1"

Parameters that you may update are the following:

Key Description Possible values
host_address Address of the server
host_port Port of the server
host_order Priority order in case of failover
use_ssl Use SSL or not 0 or 1
use_tls Use TLS or not 0 or 1

Resource CFG

Overview

Object name: RESOURCECFG

Show

In order to list available Resource variables, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a show
id;name;value;comment;activate;instance
1;$USER1$;/usr/local/nagios/libexec;path to the plugins;1;Central
[...]

Columns are the following :

Column Description
ID ID
Name Name
Value Value of $USERn$ macro
Comment Comment
Activate 1 when activated, 0 otherwise
Instance Instances that are tied to the $USERn$ macro

Add

In order to add a resource macro, use the ADD action:
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[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a add -v "USER2;public;Poller test;my comment"

Required fields are:

Column Description
Name Macro name; do not use the $ symbols
Value Macro value
Instances Instances that are tied to $USERn$ macro
Comment Comment

Del

If you want to remove a Resource variable, use the DEL action. The ID is used for identifying the variable to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a del -v "1"

Setparam

If you want to change a specific parameter of a Resource macro, use the SETPARAM action. The ID is used for
identifying the macro to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a setparam -v "1;instance;Poller test|AnotherPoller"

Arguments are composed of the following columns:

Order Column description
1 ID number of resource configuration
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
name Macro name; do not use the $ symbols
value Macro value
activate 1 when activated, 0 otherwise
comment Comment
instance Instances that are tied to $USERn$ macro Use delimiter | for multiple instance definitions

Service templates

Overview

Object name: STPL

Show

In order to list available service, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a show
id;description;check command;check command arg;normal check interval;retry check interval;max check attempts;active checks enabled;passive checks enabled
1;generic-service;generic-service;;;5;1;3;1;0
3;Ping-LAN;Ping;check_centreon_ping;!3!200,20%!400,50%;;;;2;2
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4;Ping-WAN;Ping;check_centreon_ping;!3!400,20%!600,50%;;;;2;2
5;SNMP-DISK-/;Disk-/;check_centreon_remote_storage;!/!80!90;;;;2;2
6;SNMP-DISK-/var;Disk-/var;check_centreon_remote_storage;!/var!80!90;;;;2;2
7;SNMP-DISK-/usr;Disk-/usr;check_centreon_remote_storage;!/usr!80!90;;;;2;2
8;SNMP-DISK-/home;Disk-/home;check_centreon_remote_storage;!/home!80!90;;;;2;2
9;SNMP-DISK-/opt;Disk-/opt;check_centreon_remote_storage;!/opt!80!90;;;;2;2

Columns are the following :

Order Description
1 Service ID
2 Service Description
3 Check command
4 Check command arguments
5 Normal check interval
6 Retry check interval
7 Maximum check attempts
8 1 when active checks are enabled, 0 otherwise
9 1 when passive checks are enabled, 0 otherwise

Add

In order to add a service template, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a add -v "MyTemplate;mytemplate;Ping-LAN"

The required fields are:

Order Description
1 Service template description
2 Alias will be used when services are deployed through host templates
3 Service template; Only one service template can be defined

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to remove a service template, use the DEL action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a del -v "MyTemplate"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific parameter for a service template, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setparam -v "MyTemplate;max_check_attempts;10"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setparam -v "MyTemplate;normal_check_interval;2"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setparam -v "MyTemplate;normal_check_interval;http://192.168.1.2/admincp"

The required fields that you have pass in options are:

15.2. Command Line API
CENTREON 46-52 RUE ALBERT FR75014 PARIS

491



Order Description
1 service template description
2 parameter that you want to update
3 new paramater value

Parameters that may be modified:

Parameter Description
activate 1 when service is enabled, 0 otherwise
description Service template description
alias Service template alias
template Name of the service template
is_volatile 1 when service is volatile, 0 otherwise
check_period Name of the check period
check_command Name of the check command
check_command_arguments Arguments that go along with the check command, prepend each argument with the ‘!’ characteri
max_check_attempts Maximum number of attempt before a HARD state is declared
normal_check_interval value in minutes
retry_check_interval value in minutes
active_checks_enabled 1 when active checks are enabled, 0 otherwise
passive_checks_enabled 1 when passive checks are enabled, 0 otherwise
contact_additive_inheritance Enables contact additive inheritance=
cg_additive_inheritance Enables contactgroup additive inheritance
notification_interval value in minutes
notification_period Name of the notification period
notification_options Status linked to notifications
first_notification_delay First notification delay in seconds
recovery_notification_delay Recovery notification delay
parallelize_check 1 when parallelize checks are enabled, 0 otherwise
obsess_over_service 1 when obsess over service is enabled, 0 otherwise
check_freshness 1 when check freshness is enabled, 0 otherwise
freshness_threshold Service freshness threshold in seconds
event_handler_enabled 1 when event handler is enabled, 0 otherwise
flap_detection_enabled 1 when flap detection is enabled, 0 otherwise
process_perf_data 1 when process performance data is enabled, 0 otherwise
retain_status_information 1 when status information is retained, 0 otherwise
retain_nonstatus_information 1 when non status information is retained, 0 otherwise
stalking_options Comma separated options: ‘o’ for OK, ‘w’ for Warning, ‘u’ for Unknown and ‘c’ for Critical
event_handler Name of the event handler command
event_handler_arguments Arguments that go along with the event handler, prepend each argument with the ”!” character
notes Notes
notes_url Notes URL
action_url Action URL
icon_image Icon image
icon_image_alt Icon image alt text
graphtemplate Graph template namei
comment Comment
service_notification_options Notification options (w,u,c,r,f,s)

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Addhosttemplate and Sethosttemplate

You may want to tie a service template to an extra host template. In order to do so, use the ADDHOSTTEMPLATE
or SETHOSTTEMPLATE actions where add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a sethosttemplate -v "MyTemplate;generic-host-template"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addhosttemplate -v "MyTemplate;Linux-Servers"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delhosttemplate

In order to remove the relation between a host template and a service template, use the DELHOSTTEMPLATE
action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delhosttemplate -v "MyTemplate;Linux-Servers"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getmacro

In order to view the custom macro list of a service template, use the GETMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a getmacro -v "MyTemplate"
macro name;macro value;description
$_SERVICETIME$;80;description of macro1
$_SERVICEPL$;400;description of macro2

Setmacro

In order to set a macro for a specific service template use the SETMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setmacro -v "MyTemplate;time;80"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setmacro -v "MyTemplate;pl;400"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delmacro

In order to remove a macro from a specific service template, use the DELMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delmacro -v "MyTemplate;time"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delmacro -v "MyTemplate;pl"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Getcontact

In order to view the contact list of a service template, use the GETCONTACT action:

[root@localhost core]# ./centreon -u admin -p centreon -o STPL -a getcontact -v "MyTemplate"
id;name
28;Contact_1
29;Contact_2

Addcontact and Setcontact

In order to add a new contact to notification contact list, use ADDCONTACT or SETCONTACT actions where add
will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addcontact -v "MyTemplate;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setcontact -v "MyTemplate;User1|User2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontact

In order to remove a contact from the notification contact list, use the DELCONTACT action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontact -v "MyTemplate;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontact -v "MyTemplate;User2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getcontactgroup

In order to view the contactgroup list of a service template, use the GETCONTACTGROUP action:

[root@localhost core]# ./centreon -u admin -p centreon -o STPL -a getcontactgroup -v "MyTemplate"
id;name
28;ContactGroup_1
29;ContactGroup_2

Setcontactgroup

In order to add a new contactgroup to notification contactgroup list, use the ADDCONTACTGROUP or SETCON-
TACTGROUP actions where add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addcontactgroup -v "MyTemplate;Group1"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setcontactgroup -v "MyTemplate;Group1|Group2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delcontactgroup

In order to remove a contactgroup from the notification contactgroup list, use the DELCONTACTGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontactgroup -v "MyTemplate"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontactgroup -v "MyTemplate;Group1"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Gettrap

In order to view the trap list of a service template, use the GETTRAP action:

[root@localhost core]# ./centreon -u admin -p centreon -o "STPL" -a gettrap -v "Ping-LAN"
id;name
48;ciscoConfigManEvent
39;ospfVirtIfTxRetransmit

Settrap

In order to add a trap to a service template, use the ADDTRAP or SETTRAP actions where add will append and set
will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addtrap -v "Ping-LAN;snOspfVirtIfConfigError"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a settrap -v "Ping-LAN;snOspfVirtNbrStateChange|snTrapAccessListDeny"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Deltrap

In order to remove a trap from a service template, use the DELTRAP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a deltrap -v "Ping-LAN;snOspfVirtIfConfigError"

Services

Overview

Object name: SERVICE

Show

In order to list available service, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a show
host id;host name;id;description;check command;check command arg;normal check interval;retry check interval;max check attempts;active checks enabled;passive checks enabled;activate
14;Centreon-Server;19;Disk-/;;;;;;2;2;1
14;Centreon-Server;20;Disk-/home;;;;;;2;2;1
14;Centreon-Server;21;Disk-/opt;;;;;;2;2;1
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14;Centreon-Server;22;Disk-/usr;;;;;;2;2;1
14;Centreon-Server;23;Disk-/var;;;;;;2;2;1
14;Centreon-Server;151;Load;;;;;;2;2;1
14;Centreon-Server;25;Memory;;;;;;2;2;1
14;Centreon-Server;26;Ping;;;;;;2;2;0
14;Centreon-Server;40;dummy;check_centreon_dummy;!2!critical;;;;2;2;1

Columns are the following:

Column Description
Host ID Host ID
Host name Host name
Service ID Service ID
Service description Service description
Check Command Check command
Command arguments Check command arguments
Normal check interval Normal check interval
Retry check interval Retry check interval
Max check attempts Maximum check attempts
Active check enable 1 when active checks are enabled, 0 otherwise
Passive check enable 1 when passive checks are enabled, 0 otherwise
Activate 1 when enabled, 0 when disabled

Add

In order to add a service, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a add -v "Host-Test;ping;Ping-LAN"

The required fields are:

Order Description
1 Host name
2 Service description
3 Service template - Only one service template can be defined

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to remove a service, use the DEL action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a del -v "test;ping"

The required fields are:

Order Description
1 Host name
2 Service description

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Setparam

In order to set a specific paremeter for a particular service, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setparam -v "test;ping;max_check_attempts;10"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setparam -v "test;ping;normal_check_interval;2"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setparam -v "test;ping;normal_check_interval;10"

The required fields are:

Order Description
1 Host name
2 Service description
3 Parameter that you want to update
4 New parameter value

Parameters that may be modified:

Parameter Description
activate 1 when service is enabled, 0 otherwise
description Description
template Name of the service template
is_volatile 1 when service is volatile, 0 otherwise
check_period Name of the check period
check_command Name of the check command
check_command_arguments Arguments that go along with the check command, prepend each argument with the ‘!’ character
max_check_attempts Maximum number of attempt before a HARD state is declared
normal_check_interval value in minutes
retry_check_interval value in minutes
active_checks_enabled 1 when active checks are enabled, 0 otherwise
passive_checks_enabled 1 when passive checks are enabled, 0 otherwise
notifications_enabled 1 when notification is enabled, 0 otherwise
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
notification_interval value in minutes
notification_period Name of the notification period
notification_options Status linked to notifications
first_notification_delay First notification delay in seconds
recovery_notification_delay Recovery notification delay
obsess_over_service 1 when obsess over service is enabled, 0 otherwise
check_freshness 1 when check freshness is enabled, 0 otherwise
freshness_threshold Value in seconds
event_handler_enabled 1 when event handler is enabled, 0 otherwise
flap_detection_enabled 1 when flap detection is enabled, 0 otherwise
retain_status_information 1 when status information is retained, 0 otherwise
retain_nonstatus_information 1 when non status information is retained, 0 otherwise
event_handler Name of the event handler command
event_handler_arguments Arguments that go along with the event handler, prepend each argument with the ‘!’ character
notes Notes
notes_url Notes URL
action_url Action URL
icon_image Icon image
icon_image_alt Icon image alt text
comment Comment

Continued on next page
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Table 15.7 – continued from previous page
Parameter Description
service_notification_options Notification options (w,u,c,r,f,s)

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Addhost and Sethost

You may want to tie a service to an extra host. In order to do so, use the ADDHOST or SETHOST actions where add
will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a sethost -v "host1;ping;host2"

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addhost -v "host1;ping;host2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delhost

In order to remove the relation between a host and a service, use the DELHOST action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delhost -v "host1;ping;host2"

The service ping which was originally linked to host1 and host2 is now only linked to host1.

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getmacro

In order to view the custom macro list of a service, use the GETMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a getmacro -v "host1;ping"
macro name;macro value;is_password;description
$_SERVICETIME$;80;0;description of macro
$_SERVICEPL$;400;0;description of macro

Setmacro

In order to set a macro for a specific service use the SETMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setmacro -v "test;ping;time;80;0;description of macro"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setmacro -v "test;ping;pl;400;0;description of macro"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delmacro

In order to remove a macro from a specific service use the DELMACRO action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delmacro -v "test;ping;time"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delmacro -v "test;ping;pl"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setseverity

In order to associate a severity to a service, use the SETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setseverity -v "Centreon-Server;ping;Critical"

Required parameters:

Order Description
1 Host name
2 Service description
3 Severity name

Unsetseverity

In order to remove the severity from a service, use the UNSETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a unsetseverity -v "Centreon-Server;ping"

Required parameters:

Order Description
1 Host name
2 Service description

Getcontact

In order to view the contact list of a service, use the GETCONTACT action:

[root@localhost core]# ./centreon -u admin -p centreon -o "SERVICE" -a getcontact -v "Centreon-Server;Ping"
id;name
28;Contact_1
29;Contact_2

Addcontact and Setcontact

In order to add a new contact to notification contact list, use the ADDCONTACT or SETCONTACT actions where
add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addcontact -v "test;ping;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setcontact -v "test;ping;User1|User2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delcontact

In order to remove a contact from the notification contact list, use the DELCONTACT action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontact -v "test;ping;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontact -v "test;ping;User2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getcontactgroup

In order to view the contact group list of a service, use the GETCONTACTGROUP action:

[root@localhost core]# ./centreon -u admin -p centreon -o "SERVICE" -a getcontactgroup -v "Centreon-Server;Ping"
id;name
28;ContactGroup_1
29;ContactGroup_2

Addcontactgroup and Setcontactgroup

In order to add a new contactgroup to notification contactgroup list, use the ADDCONTACTGROUP or SETCON-
TACTGROUP actions where add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addcontactgroup -v "test;ping;Group1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setcontactgroup -v "test;ping;Group1|Group2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontactgroup

In order to remove a contactgroup from the notification contactgroup list, use DELCONTACTGROUP action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontactgroup -v "test;ping;Group1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontactgroup -v "test;ping;Group2"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Gettrap

In order to view the trap list of a service, use the GETTRAP action:

[root@localhost core]# ./centreon -u admin -p centreon -o "SERVICE" -a gettrap -v "Centreon-Server;Ping"
id;name
48;ciscoConfigManEvent
39;ospfVirtIfTxRetransmit
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Addtrap and Settrap

In order to add a new trap, use the ADDTRAP or SETTRAP actions where add will append and set will overwrite
previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addtrap -v "test;ping;snOspfVirtIfConfigError"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a settrap -v "test;ping;snOspfVirtNbrStateChange|snTrapAccessListDeny"

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Deltrap

In order to remove a trap from a service, use the DELTRAP command:

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a deltrap -v "test;ping;snOspfVirtIfConfigError"

Service groups

Overview

Object name: SG

Show

In order to list available servicegroups, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a show
id;name;alias
11;Alfresco;Alfresco Services

Add

In order to add a servicegroup, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a ADD -v "Alfresco;Alfresco Services"

Required fields are:

Order Description
1 Name of service group
2 Alias of service group

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to remove a servicegroup, use the DEL action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a del -v "Alfresco"

15.2. Command Line API
CENTREON 46-52 RUE ALBERT FR75014 PARIS

501



Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to change parameters for a servicegroup, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a setparam -v "SG1;name;Web Service"

You can change the following parameters:

Parameter Description
activate 1 when service is enabled, 0 otherwise
name Name of service group
alias Alias of service group
comment Comments regarding service group

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getservice and Gethostgroupservice

In order to view the members of a service group, use the GETSERVICE or GETHOSTGROUPSERVICE actions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a getservice -v "Web-Access"
host id;host name;service id;service description
14;Centreon-Server;28;http
14;Centreon-Server;29;TCP-80

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a gethostgroupservice -v "Web-Access"
hostgroup id;hostgroup name;service id;service description
22;Web group;31;mysql

Note: hostgroupservice is a service by hostgroup

Addservice, Setservice, Addhostgroupservice and Sethostgroupservice

In order to add a new element to a specific service group, you can use ADDSERVICE, SETSERVICE, ADDHOST-
GROUPSERVICE, SETHOSTGROUPSERVICE where add will append and set will overwrite previous defini-
tions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a addservice -v "Web-Access;www.centreon.com,http"
[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a setservice -v "Web-Access;www.centreon.com,TCP-80|www.centreon.com,http|www.centreon.com,mysql"
[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a sethostgroupservice -v "Web-Access;web group,TCP-80"

Note: hostgroupservice is a service by hostgroup

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delservice and Delhostgroupservice

In order to remove a service from a service group, use the DELSERVICE or DELHOSTGROUPSERVICE actions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a delservice -v "Web-Access;www.centreon.com,http"
[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a delhostgroupservice -v "Web-Access;Web group,mysql"

Note: hostgroupservice is a service by hostgroup

Note: You need to generate your configuration file and restart monitoring engine in order to apply changes.

Service categories

Overview

Object name: SC

Show

In order to list available service categories, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a show
id;name;description
1;Ping;ping
2;Traffic;traffic
3;Disk;disk

Columns are the following:

Column Description
Name Name of service category
Description Description of service category

Add

In order to add a service category, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a ADD -v "Alfresco;Alfresco Services"

Required parameters are:

Column Description
Name Name of service category
Description Description of service category

Del

In order to remove a service category, use the DEL:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a del -v "Alfresco"

15.2. Command Line API
CENTREON 46-52 RUE ALBERT FR75014 PARIS

503



Setparam

In order to change parameters for a service category, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a setparam -v "SG1;name;Web Service"

You can change the following parameters:

Parameter Description
Name Name of service category
Description Description of service category

Getservice and Getservicetemplate

In order to view the member list of a service category, use the GETSERVICE or GETSERVICETEMPLATE action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a getservice -v "Ping-Category"
host id;host name;service id;service description
14;Centreon-Server;27;Ping
27;srv-web;42;Ping

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a getservicetemplate -v "Ping-Category"
template id;service template description
22;Ping-LAN
23;Ping-WAN

Addservice, Setservice , Addservicetemplate and Setservicetemplate

In order to add a new element to a specific service category, you use the following action ADDSERVICETEM-
PLATE, where add will append and set will overwrite previous definitions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a addservicetemplate -v "Ping-Category;my template"

Delservice and Delservicetemplate

In order to remove a service from a specific service category, use the DELSERVICE OR DELSERVICETEM-
PLATE actions:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a delservice -v "Ping-Category;my host,my service"

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a delservicetemplate -v "Ping-Category;my template"

Setseverity

In order to turn a service category into a severity, use the SETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a setseverity -v "Critical;3;16x16/critical.gif"

The needed parameters are the following:

Order Description
1 Service category name
2 Severity level - must be a number
3 Icon that represents the severity
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Unsetseverity

In order to turn a severity into a regular service category, use the UNSETSEVERITY action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a unsetseverity -v "Critical"

The needed parameters are the following:

Order Description
1 Service category name

Settings

Overview

Object name: Settings

Show

In order to list editable settings, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SETTINGS -a show
parameter;value
broker;ndo
broker_correlator_script;
centstorage;1
debug_auth;0
debug_ldap_import;0
debug_nagios_import;0
debug_path;/var/log/centreon/
debug_rrdtool;0
enable_autologin;1
enable_gmt;0
enable_logs_sync;1
enable_perfdata_sync;1
gmt;1
interval_length;60
mailer_path_bin;/bin/mail
nagios_path_img;/usr/share/nagios/html/images/logos/
perl_library_path;/usr/local/lib
rrdtool_path_bin;/usr/bin/rrdtool
snmpttconvertmib_path_bin;/usr/share/centreon/bin/snmpttconvertmib
snmptt_unknowntrap_log_file;snmptrapd.log

Setparam

If you want to change a specific parameter of a Vendor, use the SETPARAM action:

[root@centreon ~]# ./centreon -u admin -p centreon -o SETTINGS -a setparam -v ";"

Arguments are composed of the following columns:

Order Column description
1 Parameter name
2 Parameter value
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Parameters that you may change are:

Column Description Possible values and
examples

broker Broker engine ‘broker’ for Centreon
Broker

bro-
ker_correlator_script

This parameter is misleading (subject to changes) Refers to
the Centreon Broker init script

i.e: cbd

centstorage Enable/disable CentStorage Enable: ‘1’, Disable: ‘0’
debug_auth Enable/disable authentication debug Enable: ‘1’, Disable: ‘0’
de-
bug_ldap_import

Enable/disable LDAP debug Enable: ‘1’, Disable: ‘0’

de-
bug_nagios_import

Enable/disable Nagios configuration import Enable: ‘1’, Disable: ‘0’

debug_path Debug log files directory i.e: /var/log/centreon/
debug_rrdtool Enable/disable RRDTool debug Enable: ‘1’, Disable: ‘0’
enable_autologin Enable/disable autologin Enable: ‘1’, Disable: ‘0’
enable_gmt Enable/disable GMT management Enable: ‘1’, Disable: ‘0’
enable_logs_sync Enable/disable CentCore log synchronization (not necessary

when using Centreon Broker)
Enable: ‘1’, Disable: ‘0’

en-
able_perfdata_sync

Enable/disable Centcore PerfData synchronization (not
necessary when using Centreon Broker)

Enable: ‘1’, Disable: ‘0’

gmt GMT timezone of monitoring system i.e: 2 (for GMT+2)
interval_length Monitoring interval length in seconds (default: 60) i.e: 120
mailer_path_bin Mail client bin path i.e: /bin/mail
nagios_path_img Nagios image path i.e:

/usr/share/nagios/html/images/logos/
perl_library_path Perl library path i.e: /usr/local/lib
rrdtool_path_bin RRDTool bin path i.e: /usr/bin/rrdtool
snmpttconvert-
mib_path_bin

SNMPTT mib converter bin path i.e:
/usr/share/centreon/bin/snmpttconvertmib

sn-
mptt_unknowntrap_log_file

SNMPTT unknown trap log file i.e: snmptrapd.log

Time periods

Overview

Object name: TP

Show

In order to list available time periods, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a show
id;name;alias;sunday;monday;tuesday;wednesday;thursday;friday,saturday
1;24x7;24_Hours_A_Day,_7_Days_A_Week;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00
2;none;No Time Is A Good Time;;;;;;;
3;nonworkhours;Non-Work Hours;00:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-24:00
4;workhours;Work hours;;09:00-17:00;09:00-17:00;09:00-17:00;09:00-17:00;09:00-17:00;
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Add

In order to add a Time Period, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a add -v "Timeperiod_Test;Timeperiod_Test"

Required fields are:

Order Description
1 Name
2 Alias

Del

If you want to remove a Time Period, use the DEL action. The Name is used for identifying the Time Period to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a del -v "Timeperiod_Test"

Setparam

If you want to change a specific parameter of a time period, use the SETPARAM action. The Name is used for
identifying the Time Period to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a setparam -v "Timeperiod_Test;monday;00:00-24:00"

Arguments are composed of the following columns:

Order Column description
1 Name of time period
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
name Name
alias Alias
sunday Time Period definition for Sunday
monday Time Period definition for Monday
tuesday Time Period definition for Tuesday
wednesday Time Period definition for Wednesday
thursday Time Period definition for Thursday
friday Time Period definition for Friday
saturday Time Period definition for Saturday
include example: [...] -v “Timeperiod_Test;include;workhours”; Use delimiter | for multiple inclusion definitions
exclude example: [...] -v “Timeperiod_Test;exclude;weekend” use delimiter | for multiple exclusion definitions

Getexception

In order to view the exception list of a time period, use the GETEXCEPTION action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a getexception -v "mytimeperiod"
days;timerange
january 1;00:00-00:00
december 25;00:00-00:00
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Setexception

In order to set an exception on a timeperiod, use the SETEXCEPTION action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a setexception -v "mytimeperiod;january 1;00:00-24:00"

Note: If exception does not exist, it will be created, otherwise it will be overwritten.

Delexception

In order to delete an exception, use the DELEXCEPTION action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a delexception -v "mytimeperiod;january 1"

Arguments are composed of the following columns:

Order Column description
1 Name of timeperiod
2 Exception to remove from timeperiod

Traps

Overview

Object name: TRAP

Show

In order to list available traps, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a show
id;name;oid;manufacturer
576;alertSystemUp;.1.3.6.1.4.1.674.10892.1.0.1001;Dell
577;alertThermalShutdown;.1.3.6.1.4.1.674.10892.1.0.1004;Dell
578;alertTemperatureProbeNormal;.1.3.6.1.4.1.674.10892.1.0.1052;Dell
599;alertFanEnclosureInsertion;.1.3.6.1.4.1.674.10892.1.0.1452;Dell
600;alertFanEnclosureRemoval;.1.3.6.1.4.1.674.10892.1.0.1453;Dell
601;alertFanEnclosureExtendedRemoval;.1.3.6.1.4.1.674.10892.1.0.1454;Dell
602;alertLogNormal;.1.3.6.1.4.1.674.10892.1.0.1552;Dell
605;ccmCLIRunningConfigChanged;.1.3.6.1.4.1.9.9.43.2.0.2;Cisco
[...]

Add

In order to add a trap, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a add -v "aNewTrap;.1.3.6.1.4.1.11.2.3.9.7.1.0.30"

Required fields are:

Order Description
1 Trap name
2 OID of the SNMP Trap
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Del

If you want to remove a Trap, use the DEL action. The Name is used for identifying the Trap to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a del -v "aNewTrap"

Setparam

If you want to change a specific parameter of a Trap, use the SETPARAM command. The Name is used for identifying
the Trap to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a setparam -v "aNewTrap;vendor;3com"

Arguments are composed of the following columns:

Order Column description
1 Name of Trap
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description Possible values
name Name
comments Comments
output Output
oid OID
status Status ok, warning, critical, unknown or

0, 1, 2, 3
vendor Vendor name A valid vendor name
matching_mode Advanced regexp matching mode 1 to enable, 0 to disable
resched-
ule_svc_enable

Whether or not will reschedule service check when
trap is received

1 to enable, 0 to disable

execution_command Command to be executed when trap is received A valid Unix command line
execu-
tion_command_enable

Whether or not will execute the
‘execution_command’

1 to enable, 0 to disable

submit_result_enable Whether or not will submit result to Service 1 to enable, 0 to disable

Getmatching

In order to display the list of matching rules defined for a specific trap, use the GETMATCHING command:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a getmatching -v "aNewTrap"
id;string;regexp;status;order
8;@OUTPUT@;/test/;UNKNOWN;1

Column Description
ID ID of the matching rule
String String to match
Regexp Matching Regular Expression
Status Status to submit
Order Priority order of the matching rule
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Addmatching

In order to add a matching rule, use the ADDMATCHING command:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a addmatching -v "aNewTrap;@OUTPUT@;/test2/;critical"

Required fields are:

Order Description Possible values
1 Trap name
2 String to match
3 Matching Regular Expression
4 Status to submit ok, warning, critical, unknown or 0, 1, 2, 3

Delmatching

In order to delete a matching rule, use the DELMATCHING command:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a delmatching -v "8"

Required fields are:

Column Description
ID ID of the matching rule

Updatematching

In order to delete a matching rule, use the UPDATEMATCHING command:

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a updatematching -v "8;status;critical"

Arguments are composed of the following columns:

Order Column description
1 ID of the matching rule
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description Possible values
string String to match
order Priority order
status Status to submit ok, warning, critical, unknown or 0, 1, 2, 3
regexp Matching Regular Expression

Vendors

Overview

Object name: VENDOR
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Show

In order to list available vendors, use the SHOW action:

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a show
id;name;alias
1;Cisco;Cisco Networks
2;HP;HP Networks
3;3com;3Com
4;Linksys;Linksys
6;Dell;Dell
7;Generic;Generic
9;Zebra;Zebra
11;HP-Compaq;HP and Compaq Systems

Add

In order to add a Vendor, use the ADD action:

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a add -v "DLink;DLink routers"

Required fields are:

Order Description
1 Name
2 Alias

Del

If you want to remove a Vendor, use the DEL action. The Name is used for identifying the Vendor to delete:

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a del -v "DLink"

Setparam

If you want to change a specific parameter of a Vendor, use the SETPARAM command. The Name is used for
identifying the Vendor to update:

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a setparam -v "3com;name;HP"

Arguments are composed of the following columns:

Order Column description
1 Name of Vendor
2 Parameter name
3 Parameter value

Parameters that you may change are:

Column Description
name Name
alias Alias
description Description

15.2. Command Line API
CENTREON 46-52 RUE ALBERT FR75014 PARIS

511



Generatetraps

It is possible to generate new SNMP traps from a given MIB file. In order to do so, use the GENERATETRAPS
command:

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a generatetraps -v "3com;/usr/share/mymibs/3com/A3COM-SWITCHING-SYSTEMS-MIB.mib"
[...]
Done

Total translations: 10
Successful translations: 10
Failed translations: 0

Note: Make sure to put all the mib file dependencies in the /usr/share/snmp/mibs/ directory before starting the
generation. Then, remove them when it is done.

Required fields are:

Column Description
Name Name of Vendor
Mib file File path of .mib

15.2.4 Import/Export

Export

At some point, you might need to export all of the object configuration parameters into a plain text file, either for
synchronizing or backuping purpose.

The following items will not be exported:

• Escalation

• ACL (ACL Groups, ACL Resources, ACL actions)

• LDAP settings

• Global Centreon settings

This export feature is ran like this:

[root@centreon ~]# ./centreon -u admin -p centreon -e > /tmp/clapi-export.txt

This will generate CLAPI commands and redirect them to the /tmp/clapi-export.txt file.

This file can now be read by the import command.

With this, you can also build your own CLAPI command file if you know the straight forward syntax.

For instance::

HOST;ADD;Host-Test1;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test2;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test3;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test4;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test5;Test host;127.0.0.1;generic-host;Local Poller;Linux
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Export of a subset of objects

Compatibility: Centreon Web >= 2.7.7

You can choose to export only predefined hosts or services.

For example, to export all services linked to “srv-mssql-01” host you have to execute following command:

[root@centreon ~]# ./centreon -u admin -p centreon -e --select=’HOST;srv-mssql-01’ --filter-type=’^(HOST|SERVICE)$’

To export “memory” and “mssql-listener” services execute following command:

[root@centreon ~]# ./centreon -e --select=’SERVICE;memory’ --select=’SERVICE;mssql-listener’ --filter-type=’^SERVICE$’

To export all commands run:

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a show | awk -F\; ’NR > 2 { print "--select=\"CMD;" $2 "\"" }’ | xargs --verbose php ./centreon -u admin -p centreon -e

Import

You can import configuration from the exported file /tmp/clapi-export

[root@centreon ~]# ./centreon -u admin -p centreon -i /tmp/clapi-export.txt

In case you have a very large export file, it is advised to redirect the output of the above command to a file. Indeed,
when errors occur during the import process, CLAPI will print out an error message along with the line number of the
file, you might need to store those output message for troubleshooting later on.

You can build your own CLAPI command file if you know the straight forward syntax. You can use parameter
described in Object Management with the syntax you can see in export files

OBJECT;AACTION;Parameter1;Parameter2;Parameter3;...

15.3 Centreon Plugin API

15.3.1 Other Resources

If you’re looking at writing your own plugins for Centreon Engine, please make sure to visit these other resources:

• The official Nagios plugin project website

15.3.2 Plugin Overview

Scripts and executables must do two things (at a minimum) in order to function as Centreon Engine plugins:

• Exit with one of several possible return values

• Return at least one line of text output to STDOUT

The inner workings of your plugin are unimportant to Centreon Engine. Your plugin could check the status of a TCP
port, run a database query, check disk free space, or do whatever else it needs to check something. The details will
depend on what needs to be checked - that’s up to you.
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15.3.3 Return Code

Centreon Engine determines the status of a host or service by evaluating the return code from plugins. The following
tables shows a list of valid return codes, along with their corresponding service or host states.

Plugin Return Code Service State Host State
0 OK UP
1 WARNING UP
2 CRITICAL DOWN/UNREACHABLE
3 UNKNOWN DOWN/UNREACHABLE

15.3.4 Plugin Output Spec

At a minimum, plugins should return at least one of text output. Beginning with Centreon Engine 3, plugins can
optionally return multiple lines of output. Plugins may also return optional performance data that can be processed by
external applications. The basic format for plugin output is shown below:

TEXT OUTPUT | OPTIONAL PERFDATA LONG TEXT LINE 1 LONG TEXT LINE 2 ... LONG TEXT LINE N | PERFDATA LINE 2 PERFDATA LINE 3 ... PERFDATA LINE N

The performance data (shown in orange) is optional. If a plugin returns performance data in its output, it must separate
the performance data from the other text output using a pipe (|) symbol. Additional lines of long text output (shown in
blue) are also optional.

15.3.5 Plugin Output Examples

Let’s see some examples of possible plugin output...

• Case 1: One line of output (text only) Assume we have a plugin that returns one line of output that looks like
this:

DISK OK - free space: / 3326 MB (56%);

If this plugin was used to perform a service check, the entire line of output will be stored in the SERVICEOUT-
PUT macro.

• Case 2: One line of output (text and perfdata) A plugin can return optional performance data for use by external
applications. To do this, the performance data must be separated from the text output with a pipe | symbol like
such:

DISK OK - free space: / 3326 MB (56%);|/=2643MB;5948;5958;0;5968

If this plugin was used to perform a service check, the first portion of output (left of the pipe separator) will be
stored in the SERVICEOUTPUT macro and the second portion of output (right of the pipe separator) will be
stored in the SERVICEPERFDATA macro.

• Case 3: Multiple lines of output (text and perfdata) A plugin optionally return multiple lines of both text output
and perfdata, like such:

DISK OK - free space: / 3326 MB (56%);|/=2643MB;5948;5958;0;5968
/ 15272 MB (77%);
/boot 68 MB (69%);
/home 69357 MB (27%);
/var/log 819 MB (84%);|/boot=68MB;88;93;0;98
/home=69357MB;253404;253409;0;253414
/var/log=818MB;970;975;0;980
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If this plugin was used to perform a service check, the red portion of first line of output (left of the pipe separator)
will be stored in the SERVICEOUTPUT macro.

The orange portions of the first and subsequent lines are concatenated (with spaces) are stored in the SERVICEPERF-
DATA macro. The blue portions of the 2nd - 5th lines of output will be concatenated (with escaped newlines) and
stored in LONGSERVICEOUTPUT the macro.

The final contents of each macro are listed below:

Macro Value
$SERVICEOUT-
PUT$

DISK OK - free space: / 3326 MB (56%);

$SERVICEPERF-
DATA$

/=2643MB;5948;5958;0;5968 /boot=68MB;88;93;0;98
/home=69357MB;253404;253409;0;253414 /var/log=818MB;970;975;0;980

$LONGSERVICE-
OUTPUT$

/ 15272 MB (77%);\ /boot 68 MB (69%);\ /var/log 819 MB (84%);

With regards to multiple lines of output, you have the following options for returning performance data:

• You can choose to return no performance data whatsoever

• You can return performance data on the first line only

• You can return performance data only in subsequent lines (after the first)

• You can return performance data in both the first line and subsequent lines (as shown above)

15.3.6 Plugin Output Length Restrictions

Centreon Engine will only read the first 4 KB of data that a plugin returns. This is done in order to prevent run-
away plugins from dumping megs or gigs of data back to Centreon Engine. This 4 KB output limit is fairly
easy to change if you need. Simply edit the value of the MAX_PLUGIN_OUTPUT_LENGTH definition in the
include/centengine.h.in file of the source code distribution and recompile Centreon Engine. There’s noth-
ing else you need to change!

15.3.7 Examples

If you’re looking for some example plugins to study, I would recommend that you download the official Centreon
Engine plugins and look through the code for various C, Perl, and shell script plugins. Information on obtaining the
official Centreon Engine plugins can be found here.

Additional online resource:

• Demo
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